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Word Processing Study
Subject 1
1. copy file
(selects copy)
[Name of file to be copied:]
(enters STIJDYDOC)
[Name of flle to be copied to:]
(enters S'TIJDY.COP)
2. edit file
You want me to edit the copy? That's a non-document file then, so it's N [because extension isn't .DOC].
Well you want to edit iJ as a document, so you better rename it as somerhing.DOC
(renames and opens copy)
3. delete char. insert word
(inserts word. overlooks char)
4. insert paragraph
Anywhere at the beginning?
Top right-hand like in a letter.
(moves cursor to the right in f1tst line, starts typing)
That's on the same line as your text is now ...
Ob right (deletes characters) What do I do to move the text down?
Where are you at the moment?
In the frrst line.
And what can you do to get some space (moves cursor to the beginning of line, presses CR. moves cursor with TAB, inserts para)
5. move paragraph
(presses CONTROL-K) Now, I did something wrong- I CONTROL-K ... I thought it was the K's that block the
text off Wasn't it CONIROL-K?
Yes - you've got the Block Menu up now ...
{reads menu) Is it V for MOVE?
You've got to mark the text first CONfROL-K B?
You are in the CONTROL-K menu already- you can select the beginning marker now- which one is that?
B (selects, moves cursor with ARROW KEYS}
There must be a quicker way ofdoing that (looks at tbe menu, uses CONTROL-F)
And now you want to mark the endI've lost the menu You haven't lost it- it returns to the Main Menu once you have selected a command.
(CONfROL-K, selects k to mark block) Now I've got to move this [positions cursor] . (CONTROL-K, selects

C)
[paragraph copied to cursor position]
Ab, that was a mistake, I've copied it rather than moved it.
(suggests he deletes this in the following task) .
6. delete paragraph
(deletes line-by-line)
Would there be another way ofdeleting a block of text like that?
I think is there is, but I haven't done it You block the text again?
7. copy paragraph (address) into separate file (transfer task)
Do I just open a new fde and call it address?
You can create a new file witlwut leaving this document, by marking a piece of textI block it again frrst (inserts Beginning Marker, whole text marked) I thought it would just mark the beginning,
tbe f"rrst letter, and now it's done the next paragraph .. .
(explains)
So that will disappear when I insert the other one? (inserts End Marker)
Now you want to farm that out into a different file - it's in the K menu ...
(CONTROL-K) W- WRITE?
Yes, why tlwt one
Well, it's not the whole file to be saved. it's not placing a marker, it will be something in the Block Options,
and it's not COPY, and none of the others (selects WRITE)
[Name of me to write text to: ]
So I just call it address? (does)
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8. include file (transfer task)
CONTROL-K again? (selects, read Block Menu) It's another ... is it in the other menus?
No, it's in the K menu. You're now saying include an existing file in this document READING it?
Why do you think it's READ?
Well, I just want to have a look at it and make sure it's the right one.
If you select READ, it will import the file straight away. You have to put the cursor where you want it.
(does)

9. delete block of text
(deletes line and wocd-by-word)
10. save edited file
(CONI'ROL-K)
And to go to the Opening Menu is SAVE and?
(presses SPACE BAR) What do you want me to call it?
You've got to SAVE it first Didn't I save it then?
No, when you press SPACE BAR it cancels the menu - it's CONTROL-K and
(CONTROL-K. reads Block Menu) D? (saves me)
11. rename file
(renames file)
12. What does a word-processor do?
It's something that's not linked to a Mainframe computer - so you can take it anywhere you go. It's like having
all your files on a small piece of disk. I don't really know enough about it to say what it can do.

Subject 2
1. copy file
(copies flle)

2. edit file
(edits flle)
3. delete char, insert word
(overlooks this one)
4. insert paragraph
Wbere do you want this?
Top right-hand comer, like in a letter.
(moves cursor to the rigbt, presses UP ARROW a couple of times) Hm ....
What's the problem?
It won't go up.
Where in the document are you?
Line 1 ... so I've got to move the whole lot down?
What is the easiest way to do that?
Scrolling?
No (explains what scrolling does). How can you get extra bltlnk lines?
I've done this, but I can't remember ...
Ifyou put the cursor on the first character, and then press RETURN
(does) Abl (moves up, presses CONTROL-F to mqve to the right) Wby doesn't that work?
(explains)
(uses SPACE BAR, then TAB to move to the right, inserts para)
5. move paragraph
(mark.s para, positions cursor, reads menu) It's probably CONTROL-K (selects, reads Block Menu, selects
MOVE)
6. 6. delete paragraph
(inserts Beginning Marker)
(text marlc:ed to end of following previously marked para]
Hang on, I don't want to delete that bit.
No, but you haven't inserted your End Marker yet. (explains)
(inserts End Marker and deletes para)
1. copy paragraph (address) into separate file (transfer task)
So you want me to copy my name and address into another file? Which one - what is it called?
How do you normally copy a piece oftext?
You highlight it and tben you select a command. _
You don't have to leave this document to do this, you just choose a similar command that copies it into a
new file.
(marlcs para) What now?
If you have a look at the CONTROL-K menu
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(does) COPY Fll..E?

That will COPY the entire file ...
C?

That would copy this block within this document.
Yes, that's true ... WRITE? Yes? That's very logical (laughs). (selects WRlTE)
[Name of ftle to write text to: ]
(entees filename)
8. include file (transfer task)
(selects CONTROL-K and reads Block Menu)
Any idea?
Well if th~ last one is any~ing to go by, ~t could be anything. Wel~ it's probably a Block Operation ...
lAst tune we started wtth a block wh1ch we turned into a file, and now we are including a complete file into
the document ...
So it's a file operation ... COPY? ... READ? If it's sort of the opposite ... (includes file) Why was it
inserted down there?
'Cos that's where I left the cursor.
9. delete block of text
(marks block and deletes with CON1ROL-K Y)
10. save edited file
(presses CONTROL-K and reads Block Menu, presses SPACE BAR) Where has it gone.
(explains) Which SAVE option did you want?
SAVE & EXIT? That would take me right out. SAVE & RESUME?
That would SAVE but you'd stay in this file.
Well, that only leaves one (laughs). Why is it called SAVE & DONE?
(explains)
11. rename file
(selects REN'AME and renames flle)
12. What does a word-processor do?
It's a machine for writing out pieces of text, and you can change things easily before you print them out Unlike
a typewriter - you make a mistake and that's it, it's printed - you can decide what you are going to write, change
it. move it around, and then print it

Subject 3
1. copy file
(types copy)
[warning: error bas occured- not a recognised Wordstar command)
Isn't it COPY to copy a file? [trying to use DOS command]
You can copy the file within Wordstar- just get rid of the error message by pressing ESCAPE.
(does) Is it D to open a file?
You want to copy i( first 0 then (selects and copies flle)
Z. edit file
(selects
[Name of file to edit]
Which one do you want me to edit?
The copy.
(enters filename)
3. delete char, insert word
(switcbes to type-over mode, types word over char)
4. insert paragraph
(presses UP ARROW a few times, cursor moves to ·the right)
You want to insert your address in the top-right hand comer.
.
How do 1 get above it [line 1] (reads Main Menu, CONTOL-H to move screen down, tnes UP ARROW agam) It
still won't go(explains scrolling) So what do you have to do.1
Insert some space at the top - bow do I move the whole thing down again?
·
What's the easiest way to do that?
RETURN _ I'm on the H (first char) at the moment - (inserts blank lines, moves up, moves to the right with
TAB and inserts para)
5. move paragraph
.
. .
(pos'tions cursor presses CONTROL-K and reads Block Menu, selects B to msert Begmnmg Marker, moves to
end ~ith CONTROL-F. CONTROL-K K to mark para; positions cursor and selects CONTROL-K V to move

EDm

pmt)
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6. 6. delete paragraph
(deletes line-by-line)
Is there any other way to delete a paragraph?
I suppose you could probably do the same - mark it and delete it. but I can't remember how to do that.
7. copy paragraph (address) into separate file (transfer task)
It must be K, I'm sure (presses CONTROL-K and reads Block Menu) COPY?
What do you have to do first with these operations?
Mark wbat I want to copy first (returns to file, inserts Beginning Marlcer)
[all text marked]
~nteresting - it's highlighted it all from the beginning - I thought that only happened when you fmisbed marking

lt.

Why do you think it's done tlult?
Maybe I haven't wiped off the last one -

(explains)
(inserts End Marker) To a separate file (presses CONTROL-K and reads Block Menu) Well I want to COPY itbut I can't see where it says to a separate me.
(explains wlult COPY does)
Must be one of these (File Operations) then -

Since you are marking a block of text in. the current file, it's a Block Operation - it's WRITE.
WRITE? SoW - (selects)
[Name of me to write text to: ]
What shall I call it? (enters mename)
8. include file (transfer task)
(presses CONTROL-K and reads Block Menu) I can't tell from these File Operations which one includes an
outside me ...

You're doing something tlult is similar to the operation you did before- you're reading in a whole file
Do I have to go and get the me fJ.£St?
When you select the option, it will ask you which file you want ... it's READ.
Oh I see (selects READ and enter filename)
[flle imported]

Can you see where it went?
Ob the cursor was there, that's why.
9. delete block of text
(marks bloclc and CONTROL-Y to delete)
10. save edited file
(presses CONIROL-K and reads Bloclc Menu) SAVE & EXIT?
Where would tlult take you?
Ob no, that will take ymr out to the A> cursor [operating system]. that's not what we want. Is it S (SAVE &

RESUME)
.
Tlult would save but stay in the same document.
Must beD then (laughs) (saves flle)
11. rename file
I have lO OPEN it frrst, do I?

No, you can RENAME it without opening it first.
RENAME? (selects and renames file)
·
U. What does a word-processor do?
Good grief ... it makes it easy to type without thinking what your are doing, you just put the words on the page
and you can tidy it up afterwards, you don't have to .think about the formatting. Y~u can.make as ~Y mistakes
as you like without anyone noticing, 'cos you can wipe them out afterwards. And If you ve got a basic letter and
you just want to change the name and address, you can do that without typing it again and again, you just change
the name and address.

Subject 4
1. copy file
(copies file)
2. edit file
So, load me copy? (selects EDIT and enters filename)
3. delete char, insert word
Just put my name where the cursor is now?
No, instead of the X.
.
Oh, sorry. (moves cursor and inserts word) Is that 1t?

Can you delete the X?
(does)
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4. insert paragraph
(moves cursor to the right in line 1, presses UP ARROW a few times ) Hm

Why do you think it won't go up ?

····

'cos this is the top of the page?

_so what do you ha_ve to do if you want some space on top ?
Put m a space ... Do I JUSt press the SPACE BAR? Can't I just scroll up?

No (explains). If you put the cursor on to thejirstletter-

(does) And now?

You press CR a couple of times and that will push the whole lot down.

(does) Ob I see.

Now you want to move over to the right So do I just type in lots of SPACES?

Or you can use the TA.B.
(does, inserts para)
5. move paragraph
Unfortunately, I can't type in "no" [in response to "can you remember bow to do that?"] (laughs). You mark it,
don't you? (positions cursor) It's CONTROL-B. isn't it?

CONTROL ... ?
CONTROL-K B! (inserts Beginning Marker, moves to end) CON1ROL-K E?

You can look it up in the menu ijyou're nor sure.
(presses CONTROL-K and reads Block Menu) Oh, it's K again. (marks block)

And now?
Is that still in the CONTROL-K menu?

Where is it going to move it to?
Ob, I've got to put the cursor ... (positions cursor) And then it's (presses CONlROL-K and reads Block: Menu)
V (moves para)
6. delete paragraph
(deletes cbar-by-<:har)

There must be a quicker way to do this.
What. mark it and then delete it? Or CONTROL-Y. (deletes line-by-line)
7. copy paragraph (address) into separate file (transfer task)
(selects HELP menu) Hm ... I wouldn't know bow to do it
Well. you want to (explains).
CONTROL-K C?
1'hlJJ would be copying within the same document.
(moves cursor to para, tries to move it to right with TAB) How do I move to the right?
CONTROL-F?
(does, inserts Beginning Marker)
[all text marked]
Ugh! It's marked the lot! Is it because of the CARRIAGE RETIJRN? Have I done something wrong?
No (explains)
(inserts End Marker)
What you have to do now is go to the Block Menu and see if you can find the command.
(presses CONTROL· K and reads Block Menu) So is it just SAVE?
No - because you are taking a block of text out' of the current document, it's a block operation.
Is it MOVE?
No, that's what you just did.
Must be WRilE, then. (selects and writes file)
8. include file (transfer task)
Do I have to leave the document?
No (explains)
(presses CONTROL-K and reads Block Menu) Can't see anything ...
It's one of the File Operations ...
COPY?
No.

READ?
Why READ?
. ,
'Cos you can read another me ... (selects READ and includes flle) Oh - 1 d1dn t see where the cursor was.
9. delete blo.c k of text
(deletes line and word-by-word)
10. save edited file
Return to the Opening Menu ...

Where are the SAVE options?

Transcripts-5

Can I press F8 (function key)? CONTROL-0?
No. It's in the CONTROL-K menu as well.
(presses CONTROL-K and reads Block Menu) Shall I copy it first.
No.
SAVE&EXIT?
Where will that take you?
Out of the sysrem? SAVE & RESUME?
Where will that take you?
Back to the start again.
No, that will leave you in the same document.
Must be SAVE & DONE then, I don't know what that meant. (saves ftle)
11. rename file
Wbat did I call it flrst? (selects EDfD
You don't want to ediJ it again ... ESCAPE will take you back
RENAME? (selects and renames ftle)
12. 12. What does a word-processor do?
Just allows you to put text in, juggle about with the text, put it where you want. And typing and moving around
the screen, create your own piece of writing. And you can save it on disk, and use it any other time you want,
and change it any time you want.

Subject 7
1. copy file
(selects COPY)
[Name of ftle to be copied:]
(enter ftlename)
[Name of fde to be copied to:]
You want another name? (enters new mename)
2. edit file
(selects EDm
[Name of file to be opened:]
(enters filename)
3. delete char, insert word
Right. Is this Wordstar that I'm in now? (deletes char, insens word)
4. insert paragraph
Would you like the address above this [flfst line]? Can I get it in above it? I don't know how to actually insert
something above here - my cursor is right at the start.
You're at the top left TWW, but want some space before that- what could you do?
You want to move the whole block of text down, you want to create room at the top.
How could you do that?
(thinks) Well, I could INSERT a line- do a few SPACE BARS - (presses CR) Ah - great. (inserts a few blank
lines, tries to move cursor to the right with RIGHT ARROW) Ah - it won't go.
Any idea why not?
No.
What can you actually do?th a cursor? What is it therefor?
To mark a position in the text
But you have no text up there- you've ...
Tabulate! (uses TAB to indent, inserts para)
S. move paragraph
That's K (CONTROL-K to bring up Block Menu, presses K) Ah - I put in KK instead of KB.
(helps him to remove it) Start again.
(inserts Beginning Marker and End Marker, positions cursor) Now - I can't remember what the command was to
actually MOVE the paragraph. And the K menu doesn't help, I'm not sure ... (CON1ROL-K). Is it MOVE?
(presses V)
6. delete paragraph
(uses DELE1E LINE)
Is there another way to do il?
Presumably by paragraph - it will be in the K menu. Could you do it by marking the paragraph and then a
command ... (presses K X and exits program) Ob dear, I pressed the wrong one, I've got to get back into
Wordstlt (do?)
7. copy paragraph (address) into separate file (transfer task)
Right, so I've got to open another me?
Why?

I want to open another file - I want to go back to the .. .
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There is a way to save this out into a separate file without leaving this o ne . you can mark a piece and say
Is that in the K menu? Do you mark it again in the same way? (tries to move cursor with TAB) (marks para)
Is it the C [COPY] in Block?
No - that's within the same document.
Must be WRITE then (selects)
[Name of ftle to write text to: ]
How many characters can you use in a filename?
Eight.
(enters filename)

8. include file (transfer task)
(CONTROL-K, reads menu) It should really be called READ . because iit's the same as WRITE in reverse.
(selects READ)
[file inserted at cursor position]
So it reads the whole me that I asked for straight in? Could I ask for a block from a particular flle?
9. delete block of text
My initial response would be to use DELETE LINE and DELE1E WORD - I know you can mark it and delete
it, but I can never remember these K-K's and K-D's. (deletes line and then words)
10. save edited file
(CONTROL K, reads menu) It's D. (selects)
11. rename file
You want me to change the name? (selects command)
[Name of me to rename: ]
That was COPY.IX>C, wasn't it? (enters filename)
[New Name:]
(enters new name)
12. What does a word-processor do?
It's a very extensive typewriter system, where everything you ever wish to do on a typewriter is there • it's a
typewriter, computerised. And also it's a filing cabinet, 'cos it can store as well.
What's different from a typewriter?
The ability to always correct errors · you can always correct

Subject 8
1. copy file
(selects COPY)
[Name of me to be copied:]
(enters filename)
[Name of me to be copied to:]
What do you want me to call it?
I don't mind· NEW.DOC?
(enters new filename)

2. edit file
(selects EDIT and presses CR) Why won't it do anything?
(e.xpfajns she pressed CR and therefore entered bank filename)
(selects EDIT and enters ftlename)

3. delete char, insert word
(deletes char, inserts word)
4. insert paragraph
What, at the beginning at the text?
Well, you obviously need some space ...
(moves cursor to line 2 and inserts blank lines)
You should try and put it before anything else, like in a letter.

rn

(explains she has to put cursor at very beginning)
(does, inserts blank lines with CR) (moves cursor to right with TAB and types address)

5. move paragraph
So you want me to move this paragraph? Is it- well I think I can remember the instructions ... Is it K • B?
(positions cursor and inserts Beginning marker) (moves cursor char-by-char)
Is there a quicker way?
Don't know (holds RIGIIT ARROW down) (positions cursor, presses CONTROL-K K to insert End Marker)
Now rve got to move it down {positions cursor), and it's K V. (selects command and moves para)

6. delete paragraph
I can't remember how to delete. (moves cursor to beginning and deletes char-by-char)
There must be a faster way of doing this.
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I can't do it without the instructions.

You've got DELETE commands in tlult menu up there

Ah- DELETE LINE. (does)

...

When you've got a block like tlult, you can mark it and delete it.
7. copy paragraph (address) into separate file (transfer task)
(types J) I keep pressing J to get HELP.
It's CONTROL-J for HELP
(Calls HELP Menu, reads it) Don't know.
What do you do when you copy within a document?
Is that what we just did previously?
It's a similar operation- you have to the piece of text you want and then select a command
Can't I just put X and SAVE it?
.
You don't have to exit it to do that.
ls that K V or s001ething.
That moves it within the same document.
So I've got to mark something (moves cursor to para, tries to use TAB then to move cursor to right)
(explains)
(positions cursor at the beginning) ls that K B then? (inserts Beginning Marker)
[all text marked]
Why does it do that?
(explains)
(inserts End Marker) Now I want to put it in a separate file ... CONTROL-D?
Why don't you have a look at the menu that contains the commands for COPY and MOVE?
(calls up Block Menu)
Which one do you think it might be?
Is it CONTROL-0 or something?
No, that's a menu.
Can't we use COPY, then?
No, to copy it into another file ...
RENAME?
No- WRITE.
(selects)
[Name of me to write text to: ]

m

What does it want to know?
What ftle do I want to put it into? (enters filename)

8. include file (transfer task)
Is that CONTROL-D?
What does thill do?
That will tell me - show me all the different commands.
There is no CONTROL-D menu - CONTROL-D moves the cursor to the right.
So I'm trying to get INCLUDE.DOC onto this file, and this file is called NEW.DOC. So I want to COPY,
don't!?
If you lulve a look at the previous menu - since it contained the command for saving a piece of text ifllo a
file ...
(calis up Block Menu, reads) MOVE?
No, you used tlult to move a piece of text within a file.
READ?
Why READ ?
I can't understand wby we don't use COPY in the first place, that's what you use for flies .
No, within a document it's called READ.
(includes file)
9. delete block or text
(deletes cbar-by-cbar)
Isn't there a quicker way?
CONIROL-X?
How do you delete a whole line?
(uses CONTROL-Y, deletes tbe rest char-by-char)
10. save edited file
That's CONTROL-X, is it? No, it's not ... (CONTROL-K to see Menu) S instead of X you think?
Where does X take you?
Takes us back to the ... can't think. Doesn't take us back to the Main Menu, anyway. S? [SAVE & RESUME]
Thai would lilke you back to the document.
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D then (selects)

11. rename file
(selects RENAME)
[Name of ftle to rename: )
What was it called?

NEW. DOC.
(renames file)

12. What does a word-processor do?
I think it's faster than writing, so if you want to wipe things off you can do that easily. You can also chop text
up and move bits from one to another. It's faster, and you can delete things ...

Subject 9
1. copy file
(selects copy)

[Name of me to be copied:)
(enters STIJDY .DOC)
[Name of me to be copied to:]
(enters STIJDY .NEW)
2. edit file
(selects OPEN)
[Name of file to be opened:]
(STIJDY .DOC)

Is that the copy?
Ob (changes to S1UDY.NEW)
3. delete char, insert word
(badcspaces cbaract.er and adds name)

4. insert paragraph
(Moves to beginning of the text, tries to move cursor upwards) How do you scroll up?

What exactly are you trying to do?
Bring this [fU'St line of text) down so that get the space to add ... (reads menu) SCREEN DOWN, is it?
[points out that he is in line 1, column 1) If you think about it, can you go up any further than line 1?
No you can't· transfer that [text in line 1] down bere?

How can you do thai?
Do you mark the whole lot and scroll?
Whal does scrolling do?
Whal you really need to do is insert a couple of blank lines- whaJ's the easiest way to get a few extra lines?

Press RETIJRN?
What will happen if you press RETURN?
It will space it out (presses CR a few times, moves cursor up, uses TAB to move cursor, types address.)
S. move paragraph
You want me to move this one? See if I can remember bow to do that. (positions cursor at the beginning of the
paragraph). I really need my instructions, I can't remember the commands ...

If you haven't got your instructions, how can you find out which command it is?
From lhe menu ... (selects Block Menu, reads block operations) Beginning, end ... So it's CONTROL-K V.

But what do you have to do first?
Mark this piece of text. (Sets beginning and end marker [doesn't know bow to move cursor to end of line]

What's next?
Mark: the ... tell the computer where it want to go? CONTROL-K B to bring it down?

How can you tell it where you want it to go?
Using the cursor! (positions cursor)

And now?
I can't remember ... (calls menu up) V. (presses CONTROL-K V)
6- delete paragraph
(deletes dlaracler-by-dlaracter)

lsn't there a quicker way ofdoing this?
I need the actual instructions bow to do it ...

You could look at the menu and see if there's ...
(reads menu) DELE1E! (deletes word by word using CONTROL-n

Can you delete a whole line at once?
(reads menu again) Yes. (deletes two remaining lines with CON"ffiOL- Y)
1. copy paragraph (address) into separate file (transfer task)
Are there any instructions for doing this?
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We~l. you have .c opied paragraphs within the same document before- can you find out whether there's and
optwn to copy ll into a separate file?
Well. you ~veto name a file- don't I have make to a me ftrst?
Maybe It will ask you ...
Oh, you mean you select the command and it says: "Name of fLle ... " I need another menu to do it ...
Whal do you Mrmally do when you copy a block of text?
You've got to mark it ... (presses TAB to move cursor. text is moved) Rats!
What happened there?
Ab - I pressed TAB, but it pushes the text further out. (deletes extra spaces, positions cursor with cursor keys
before first char selects CONTROL-K for Block Menu, then B)
[whole text marked]
Argb- what happened there?
(explains)
(inserts end marker, selects Block Menu with CONTROL-K)

Which one do you think it is?
(reads menu) It's C for COPY ... but that's within the same ftle ... don't know.

E: It's WRITE.
Ob really? I wouldn't have guessed ... (selects W)
[Name of ftle to write text to: ]
You have to give it a name ...
Can I call it anything I want? (enters filename)
8. include file (transfer task)
So there's a file there you want me to include?

Yes· any Idea how to do it?
No.

What commands have you got?
(reads menu) Is it one of these [flle operations]. It's not RENAME, is it? (reads menu again)

You'vejust written text out to a separate file, what did you use for that?
. ?
WRITE agam.
rrs the last one ...
What. READ?
Well, it's the opposite of WRITE ...
Oh dear (selects oonunand to include ftle)
9. delete block of text
[not attempted]
10. save edited file
CONTROL-K D [SAVE & OONE]
11. rename file
selects command
[Name of me to rename: ]
(enters SlUDY DOC)
[New Name:]
What shall I call it?
How about your name?
(uses surname as ftlename)
12. What does a word-processor do?
It stores information ... basically, it's the same as using paper ... lbe computer doesn't actually do too ma.'ly
calculations ... well, it can do, in certain programs ... it's more for storing information in a much more compact
form. documents and papers and flies ... it helps you to compose what you are trying to write, 'cos you can come
back to something and add new pages- if I had to do a dissertation in my 3rd year, it would be ideal, things
you've missed out you can insert. You can save things all the time, so you don't loose anything. That's it,
really.

Subject 10
1. copy file
(copies file)

2. edit file
Actually go into the copy? (selects edit)
[Name of file to edit:]
(enters filename)

3. delete char, insert word
(Deletes fust line and adds her name)
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4. insert paragraph

Do you want me to type my address? (pushes her name over to right using TAB. inserts a few blank lines and
<kids her 3(kJress)
5. move paragraph
(moves CUJ'SOr to beginning of block, CONTROL-K for Block menu, selects Beginning Marker, moves to end of
block (wold-by-word), selects End Marlc:er)
So you have marked it now ...
(positions cursor, CONTROL-K for Block Menu, selects MOVE)

6. delete paragraph
(deletes J.ioe..by-line)
You have deleted this line-by-line Could I have deleted it with this [points to marked para]?
7. copy paragraph (address) into separate file (transfer task)
Do I need to come out of this me?
You don't have to- you can mark a para within a document and save tlult into a separate file.
(tries to move cursor with TAB) (inserts Beginning Marker)
[all text highlighted]

m

(explains)
(inserts End Marker, CONTROL-K for Block Menu) It must be C
That copies within in the same document, so it can't be the same for this ...
So is it a File Operation?
No - it's WRITE.
(selects WRITE)
[Name of ftle to write text to: 1
(enters filename)

8. include file (transfer task)
I'm completely stuck now.
You're trying to include this file ... it's similar to the operation you have just done ...
So it's CONTROL-K (brings up menu) So would it be a COPY?
No - to include it in this file, you have to use READ.
(selects READ, enter ftlename)
Where did it put it?
Where the cursor was.
9. delete block of text
(sets Beginning and End Marker, CONTROL-K, selects DELETE BLOCK)
10. save edited file
(CONTROL-K) SAVE & EXIT - that will take me out to the Main Menu [the instruction says Opening Menu]
won't it?
That will take you to the Operating System (selects SAVE & DONE)
11. rename file
(selects
You don't have to edit it:
(CONTROL-U to UNDO) Hmm (reads menu) (Selects RENAME)
[Name of flle to rename: ]
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(enters filename)
[New name:]
(enters new filename)

12. What does a word-processor do?
Oh goodness - I would say that it's very much like using a typewriter on a - with a computer. But you can
actually store information on a computer disk. It enables you to move text around and to delete it, and it's more
flexible than a typewrite1'.

Subject ll
1. copy file
(selects COPY)
[Name of file to be copied:]
(enters filename)
[Name of
to be copied to:}
I'll just check the name I want isn't used already ... (enters fLlename)

me

l. edit file
Open it? (selects OPEN)
[Name of file to edit]
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(enters fiJename)
3. delete char, insert word
(deletes char and inserts word)
4. insert paragraph
(positions cursor on later char in 1st line, presses UP ARROW) Can I use RlGHT ARROW now or will that
just go into the next line.
Yes it will.
CONTROL-F (fOIWard)
Where are you now?
Line!
Is tMre any space above no?
No.
So Jww could you get some space up there?
Press RE1URN.
BUl if you press RETURN now, where would the line be insened?

????
You want to insert the space above to the first line ...
(moves cursor to the beginning and inserts lines, moves cursor to right) How can I go up there without it
{cursor] going back to tbe beginning?
You can use the TAB (explains)
(positions cursor and enters address)
S. move paragraph
(positions cursor and presses CONIROL-K D) Oh that wasn't it - CONTROL-K D is for SAVE & EXIT.
What was it that you were trying to do?
CONTROL-K something ... CONTROL-K K is for tbe end (returns to rue, positions cursor, CONTROL-K B to
insert beginning marker, moves to end (word-by-word) and inserts End Marker, positions cursor) CONTR.OL-K
V? (selects MOVE)
6. delete paragraph
(deletes line-by-line)
You deleted using CONTROL-Y- is there any other way you could have done it?
Could I have marked it as a block and then deleted it?
7. copy paragraph (address) into separate file (transfer task)
Hmm - so, would I make up a new ftle for this?
You will be creating a new file, yesHelp! If I create a file and put it in, if I wanted to write a letter, how would the computer know that I just
wanted this address and phone number?
You mark. the address and phone no. in this file, and say "this is whaJ I want to put into a separate file.
So I mark it tbe same way that I've marked things before? (inserts Beginning Marker, whole text marked) It's
marked everything on the screen!
(explains)

(inserts End Marker) So if I press CONfROL-K (does, reads Block Menu) C.
No. (explains COPY) It one oftM others.
WRIIE? (selects)
{Name of file to write text to: ]
(enters fllename)
8. include file (transfer task)
So if I look in CONTROL-K, and see if there is anything- (does, reads Block Menu) There's nothing here (in
Block Operations).
No, because you're importing an entire file, it's under File Operations.
COPY or READ?
It's READ.
(selects, includes flle, cursor happens to be in correct position)
9. delete block of text
Wouldn't I want to delete all this? (marks block) Is it D? CONTROL-K something ...
You could look. it up in the menu - it's Y.
10. save edited file
CONTROL-K D? That's SAVE & DONE ... (saves file)
11. rename file
(renames flle)
12. What does a word-processor do?
Well it's a means of being able to produce letters, documents, and being able to correct it on the screen before
you print il It saves a lot of time and effort. You can re-fonnat things.
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Subject 12
1. copy file
(selects CONTROL-0 and CR) Hm ...
I think you were a bit too quick there -you just pressed CR and enJered no filename.
Ob I see (selects option)
[Name of ftle to be copied:]
(enters filename)
[Name of me to be copied to:]
(enters new fLlename)
2. edit file
(selects
[Name of tile to edit:}
Do I want to get rid of this?
No, now you enter the name of the copy-
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(does)

3. delete cbar, insert word
(typeS word. deletes character)
4. insert paragraph
Do you want me to put my address up here on the right?
Yes.
(pressing UP ARROW) It won't go up.
Where in the file are you?
I'm at the beginning of the letter.
It won't move the cursor up - why not?
'Cos that's the beginning of the file.
Yes, any ideaCARRIAGE RETURN?
Yes.
(inserts a few blank lines using CR. uses TAB to indent, enters para.
S. move paragraph
(positions cursor within para to be moved. CONTROL.{))
[Onscreeo Menu]
Was that the wrong thing to do?
What were you trying to do ?
Trying to mark the beginning - I thought it was 0 but it's not. (ESC to remove menu) Is it K?
Yes- but where do you want to put the marker?
At tbe beginning and at the end. Ob- (positions cursor at beginning of para, CONTROL-K. reads Block Menu)
B (selects B, moves cursor to end of para. inserts End Marker)
[paragraph marked]
I've got to move the cursor to where I want it (positions cursor, selects MOVE)
6. delete paragraph
(deletes line-by-line)
Can you think of another way of doing this?
Delete the paragraph, but I couldn't remember wba~ that was.
7. copy paragraph (address) into separate file (transfer task)
Oaugbs) I can't find out how to do anything on this. [referring to instructions]
Well, it's similar to operations like COPY and MOVE, but you want it in a separate file.
So I create a file for my name and address?
Yes, but you don't have to leave this file to do that. You can mark a block of text and copy this into a
separate file.
Is that COPY AND RESUME?
Thai's for copying the enJire file ...
So I mark this (pushes TAB to move cursor and pushes text) Oops.
(explains)
(inserts Beginning Marker)
[all text marked]
Why bas it done that?
(explains)
(inserts End Marker, CONTROL~K)
[Block Menu]

Any idea which it might be?
C?

You can't use that, since it copies within the same document. What else could it be?
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MOVE?

Tfuzl's what you did before Oh, sorry, yes ...
How about WRITE?
(selects WRfiE)
[Name of me to write text to: ]
(entets filename)
8. include file (transfer task)
Hm ...
It's a similar operation, but now you're calling a file to include ...
How do I get back to tbe ooginning?

The beginning ojwhat?
I want to find it from the Opening Menu.

You don't have to leave this file- where do you want to put it?
Below the paragraph (positions cursor)
Why don't you have a look at the menu and see if you can find a commandIs it CONTROL-V?
No, it's in the Block Menu as well?
(selects Block Menu, reads) HIDE and DISPLAY?
You've just done WRITE to put it into a separate file - what's the opposite of WRITE?
Wrong (laughs) - WRITE ... MOVE?

No it's READ.
(selects READ and includes file)
9. delete block of text
(deletes line and word-by-word)
10. save edited file
(CONTROL-K, selects SAVE & DONE)
11. rename file
(selects RENAME)
[Name of me to rename: J
(enters fJ.I.ename and new mename)
12. What does a word-processor do?
It's just like a typewriter, isn't it? Well, it's more sophisticated than a rypewriter- you can re-arrange paragraphs,
and it's easy to get rid of mistakes you've made. You can print out as many copies as you like.

Subject 13
1. copy file
It's 0, isn't it (selects COPY)
[Name of f"tle to oo copied:]
(S1UDY .DOC)
[Name of me to oo copied to:]
What shall I call it? (enters falename)
2. edit file
So I've got to load it in (selects
[Name of file to edit:]
(enters filename)
3. delete char, insert word
(deletes char, inserts word)
4. insert paragraph
(presses UP ARROW a few times) Now this is the interesting bit- how to get it [lbe cursor] to go up? Does it
means at the reginning of this text.
What is the problem?
I want the screen to go down, don't I? Shift everything back a bit.
Any itka how to do that?
To mark it and to move it down?
There's a quicker way ofdoing it.
Keep pressing CARRIAGE RETIJRN. But the CARRIAGE RETIJRN has got to be in front (at the beginning
ot) the row. (moves cursor and inserts blank lines by pressing CR) Do you want the address that this [right-hand]
side? (presses RIGIIT ARROW a few times)
[CUfS(X' moves down]
Ob!
Why can't you get the cursor over there?
(presses SPACE BAR) I can do it with that one.
Or?

EDm
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CONTROL-F ... but that's for words, isn't it? [means because it move word-by-word) (uses TAB and inserts
Jma)

5. move paragraph
(moves cursor to the beginning) Is it K, B? (inserts Beginning Marker, moves lO end with RIGHT ARROW)
Is there a quicker way ofdoing that?
Yes - CONTROL-F. (inserts End Marker, inserts End Marker)
And now?
l move the cursor down to where I want it to be (does) I can't remember how to do it- it's not CON'IROL-K, B
is it?
You could just look it up.
Yes (CONTROL-K, reads Block Menu) V (selects MOVE)

6. delete paragraph
This is going to be interesting (presses CONTROL-K) How do you delete it (reads menu) without going back
letter by Ieuer?
If you look al the Block OperationsIt's TBut what do you have to do first?
Made the text (does, selects DELE1E BLOCK)

7. copy paragraph (address) into separate file (transfer task)
Do you make a file called address?
You don't have 10 leave the file- you CQil copy it from this document into a new [de.
So I have to go back up (moves to para) So do I mark that piece of text? (marks para) So it's File ... (looks at
Main Menu) Is it in K? (presses CONTROL-K, reads Block Menu) C?
No - that would copy it within the same file.
(reads again) I'm afraid I don't know which one it is - is it the RENAME?
It's WRITE.
(selects)
[Name of me to write text to: }
What shall I call it, just address or something? (names file)

8. include file (transfer task)
Ah - how do I do that? Can I get help from K - K seems to be very helpful (laughs) (CONTROL-K, reads Block
Menu) Is it that H one ... or is it READ?
Why READ?
Because it means I can read other files. (includes file)
Why did it include it at this point?
Because my cursor was there.

9. delete block of text
(marks para, deletes)
10. save edited file
(presses CONTROL-K) I have to have a look at this ... It's SAVE & OONE, isn't it? (saves file)

11. rename file
So- (selects RENAME. renames file)

12. What does a word-processor do?
It's a lot easier to use than a typewriter, because you can move things around. And it's a lot more variable,
because you can put things in without messing the paper up. I was a bit scared to begin with in case I might
break something, but it's not easy to break things. It's a lot easier and quicker to get things done in a way. And
it looks neater- they're a very good idea, really.

Subject 14
1. copy file
(selects command)
[Name of flle to be copied:)
(enters Sn.JDY DOC)
[Name of ftle 10 be copied to:]
Willi call that by a new name?

You have to give it a new name ...
(enters NEW.DOC)

2. edit file
(selects edit)
[Name of file to be opened:}
(enters NEW.DOC)
3. delete char, insert word
(positions cursor, deletes char, enters text, bits CONTOL-K instead of SHIFT-K)
[Block Menu}
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What happened?
I bit the CON1ROL key instead of the SHIFT. (presses E and inserts End Marker)
Whal's thai?
One of those things for block ...
Yes (explains why block marker was inserted, removes it.)
4. Insert paragraph
Do you want it here [below the flfSt line)
No, above the first line ... you need some more space at the beginning- how could you do that?
Insert a new line?
How do you do thai?
Just press RETI.JRN?
Where would it insert the line if you pressed the RETURN now?
Where is the cursor now? ... You want it above the first line.
(positions cursor at the beginning) It won't go any further up ...
No, you're right at the beginning ...
(uses CONTROL-M to insert blank lines) (tries to use cursor keys to move cursor to the right)
The cursor keys won't take you there- how can you get it over to the right?
Create a new margin?
You could - but there's a quick way ofdoing it?
(uses SPACE BAR)
(points out TAB key)
5. move paragraph
(moves cursor to beginning of para) CONTROL-K?
What would you like to now?
Mark it out- (presses CON1ROL-K) I just want to look at the other menu to fmd out. (reads Block Menu)
CON1ROL-K B?
But you've already pressed Control-K.
What did you do to get this menu?
CONTROL-K- so just B now? (does, moves cursor to end using CURSOR KEYS.)
Is there a quicker way ofdoing that?
Ob yes (moves word-by-word) CONTROL-K K? (does, para is marked.
What now?
(moves cursor to new position) Is it COPY?
What are you trying to do?
Can I go back to the instructions? (CONTROL-K, reads Block Menu) CONTROL ... V? (selects, para is
moved)
6. delete paragraph
With those (commands] as well? (Inserts beginning marker)
[whole text marked]
Hm ....
What's happened?
I wanted to mark this paragraph.
(explains)
(inserts end marker)
Now you tell it you want to delete it.
(CONTROL-K, reads Block Menu, selects, D)

7. copy paragraph (address) into separate file (transfer task)
Is that in the same menu?
What do you have to do to copy it?
Mark the block that you want to copy. (marks beginning, moves cursor to end, presses CONTROL-K B again)
(previous beginning marker moved to end]
Why doesn't it mark it?
(explains)
(marks block) Will I have to open another file?
How are you going to find out what to do?
Go to the K menu (does, reads menu)

Which one looks most promising?
The file operations ... or ... Can we copy that onto another disk? [diskette]
You want to copy it onto the same disk. just a separate file. You have used the COPY and MOVE
comnuuu:ls - maybe there is another one there.
(reads menu) WRfiE? (selects it)
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[Name of me to write text to: )
Just call it a new fllename? ADDRESS.IXX:: (does that)
8. include file (transfer task)
(reads Main Menu) Open a file INCLUDE.rxx::? Do I have to finish this first?

There is a file called INCLUDE.DOC which you can import into this document. You don't have to ll!ave
this document.
???

You just copied a piece of teXI into a separate file, now you're trying to do the opposite. Any idea how to
do thtu? It's in the same menu ...
(CON1ROL-K to call up Block Menu) Is it WRI1E again?
That writes something from your current file into a new file - you want to call in an existing fill! ...
READ? (laughs)? I don't want to DELETE. or COPY ... (CONfROL-Y to include file)
9. delete block of text
You can delete the line, or mark it as a block again. (deletes line) Can I get rid of the rest by typing over with a
SPACEBAR?

No.
10. save edited file
(CONlROL-K to call up Block Menu) Save and Exit?

Where will thtu take you?
The beginning?

What's the difference between the three SAVE options you lulve ?
Tbe fust one (SAVE & resume) means you can go back to it, SAVE & DONE means that's the end of it SAVE & EXIT- I'm not quite sure.
(explains)
11. rename file
(selects RENAME)
[Name of ftle to rename: ]
(enters current ftlename)
[New Name:]
(enters new name)
12. Wbat does a word-processor do?
Well, basically like a typewriter, if you're using it as a typewriter, it's got additional functions like when you
make mistakes, you don't have to correct them straight away - you can correct them before they are printer out on
paper. You can insert things ... the tabbing and all that, it's easier to do then on paper - you can lay it out
beforehand. It's very efficient. It can do calculations ... I suppose that's the computer. It all on disk and in the
memory - there's a program already done for you - I would work from my instructions. You've got a set of
commands, and you just follow those.

Subject 16
1. copy file
(selects COPY)
[Name of me to be copied=]
(enters STI.JDYDOC)
[Name of flle to be copied to:]
Don't mow what to call it ... (enters ANGELA.DOC)
2. edit file
The original, or tbe copy? (selects EDIT)
[Name of file to be opened:]
The copy.
(enters ANGELA.DOC)
delete cbar, add text
(deletes character, inserts word)
4. insert paragraph
(positions cursor at beginning, hits UP ARROW repeatedly)
What are you trying to do?
Trying to get further up to put my address ...

Which line are you currently on?
The top one ... so you can't go further ...

So what do you have to do?
I don't know bow to get further up ...

You need some more space on top there, don't you? 'Cos you are on line one at the TTI()ment ...
So I have to move the text further down ...

Any Uka how to do that?
It's not by marking it, is it?
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No- how cou/Li you put some extra lines in?
I can't remember.

Wluu lulppens if you press CR now?
Does it bring it down? (tries it) Oh I see. (inserts lines, presses RIGHT ARROW to move cursor to the right)
[cursor goes down 10 next line]
Why does it go down when I press right?
(explains)
(uses TAB to position cursor, enters paragraph)
5. move paragraph
(moves cursor to beginning of para) CONTROL-K B, isn't it? (inserts marker) (moves cursor using CURSOR

KEYS)
Is there a faster way ofdoing this?
Yes (moves word-by word) (inserts End Marker) (positions cursor) Right- is it just B? I can't remember. I just
can't remember the conunand to bring it down [MOVE)

It's part of the K [Block] Menu, ifyou're not sure.
(calls up menu. reads it) B?

What does CONTROL-K B do? You've done that.

v (does)

6. delete paragraph
(deletes lines with CONTROL-Y)

Cou/Li you get rid of it as one block?
I wouldn't know how.
You could mark it as a block
Oh I see
7. copy paragraph (address) into separate file (transfer task)
Into a separate ftle? What do you mean, in its own file, so you can keep calling it back? Isn't it just like a new
file, you make it ...

WhaJ you want to do here is copy it out from this file - you don't have to leave this file.
Do I mark it in some way? (tries to move cursor with TAB and pushes text)
(explains)
(insert beginning marker)

[whole text marked]
Why did it do that?
(explains)
(inserts End Marker) Is it in K? (call up Block Menu, reads) What is the difference between File Operations and
Block Operations?
(explains)
So I don't want to do that (File Operations)
It's WRITE.
Ah ... (selects)
[Name of file to write text to: ]
Oh I see (names flle)
8. include file (transfer task)
So that will be in the K Menu - calling in an outside file. (selects Block Menu - reads) So is it READ?
Why do you think it's READ?
·
Because I want 10 see it. (selects READ)
[para inserted at cursor position)

Can you see wluu happened there?
Has it gone over [overwritten) something?
No. It's just inserted it right in the middle ofthis paragraph- why?
Because the cursor was there.
?. delete block of text
(deletes using DELETE LINE and DELETE WORD)
10. save edited file
SAVE & DONE, is it?
Ifyou want to go to the Opening Menu ...
Ah- X, is it?
Where will that take you?
Hm- the operating system?
Yes. So which one do you want?
SAVE & OONE (does)
11. rename file
(selects command)
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[Name of ftle to rename: ]
(enters filename)
[New Name:]
(enters new filename)
12. What does a word-processor do?
I suppose I would liken it to a typewriter, with a keyboard and a memory or something ... it's much more
flexible, though, you can correct mistakes and that ... you can store things ... re-format things ... What I found
difficult is things like spaces and tbat, when you're keying in things, and it won't accept it- little things like
fullstop and colon when you're naming files are very important

Subject 17
1. copy file
So it's COPY Fll...E? (selects COPY)
[Name of file to be copied:]
(enters filename)
(Name of me to be copied to:]
Does it not matter what I call it? (enters NEW .DOC)
2. edit file
(opens tile)
3. delete char, insert word
(deletes cbar, inserts word)
4. Insert paragraph
Do you want it as if it was a letter? It [tbe cursor] won't go up, 'cos it's at line 1 already. If I press CARRIAGE
RE1URN, will that insert lines? Do I have to go to the beginning [of the line]? (moves cursor and inserts lines,
moves up and moves to right witb SPACE BAR).
You can use the TAB (does, inserts address)
S. move paragraph
(positions cursor, CONTROL-K B to insert Beginning Marker, moves word-by-word, CONTROL-K K to insert
End Marker, presses CONTROL-K and reads Block Menu) You want it down there? (tries to move cursor)
[system error]
I don't think it likes you tTWving the cursor while it's waiting for a selection.
(positions cursor, presses CONTROL-K V to MOVE para)
6. delete paragraph
(marks para. presses CONTROL-K and reads Block Menu, selects Y to DELE'IE marked block)
7. copy paragraph (address) into separate file (transfer task)
So can I copy tbe paragraph while I'm in this file - I don't have to go out? So if I just mark it? (moves to para,
tries to use TAB to position cursor) Argb!
What happened?
I've inserted some spaces (deletes those) Can I use those (RIGHT ARROW)? (does, marks para, presses
CONTROL-K and reads Block Menu) So I can just press C?
That would copy it within the same document.

0?
That will copy the whole file ... Since you mark a block in the current document to start with. it's a Block
Operation.
Wel~

it's not COPY and not MOVE -

WRITE (selects WRITE and enters ftlenarne)
8. include file (transfer task)
So can I stay in this me, and look at it?
You can just call up the file from within this document.
Hm (reads Main Menu) There's nothing bere.
It's similar to the operation you just did before.
I just don't know bow you can do it and stay in this file.
By telling it "I want to include a file" and it will ask you for the name.
HELP? Or is it in K? (presses CONTROL-K and reads Block Menu) I don't know ... presumably it must be a
File Operation ... so is itjust READ?
Yes. Why do you think it might be READ?
'Cos you can read tbe text of the file. (includes me)
9. delete block of text
(Ill3lks block and deletes it)
10. save edited file
(presses CONTROL-K and reads Block Menu) So just X?
Where will X take you?
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Oh, that will go to the Operating System. D [SAVE & DONE] - (does)
11. rename file
(selects RENAME and renames flle)
12. What does a word-processor do?
I would say that it's quite like a typewriter, in that you use a keyboard the same as a typewriter, and you can see
what your typing on the screen. But the advantage is you can always edit it, change the spelling, change the
format. and it's a lot easier than on a typewriter. And if you can type, it's a lot quicker than writing.

Subject 18
1. copy file

(copies file)

l. edit file
(selects OPEN)
[Name of file to edit)
(hesitates) So, which one ...
The copy(enters filename)
3. delete char, insert word
(inserts word, deletes char)
4. insert paragraph
(presses UP ARROW, cursor at end of line 1)
[cursor moves down]
Ob! (returns cursor to line 1 and tries again) HrrunWhat's the problem?
I've got to move the screen up ...
Where are you al the moment?
Is it right at the top?
That's right - so what do you want to do ?
Move the text down ...
What is the easiest way of doing that ?
Just using this [CR]?
Yes.
(inserts lines, moves cursor to right with TAB, inserts address)
5. move paragraph
(moves to beginning of para) Is it CONTROL-K B? (inserts Beginning Marker, moves to end using
CXONTROL-F) K, K? (inserts End Marker) Down here? (positions cursor) CONTROL ... K, C? Is that to
COPY it.
C is COPY- wok it up if you're not sure ...
(hesitates) What's that. by doing the K? (CONTROL-I<. reads Block Menu) MOVE, so it's V . (moves para)
6. delete paragraph
All this? DELEfE ... by line or by block?
Which ever you think is faster.
(inserts Beginning Marker)
[text marked to end of following, previously marked block]
Ob.!
What's happened?
It's done all of that.
(explains)
(inserts Eod Marker and deletes para)
7. copy paragraph (address) into separate file (transfer task)
So I need to bring a new screen up? Would I have to mark il and then tell the computer to copy it? So I've got
to bring the screen up [scroll]. (tries to move cursor with TAB)
(explains why she can't use TAB)
So bow would I get there?
CONTROL-F.
(marlcs para)
Now you have to find out what command is for copying it into a separate file ... where do you think it
might be?

Blodc?
Yes, it is in the Block Menu.
(CONTROL-K, reads Block Menu, points to marked para) So you want me to copy that into an extra file?
COPY?
That's within the same document ...
This one? (points to FILE COPY)
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That would copy the entire file. Since you are copying a block from a current file, this is classed as a Block
Operation ...
Ab - it's not MOVE, is it? HIDE?

What about WRITE?
Oh. (selects WRITE)
[Name of file to write text to: ]
So I'm creating a new ftle now, so I have to give it a new name? (does)
8. include file (transfer task)
So I've got to get into tlle other file, INCLUDE.DOC.

All you have to do is tell the system that you want it included in this document.
Hm ... I can't think bow to do that
It's the reverse operalion ofwhat we did previously.
So CONI'ROL-K? (brings Block Menu up, reads) It's not HIDE & DISPLAY?
It's a file operation.
COPY?
That will copy tire wlwle file.
ITs not DEI..E'IE ... READ? (selects READ, enters filename)
Why did it insen there
??? ... 'cos I bad the cursor there?
9. delete block of text

10. save edited file
SAVE ... Q was it?

Which menu contains the SAVE options?
No it's in the K menu.
(presses CONTROL-K) Dis it? (saves file)
11. rename file
E (selects RENAME.
[Name of file to rename: )
(enters new filename, CR)
[New name:]
Oh.

You've got to enter the name of the file you want to RENAME first. If you press ESCAPE and try again.
(does and renames flle)
U. What does a word-processor do?
Well, it's easier ... it's got lots of different uses. It's easy to type letters, 'cos you can save so many things on it
You can move things around ... it's basically like a really really complex typewriter, I suppose, it's got a Jot
more uses than that. If you want to go back and delete things or change them, you can do it Or if you have a
file in there and want to update it. and you can print it off.

Subject 20
1. copy file
So 0 (selects 0)
[Name of me to be copied:]
(STUDY DOC, CR)
[Name of me to be copied to:]
So I can call it anything? (enters filename)
edit file
So shall I edit S1UDY or this one? (opens copy)

z.

3. delete char, insert word
Right. (deletes char, inserts word)
4. insert paragraph
Do you want it up here, where it usually goes in a letter? (presses UP ARROW a couple of times, then RIGHT
ARROW)
[cursor moves down]
Ub - oh dear. (Returns cursor to first line.) So I have to move it all down, or can I just ... I'm at the beginning

Ifyou want to add anything on topI have to move it down? CONTROL-B do I use, or [wants to use MOVE]
What is the easiest way to push the text down?
Just add spaces, I suppose. (presses CR, moves cursor up and tries to move it to right with RIGHT ARROW]
[cursor moves down]
Oh. Do you want it on this side? (uses TAB, inserts address)
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5. move paragraph
have to go to the other menu, yes? (presses CONTROL-0) Ob I didn't want that, did I? (ESC to return to
file) Is it the K menu? (presses CONTROL-K for Block Menu) That's it (reads). Right ... do I do the
CONIROL-B frrst?
You've already pressed CONTROL-K, so Ob, all right (selects MOVE)
[No block marked- press ESCAPE to continue]
(explilins text needs to be marked first)
Ob, ok. 111 have to get back to it (inserts Beginning Marker, moves cursor to end (word-by-word)) What was the
thing for the end, I can't remember.
You can look at the menu
(CONTROL-K, selects K)

rn

[para marlced]
Where do I have to move it to? (positions cursor) Here? (CONTROL-K v to move para)
6. delete paragraph
(deleres line-by-line)

You have deleted this block line-by-line- is there any other way you could have done that?
Could I have marked it and then deleted it? But that would have been slower, wouldn't it?
7. copy paragraph (address) into separate file (transfer task)
So I open a new file?

You don't have to- you can mark a piece of text in the document you're working on and save it to a separate
file.
Oh I see. (moves cursor and, presses CONTROL-K) I can't remember the second letter.
[all text marlced]
How can that happen - bow can it mark the whole lot.
(explilins)
(inserts End Marker) Copy it into another file ... (looks at Main Menu) I can't see anything like that
It's in the other menu.
(CONTROL-K, reads Block Menu) C.
You have used COPY before - that's copying within the same document ...

???
It is a Block Operation, because you take a block of text from the current file WRITE? (selects)
[Name of me to write text to: ]
So I've got to give it a name for the file ... (enters filename)
8. include file (transfer task)
So do I go back to the CONTROL-K menu? (Read Block Menu) I still do want W [WRITE], do I?

No, you want to do the reverse operation.
DELETE?

You want to include an existing file in your document.
None of these [options] seem to fit it. DISPLAY? READ, what's that?
That's it.
(selects R)
[Name of file to read:]
(enters filename)
[file included at cursoc position]
Where bave I included it ... because I left my cursor there. So if I just mark that and move it where it's supposed
to go (does)
9. delete block of text
(deleres line and words)
10. save edited file
CONTROL-K X, isn't it? (presses CONTROL-K)

Where would that take you?
(reads menu) So if I do D?

11. rename file
Now I want to rename so (selects RENAME)
[Name of me to rename: ]
What was the name of this file?

(tells her)
(renames flle)

12. What does a word-processor do?
A way of typing out letters and correcting letters, by computer, and it's meant to be quicker (laughs) ... would be
if you got used to it. And you can print from it ...
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Spreadsheet Tasks
Subject 1
[empty spreadsheet]
(points at screen) OK so we've got 2 columns obviously when it comes on later we can alter the width of these
if we want to and we've got a list down here so we could have something like a list of names and the type of
training each person's doing (points to cursor) so that's where the cursor is that purple blob there.

Enter text
So come down to there. (points to input line) And this is what is actually going to be typed in. It shows you
what is going to be typed in and press CR and we get a name in so the first thing is to give it a title - training
study, if you want to do it in capitals it's this that's this (points to SHIFT)
(types "Training study 1988", CR) [tilk longer than 12 chars, displayed across AJ &. BJ]
(points to title) 1bat actually can extend across the size of that but it will come up. Now the best thing to make
this (the title) stand out we could miss a column (means row) and then come down
(moves cursor to CI)
Now we want a heading for that .. in capitals
(proceeds to type in text headings CI to C4 under subject's instruction, then moves cursor to Dl)
(points to headings) We'll make that stand out so we'll underline that so you do that by SHIFT and capitals that
would be a continuous line
(types) lww long for?
10, I think it is, each column It doesn't matter, you can do it in one go by going straight across (the columns)
(produces line ofdashes) shall/ ... ?
yes, press CR [underline displayed A4- D4] (somewhat surprised) oh, it worked That makes that stand out now
we can enter some names
(proceeds to put in names under subject's instruction in A, then moves to 85)

Enter numbers as text
So just enter in 3,4,5,6 miles
how do I enter it? Just 3, or 3 miles, or ... ?
Just - 3m is what I'd do
(types "3m", CR)
["Illegal cbarnd.er"]

yes, made a mistake, sorry. It has come up as a number now press UNDO to continue- that's my mistake,
sorry can't remember bow to get out. Press UNDO twice. Now it is down as a NUMBER but it should be
down as 1EXT because there is a letter in there. So F7 will reverse it to text and now press CR and it will
come up. It is a mixture of NUMBERS and TEXT and we had it as NUMBERS and we've got to reverse it
round to show, otherwise when it comes to calculations it would ignore them.
so we have to use F7 ? (presses)
[warning bleep]
no you do it (F7) after you've put it (entry) in
(enters dala as text, as instructed)
So we've got what each one can do, so we could, say, take the averages so we can see what each person can do
above or below the average. So frrst we can underline all that to separate any calculations we might do
the same way? Can we not copy the underlining that's already there?
We could, but it seems such a simple thing to do so I would justSHIFT and Capitals? (proceeds to produce a line of underscores)

Formula
I've now got to remember, if you go down to this (All) ... now I've got to remember bow to count ... let's type
out average for that column
(types "Average", moves cursor to Bll)
I can't remember how we total up, what I want is the MEAN, mean being the average so if you type in mean,
M E A N OK and now we're going to give it an instruction of what we want tbe Mean of so we put it in
inverted commas, so it's the mean of and inverted commas specifies which area we're doing. So put inverted
commas frrst ...
(types)
right we've got B5, type in B5, and then to the way of saying 'to' is the colon, to B8, and CR,
(presses CR entering MEAN"B5:B8")
[displayed in Bll]
sorry I forgot to toggle it, this time we want it to be numerical so all it's done at the moment is just typed in
there, this time we want it to be numerical because we want it to calculate so if you type it in again, right and
close inverted commas and change it over, right il's numerical and press CR.
(types same again, toggles to NUMERICAL, presses CR)
[BAD COORDINATE]
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1 don't know what I've done wrong. I'm absolutely stuck
one thing I've seen before, is it double quotes or a pa.renthesis?
Oh it might be, you might be right
Shall we hit UNOO, bit UNOO again. Nonnally I just work from the instructions.
(types "MEAN(B5:B8)")
Tbat is still in numerical so - presses CR
[?n?j

It doesn't like that
Enter numbers
think it doesn't like it because we've got the things (points at entries in B column) in as well. I think that's
going to be a problem all the way along (points at other data entries) (realises that be bas "mixed" numbers in
with text) It's going to be a big problem there because I don't know how it's going to total that. Let's move
along to this because it is all (figures) it might take that one.
OK (moves cursor to Dll)
Do exactly tbe same. mean, and then you type in the co-ordinates which are 05 to D8 and reverse it over to
numerical. see wbat bappens

(tries to enter formula)
(?n?]

It won't because it's got the X (e.g. 6X400) (realises that all the data that have to be entered again) I've
completely wasted your time. I think what we'd have to do is leave everything out - the one that identifies the
distance, just have the numbers and then you can do it and what you can always put back in is the typing, well
you can put in brackets, long run in brackets miles, minutes (suggests all data entries have to be retyped as pure
numbers)
shall we do that then? If 1 go over and just type the numbers ...
(retypes data - numbers only in B colwnn)
Now come down to the average (B 11) again and try it. Type that in again, MEAN. No you didn't reverse the
text, ... CR.
[average displayed in B 11]

Change width
Oh we've got it. Now we've got a bit of a mess here (column labelling in B3) so we'll come out of there for the
moment and we'll make this a bit wider. this column. So if you press the menu, that will take us back to the
menu. Now what we·re looking at is the FORMAT and the way it's made up so you can either move it along
to fonnat or you1l notice there's only one alphabetical, there's only one of each so you can just type F because
it will not go down and then across, it will go all the way across (etc). If you wanted "WINDOW" or
something you'd have to go all the way through to find it So just type Fit will go straight there.
Now the width fust of all so that's - just press, you're on the width so stay on WIDTH and press CR. Now at
the moment it is 12 long, that's a bit narrow, let's make it 20. Just type in 20. Right So we just do this
column. It's got one in already so just type CR.
[column set to 20]
Cbange attributes
Right, now that's fine, we've got a wide enough column but everything is over to the right (numbers adjusted
to the right of the column) so we'd like to move it into the middle, so we'll stay in FORMAT, right, now
that's the ATI'RIBUfES. We've done the width so move across one and look at the AITRIBlTfES Now this,
the instructions are here at the moment it is at the RIGHT so we can either have LEFT. CENTRE or RIGHT.
what does the 2 and the minus mean?
2 is the number of digits you've got after the number which well leave in because we want that for 3.50 If we
wanted an exact number we could move that to nought. Now you use this to move across OK but we want to
stick, if you notice when you move that you've got instructions coming up on the left as to what that
particular question mark stands for, well we only want the first one again. Move back. Now the way you1l
move the instructions up and down is the space bar. So you've got LEFf, CENTRE, RIGHT, LEFT, CENTRE.
1bat's it .. question mark.
We've got the centre so press CR. So that applies to area- you can move the cursor up or down so move it
up, right so we've got it to apply to this area. B5. Now we want it to apply to the whole area. to that column,
so if you press the colon again, so that tells us from B5 to whatever the area is, so if you move the cursor that
will automatically give us the rest of the space Yes, right and now press CR
(moves cursor from to Bll, CR) that's quite good that
That, the other thing we want to do is we can have the order - they're not in any order are they? I think if you
press 0 ftY Order

(selects option)
so what do we want over wbat area - B, A5 so we want AS, now we want it in alphabetical order so go to the
left and up.

(selects area)
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Right and now move it straight down .. and CR - CR always gets you on to the next instruction. Column, so
that's what we want. Ascending or descending. Ascending would start you with alphabetically the first name
[orders rows alphabetically by name]
OK now we can move on we've got the averages we can move onto the circuits now (change width of C and D column)
Yes, we've got that Now what's happened now is the whole menu [model] bas now become too big for the
screen so if you want to see what's left, press CR, sorry press arrow indicator again to the left, sorry you've
come up in the menu. Right we'll go back to edit for now, press CR, just quickly if you want to see what's to
the left, that's it so it's moved us down that way as well. So we'll do circuits exactly the same
(changes entries inC and D columns)
Copy formula
Before we centralise these we might as well work out the MEAN We can COPY this (formula) so come back out
to the menu and we've got the instruction COPY, right so we want to copy, oh I've got to get this right,
copy from area ClO, that's what we want to COPY, that mean, so press the CR for that. And we want to
COPY to base co-ordinates, we want to copy the whole of this column. I think that's it just to DlO, press
CR, we want all of those and we want the relative values
[mean appears in D 11]
(CENTRE figures in columns C and D, patch up underlining which has been spoiled by widenin.g columns)

Save
So we go back to the menu, we want to come out and save what we've done, so it's just Q,
(selects QUm [returns to spreadsheet main menu]
oh, press CR, I'm not sure I hope it's saved

Subject 2
Now what we have here, a spreadsheet is basically just this big square and what we have is a series of rows and
columns and rows are numbered 1. 2, 3, 4, like, down and columns are lettered A, B. C. So right let's get in
to start off with.
[empty spreadsheet]

Enter text
That's your basic spreadsheet. Now what we do is this pink highlight [cursor] there- we can move it around.
If you use the [arrow keys] there, you see it moves round. If we put it in the space where we want to write
something and then we put in the input, and it will come up here and then CARRIAGE RETURN and it will
come up where the highlight is. Ok so if we start on the second line down
(moves cursor to A2)
If you type in names (instructs co-experimenter to enter text labels in A2-A6)
(once does nor move cursor before next entry, overwrites previous one)
You just typed it in over the top because you didn't move the highlight down. If you move the highlight down
it will always go in and if there's something underneath it it will obliterate it.
If you move the cursor to B I (does)

Enter numbers as text
If we put the date on top there [as column beading] and then we can put the times down underneath. I don't
know, call if the ftrst of the twelfth, second of twelfth, we go three columns across, CARRIAGE RETIJRN.
(types "1-12-88". CR)
["-99" appears in Bl]
(laughs) minus 99
toggle (thinks) Try F7.
[does not reason about why system bas performed a calculation] - (does)
[ warning beep ]
[system doesn't allow to toggle entry now, would have to be done before entering; if he would make any edits
fust, toggle would work]
Tricky, what did we do? Try again, type it in again then try again.
(does)
["-99" again]
(thinks) Right so if you type in January, February, March ...

Enter numbers
(enters text labels in Bl-Dl, and numbers in B2-D6)
Right in column E there we could put their average time overall or go for their improvement from January oo
March. So if you go to El, type in 'improvement'
(enters text label)
get the main MENU up, so if we go to ... F8 (does)
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Insert row
(reads MENU) bow do we do this? (thinks) right I'll be thinking about lhat, in lhe meantime - while I'm
thinking about that - if we INSERT a line between row 1 and 2 so we move the rest of it down. We could put
a line in underneath just to separate it out and make it look a bit smarter, so if we go to FORMAT.
[Format Width Attnbutes Ftller_cbar Data_type]
(reads options) Mmmm. We don't want to go into FORMAT, go to UNDO, (reads MENU again) go INSERT,
that's the ooe

(selects INSERT)
[Insert Row Column]
right we want to INSERT a ROW
[Insert row(s) starting at: 1]
we want to INSERT 1 ROW starting at 1, that's right,
[Insert how many rows/columns: 1]
and we want to INSERT 1 ROW.
[new row inserted above row 1]
There you go. So it has moved it all down one and now we can put another one in underneath to make it look
a bit better.
[wbicb is what be originally said he wanted to do, but choose the wrong insertion point]
So if we go to that again, INSERT a ROW,
[Insert row(s) starting at: 1]
starting at number 3
(types "3", CR)
and one
[new row inserted between rows 2 and 3]
there you go, wasn't too difficult.
(reads MENU) The only way I can think of doing it is go to A3 move the cursor along to A3,
(does)
get rid of the MENU, UNDO, F'2, and if you go SHIFf [underscore], put in 11
(enters ll "_")
that's it and then RETIJRN,
[line of "_" entered in A3]
that's it, now go into the MENU, so it's F8 again, you want COPY,
[ Copy from area: A3]
COPY FROM AREA A3 that's right, just CR
[ Copy tQ base coordinate: A3]
TO BASE Co-oRDINATE A3, colon, E3, ... just E3.

(enters "A3:E3", CR)

Dine of"-" A3-E3]
So it looks nice and pretty.
[used COPY instead of FORMAT, rlLLER_CHAR]

Formula
Now what we've got to do is work out this improvement, and I still haven't got a clue ...
The number of seconds? (thinks) Take away this one from thal one (points)
Yes, we go A3- there's a function for doing it we put B4 minus D4. B4 minus D4 then we COPY it into the
other columns - (thinks) let's go for help, sounds pretty good.
(experimenter tells him that all he has to do is enter subtraction as a formula)
All right - If you move the cursor to FA where we are going to put it in. So if we go 84 minus D4
(types "B4-D4")
Now we want to make that. we don't want it TEX~ LO appear up U1ere - we want a NUMERICAL value w
appear, so if we change it using F7 that should -

(toggles)
there we go we've got a NUMERICAL value, hit CR and cross your fingers [result appears in A4]
There we go - aikey it did it! (laughs)

Copy formula

So if we go back to the MENU now, F8. So if we go to COPY again - With our little spreadsheet it may
have just been quicker to put it in but if you've got a huge spreadsheet, you know with lots and lots of numbers
you can just do it once

(selects COPY)
[ Copy from area: A41
Yes we're going to COPY FROM AREA- FA, RETIJRN
[ Copy to base coordinate: ]
TO BASE CO-ORDINATE E8, RE1URN
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[Copy Values All]
We want to COPY ALL of it, not just the VALUES
[Copy Relative Absolute Prompted]
and we want it to be RELATIVE to each one, we don't want the ABSOLUTE COPY otherwise it would copy
wbat E4 is so we want it RELATIVE to each row. So if you imagine if you've got a huge spreadsheet it
would be mucb quicker and witb me being a bit rusty as well ...
We can put tbe average for January, February, and March- Move the cursor along to A9 (instructs subject to
enter another line of"_" using COPY, and enter text label in AlO)

(moves cursor to BJO)
OK if we go back to the MENU (can't fmd MEAN in MENU, experimenter tells him it's formula)
MEAN OK if you type in M-E-A-N and open brackets, we go is it B4 colon B8, close brackets, we want the
NUMERICAL value we don't want TEXT so F7, CR
[result appears in BlO) OK so tbe average for January is that
If you go into COPY now and we'll- (instructs to copy to ClO-ElO)
Save
SAVE this, so we can come back to it another day - We're going to QUIT/SAVE so we just go Q. We want
ab (reads options) OPTIONS, OPERATING SYSTEM

Subject 3
Spreadsheets are rather like tbe microfilms in tbe library, you know you have large sheets with tbe lists on on
very small pieces of paper and you can move it around the screen. it is actually bigger than the screen. You see
a little bit of it and you can move it around because the whole thing is bigger than the screen.
[empty spreadsheet]
Enter text, enter numbers
The cursor on the screen, when you type anything in that is where it is going to come up and before you type
anything you have to make sure the cursor's in the right place otherwise you might be typing over information
you've already got by accident, that's the pink thing which moves around. (instructs co-experimenter to enter
text labels in B2-F2 and A4-A9) Now we just make up some figures of what we've sold ... (instructs coexperimenter to enter numbers)
Oh, you've still got the CAPS LOCK on ... (moves cursor) apparently, it doesn't make any difference [with
numbers]
Change attributes
(enters numbers in B4-D9) Can we get rid ofthese trailing numbers?
The decimals? Yes, you've got to change the FORMAT so the ftrst thing to do is to get the MENU which is
F8, we're changing the FORMAT so you want to put F for FORMAT, now we want to do - good grief ... the
A TIRIB UfES. hit the A, tbe ftrst one
(selects FORMAT, A1TRIBUTES)
[ NUM [R 2 -] LCRl[????????] ]
there are different kinds of aspects, I can't remember - if you press the SPACE BUITON it moves it along to
different kinds of aspects of it under the question mark. So push that once, that means you see, push it again,
C that means it is going to be in the CENTRE of the colwnn which is quite a good idea move it on to the next

one
how do you move it?
move the cursor keys, (points) no go back one, push the SPACE BUITON I think it's the right one. keep
pushing, no it's not that one, move the space back again to the LEFf, push that one,

what are we looking for?
we're looking for a nought because it asks us whether we want it DECIMALISED
this seems to be F, C and blank
try that one. OK, ... that one, nought, is that ... yes, can't remember, push RETURN see what happens
[ Format applies to area: F9]
oh rigbt area tbat applies, this is better, we want it to apply to all these numbers so if you move it to the flfst
one and start there then we can copy it across the rest of the numbers so put the cursor there on the flfst
number

(moves cursor to B4)
and push RETURN and see if I've got it right, 'cos I can't remember ...

(CR)
[entry in B4 centred and no decimal places]
so now I want to COPY it to the other numbers, so select COPY from the menu which is C
[ Copy from area: B4]
from area B4 then you push RETURN
[Copy to base coordinate: B4]
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now it's asking you where to coordinates so do B4 again and if you do a SHIFf and colon that means that
where you are copying it to which is, I can't remember if you do it Hke this but you can try putting it down lO
"Saturday" [row 9], press F9 [coordinate not function key], to do it all, press RETIJRN.
[Copy Values All:]
You want to do all of them so press A for ALL. Can't remember what VALUES ALL means [numerical entry "10" appears B5-F9]
[used COPY to "copy format of entries" - to change format of entries, instead of using FORMAT
ATIRIBUfES, FORMAT APPLIES TO AREA]
Oh dear, never mind. we11 start that one again ...

can we get rid ofthat, what /just did now?
I'm not sure if you can get rid of what you just did, you must be able to,
[there is no UNDO function]
all the numbers have gone, never mind. we'll type all tbe numbers in again so we want to get rid of the
MENU, then you press the UNDO button, right so now we've got to type in all the numbers again, leaving

some spaces
Blank
How do we leave spaces [empty cells] now that we've got number in?
delete it

delete
push the DELE1E butron, will it work, no, urn,
[could overwrite current entry with a blank one, or edit current entry]
get to the MENU, might have some delete tbingies on it, F8, press DELETE which is D

(selects DELETE)
[Delete Row Column]
shall we delete all of it
rw, we don't want to delete a row or column
no, we just want to delete the thingies in it (experimenter advises ber to use BLANK)
we want BLANK, so I'm going to go back to the MENU in fact, F8 to bring the MENU back
(F8)

[ warning beep ]
ob - it didn't take any notice of that bow do we get blank?
(experimenter tells her lO use UNOO)
ob UNOO, F2 lO get out of that, now we want BLANK which is B.
[Blank applies to area: C5]
May as well blank most of it
shall we blank the middle bit?
Right so put a colon for where you want to blank it to and type in the number for where you want to blank,
wbicb one, E9.

(enters C5:E9)
[Verify blanking area: C5:C9]
[first time subject comes across having to conftrm something in this application]
Now just pusb RE1URN I thinlc
[area blankfd]
we've got to get out of the MENU which is F2 for undo. Now just type in some numbers.

(eiJlers numbers, leaving some cells blank)
Change attributes
We need to go back 10 taking off the decimal points so push the MENU button to get the menu back, push the
FORMAT button, because we're going to FORMAT, so that's F, we are going to do ATIRIBUTES, ENTER
[ NUM [R 2 -] LCRI [????????] ]
push the SPACE butron until the C come up so that's in tbe CENTRE

(selects CENTRE)
keep moving the thing, stop and change that to 0 now RE1URN

(sets decimal poinls to 0)
[ Foonat applies to area: D9]
if we move it back to where we want it to apply to, same place we blanked C5 10 E8, REfURN now we want
to- ob, it's done it already, that's rather nice ...
(seems she thought she would bave to COPY again, does not seem to understand that you can change format for
a range]
[all entries centred and without decimal points]

Formula
now we want to try and find out how many, what the average number sold per day is
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You move the cursor to where you want to do the sum so we want to do it under Saturday to work out what
was sold today so if you move it down -

(moves cursor to Al2)
write in MEAN, REWRN
(does)

["mean" in All]
that didn't work ... - obI know, sorry you're going to have to redo it because you are dealing with NUMBERS
as well as TEXT you have to push this so it takes this into account because at the moment it is just
understanding words and it can't deal with numbers at the same time so push F7
(does)
[ warning beep ]
oh dear! you get rid of MEAN, write mean again don't push RETIJRN push F7
(does)
[indicata: changes to NUM]
I hope this is going to work. now push RETIJRN
(does)
[Bad coordinate] [did not enter any coordinates, which is the problem]
How to come out of it try pressing 00 I don't know is it, try UNDO
you hoven't told it whot we want the MEAN of ...
oh we haven't have we
(experimenter tells her she luJs to enter coordinates after MEAN)
Is that before you push F7? ok, afterwards - So we're talking about this column here so it's sort of B4 to B9 so
if you type that in, the TO you write with a colon, you are going to move the cursor to - hang on .. Let's try it
there B4 with a colon which means to, B9, REflJRN,

(enters "meanb4:b9", RETURN)
[Bad oooolinale]

[brackets missing]
no that's not going to work either, brackets, OK, where has the cursor gone, press RETURN to get rid of ... if
you move the cursor back you type in a bracket, overwrite, ... other bracket and RETIJRN.
[result appears in All)
Copy formula
I've put it in the wrong, because I've told you to put the cursor in the wrong box, but that is the formula you
want. now you want to COPY it across the various columns, so you want the MENU, so you can get the
COPY command, FS. COPY again, so it is eit.ber moving the cursor or pressing the C
(selects COPY)
[ Copy from area; A 11]
COPY FROM AREA All, that is right. so RETURN,
[ Copy to base coordinate: A 11]
COPY TO BASE COORDINATE so you want to move it along to Fl I

(enters All-Fll, RETURN)
[ Copy Values All ]
RE'IURN, VALVES, we did it ALL last time which means the same number I think
[value "10" in All-Fll]
no wrong one again ... [ALL would have been right - last time she was copying a number, not a formula - but
since the nwnbers are displayed, she thinks she made the same mistake]
let's go back again to COPY All again to Fll, RETIJRN, try ALL,
[doesn't change]
not much use either ...
[because in the last attempt, she overwrote formula with number 10]
Save
Do you want to SAVE it, choose the QUIT and SAVE direction from the MENU which is, just push the Q,
and now you want to push that. I'm not quite sure why but MODEL SELECTION and now you want to get
into the OPTIONS so you can choose to get out of the thing so push 0, now you have to get back into the
OPERATING SYS1EM which is 0 again
[remembers procedures, but not where to apply them; when operations go wrong, sbe starts changing
procedures)

Subject 4
The spreadsheet allows us to program information into the computer and it will be displayed on the screen,
allow us to manipulate the data, move it about, so that just like writing an essay or whatever on paper, but it's
in the computer you can put the words into the computer and move them about Format a table or a chart or
something.
[empty spreadsheet)
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Enter text, enter numbers
This is tlle spreadsheet, it consists of rows and columns. and so you just create your own table or whatever to,
so you've got tlle columns and rows if you want to create a table to show a certain thing you can just program
it in. and it comes out If we move the cursor down a couple of spaces (moves cursor to A3)
and type in "Monday" and press RETURN
(does)

Now that's come up there - whatever you type in is going to come up where the cursor is so if you type in
"Tuesday" now, remember to move the cursor down one (instructs co-experimenter to enter text labels in A3-A6
andB2-E2)
Now we've got the figures for bow much stock we've sold each day - (instructs co-experimenter to move cursor
to B3, type "SO" and REIURN)
[entry 50.00 in B3]
Now that's come up there [numerical entry in B3] and we don't have to worry about being offset in the column
here because we can format it later, so if we then move down here
luls that added two noughls?
That's just in case, it assumes that you want decimal places, but after we've gone through it we can format it
and knock off the two noughts. Right then if we go down "Tuesday" and say twenty five pounds (enters nwnbers in B4-E8)

Insert row
Right now we've got everything in, but it looks untidy so if we tidy up the table, the spreadsheet and it just
looks nicer and it's easier to read and everything. First we could leave a space in between the title of the
column and the first figures, I think it would be useful because it runs in a bit there (between rows 2 and 3] so if
we insert a space between the title and where the figures start it would be better. I can't remember So if you
move the cursor to where you want the space which would be on A2
(moves cursor to A2)
no down one
(moves cursor to A3)
and then (thinks) perhaps we don't want a space ... press F8, these function keys here get us the MENU up so
if you press F8, and we've got the MENU here and each option will do a different thing to the spreadsheet To
put a space in we (reads MENU) if we choose the INSERT option, so we can either move the cursor and press
RETURN or press I which will select that as well.
[ Insert Row Column ]
Right- then we want to INSERT either a ROW or a COLUMN. We want a ROW there so we then get a
blank. so if we press ROW and RETIJRN.
[Insert row(s) starting at: 31
(hesitates) So now is says where do you want the row starting from. It's got it starting at 3 so press
RE1URN.
[How many rows/columns: 1]
How many rows and columns. well it's already got 1 in there so that's ok just press RETURN.
[new row inserted between 2 and 3]
Change attributes
Next thing I think would be to put the figures in the centre of the column just to make it easier to understand,
so for that choose a different conunand (reads MENU) so we want FORMAT- which is the way that everything
is set out on the screen. So it's the way the actual data is. so either move the cursor or press F .
[Format Width Attributes Filler_char Data_type)
To put the figures in the CENTRE we need to select ATTRIBUTES conunand, so, yes, press RETIJRN.
[ NUM [R 2 -] LCRl[??'!?????] 1
Now these funny things down here tell us different conunands that we can actually do. (points to first"?") Tba1
stands for LEFT CENTRE and RIGIIT so we want the CENTRE and each one of these question marks gives
us a different command. So if we move the cursor to the 3rd question mark along. Each one is a different
command but we only need the CENTRE one so (moves cursor along "?"s, returns to first " ?")
Right if we press the SPACEBAR and again, CENTRE, that's right, right underneath the cursor we've got a C
which stands for CEN1RE, so we've chosen that, so if you press RETURN.
[ Fonnat applies to area: A3]
(hesitates) Right if we put a command in we should have the cursor in the right position and we've got it in the
wrong position at the moment so if we delete that A3 and then move the cursor along to B4, rigbt, press
RETURN
(does)
[entry in B4 centred]
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rigbt then it's put the figures for B4 in the centre so now we can either do that all the way down or we can copy
the - no we can't .. so we select t.he FORMAT again to put the figures in the CENTRE, so RETURN again,
ATTRIBliTES, press SPACE BAR twice, that's CENTRE, now press RETURN,
[ Format applies to area: B4] now format what area B4, by pressing REWRN now it just does B4
which you've already done, if we want to do the whole column, if we press colon, right and now we
move the cursor down with the arrow key to the end of the column, right now press RE1URN
(ti?es)
[entries B4-B7 centred]
and that's told it to put the thing in the centre of B7, so if we move the cursor along to the second column.
(repeats for column C, D and E)
(instructs co-experimenter to centre text entries in B2-E2 in one go)
[seems to assume that range can only be defined for one row or column at a time]

Formula
We can use the computer to calculate things from the data, perhaps what the average amount of cereal you're
selling in the first half of the week or whatever. so, if we perhaps want, say, the average takings on Monday,
so could be used for the average for each day ..

could you add them all up so you could see how much you took ?
Right if we do bow much money we've taken each day, so if we get rid of the MENU, press F2, now to
calculate something you bave to put in an equation so if we, when you put the equation in, you put an
equation in, say, to work out the average or addition of the lot, the answer will be displayed where the cursor is,
so ftiSt we should put the cursor where we want the answer to appear which would be
(moves cursor to F4)
.. yeah. And we want those added up- (thinks) so if we put total - we have to pick an equation which will
actually perform it for us. Umm, if we type in "total"(is not sure - experimenter tells him its SUM)
SUM, right, so if we type in SUM, then press SPACE BAR and then we want it added up from B4 through to
E4, so type in, sorry capital B delete [doesn't matter whether it's capitals or not]
B4, colon. E4.
(enters "sumB4:E4")

Now if we put that in now because we're in TEXT mode it will actually come up where the cursor is whereas
usually we type in data and it comes up

so.
so if we did it now it would actually come up because we've not told the computer it hasn't got to go in.
Usually if we want anything typed in, in there, press RE1URN and it will go in
so it will actually print that?
It would actually print tbat so if we want to distinguish that we want the calculation instead of just it thinks
we want that written in so if we press F7
(does)

now it's got NUMERICAL command which means that you are calculating something from the data and it
won't actually print it up there, it will work it out for you, so in NUMERICAL then press RE1URN.
(B<d coordinate]

It doesn't like that one - ah if we press F2 again to UNDO
[warning beep]
try F2 again, rigbt if we delete the B4 colon E4 and now move the cursor with the arrow key and move it along
to B4.
(can't see what's wrong with the formula- experimenter tells him it's brackets)
yes sorry we need brackets as well, so if you move the cursor back to F4, press open bracket B4, colon, E4,
close bracket,
(enters "sum (B4:E4)")

now press. no sorry, we have to toggle it again, just press RETIJRN
(Bad coootinale]

Unfortunately we've put a space there which we shouldn't have done so press F2 again, right and again, now
delete the brackets. if we delete that, then open bracket, B4, colon, F4, right then press RETIJRN.
[result appears in F4]
Copy formula
Right now it has summed that lot. Now do the same for each row so if we just calculate the sum of each row
but instead of going through and actually putting that formula in for each one, I know it's not much at the
moment but if you bad hundreds of rows it would take too long, you can actually COPY that formula
throughout the whole rows, so select the MENU again, F8 and the COPY command, press C.
[ Copy from area: F4]
Rigbt now it says COPY FROM AREA F4, so at the moment that equation is in section F4, so it asks if you
want to COPY that equation, so we say yes, press RE1URN.
[Copy to base coordinate: F4]
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Now copy to base coordinate. It says where do you want that copied to, so we want it to the end so we press
colon which is to and then move the cursor down to the last column and then press RE1URN.
[target coordinate overlaps base coordinate]
[ Copy Values All )
Now it says, we press ALL, we want that displayed in every, in all of them, so press REI1JRN
[ Copy Relative Absolute Prompted ]
and then RELATIVE. press RETIJRN again

so it hasn't just copied ...
it's totalled them for all, and adjusted ... then, put a heading for that row [column F] perhaps we call that
"turnover"
(does)
and if we CENTRE that [entry F4 -doesn't CENTRE rest of column 4]
Save
If we want to SAVE it if you press Q which is QillT/SAVE then the easiest way, if you press 0 for options

Subject S
[empty spreadsheet]

Enter text
We can move the cursor around (demonstrates using arrow keys) and if we want to put anything in it appears first
in the input box (points) what we type in there is going to appear where the cursor is. So perhaps if we have
say five people, five subjects first, put them in, any names

(enters names in A4:A8)
Enter numbers as text
If we have them running different distances, perhaps if we do 100, 200, 400 say. so if you label the columns.
start with 100, metres.
(moves cursor to B3, enters text label "100 metres")
Then REIURN.

(does)
[Bad coooli:nare]
It is not going to fit in is it. I don't know what has happened but F2 is UNDO
[warning beep; edit <left> <right> <insert> <delete>]
ob right it is not going to take 100 metres so just put 100m say, change that
[thinks it's length that is the problem]

what dol do now?
EDIT - yes just press RETIJRN
(does)
[bOO coordinate]
[nothing changed] - (UNDO)
[warning beep]
yes, right DELETE, so pick DELETE

How?
Just move the cursor along

(tries, nothing happens)
I don't understand ... and then, press CR, what happened last time we did that?

press CR and .. .
so we want to DELETE the S really [of "metres") don't we. Try it 'Press do or undo to continue'. What to
do is move that, try ... (presses CR)
[bOO coordinate]
(UNOO)
[warning beep]

maybe we should just delete that (uses BACK SPACE to delete "metres")
yes, of course, BACK SPACE, if we just put an min there, that's what we want.

(does, CR)
[bad roordinate]
Why won't it go in?

I think it's because of the "m", it wants a number, just a number
Do you think that's right? If we change it by F7 to text, will it take it m then, or will it confuse it, F7,

(presses Fl)
[warning beep]
no it doesn't want to play does it?

(presses UNDO)
["bad coordinale" disappears]

(presses F7 again)
[NUM toggled to TXT]
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(CR)

l"loom" appears in A3]

Enter numbers
If we want to do it. ok and then RE1URN, so yes if we want to do it, we have to put it in as text. we use F7
(instructs to enter text labels in C3 and 03, and numbers for times in B3-8, C3-8 and 03-8)
Now, if we want to work out the average, it's going to have to be 400 metres, so if we move the box, the
cursor, to where we want the result to go in, well we could type in average couldn't we, we could name it in
this column bere. Or just put MEAN, it will fit in.
(enters text label in A9)

Formula
0~ move the cursor to where we want the MEAN to be put in,

(nwves cursor to B9)
and what we want to do is to tell it to work out the MEAN don't we. So the instruction is MEAN so if we
just type in MEAN then open brackets and we want to tell it to work out the mean from one figure to the next
so if we give it a starting co-ordinate which is B4 and then colon and then down to B8, close brackets, and we
want to count numbers not text, so we want to change that with the F7 button, RE1URN, did it.
[mean appears in B9]

Copy formula
Now we could do that all again for the next one without doing the same thing so if we find the MENU, F8 and
we want to COPY so search again to find COPY and then, if you just type c in there it will be quicker,
(selects COPY from MENU)
[ Copy from area: 1right we want to COPY what's been done in a previous box so you want to
COPY what was done in B9 so from B9 and then REWRN
( Copy to BASE COORDINA1E]
and we want the BASE CO-ORDINATE which is where we're at now, so C9 is correct, so now you want a
colon and where we want it to go to, so if you move the cursor along to where you want it to be, no, it wants
to be copied from the base co-ordinate C4, so we want to work out from C4 to C9 again, so, yeah and then
RETIJRN,
is that righl
yeah go on RETURN. We want to COPY, ALL, then RELATIVE,
[ ?n? displayed in C4:C8 1
why bas it done that? [gave C4:C9 as target coordinate, instead of C9] I don't know why it's done that. We have
to put some numbers back in.
(types numbers back into C4:C8)
I don't know whether we can still COPY now what we did before or whether we have to go through the whole
process again.
Shall we try?
Try to COPY. Get the MENU. COPY again.
[ Copy from area: 1
try again, and it was C4 to ... where? (enters C4:C9)
C9? Did it ask you for a BASE CO-ORDINATE?
C4 to C9 is what we did before and it went wrong didn't it?
Yes, from now it is calculating, so we want to be in that mode don't we. Try RETURN again? Shall we try
it?
1 don't know, that's precisely what we did last'time. What might have been wrong with it?
Oh, yeah, right we want it just to go from C4 to C8, last time we asked it to count C9 and there wasn't a value
in C9 so that is what it got confused about, ... to C8, [accurate diagnosis] and now try RE1URN.
( Copy to base coordinate: ]
Right, COPY to BASE CO-ORDINA1E. No this is going totally wrong
[accurate diagnosis]- sba11 I UNOO?
Yes, UNOO if it will let us. I think we sbould have another go. Right FROM AREA, We want to COPY the
MEAN. so we want to copy what the MEAN was, B9 to • from C4 to C8,
[same mistake again)
REWRN, we did all last time, RELATIVE, no ... Stupid thing!
(replaces numbers)
MENU again, so COPY
(selects COPY from MENU)
[ Copy from area: ]
COPY FROM AREA. it must be B9, I'm sure, RE11JRN yeah. COPY TO BASE CO-ORDINATE which
is C4, we put in last time, which it didn't like did it. I think, C4 ... last time we told it to ... so surely this
time it should go from ...
so whal do I type?
C4 to C8
(Experimenter intervenes and points out mistake)
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COPY it to, right l see, we want to, C9 we want, which is COPY TO BASE CO-ORDINATE
[mean appearr in C9)
it did it!
Save
Rigbt and then we're going to QUIT and SAVE are we, so we're on the MENU now so pick QUIT and SAVE,
RE1URN, mmm I think OPTIONS, I think that saved it. (not sure)

Subject 6
[empty spreadsheet)
We could put the names of drinks down here [column A) and then across how many bottles we've sold for each
day ...

If you tab down a couple of spaces we can leave room for a title later on if you tab down to 5

(nwves cursor to A5)
Enter text, enter numbers
If you type in now, it will enter here (points to input line) it will only come up on the screen once you've
pressed RETURN so if you make a mistake you can delete and you can type it again, so if you type, say,
"whisky"
(does)

and then just a CARRIAGE RETURN
(does)

[ "whisky appears in A5 ]
and then say if you then tab down and enter more otherwise you'll delete what you've just done, tab down one
more and then well just do, ... and then CARRIAGE REfURN again and then if you tab down again and enter
more (instructs to enter text labels in A5 to A9, numbers for bottles sold in B5 to B9)
Change width
What you want to do is FORMAT it because we want to widen the column so you could press, to save time
press F, and that will automatically select whichever one begins with that letter,
(selects FORMAT)
what you need to alter is WIDTH and its on that so RETURN.
(selects WIDTH)
[ Set width of the column to: ]
It's currently set on 12 we want it to be slight narrower I should think ... no point in a whole wide column
being used so we could narrow it down to 8, say, so give it 8 then a CARRIAGE RETURN
(does)

[ set how many columns to this width? )
just the one column,
(enters 1)
so that's now done it and if you press F2 that will then remove the MENU, so any time to call it up is F8
then to get rid of it F2.
You can go up here [B2] and enter a title for the column
(enters text label 82-84)
We want to divide each column so it's clear, so there's a separation there, so what we need to do to do that is
put some sort of FILLER CHARACTER down in between the two columns, to do that we need to enter
another column between A and B and then reduce it to the WIDTH. to one, to one letter and then we can enter
in a FILLER CHARACTER, lets say, the two .dots, the colon, so if you call up the MENU again then
FORMAT, now we want the FILLER_CHAR.
(selects)
[ Set filler to: ]
now we have to decide what we're going to use as the FILLER CHARACTER so we use, right. then Insert column
ob we didn't put the column in did we?
A good example now of how to use the UNDO. If you do something like I've just done and you get to the
wrong thing and if you press F2 that will then get you back to the MENU again.
(does)
Now what we need to do is call up FORMAT again, so CARRIAGE RETIJRN, so whatever stage you are then
at. if you make a mistake you can get out of it by just UNDO.
What we want to do is INSERT so F2 again and then, press the letter I, it will save time, we want to
INSERT a COLUMN this time so ... then CARRIAGE RETIJRN. It inserts columns always to the left of
the one the cursor is over so that is where we want it so that is Ok so if you, just the one column, so if you
CARRIAGE RETURN again
(does)
[ new column inserted between columns A and B )
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Change width
You see it's already, that's it, and now we want to FORMAT it so if you press F and WIDTH is what we want
to do so if you set it to 1, RETIJRN, and just one column
(t!Jes)

[ column B set to width 1 ]
So that's ok. now we'll use it like that. Now the easiest way actually, the way I've done it, if you just get rid
of the menu. UNOO F2 and if you tab up to B 1
(does)

Filler character
for tbe FILLER CHARACTER use the colon so if you press just one, just enter one and then REnJRN,
Now if you now call up the MENU again F8 and COPY. We want to COPY from area Bl and CARRIAGE
RE1URN, COPY TO the next CO-ORDINATE, now if you take it down 1 to B2 because we want to copy it
from B2 down to B8 so if you type in colon
Why?
because tbat is the area you are copying it to, the colon is for B2 to ... now you can either type in B8 or you
can tab down to where you want, stop, now press CARRIAGE RETURN it will
[ ":" copied to B2 to B8]
[copies character instead of using Fll..LER CHARACIER, even though he selected it earlier]
Change Attributes
If we now, divide across now, we can now divide across or we can move on or leave that to the end ... it will
save time otherwise we11 be doing that every time you're entering. If we now, we've got these extra figures on
the decimal points because it's not going to be 6 point something bottles so if you'd like to call up FORMAT
again
(does)

and to do this we need A TI'RIBtiTES and that will hopefully do it
(selects A1TRIBUTES)

[ TXT [2 ] LCRl [???????] l
Now this key here (points to input line) the left band side one is, determines where within the column the
figure will be so at the moment it is on the left hand side and we want it to move across so if you press the
SPACE BAR you11 see it comes up LEFT, moves it to the LEFT, CENTER, RIGHT
(toggles with SPACE BAR, RETURN)

[ Fonnat applies to area: ]
(tries to position cursor)
[ warning beep ]
Ah - we'll have to (presses UNDO) that will do it properly now move the cursor again, FORMAT,
ATIRIBUIES (relllms to attribute selection)
now that shows you it being on the RIGHT hand side of the column which is where it is at the moment we
would like it to be in the CENTER so if you tab on the SPACE BAR, press the SPACE BAR and it will say
where it will be if you change it If we then move it using the arrow keys - if you keep moving it across the
figure above the question marks if exactly what figure we've got so at the moment it's on the right band side of
the box, it's got 2 decimal points, the thing at the left hand side here explains what you'd actually want to ...
so if you move it along one more it gives a choice of bow many decimal points you can bave it's up to ninewe ideally want it at nought decimal points, so no you're ... using the SPACE BAR again, the frrst one should
be nought that's all we want at the moment so if you RETURN
(toggles "?" to "0", CR)
·
[ Format applies to area: ]
it shows C5, we want if from CS to C8 because our concern here, so if you enter that and then, and then
RETURN
(dbes)
[ column C reformatted ] so now you've got rid of all the decimal points and it's all centred
(instructs to enter prices in column D)
If we now calculate the number, the amount we make per week .. .
We want to be able to multiply the numbers by the price .. .
Formula, Toggle display
I can't remember exactly how we did it, yes if you call up the MENU, you need WINDOW, just press W, and
VIEW, V, EQUATIONS is what we need, so RETURN, right and then you can just UNOO, get rid of the
menu
I can't remember, I'm trying to remember which way round it is, it's just the SUM, SUM is what we want
(e~perimenter intervenes and tells him to enter formula to multiply)
Well if you tab up to the top one [E5] and enter in, because that is where we want the actual answer to come, if
you see what I mean, and if you then type in what you want here, C5 and star DS, now at the moment it is
entered in as TEXT because the frrst thing you did was a letter, not a NUMBER so you have to toggle it by
pressing Fl and make it NUMERICAL, well make it a calculator and then RETURN
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[ foonula displayed in E5 )
That's exactly what happened last time when I did it ... if you now have to press WINDOW, VIEW and
EQUATION.
[ result of multiplication now displayed in E5 ]
That's wbal happened last time I did it. It does the calculation for you. What we now want to do is rather than
go to something and. well it wouldn't take long with this one but if it was a large spreadsheet it would take
ages is DOW to COPY that instruction so we need to call up the actual formula otherwise what we11 have is
just 42 in each box, so if you, whenever you've got an equation, the result of an equation you then go through
the WlNDOW, VIEW, EQUATION, it will put on the screen what the actual formula was
[ foonula displayed in E5 again )
[wrong- it would copy the formula, not the result]

Copy formula
so if you do that then we can COPY that for C6, C7, C8. Right now if you'd like to select COPY initially,
from area E5, if you press CARRIAGE RE1URN and then tab down one and to E8, RETIJRN, COPY, ALL.
that's it, Rfl.ATIVE
What's the difference?
don't know to tell the ttuth.
[ formula copied to E6 to E8]
Now if you now press WINDOW, and then VIEW, and EQUATIONS it should
[ results displayed in E5 to E8 ]

Save
To SAVE what we've just done you have to select QUIT and SAVE we now want OPTIONS because that
gives the choice of saving WITI1 or WITHOUT SAVING
[ OA menu displayed ] [WITH SAVING or WITHOUT SAVING only when model bas been saved at
least once]

Subject 7
[empty speadsbeet)
Right this is the basis for our spreadsheet. You can work in rows and columns and by moving cursors we
sbould be able to move this indicator around, so if you just try that out

(moves cursor about)
Now you have to decide on the sort of information that we are trying to present, for example, the suggestion
was a sweet shop. For a sweet shop we could have - for different colwnns, name of sweet ... if we shift this
[cursor] down, to leave some space, so we can put a title in later ...

Enter text
Type in name of a sweet it wiU appear here [input line] and then we transfer it up to here [cursor position A4]
when we are sure it is correct
(types in "names", CR)
[text label appears in A4]
DOW you have to move it [cursor] down before entering the next one (instructs co-experimenter to enter text
labels A4-D4)
now this is the basis for what we are going to do so if we return to the frrst colunm and bow you return is by
using these keys [arrow keys] here. And perhaps to clarify the titles away from the data you're going to put in
we move down one to leave a space. So now we need some products. (instructs co-experimenter to enter text
labels in A6-A9)

Enter numbers
And now we have to create some data. say cost price, roughly the value you'd expect less say 3 pence (instructs
co-experimenter to enter figure in B6)
Now what you'll notice is that if you start putting an input in with one of the numbers you may not have
spotted it but this little indicator here [above input line] switched from txt whicb stands for 1EXT ro number,
NUMERICAL sorry. 111 explain a little more about that later but it is worth observing tbal. .. yes switched
into another mode so if you just carry on putting in prices (instructs co-experimenter to enter numbers in lJ6C9)

Formula

Now wbat we could do here is if we wanted to work out profit margin [text label of column D] mmm. I'm just
trying to wodc out bow it's done. See, there is a method whereby you can get the _computer_ to work out
bow mucb the profit margin is. By subtracting the values in this column from the values in that column.
Now I'm not sure, I'm ttying to think bow it's done, I'll think about it. Maybe we can try some later on. For
now we'll just work it out in our beads (works out difference between C6 and B6, instructs subject to enter result
inD6)
(subject bas clearly stated that be knows be should use a formula, but doesn't seem to make a great effort to
remember/work out how to do it]
(instructs subject to enter other results in 07-09)
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Now we've got our database, as it were, we can actually stan to play around with it. Before we stan to
manipulale wbat we've got here it would be good if you saw the MENU of options you've got, so F8 MENU,
present you with all the options.
Now I don't understand every single one of the options, but I understand most of them so if you were to go for,
... what
realJy interested in doing is calculating the MEAN of these prices so we know the average price of
tbe products in the shop. I think to do that we start off by using, let me think, WINDOW, so if you want to
just move the cursor, as you are doing now, or the other option is to, each one of these options has a different.
they're in alphabetical order so if you really want to be quick you merely look at the option that you are after
and press tbe flfSt letter - and it takes you straight there.
(selects WINDOW) [Window Split Unsplit Connect Titles Edge View I
Now what are we after, we might be getting ourselves in a bit of a mess. Ah yes I have - Consider that little bit
we've just done as an exercise in going to a different option, now if we return back to the spreadsheet I think I
can remember how you manipulate data just on the screen.
[WINOOW and VIEW to toggle formula/results display]
So you want to get back, press UNDO and that will take you back to where we were before, and you want one
step f~ so another UNDO.
This is something that is particularly unfriendly about this system. if you're in the MENU and you want to
start manipulating data by moving this cursor around, you can't, you have to press UNDO, which is
something to bear in mind - that tbe UNDO key is always there.
How is it done ... ob yes, as I was saying earlier this indicator here [just above input line] transfers itself
between NUMBER and TXT, for instance if I press U it will stay TXT but if I were to delete that and press 6
it will change to number. (demonstrates) Now the key that we use to switch between the two if we want to tell
the computet, if we want to command the computer to change I think is Fl, (presses Fl)
[ warning beep 1
[correct key, but cannot toggle without anything on input line]
no it isn't ... it is one of these keys, a toggle key (tries F3)
Uet's see if I put something in and then try. (types in a letter, presses F7)
[ indicalO£ switched from TXT to NUM ]
Ah yes, you need something.
(presses CR) Oh dear- I've just inputted it.
Ah if you accidentally put something in to a box [cell] and you don't want it there, what you can do to reverse
that is keep the cursor there and then simply blank it out using SPACE BAR and RE1URN and now you can
re-insert what we bad before.
[could simply overwrite incorrect enrry by entering correct one]
Now what I'm going to do is to show you bow to use a formula and these formulas are mathematical and they
can be used to manipulate the columns. The one I'm going to try and do is to get the mean of the cost price.
So what I'm going to do flfSt is to move the cursor to there [All] which is where I want the data (result] to go
in. Now what I want you to do is to type the word MEAN M-E-A-N. OK. Space. Now what we're asking it
to do is to make a mean of a list of figures. Now in order to tell the computer which figures you want you
bave to list them. You don't bave to list every single one you merely list the co-ordinates at which the list
starts and stops. which in this case is B6 and B9 so in order to do this if you just type in B6, now the notation
that you have to use in order to tell the computer that it's a list you've got here is colon, so if you fmd the
colon function, then the final co-ordinate which in this case is B9.
(types "mean b6:b9" as instructed)
Now what the computer is obviously thinking is· that we're trying to insert text into the spreadsheet. Now
clearly that isn't true, we're trying to introduce a formula and the way that you can tell the computer that it's a
formula and not text is by toggling using F7
(toggles)
so now it is a numerical thing. So if you press RETURN, with any luck you1l get,
[ Bad coordinate ]
ob dear mm it says it's a bad co-ordinate ... B6 to Obviously we're going to have to press UNOO, we've got no
choice. Try UNDO again, that's better. I'm trying to think what's going wrong .. (looks at formula again)
Mean, B6, B9 - I'm not sure what's wrong here.
mean .. do we need to put it in brackets?
I'm trying to remember - I'm pretty sure there's no brackets involved ... - ok let's try brackets.
(enters formula with brackets, toggles, CR)
OK let's uy again ...
[ result displayed in A 11 ]

rm

Copy formula
Now what you've obviously got here is the mean of these, ok, so now what we can do is COPY this formula
and make it apply to this column and this column [C and D] Now the way to do this is rather than do each one
in tum which is a possible option if you want to. What we can instead do is to go to the MENU and use tbe
COPY option.
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C (selects)
[ C~y from area: B11]
Now once again, it's a little while since I did this and I'm trying to remember what happened. Copy from B11,
yes.

Is that- Bll -that's where we are now? (moves cursor about, indicator changes correspondingly)
That's correct, yes. You can actually change the position ... I think the way it works is that you merely press
REIURN
[ C~y to base coordinate: B 111
ob dear ••• now here we have to indicate that you are trying to COPY what happens in this. yes, that's all
right, we've done it correctly. Now what, here we have to once again delineate- yes that's fine, wbal we want to
do here is, once again, inform it of, once again delineate the list, I think what happens is, mmm... I think
wbal wedois
[ warning beep 1
no we don't list the co-ordinates we're trying to find the mean of in this case. You can see it's going ahead.
(enters "D5:d9 as target coordinates, CR)
[ Copy Values All ]
I'm not sure if it's going to turn out bow we want it, but basically now it's asking us two options here. I
don't understand what they are but basically for the task we want to do we don't merely want VALUES we want
them ~. for some reason. (CR)
[ Copy Relative Absolute Prompted ]
RELATIVE in Ibis case. I don't understand all of these options but when I was being instructed bow to use
this in this situation we were just told to proceed, I think it was yes we had to use RELATIVE. I'm not a
very good teacher in this case because I don't understand.
[list of ?n? displayed in D5-d91
Ab yes, we seem to have made an absolute boo boo. Mm this is experimenting. If we try again, yes and this
time

selects COPY
[ Copy from area: B 11 ]
is that copy from area Bll?

I'm trying to think whether the error is at this stage or the next stage ...
(experimenter tells him it is at next stage)
So the error is at the next stage. OK so if we just continue past Ibis and find out what we did wrong. (presses
CR)
Yes I think I've remembered what we did wrong. Instead of re-defining the list what it's asking is bow far do
you want to extend this copying process, in which case since we've now lost our numbers if we just extend it
from here to bere. So it's C 11, colon, and if you move back this way, no it should be from B 11 if you delete
and try again, then move the cursor back to there, to C 11
(enJers target coordinates BI I:CI 1, CR)
Yes we warit AlL, RELATIVE
[result displayed in C11 1

Formula
And there we are. Now if I hadn't made tbat initial cock-up I could've proceeded across [D column] and also
calculated the profit margin
could we work out tM profit margin [in D6-D9] like you've done Mre with a formula?
Yes, you can but the actual notation of it? I might
help on as to what the formula actually is
Do we just use a maths option? Minus, isn't it?
Yes, we seem to have the relevant keys ...
I would imagine what you would. perhaps one way of doing it, and since this seems to be our experiment
column, we'll either have to enter them all again or play around. Yes and then move yourself up [to 06].
Now I'm trying to think whether you'd have to clear tbe n [?n?] away first, if I can just try tbis. I think what
you would have to do is we would have to enter obviously as you said another formula which in this case
would presmnably be B6 minus - sorry C6 minus B6, if you try tbat, see what happens.

need

(enJers "C6-B6")
I'm not sure, 'cos I've never done this. Ok, now thinking of it as a text entry, obviously you want to toggle that
away and let's see wbat happens.

(toggles, CR)
Come oo - world
[result displayed in 06]

Copy rormula
Yes it worked. Now presumably we could COPY this formula venically, just as we did the last one
horizontally. So if you RETURN to the MENU and move to the COPY option. Yes we want to COPY from
area D6 to basically tbe whole of this. It would presumably be D6, colon, to 09. Let's try tbat, AlL,
RELATIVE. OK. Excellent.
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[formula copied to 07- 09]
(instructs co-experimenter to enter text labels)

Filler character
Now that you've seen some of the basics of what you can do in terms of data manipulation it might be a good
idea if I just briefly show you how we can improve the presentation of what we've got. because if we were to
say print this out to present it to a shop manager it might be nice if we could insen a few lines to make it
clearer. Now if you return to the MENU I'll show you the option we can use. If you go to FORMAT

(selects FORMAT)
{Foooat Width Attributes HJ.Jer_cbar Data_type]
Then it should present you with some OPTIONS you can use to change the FORMAT. First is the WIDTII.
Now you can use that to alter the WIDTH of COLUMNS or ROWS. I won't show you that one now, what I
want to sbow you is the FILLER CHARACfER, so if you shift across. That's the one.

(selects FILLER_CHAR)
[ Set filler to: 1
Now what I'm asking it to do is fill an area with one character in order to try and form a line. Now there are
several characters that work betlf'J' in this case so we set it to,
What are we trying to fill here anyway?
What I was thinking of was if we could insert a line across row 5. Now we might have made an error already
because we might have to have the cursor in the right place you proceed. [current cursor position is All] So if
we can actually backtrack, so if you come out of what we bied to do
(presses UNDO)
and again it will take you back to the spreadsheet. if you shift it to, that's right. move it up to 5.
(moves cursor to A5, MENU, FORMAT, FIUER_CHAR)
[ Set filler to: ]
Now the cbaracter we can set it to, to do a vertical line, how about this one [-] should produce a line.
(types in "-")
[Format applies to area: A5]
Now it is asking what area do we want to apply this to, now in this case, A5 to wherever, 05.
( emers, CR)
[line of"-" appears A5- 05]
Right there it goes. Now we have a line.

Save
Right. if you want to SAVE the option you move to is QUIT/SAVE which you can get to quickly by using

Q.

(selects QUIT/SAVE)
[Quit and Save: Options Context Save_Backup Save_New_Model J
Now what do we want, we want to SAVE to a model
(selects)

[Save to what model: ]
It wants a name ...

We've already got a name
Maybe I'm wrong, try to move back and go to QUIT/SAVE (presses UNDO)
[ spreadsheet and menu ]
thal's not consistent- it didn't take us back to the last one [stage]
[it vecy often does not]
No you're right (selects QUIT/SAVE again)
(Quit and Save: Options Context Save_Backup Save_New_Model)
I don't know how you do this. How embarrassing. I'm sure it is SAVE_NEW_MODEL, it seems the logical
thing to do ...
unless it means save it as a new model, not save this as the old one
I think out of desperation we should save it as a new model as I can't remember what we're supposed to be
doing
(li>es)
Mmm optioos good

Subject 8
[empty speadsbeet]
Let's do theatre tickets You put right down here (points to A column) the days of the week - that [points to
highlighted cell] is is cursor you use these keys to bring that down you can move sideways if you want

Enter text
we can type in a beading if you want
(types 'TheaJre tick£ts for George Michael")
and just press RE1URN or no - let's try it (seems insecure, but presses CR, text entered)
Maybe if that [beading] was in the middle it would look nicer, .s o wipe that off and try again, DELETE.
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Delete row
Call the MENU up (presses F8) and DELEI'E a whole line. You don't want to blank a word or whatever you
want to DELE1E a whole line so it is DELETE. (selects DELETE from MENU) There and accept that, and it is
a ROW, nota COLUMN. So RETURN.
[Delete bow many rows?]

1?
Yes, just one, and RETIJRN. And it is just 1 row so choose 1.
[row 1 deleted]
I think it would be nice if we bad it in the middle (moves cursor to C column, types title in again)
[could bave moved the beading by inserting 2 columns to the left of A}
We can start with the days now (moves cursor to A4)

(enJers days in A4 to A9)
right across there, we can put the prices put "Performances" there [A3]
(ti>es)

Blank
Actually we could DELE1E tbal, BLANK it, if you want to get rid of one word, use BLANK (selects BLANK
from MENU)

what does BLANK do then?
Well, I want to get rid of "Performances" because I want to put a colon there, but I'm not sure if I put colon
again it will get rid of that so I'm just going to BLANK that word, so I'm going to BLANK the word and put
it back in again and say colon
So it says area A3 and that's A3. so it's what we want, so that's got rid of that so we can go back by pressing
UNDO and type Performances again, if you would, colon ...
[wants to add colon quickest way would be to edit the entry]
(enter text labels in row 3)
Do you think that looks a bit squashed? You can always create a space, instead of having to DELETE that to
create a space. so go back to the other MENU (does, reads entries on menu) and for space ...

It's not there
Insert row
(reads MENU) INSERT, I should think, if you just press I, instead of going right down there.

(does) do we want a COLUMN
Just a minute, we don't want a COLUMN do we .. we want a ROW, press RETURN

starting at 4?
yes. RETIJRN

1 or2?
1 so just press RETIJRN Do you want more space or do you think that's alright? Ok we can go back, UNDO.
Enter numbers
(instructs to enter numbers in C and D for Prices and Numbers Sold)
Formula
Revenue. Let's think bow that works Because a spreadsheet really should do everything for you so you don't
have to work anything out for yourself. So if you go back to open MENU, hopefully tlhere should be
something there. Right ... (reads MENU) I'm not too sure. Can you think of anything there we could use.
well RECALC probably. no that is 10 RECALCULATE something that bas gone wrong. I sbould think
I can't see anything, can you not think .of the way to do it
I can't remember, try HELP, seeing as I can't do ·anything ru just press H and see. RETIJRN. (selects HELP
from MENU)
Math expressions, junctions, is that the one
Let's go back again (presses UNDO, reads MENU again) Try ORDER RETIJRN. No I'm not sure what
ORDER stands foc (selects ORDER)
[ Order over area: ]

maybe that's ordering things in alphabetical or numerical order
(Jxesses UNDO>
[warning beep]
(presses UNDO again) If you bave any problems just press UNDO and that should son it out.
(reads MENU again) Well we need something to count from one area to another, to work out revenue but I'm
not sure if that's going to work here. Let's see. You can work it out yourself but that's not what a spreadsbeet's
tbere for it's supposed to do things for you ...
(experimeotet' intervenes and asks her to multiply figures, but she cannot work out bow to do it)
You just wOfk that out, OK 111 just UNOO this. So it is numbers from one column times prices. so we can
just work that out ourselves I think.

Can you not think how to do il using the spreadsheet?
I can't remember what sbe said, but that you can do it that way and maybe you can.
Why bas it got fifteen thousand there, that last work?
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Save
Right if you want to QUIT and SAVE, go to the MENU, you go to QUIT and SAVE and you just press
RETURN, and you choose one of these, choose OPTIONS and then to get out you go right down to the
operating system

Subject 9
[empty sp-eadsheet]
Right. this is your spreadsheet You put information in here.
It's for putting information in ... you can
make calculations. It is basically word processing so you just format it all, so you can show that infoooation
in the best way you can, so when you put it out on the printer it is all very clear and you can work out
averages and means and ... It is basically like putting information in, the one we did in class was exam marks,
so you have subject across the top and members of the class, what they got, you worked out average mark for
rhe year per student. average mark per subject, number of subjects eacb person takes

so you're making a table?
basically yes, you're making a table. So, and then just use this [cursor} to go where you want. (demonstrates use
of CUJ"S(¥ keys)

shall we just name soTM sweets? (types "Sweets")
Enter text
you see you type it here (points to input line) as soon as you CARRIAGE RETURN, it will go to the point
where the cur- the bar is, (presses CR and enters text label in AI) so you can come out of that (moves cursor to
A2) and it will still stay there do about 5 I suppose ...
(moves cursor to AJ, enters text labels in A3- A7)
Right this is your MENU button over here [F8] so press this one here (does)
[MENU displayed]

Filler character
and this gives you all the options you have to use in that matrix, so say you want to blank something out you
gc ~o BLANK. FORMATriNG it - sort of jiggling it about so it looks neat, PRINT so you can print it,
INSERT is insen extra COLUMNS. ROWS and things. I'll show you. so go to FORMAT.

(selects FORMAT)
[F<IJDat Width Attributes Filler_cbar Data_type]
Rigb~ this is WIDTH so you can change the WIDTH of your COLUMNS or WIDTH of your rows, [nonsense only of columns] ATfRIBUTES, I'll come to that later.
FILlER CHARACfER- go to FILLER CHARACI'ER. If you want dividing lines in between the data

(selects FILLER_CHAR)
[ Set Filler to: 1
that's the one, so SET FILLER TO - you can put anything, it's up to you, star or something, SHIFT and ..
(selects"=")
[Format applies to area: ]
That applies to area A7 because that's what it's on at the moment So you don't want the line there, so say
you want it dividing- that's the title of your column [in AI]

(moves cursor to A2)
then area A2 to where you're going to finish it so to F2 so the way you do that is SHIFf colon, then put F2
in, so it will draw tbe line from there to there.
[line of"=" appears A2- F2]
In tbe same way you can make your lines down tb.at way and this will sort of split it up. That's one thing you
can do with it ..

Change attributes
What else - go back to that again [FORMAT] Now ATTRIBUTES,
[ NUM [R 2 -] LCRl[????????] ]
these basically are loads of functions in bere [question marks] that you move by pressing this one here [SPACE
BAR], so.

what's LC..
LEFT, put data to the LEFT of tbe column, C is CENTRE and R is RIGHT so we haven't got any ioformatioo
in there so go along so each question mark gives you a different function basically it's a very useful tool, move
one, right this one, just put the pound sign or dollar sign next to it. decimal places rather than figures, convert
it to decimal or percentages. Put it in percentages, actually converting percentages it will put percentage oo the
end. it says, something .. it11 say, say 5700 per cent so after that you've got to divide it you can't actually
convert it straight into percent so that's a bit ..
Anyway the way this is going to be used is to mark and present the data more clearly. The whole idea of this
program is basically. So, I don't know what sbe wants ...

we could diJ costs and selling prices ... how do you get out of that [A1TRIBVTES]?
Oh yes UNDO. Any problems whatever, that will take you back to the MENU. the original MENU.
UNDO once more, and you're back to square one. Put cost price ...

And

(enters text label in Bl, and numbers in B3-B7)
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Tbey [numbers] are all to the RIGHT, aren't they? Are you going to CENTRE them - so you go back to the
MENU, FORMAT, go to FORMAT,
[Format Width Attributes FJJier_char Data_type]
so it's ATTRIBUfES,
[ NUM [R 2 -1 LCRI [????????] ]
it is this C, RETURN.
[ Fmnat applies to area: B7 ]
FORMAT applies to area B7, delete that [B7]
(deletes with BACK SPACE)
go up to tbe top of tbe column, so it's B3 to, which is colon again, to so come down to .. yes, Right,

RETURN.

[nmnbers in B3:B7 centred]
It bas CENTRED those now. get rid of that again, UNOO.
Change width
Do you want to, it looks like these columns might be a bit too skinny, we won't have enough room in there for
the next one. So that's FORMAT once again. F8, right so it's WIDTH
(selects FORMAT, WIDTH)
[Set width of this column to: 12]
set WIDTII of this column to eh (points to input line) this says 12, now does that mean it is 12 now?
I'm not sure, it's how many characters you can fit in I think (counts) yes that's 12 obviously, so set it to 15
pedlaps,
[Set bow many columns to this width?]
set how many columns, (counts) set aU six
(enter "6", CR)
[columns B- G set to width 15] has it changed them? yes it has ...
[wanted A widened as well, but since cursor was in B, this was the first column]
this one has [B), but this one hasn't [A]
that's because- that [the cursor] was located in B it counted from there onwards ... [correct diagnosis] it doesn't
matteJ', really
so go along to your selling price ... (instructs co-experimenter to enter text label in Cl, numbers in C3 - C7)
Blank
I have ttJOde a mistake [while inpuning number1how do I change that?
Go to MENU and work your way to BLANK, that will blank out. C4, yes
[ entry in C4 blanked out ]
so I do it again now?

yes.
[would have been much quicker to just overwrite cwrent entry by entering new one]
Change attributes
Right so now you can start ... it's those bloody formulas ... I've forgotten how to do these - basically the idea is
to put a formula rather than working out yourself what the profit is, put a formula in, • which I do not know and the computer will work it out f<X you and print the result up there. CENIRE that fust ...
(selects FORMAT, AITRIBUTES)
[ NUM [R 2 -] LCR1[??????7?] ]
(selects "C" for Centre)
[ Format applies to area: C7 1

(hesitales)
Doesn't matte•· which way you go. acrually (enters "C7:C3") up to there?
yes
(CR)
(1mproper coordinate. Bad syntax <X out of range]
Ab- no. UNDO. You must go tbe other way around.

(enJers range cv"ectly)
Formula
Now you can start working out things like average cost price, average selting price .. I can't remember bow you
do that ... What else could we do?
If you work out the seUing price minus the cost price
OK. you can do it in your bead but there's a fonnula for the way that you do it and I can't remember .. I need
my notes really
(experimenter tells him what the fonnula for average is)
Well do the MEAN first.
label it? (enters text label in A9, moves cursor to 89)
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Right put MEAN B3, open brackets, B3 to B7, RE1URN, see what that does.
[Formula appears in B9]
No - oh no, we didn't switch it to NUMERICAL, so BLANK tbaL
[unnecessary to blank, could just be overwritten by new entry)- (selects BLANK from MENU, blanks B9, types
"MEAN(B3:B9)")
This key over here [F7) is called a toggle key, see that [formula at input line] is TEXT input so it will just put
in_ as it is what has been written down there ... so if you press that it will change to NUMERICAL input which
will actually do the calculation for you, hopefully it will work,
[result displayed in B9]
1bere you go, so you want to CENfRALISE that now ...

(CENTRES figure)
Do the same for the selling price .. (instructs subject to re-type formula instead of COPYING it)
Save
So right you've got to SAVE it now so it will all get stored on the disk in the computer. So go over to QUIT
and SAVE, doesn't go down, no. Go to OPTIONS that will tell us what we can do

Subject 10
[empty spreadsheet]
This is a new spreadsheet and you can see each space on the spreadsheet bas its own co-ordinates, so that
would be AI.
Now we can enter things into this by typing what we want to enter and it will come out on here (points to
input line) so you can go back, you can correct it. when you want it to go in the spreadsheet, press RETIJRN
and it will come up on the spreadsheet
where
It will come up where the cursor is at that time.
So if we start. say a few lines down. You can actually move this [the cursor] by using these keys [cursor keys].

(moves cursor to A5)
Enter text, enter numbers
So if yon put the products in this column - (instructs co-experimenter to enter text label "beer") Just type and
press RE1URN and it will come up.
If you wanted to correct that if you wanted to put lager, say, instead, you could leave the cursor where it is,
type in lager, press RETURN and it will come up. So if you want to put the next item in ... (instructs coexperimenter to enter text labels in A5-A10, and A4-C4 and numbers in B5·Cl0)
These [numbers] aren't centred. later on we can actually centre them. When we've completed the spreadsheet
we can go back and centre everything.
Right now we can calculate the profit I can't remember how ... if you just [seems to try to work out bow to get profit calculated]
Ob we could calculate the average retail price I suppose. If you go a couple of rows down

(moves cursor to C12)
Formula
now we can calculate an average by - first of all if you go into the MENU, press F8
(does)
[MENU displayed]
and this gives you all the- no you don't want to go into the MENU, sorry, press UNOO which is that one...
What you actllally want to do here is calculate the .average of everything, I can't remember how to do it- help!
(Experimenter cells her she bas to use a fonnula)
If you type MEAN and then open brackets and then as each of these bas it's own co-ordinate so this will be
CS, so if you type in C5, then we want the mean here to here so a colon will- C5 to and then the very last
one is CIO and then close the brackets again. Now this [next to input line] is still showing TEXT because we
started typing and the flfst thing we typed was a letter rather than a number it still thinks it is TEXT. so if you
press RElURN now all it will come up with here [Cl2) is mean brackets which is not what we want, so we
want to cbange it to a NUMERICAL entry. So to do that if you press F7 you'll see this change

(does) so that now says it's a numerical entry
So now it will actually calculate the mean from here to here if you press RETIJRN it should could up.

(presses CR)
[result displayed in C12]
lbat's the mean price. We could also do that for the cost price as well, so you type mean again then this is 85
[does not COPY here]

(types correctfonnula but forgets to toggle)
right if you just type again

(re-enters, toggles, CR)
[result appears in Bl2]
We can wOik the profit out on each so start a new row [means column}
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(moves cursor to D5)
I've forgotten bow to take away (subtract] help!
(experimenter tells her she just has to subtract)
(thinks) Oh - I see So - it is just C5 - B5, I hope
(types)
and then change it to NUMERICAL.

(toggles, CR)
(result displayed in D5]

Yes it worked
Copy formula
Now rather than doing that separately all down there we can actually COPY that so it will do the same thing,
so if now we go into MENU, we've actually got COPY here, now you can do what you did, which is move
the cursor along or you can just press C.

(selects COPY from MENU)
[ Copy from area: D5 ]
Right it wants to know the areas- You want it copied from D5, so that's ok, just press RE11JRN again.
(tkJes)

[ Copy to base coordinate: D5 J
Now we want to copy it from here to here, so move the cursor down one, now use the colon again, then you
can move the cursor down to here [DlOJ You will see it come up. That is it, now press RE'IURN I should
hope ...
[ Copy Valoes All ]
you want AIL, so if you move

(selects ALL)
[ Copy Relative Absolute Prompted ]
and RELATIVE, just press RE1URN

what's that?
what does it mean? I'm not particularly sure.

(selects RELATIVE)
[ fmnula copied to 1:.>&-DlO]
So now it's given a profit for everything it has gone to and copied the formula for each row.
So now we want to come out of the MENU, so press UNDO. Then we can actually calculate the mean profit
again, so if you type in now mean and then D5, D 10 and then you want to make it into NUMERICAL before
you press RE1URN
(enters formula successfully)
Change attributes
Then perhaps what we could do is to CENTRE .. so it looks better. If you want to go into MENU again, go
to FORMAT,
Use F again, like wilh C
yes. Now if you go to ATTRIBUTES, we can CENTRE colwnns

(selects FORMAT, AITRIBUTES)
[ NUM [R 2 -] LCRl[????????) ]
Now this fcr each question mark (points) will do something different If you press HELP it will show you(selects HELP, reads help screen) change?
change means the SPACE BAR. So if you want CO press that you can actually move this up and then you can
see (demonstrates) that is the flfSt question mark. Move it down, just press down,
does that tell us...
yes that tells us what all the question marks do you'll see this come up to the left of the question marks. You
see you can even put pounds in here That's as far as it goes. Press UNDO, that will take us back. These are
the question marks. Now it's on LEFf or CEN'IRE or RIGHT so if you press the SPACE BAR you11 see
this change.

(scrolls through options)
so what are we going to do - centre?
CENTRE, so leave it at C, move along, we could add a pound sign to it yes, move through until the pound
sign. Now press RETIJRN and it sbould ask you what area ... - (does)
[Format applies to area; Dl2]
what area you want tbe format to apply to. So if we do it column by column, so go back right up to profit,
because we want to centre the word [text label in D4] as well then use the semi colon (sic) again

(enters "D5:Dl2" as instructed)
RE1URN
(does)
[entries in column D centred. nwnbers with pound sign]
Now we can do each column, so go back into FORMAT - same again?
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[could have done columns B-D in one go- does not seem to be aware of l.his and does l.hem one by one}

Filler character
Now we could separate the columns, so go back imo MENU and you can put lines, go back to FORMAT and
you11 see it's got FILLER CHARACfER, so if you want to move the cursor along to there and press
RE1URN. It will ask you what you want to use so

what do we want to use this for?
We can use it to separate this column from these columns, we could have a line of stars or something ... yes
[just for indicators] ... so it could be anything.

(selects FORMAT, FIUER CHARACTER)

[ Set f'iller to: ]
are we going to do it vertically?
yes- use the "1"

<X" something

(selects 'T')
[ FOl'Dlal applies to area: B 1 ]
Insert column
Now you want to say what area it applies to so if we just say it applies from here to here, A4 - Ah, I think
we're going to have to actually create a column there before we can get it in. Sorry about that, if you ~s

UNDO. it will actually bring you back into the MENU again.
FORMAT - no we want to INSERT, so UNDO again, INSERT so I.
[ Insert Row Column 1
We want to INSERT a COLUMN.
(selects COLUMN)
[ Insert columns starting at: B ]
.
Now it always inserts to the left of the cursor so that should be OK.
[Insert how many columns:]
So it's just the one column.
[new column inserted between A and B )
So now we've got a new column.

Change width
Now if we go back to FORMAT, really it is a bit- when we put the Fll..LER CHARACfER in it will fill
everything in that column, so really tbe column is too wide, so we really want a WIDTH of one so we just get
one FILLER CHARACIER. So if we actually go into WIDTH

(selects WIDTH)
[ Set width of this column to: 12]
you see at the moment it's 12 so if we use just 1.
(enters "1")
[Set bow many columns to this width? 1}
And how many columns, so just one.
[new column B set to width 1]
Now we can go back into FORMAT, use Fll..LER CHARACTER

(selects FORMAT, FIUER CHARACTER)
[ Set filler to: )
(selects "I")
[ FOl'Dlal applies to area: B4 1
yes, now you can use colon again and just move down until you get to the last co-ordinate

RETURN?
Yes and it should [Filler character inserted B4-B 12]

Save
We want to SAVE it so we want to go into QUIT/SAVE, so you can press Q to get into that you want
OPTIONS and RETURN

Subject 11
[empty spreadsbeet] This (demonstrares use of arrow keys) moves your cursor through the columns, up
and down and left <X' right

Enter text, enter numbers
(instructs to enter text labels in A5 to A12 and B4 to D4 and numbers in B5 to 012)
now say we wanted to fmd tbe average price of all the different items here (B column) we could label a column
AVERAGE (types "average") no actually I don't want to do this (deletes by BACKSPACE)
if we wanted to put a column of the highest priced items in tbe shop and the lowest priced so HIGHEST
PRICE

(enters text label in AI4)
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Formula
and in bere (moves cursor to Bl4) we want it to list the highest price of all them so you have to put in a
formula so MAX for highest priced and then we want it between this 75 pence and 6.50 (points to 85 and 812)
so that is column B5 so you put B5 to, which is colon, to 8 12, (enters formula for maximum) so ... close
brackets and because here it says 1EXT because the first thing you typed in was a letter so it automatically
thinks its going to be TEXT that is going to go here but it isn't it's the formula and the actual thing that is
going to go there is a figure that you want so you have to press F7 (toggles) which is going to change this to a
number which is going to printed there, which is the case for all formulas because it's going to be a number
that is printed there
[displays correct result in B 14] and it puts you 6.50 because that is in fact the highest price
and then the same tbing if you wanted lowest price, do exactly the same formula (enters text label in Al5,
moves cursor to B15) but instead of MAX we put MIN (enters formula. RETIJRN)
[foonuladisplayed in B15]
no don't want that. how do we do this? I forgot to toggle it because if you forget to toggle it it puts what is
actually written rather than tbe answer to tbe formula, so F7 changes it to a number (retypes formula, toggles)
[result displayed]
and you've now got 10 pence for a packet of crisps.

Change width
Other possibilities are, say you wanted this eventually printed out so you want a line coming down here so
what you want to do is close this column to 1 character so you can insert one character all the way down to
fmisb it off so ... now F8 is the MENU so it gives you all the commands you can do so if you wanted to
change tbe WIDTII of this column which conunand do you think you would have to move to
formoJ?
so if you do what ... and then WIDTII obviously, you want WIDTII,
(selects)

[ Set width of this column to: ]
so set the WIDTil of this columns to one
(enters "1")
[Set how many columns to this width?]
bow many columns to this WIDTif, just one
(enters "1")
Filler character
and you've now got that column there is just one figure thick, one character thick. So now you actually want to
insert a line coming down So if you - (tries to move cursor) now before you can start moving the cursor around
again you want to get rid of this MENU because otherwise using these arrows just moves the cursor along so
you have to UNDO which is whenever you use a conunand and you want to get rid of that command you want
to go back to before or if you do something you don't want to do you press UNDO and that will get rid of it,
(F2, moves cursor to El). So now you want to insert a FILLER CHARACfER which you can do down here
so if you get your MENU again, in fact it's not INSERT that you want, you want FORMAT again
(selects)

and this time you want Fll..LER CHARACfER,
(selects)

[ Set Filler to: ]
SET FILLE~ so now it wants you to tell it what Fll..LER CHARACTER you want because there isn't
actually a straight line or anything so the nearest you probably get is an L a little L, I'm not quite sure, yes if
you just press little L
(enters "l")
[ Formal applies to area: ]
the FORMAT applies to, well you obviously want it from the top to say about 17, which is E17 so you want
it from El which is where the cursor is, to El7, so to is, what is to, applies to area El because the cursor is
there and then move the cursor to where you want to finish it and it will change with it and then press
RETURN
[ line inserted in E J
and you press UNDO
[line is stuck next to right-justified figures in column D)
Change width
if you thought that. if you think that is too close to the figures and you want a little gap, so you now want to
expand the WIDTil of the D column just so that there's a little more room at the side so if you now tty using
your MENU to maybe add a couple of characters extra to the D column
(selects widlh o/8)
·
that's eight. you don't actually want it to be eight you wanted it to be eighteen I presume so it was 16, so tty
UNOO, press UNDO and try again from FORMAT see you want 18 and just the one,
(thes)
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~ colUJD?,O wide~ to 18, but since figures are right-justified, they still stick to the line]

m fact tt s, yes m that case it might be better to in fact widen the E column that might have done it but

anyway,
[no, since "I" is text, and text is left-justified]

Insert row

rn just go through a few more of these If you wanted to INSERT here a column [between C and D) you'd go to
the INSERT command
(selects from

MENU)

and it's a COLUMN rather than a ROW you want
(selects)

( Insert colwnns starting at: ]
and when you insert, it will always insert to the left so you've got the cursor in the right place [D column] it
will insert to the left
[ Set bow many columns to this width? ]
You just want one.
(enters

"r, REIVRN)

[new column inserted between C and D)
So now you've got an extta column if you wanted another column of information.

Copy formula
Going back ... (moves cursor to B14) Ie('s say you've got this formula which is the highest price and you
wanted to know, you wanted that fonnula to apply to that column [C) and what were the other columns, selling
price and amount sold. so you want also the highest amount sold so you want this formula to apply to the next
three columns [C to E] as well so you go back to your MENU and you COPY this formula for these colunms,
so it's now COPY command,
(selects)

[ Copy from area: ]
from area. well the cursor's on B 14 which is where the formula actually is so you want to COPY FROM so
that's right
[ Copy to base coordinate: ]
COPY TO, well you move your cursor to the first column where you want it to COPY to, which is ... to C14
to El4 isn't it so and then move it to El4 right

(enters coordinales)
[Copy Values All ]
right next thing it says COPY the VALUES or ALL, well you don't just want the VALVES of the formula.
you want AlL of it so,
(selects ALL)

[ Copy Relative Absolute Prompted 1
and RELATIVE, ABSOUITE or PROMPTED you want relative

Why?
I thought you were going to ask me that. well it's not ABSOUITE because it's going to change with eacb
column, it's RELATIVE to what the figures are in the columns so it's not going to COPY absolutely what's
already got in the B column because the figures are different here RELATIVE to what figures you've got in
your columns so press relative then right
(selects RELATIVE)
[ 1n? in Dl4]

as you haven't actually got anything in this column it's put this little question marlc in tbe column because it
doesn't actually know what to do so once you've filled in that column you could go back and redo the formula
for that one but there isn't actually anything in that column, ... right

Save
You fmisbed all you wanted to do today on it so you want to now leave the spreadsheet but you want to SAVE
what you've done today, so which one do you reckon will SAVE, right,
(selects QUIT and SAVE)
move to OIYI10NS

Subject 12
[empty sp-eadsbeet]
(points to empty spreadsheet) If you go down a few lines, to A5
(tbes)

Enter text

and tben let's type in a list of products an:d their cost-price and selling price just think of a few names . beer
(points to AS) That's a cell and anything you type down here once you press RETIJRN it will go to the cell
you're in. So if you press RETIJRN and then travel down the line with the [cursor] key otherwise it would
come up over the beer. Wine ...
(types in text labels in A6 to AJO)
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we _bav~ to put pri~es in we'd have to go across, and then up to the t,op (B5) I suppose - bow much would beer
and type in cos t-price, and then across a cell, and selling
pnce

'x: JUSt mvent a pnce for beer ... if you go up a line,

(enters tat label "cost price" in 84, "selling price" in C4
[last letter "e" is not highlighted since text label is one letter too long]
then aaoss one

(moves cursor to D4)
(hesitates) The cell is not wide enough - if you just put a space in, because it's going to go over the "e"
otherwise and then afterwards we could make the columns wider. Put in amount sold
What do l type?
space and then 'amount sold'

(does, CR)
[enters "amount sold" in 04, "e" erased]
[no concept of space as character] oh dear that'll do for now
Enter numbers
and if you go to B5 and put in a price

75? Shall I just put in 75?
Just put 75 and then return. Don't know if we should put "p" Yes, 75, then RE1l.JRN.
(OOes)
[ 75.00 in B5 ]
Oh God. Perhaps we should have put nought point 75 I don't think it would have cost that much. 0 .75.

Just type over it?
Yes.

(enters 0.75 in 85, proceeds to enter nwnbers in B5:BJO and C5:CJO)
Change width
Perhaps we should make the columns wider. If you want to make anything wider or if you want to do a
reformat. We have to call up your MENU and it gives you a selection of iterns that we could piclc to widen
columns, just reformat the page, do different things on it and to pick the menu is F8 which is there.
(calls up MENU)
What one is it? I think it is FORMAT, so if you go along with this button to FORMAT, I think that allows
you to re-format your page, make it look different. then press RETURN. Then it asks you what you want to
change and you want to change the WIDTHS of the columns Which is WIDTH so if you press WIDTII. At tbe
moment all the columns are 12 so I think we need to make it, at least one more, let's make it 14 or 16. So if
you, it's 12 there so if you press 1 and 6 to type over it Then press RETURN. How many columns. Hyou
move it back to the beginning, the cursor, oh no you can't do it Press that one see if it
[warning beep).
I think we shouldn't have bad that [the cursor) there [A column] we should have bad it in a different place. Well
if there's 4 columns, if you press 4 and see if it works. Did it work on all of them or just one?
[C where cursor was plus 4 set to width 16]
so if you want to UNDO something it is F2. Press F2 and that gets rid of your menu. If you move the pink.
thing, the cell. back to the beginning and then we have to do it again to get those two done again. Then F8
and FORMAT, WID1ll again, then change it to 16 and then 2 and that should change those 2
[A and B column set to width 16]
Amount sold, if you go across to D
(moves cursor to D5) (enters numbers in D5:DJO)
Formula
1ben we have to work out different things, profit per item. We've g.ot to work things out now. When you're
working things out numerically because we're in TEXT here we're putting in TEXT words, when you're
working something out numerically you have to toggle it to get it into NUMERICAL so you can work out
equations and matbs and that and that is F7, if you press F7, mm doesn't like that Perhaps if we move it.
can you move the cell down?
[warning beep]
I don't know why that bas happened.
[can't toggle since there is no input to toggle]
(experimenter signals end of sessioo)
Save
We're going to save now so you need your MENU, F8, what we want to do is SAVE it and leave and the
command for that is QUIT and SAVE which is that one there so if you just press Q, QUIT and SAVE, we
want to SAVE the NEW MODEL
[this would be renaming, she doesn't realise that) so if you go along to
the end and RETIJRN and then the model is off licence I don't think it is so if you put that, mm can you
press F2 again and we'll go back. QUIT and SAVE, return. OPTIONS, can I have OPTIONS, sorry. I'm not
sure it's saved .... [doesn't realise that model is saved when exiting for first time)
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Subject 13
Tbe idea of the .s~readsheet is so that you can store 1ata over a wide range and also to be able to calculate
averages and mmlUlums and maximums, to get into the programs what you have to do is, the date's already in,
you can fiddle the date but the month bas to go at the beginning
[empty spreadsheet]
This is what the actual spreadsheet looks lilce. Vertically there's an infinite number of columns going down
and aaoss also so and you can see that they're numbered lilce and letters, and I think it goes on to lower case
letters and so on, so you get an inftnite number of letters.

Enter text
Would you like just to type some names in just put the names down here (points a column A) but if you leave
two lines at tbe top we can enter tbe dates that the races were run on
(moves cursor to A3, types name)
What you do is that name you've typed there, if you press CR will go into that space (A3)- there. There and if
you want to move the cursor down one you can type in another name. Press CR again, press the cursor down
again, because if you actually want to do a correction you keep the cursor on the place you want to correct and
re-type it and press CR. so it's quite easy to correct, it's not deleting letters or anything, do you want to put
some more in
(enters names A3-A8)

Enter numbers as text
You can enter dates, we go up here [B2] and you can enter dates and shall we just put in that something (types
date) 3 days like that
(presses CR)
{Dlegal character]
illegal cbatacter problem ... press UNOO (presses UNOO function key)
[message disappears, warning beep]
It doesn't like me It really doesn't like it does it?
I think it's because you're in NUMERICAL mode (points to input line)
Right Switch to TEXT. (presses F7 function key) I didn't think you were supposed to know anything about
this and then if you just continue

(types in dales in C2 and D2)

Enter numbers
(moves cursor to B3) Now we've got to put some numbers in ... if you just toggle and put some numbers in for
each of them don't know what's realistic for 100 metres ... let's say 14 that day (types 14, TOGGLE to TXT,
CR. moves to B4, enters numbers as text in B3-B5)
I'm not sure you want to put thal in as TEXT you want NUMBERS if you're going to calculale things on it
I think if it goes in as text at the moment it's alright. I think so, I'm not sure but I'm going to pretend it is.
Just do ..•
(continues entering numbers)
try and put it in as a number and see if it makes that horrible beeping noise ..
(enters as NUMBER)
[number appears, right adjusted rather than left]
oh it doesn't So I suppose it doesn't really matter.
something like that (fills B column with numerical entries)

Formula
shall we calculate the averages for that day? Before we go and make up numbers for .the other days. I'm just
trying to remember bow to do it. Let's go down a line and put the average there. Do you want to type
"AVERAGE" in?
("AVERAGE" label in A 10)
(moves cursor to B3) Right we want tto calculate, it's to get an average, we type in MEAN (types) and then
you put a bracket (does) and then you type in the square that you're in, which is B3, which is where you want
the mean to start. Then you put a colon and you type in the number of the square, B8 which is the last one
we want to calculate. Then you put the bracket there then, because that's a TEXT entry and if it's a 1EXT entry
it won't do anytbing because it doesn'' t know and we're actually wanting to do something mathematical so we
change it to NUMERICAL which comes up here (presses F7, points to left of input line) it shows you there,
I'll just move the cursor down here (moves cursor to B 10) because that is where it will write the average and
then press CR and it should do the sum for us.
(result 14.40 appears in B3, overwriting ooginal numbers-as-text entry]
It's put it up there hasn't it? Because I moved the curs<I afterwards. If I'd moved the cursor before it would bave
written the average in there. I can't remember, we said 14 for that one so if we move down to here and write
14.40 in we know that's the average. ![only over B6-B8, since it did not calculate text entries, but she does oot
notice that] (types 14.40 in B 10) Then we can come back. to here and just type 14. (moves back to B3 and enters
"14" as number)
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Change attributes
Would you like to make it so that it's all central? Right press MENU which is the F8 key and then it will
come up, FORMAT, so yes - you actually know how to do this don't you? We want to go on to
ATIRlBl.TJr:S so do you want to press that one which is ATTRIBUTES and it's at the LEFf at the moment.
so here you see it tells us it is LEFI', CENTRE, RIGHT, so to get it, so that's the letter it is on at the
moment, so do you want to put it in the CENTRE?
so it's on that now, CENTRE, So we press RETURN. And it is saying does this apply to B5 but the area we
actually want it to apply to is B3 to the area, where is it going to? BlO, so we want a COLON, and we can
move with the cursor down to where we want it to go and press CR and they're all in a line in tbe renue.

Insert row
Do you want to put a line in here in between? So what we fJ.rst want to do is to put an INSERT so you want
to go to INSERT, press or you can move the cursor onto insert Press CR. It says do you want to insen a
ROW or a COLUMN. Well if we're up here I think we want to really insen a ROW don't you?
Yes
ROW, starting at 10, but we don't want to start at 10 do we, we want ro stan here, it always inserts above the
cursor or to tbe right of it so we want to stan at 3, so do you want to press CR again, and we want just to
insert 1 so you see it's inserted a ROW,
Filler character
o what we want to do is go onto FORMAT again, in the menu, no, yes, that's the one and instead of
ATTRIBl.ITES this time we want FilLER CHARACIER, that one,

(selects)
what do you want to do for Fll.l..ER CHARACfER?
I don't mind. equal signs or minuses or stars, lww about stars?
OK. That applies to, shall we go from A3, it's going to look better isn't it?

(nwves cursor)
We want fU"St of all to put a COLON in, otherwise it will say just A3,
(types colon)
and then we can move that, shall we go ro there, do you want to press CR

Change width
do you want to write a column in here so that the dates are separated from the names
(INSERT column) That's a bit too big a column isn't it, so I think what we'll do is go to FORMAT again so
press F, there, set it to WIDTH this time, WIDTH of this column is 12, do you think 1 is alright, then we
can put a row of stars going down.
Yes, why don't we do that ...
[Set width of this column to: 12 (cursor on 1)]
(presses DEI.EfE, erases the 1, presses DELETE again)
warning beep]
No, if you just press the one and then CR (types 1, so back ro 12, but doesn't notice)
[Set how many columns to this width?]
if we just press CR ...
[system proceeds, but width remains Wlchanged]
That was wrong ... (hesitates, can't work out what went wrong) if we go back to FORMAT again (selects
FORMAT, WIDTII)
[Set width of this column to: 12 (cursor on 1)]
(types 1, which substitutes 12, and changes width) ·

Filler character
There (rel!eved) shall we set to FILLER CHARACTER? So if you press F again (select FORMAT,

FU..LER_CHAR)
[Set filler char to?]
do you want stars again?
ShaU we do thal?

Yes. (types*) It applies to B3, now we want to go up to 1, (moves cursor to Bl) now do you want to press a
colon? down to where we stopped (B11), right, it's put some stars in, is there anything else you want to do?

Formula
Shall we get the minimums and maximums?
Yes why don't we do thal?
So, we want fliSt of all to get rid of this menu so to get anything off the screen that you don't want press F2
which is UNDO. I'm trying to remember - right, bring the cursor down (to C12), put it here so it will
actually print here what we want.
Do you want to do the minimum or the maximum?
Why don't we do the minimum and maximum? ..
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If we do minimum ftrSt we want to type "MIN", do you want to type "MIN" and we put it in a bracket and
tben tbe squares are B4 colon B9 (wrong- tbe figures are now inC since a column bas been inserted) close your
brack~ and you ~ant ~make it on a nwnerical one and then press CR. Doesn't like that does it?

I m not su~e, did I m1s-type anything? B4, ah it's actually C4 isn't it?
Yes - (balf reheved, balf irritated) So we try again sorry if you type C4 not B4 because the last one was B4
(wben tbey entered tbe formula f<W' average)
(proceeds to enter, forgets to Wggle)
ah unconverted
so we need to remember to press the NUMERICAL thing don't we. Then CR. It might actually do it for us.
So that's the minimum time, that's who was fastest. shall we do it with max (proceeds to enter formula for
maximum)
(enta figures in D colwnn)
Can we do the averages, the maximum and the minimum for those ones?
Yes, it's tbe same, except for being C it's D this time. So averages - do you remember?
(enters AVERAGE, MIN and MAX)
Shall we move this to here (F3) and get it to tell us what the M1NIMUM for each person is
So we want to type in MIN don't we. C4 to D4 (types in formula) so that is the minimum time she did.
can we do that for all ofthem?
Copy formula
We can do that and make it a bit easier for ourselves by putting it to COPY. Which is there so press CR.
(reads)

[ COPY from area: F4]
we want to copy FROM AREA F4 because that is the value we want (presses CR)
[ COPY to BASE CO-ORD/NAT]
Well we don't want, so F4, so we move down (moves cursor to F5) and then because we want it to COPY to all
of tbem so we press the colon, go down to the bottom one we want it to COPY, which is that one, (moves
cursor to F9) press that, we want to COPY AlL
What's the difference between AIL and VALUES?
I don't know. We want to COPY, I think it might mean that we want to copy the whole equation down and
not just the numbers. We want to COPY RELATIVE because we want the equation to alter itself for each
different line, so we want to COPY RELATIVE and that's everbody's
That's very good
(centre the figures in the colwnn, and tidy up other colwnns)
Save
What we do to SAVE the spreadsheet is you want to move the cursor onto QUIT and SAVE and you can eilber
do that by pressing Q or by moving it
You have to move it all the way
Yes
and then CR
yes, and then it will tell us, we want to go to OfYTIONS, I think, no we didn't. I've done that wrong, haven't I?

Subiect 14
[empty spreadsheet]
I think the best thing to do is, have - I don't know ... beans, Heinz. different brand names across the top, if you
put something like Coke, Pepsi, My Mum's something like that, if you go down a bit more and leave a space
at the top,
(moves cursor to A4)
Enter text
you may as well pul Coke or Cola or something like that.
(types "Coke")
In fact, just put "drinks" there.
(backspace, types "drinks")
CARRIAGE RElURN.
(tiles)

["drinks" appears in A4 1
(instructs to enta furtber text labels in 84 to D4)
Actually I'm just thinking that would be better down the side, there, say have about four different shops and
different prices there and then calculale the average price, do you know what I mean
yes, so whaJ ...
If you put Cola and 4 different drinks down there, shop 1, shop 2 ...
Delete row
so how do you get rid of these [text labels in A4 - D4/?
or you can just DELETE that one you're on at the moment, if you press MENU, F8, there is a DELETE
command there, press D or highlight it.
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(selects DELEfE)
[ Delete: Row Column ]
We want to DELETE, might as well delete the ROW, tbat's already highlighted [row] so RE'IURN just the

ooe

[ row 4 deleted 1
right so go back to AI

(tries to move cursor)
[warning beep]
just press UNOO to get rid of that [the menu]
CARRIAGE RE1URN
Enter numbers
(proceeds to enter text labels in A4 - D4 and A6 - A9 and figures in 86 - D9)
We can make a column here (points to A) for the average price the shops sell ... so if you want to put a title
there first in D4 just do average or mean or something like that right
(enters tat label "average" in A4)
Formula
Can you press MENU. call tbe MENU back. we want a formula for that. (reads MENU)
Yes if you press UNDO again. I think it's MEAN and then bracket, we want to print these across so B6 - and
the a colon. and obviously then D6, close brackets and then you have to change that to NUMERICAL. press
F7. and move tbe cursor down to D6
(does) Why did we choose that [nwnerical]?
Choose that? Because otherwise it reads it as 1EXT and just.prints it there. CARRIAGE RETURN.
(does)
[ result appears in A4, overwriting text label ]
Why did it do that?
[because cursor was moved after formula was typed, but before it was entered wouldn't it be better not to allow
cursor movements halfway through?)
You could just tty and print average there again

(enters text label in E4 again)
and just go over that and move it down now

(enters formula in E6, toggles, CR)
[ result displayed in E6 ]
Copy formula
and you want to COPY that formula now for the rest of them.
command COPY

So, if we get the MENU again and get the

(selects COPY)
[ Copy from area: E6 J
you want to COPY from area, yes, that's right, just press CARRIAGE RETURN.
(does)
[ Copy to base coordinate: 1
Copy to- E9, I think it is - E6. then press colon and just go back on that to make that last one E9. Then
press RETURN, ALL so either a or highlight it. you want RELATIVE so CARRIAGE RETURN
so what does that do?
[ results appear in E6 - E9 )
I think that's right
so what's that done ?
it's calculated tbe average selling price of each drink
Change attributes
what we can do now is sort of tidy it up a bit and get that CENTRED, to do that you call up FORMAT.

(selects FORMAT)
WID111.
(selects WIDTH)
Umm. actually, I don't think we really need to change the WIDTII, so just UNOO that
And it's FORMAT again, it's ATfRJBliTES then.

(selects ATTRIBUTES)
[ NUM [R 2 -] LCRI[????????]]
Right, we want to change that - to change the question mark, you use the SPACE BAR
So what are we changing here?
Try it, it gets centred (toggles) That's left and then C. that means the margin on the right and on the CENmE
so we want C, we want to get rid of the noughts as well. so if we go to there, that's the dectmaJ point column,
change it to nought and CARRIAGE RETIJRN ...

(selects)
[ Format applies to area: 1
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We want it from B4 to E9

(etllers)
[ cohunns B toE displayed in new format )

Filler character
Lovely! Right, you can use different characters to put a frame around it if you want it's FORMAT again and
FILLER CHARACfER

(selects FORMAT, FIUER_CHAR)
[ Set filler to: )
yes, do you want a margin right round that way? do it ...
we'll just do a line round there [row 5] and a line down here (between columns D and E) to separate the titles

from the numbers ...
right, to you want to put the highlight round there

(tries to move cursor)
[warning beep]
Sorry - that's going to be a problem it wants a character

(selects "-")
[ Fonnat applies to area: ]
now we have to say where it's going you'll have to move tbe cursor

(moves cursor to A5)
if you can use the colon again, E5

(enters A5:E5, CR)
[ Filler appears A5 to E5 ]
You can have one down the side [between columns A and B] and to do that you have to shift the thing along a
bit. If you choose like something like that to have a line down ... because it like the whole block. so you
want to reduce that to having just one character so we'll have to shift everything along a bit by using FORMAT
again.

(selects FORMAT)
[which she will need later to change the width)

Insert column
Oh - actually can you put UNDO and then INSERT, you want an e xtra column between A and B,
[ Insert Colwnn starting at: )
if you move that along to' B I think that will insert it to the left then just CARRIAGE REnJRN, right
[ Insert bow many columns: ]
Just the one, so RE1URN
[ column inserted ]

Change width
and so we want to reduce that to just one using FORMAT and WIDTII, you want it just 1, RETURN.
[ cohmm reduced to width 1 ]

Filler character
And tben you can put whatever you want in ... and it's Fll..LER CHARACTER.
(selects FORMAT, FIUER CHARACTER)
[ Set filler to: 1

which one?

either that or that (single quote]
[ Format applies to area: ]
do you want to move it up another one, B4 ... to,

rolon?
B9. ob, bas that gone right down.
[ fiUec char appears B4- B9]
oh yes.... that's ok. Is there anything else you want to calculate?

say we bought cola and water and beer from shop one, how do we work out the price of all the things
together?
Formula
ob right, do you want to get the answer down there the n? [bouom of column A] rigbt so you want the sum of
all of them. Press UNDO to get rid of the MENU and fonnula for that would be COUNT.
- So I have to move the cursor?
Yes, you'd better.
(moves cursor to Cll)
COUNT, bracket. C6, colon, C9 and change it to NUMERICAL and CARRIAGE REWRN
(does)
{result "4" in Cll )
oh that's just counted bow many things there are ...
[COUNT just counts the number of entries]
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I think it's probably SUM then if you want to try that
(enters formula for swn)
[correct result appears in Cll]
Copy formula
you can COPY that formula for the rest of them you get the MENU and there's a COPY command there,

C~GERETURN,

'
(copies "from CIJ" to "CIJ:Fll")
we want to F11 so colon, ALL, RELATIVE.
[formula copied successfully]
That's that, only thing is that hasn't, do you want to tidy that up?
We'll get rid of the noughts, just FORMAT again, ATTRIBU1ES, and it's just the same as the other one,
that's it to, ob Cll to Fll, that should do it now.
[ figures iD row 11 centred and no decimals )
Save
H you get the MENU up again, it's the QUIT and SAVE option, OPfiONS

Subject 15
[empty sJXeadsheet)
This thing [cursor] moves up and down you can place it anywhere you want (demonstrates use of cu~ keys)
Enter text
To write anything in, you type it out down here (points to input line) press RETURN, and it will go wherever
the pink thing [cursor] is
We want a list of several names, we want to start down here
(moves cursor to A4)
we want to write out a list of names
(enters text labels in A4)
you have to move the cursor down bef.ore you enter the next one
righl (enters text labels A5- A8)
Enter n"mbers as text
and we want to list distances across the top
(moves cursor to 82)
So you start with a 100m or something
100 metres? (types "100 metres", CR)

rBoo oooo:Jinate 1

You pressed - we want to UNOO that press F2
[warning beep, system goes into edit mode]
UNDO again you want to change that F7 I think, from NUMERICAL you can't put numbers and text in as

nmnbets
(toggles) I see so NUM is for numbers and this is for TEXT?
yes - press RE11JRN now
[text label "100 metres" entered in B2)
[successful application of toggling]
now we want to put in the distances people run 200, and F7 now 400 (instructs co-experimenter to enter text
labels in C2 and 02)
Filler character
.
You can make it pretty and underline it all if you want I've forgotten how to do it now ... if you bring up the
menu and there are a lot of things you can do there we can underline by using FORMAT, so if you move the
thing [cursor] along
(brings up MENU, selects FORMAT)
um ... select Fll..LER_CHAR
[ Set filler to: ]
right wbal: do you want to underline it with?

star?
SHIFT, star
(does, CR)
[ Format applies to area: ]
so we want it from A3 to whatever you want, E3 or D3, use the colon for to
oh one is the beginning and one is the end? (enters range)
yes, then RE1URN
[ line of filler_cbars appears in A3 - D3 )
ok, amazing. Then you could put in a line there [between columns A and B] if you want to. Do the same
again
Use FORMAT again. Just do FORMAT, select FILLER CHARACTER
[ Set filler to: ]
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two stars again now you want it putting, oh dear .. .? can't put it in there, can we? UNDO
we need a space to put it in so we need to move all this really, just put another block [column] in
[error diagnosed. procedure abandoned. restarts]

Insert column
so we .. so we can put it down there so INSERT. just press l ,
[ Insen Row Column]
we want a COLUMN,
[ Insert Column(s) starting ac D]
[current cursor position]
starting at 8
(types B, CR)

[ Insert bow many columns? ]
just one
[ new column inserted between columns A and B ]

Change width
now thal's [new column] too big for putting a line there, so we want to make it smaller, so if we go back to
FORMAT tben we can cbange the WIDTH of the line so

(selects FORMAT, WIDTH)
[ Set width of this column to: ]
we want it very small so 2 will be ok maybe just one?

(enters "2")
[ Set bow many columns to this width: ]
one
(types "1", CR)
[ new column B set to width 2 ]

Filler cbaractn
now we can put in the line, so if we press FORMAT again and we want FilLER CHARACTER

(selects FORMAT, FllLER_CHAR, selects "* ")
[Format applies to area;]
you want it from there down to here, yes B 1 to

colon? 10 B8? (enters area, CRJ
[ 2 stars each in Bl - 88]
yes, we want to stick in some figures now so you want to get out of the MENU flrst so press UNOO so we
want to put any old figures under these so think up some figures. for the times (instructs ~xperimenter to
enter number in C4 • E8]

Change attributes
Now you can make that a bit better by putting underneath that [figures under the text labels in columns C • E)
because it's pushed them all to tbe side [right-justified] we want to make it a bit neater by putting them

lllldernealb
so if you bring up the MFNU again, FS, you want FORMAT again, I think A1TRIBUIES - yes I think it's
ATI1UBU1ES
[ NUM [R 2 ·] LCRl[????????] ]
now you press the SPACE BAR. it's got several things underneath the question mark there, you want C for

CENTRE
so L is left, ...
So we want CENTER

(toggles to "C")
so if you press RETURN again.
[ Format applies to area: ]
it applies to the whole lot there so start from C3 or something. C4 and then down to wherever

(enters area, CRJ
[ figures centred in columns C • E ]

Formula
We want SOOte averages now so, well put the average down here, so write in average

(enters text label in AJO)
yes UNDO then put your two stars in 8 ·just type them in (laughs)
[sborta.lt to enter them as text, instead of fiUer_cbar]
(enters ...... in BJO. moves cursor to CJO)
Now we've got to make up a formula for the average, I can't remember bow to do that I think it's mean. type
in MEAN. now we want a mean of all these figures here, so we want to put some brackets in, from C4to C8

(types formuliJ)
but we want this in NUMERICAL, and it's in TEXT now, so if you press F7 because if it's on 1EXT it would
just put in what we'd written there (points to input line) but if you do it on NUMERICAL it puts in the actual
mean and it worlcs out, press RETURN.
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(toggles to NUM, CR)
[average displayed in ClO]

Copy formula
we should have moved it all after we'd finished this so now we want to do all three and instead of just doing all
three you can COPY the formula we've got there and put it under those two [columns D and E)
so bring up the MENU again and you want COPY
(selects)
[ Copy from area: C 10 ]
so we want it from there, so if you just press RETURN [ Copy to base coordinate: Cl 0 ]
and we want it for these two so you want 010 and ElO
so what are we copying, we're not copying the ...
no we're copying tbe formula MEAN, .. to ElO
(enlers DIO:E10) but the originalfomwla luui C4 to ...
[ Copy Values All 1
if we press in VALVES then you'd get that, but we want ALL, which is the actual formula which is still
underneath there [the result in CIO] so we press ALL, then we want the RELATIVE values, not the
ABSOLUIE
right, so that's what takes account of il being in a different column?
yes we want to move those in the CENTRE, (centres C10. EIO)
could you work out the winner?
Yes you could have the minimum time.
is there any way you could say?
If we put in the minimum we discover the minimum time is 48 and come down here so if we put winner in we
can put in the minimum score and just come up with the score, but if you want to put in the winner of tbe race
{i.e. the name of the person] you could just type it in, right so you want to put the minimum score, so we want
minimum (enters text label in A12, formula in Cl2)
yes, min, bracket,..C4 to C8, change to numerical
[result displayed in Cl2]
so you want to COPY it to the others now, so you want MENU again
[copied to D 12 and E12, centred]
could we SAVE it

Save
yes, to QUIT/SAVE, so if you just press Q, you want OPTIONS, and we want OPERATING SYSTEM

Subject 16
[empty spreadsheet]
Right, what shall we do? You can name things down here (points at column A) the articles we need and along
there munbers or prices for certain articles If you put in 2 or 3 of those If you press the arrow key and bring it
down a bit ...

Enter text
A record shop, let's have albums and prices We put the name of the albums down here (A column) and then we
can put the prices along there Put the name of the group just type it there [input line] and then CARRIAGE
RETIJRN

(enters text labels in 87:811, moves cursor to C7)

Enter numbers
OK. put 4.89 in there, CARRIAGE RETURN.
(types 489, CR)
[ 489.00 appears in C7)
489 might be a bit confusing .. we'll leave it for now Next one down
(enters numbers C8 to C 11)
suppose we need a beading or something
(enters text label "dealer price" in 85, "selling price" in C5, prices in C7 to CJJ)
Next column, E let's have Q), and 10 · 99 for each
(enters text label "CD" in E5 and "1099" in E7)
Do I have to type il in each time?
That's a very good question, I've forgotten. Yes type it in.
[copy?]
(enters price E6 to Ell)

Formula
What you do is some formulas

I don't know, work out some profits or something
Well let's do a MEAN. Mean is the price ... of the dealer price if I can remember how to do them. Right. Ok
if you bring the cursor over to this column (moves it to Cll) and type M E AN, bracket, C7 to Cl1, so C7,
colon, Cll, bracket. Press F7 and maybe we should have put it there (moves cursor to Cl2) CARRIAGE

RETIJRN.
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[result appears in Cll, deleting previous entry]
It luis written over it- shall we do it again?
Yes, put it in a different place (replaces old entry, moves cursor to Cl2) Do it again
(enters formula)
[ result appears in 12 ]
We could bave a particular group's MEAN. (moves cursor to Cl4). Type in MEAN, bracket, C9 to E9,
bracket, Fl. CR ... [calculation doesn't make sense]
Can you do a MEAN for the whole thing, yes ok let's try that. Ole let's count. Ok type in COUNT, bracket,
C7 to Ell. Fl. CR. Mmm. [another calculation which doesn't make sense] -(types title for this row)

c

Insert row

Let's move them around. Insert a few lines up here to make it look neater.
INSERT you press by, ROW, yes, so CR.
[Insert rows starting at: 12]
Yes, CR
[ Insert how many rows? ]
Say 2, CR.
[ rows are insetted]

Press menu button F8, and

Delete row
OK let's change these [the numbers] they are confusing let's change them to make it easier to read.
Press UNDO fli'St, F2, go up there [C5] with the aiT'ows. Get the MENU up again, press F8. Then press D for
DELETE. DELE'IE ROW, yes, press CR, starting at 5, yes, bow many rows, 1, yes. OK press undo, F2.
Let's go 2 up, ok you can write Dealer Price again ...
[row 5 with text labels deleted]
lets go 2 up (inslructs to enter new text labels, spread over 2 rows)
[could have made columns wider instead]
Why don't we work out the profit, between the selling price and the dealer price. Is it possible
Yes I don't bow to do it ...
Can we CENTRE the columns or something?

Change attributes
Yes. Ok. Press menu F8 and FORMAT, F, and if you arrow to A'ITRIBUTES and press CR Right if you
press the SPACE BAR twice, CENTRE,
Carriage return?
[ Format applies to area: ]
Yes. And now let's get down, no we don't need to. type C what's that, 6, C6 to Ell, ElO.
Is that right?
Yes. CR.
[numbers centred in columns]
Great, can we CENTRE the titles as well?
Yes. Do it again. Press CR, ATTRIBUTES, press SPACE BAR twice, sorry CR. Right. C3 to [E3] yes,
CARRIAGE RE1URN. Yes. FORMAT again, ATTRIBUTES, C4to 04.
[text labels centred

Save
(instructing bow to QUIT and SAVE) Move the arrow to the right .. . CR, right OPTIONS. Oh. I'm not sure
that's saved it
[seemed to expect to be asked whether to save]

Subject 17
[empty spreadsheet]
Right, so that's the format of it, where the pink is at the top that's where the cursor is. Anything new you
enter will show bere [input line] and then when you press the CARRIAGE RE11JRN it will appear where your
cursor is showing.
Yeab you can move it around and it says the point [in status line at bottom of spreadsheet] so if you move it to
Al or it goes to Bl it says the name of the cell so that identifies where your cursor is
We've got to make one up [spreadsheet] If you type 73 it shows like number or if you typed. start off with a
letter it tells you you are typing text in which is bandy if you want to do formulas. get out of that. so what do
you want to do?
shall we do a sweet shop?

Enter

tex~

enter numbers

Yes. So if we have a beading fJrSt, like cost price, type in cost price and then CARRIAGE RETURN and then
if you move it [the cursor] along to the next one [cell] selling price, CARRIAGE RE'IURN. and then a profit

column
(enters text labels in AI - Cl, enters number in A2, types
You have to move the cursor ft.rst or it will just stick it on top
(moves cursor to A3, CR)
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[ current input entered in A2, previous entry overwritten ]
oh ... try mov~g it first ... [entry appears where cursor was when f1fst char was typed - since it allows cursor to
be moved, subject assumes that entry will appear where cursor is before CR]
(enters numbers in A2 - A7 and 82 - 87)

Formula
Now we want _it_ to do the calculating. So, we want the sale price minus the cost price. So type B l (thinks). if you press F8 to get the MENU, (reads MENU) HELP? just type H
[ Coordinate_Entry Matbs_Expressions Window_Usage 1
Math expressions, CARRIAGE RETIJRN. [Help window: Enters input data into the model. If no input bas
been made made or Advance is ON <entef> will move the pointer right or down according to current Order (see
Sorting) 1
Does that maa any sense to you?
It just means if you press enter, CARRIAGE RETIJRN, it puts data in the model, wbicb is wbat we already
know. Don't want to know that. Just keep going.
how do I get rid ofthis?
1bat undoes what you've just done ... (tries to get out of HELP) That isn't much good is it. It _says_ MATII
EXPRESSIONS and FUNCTIONS ...
[obviously expecting inf<Xlllalioo on how to compose or select a formula]
We defmitely want to know what is in there ...
can we work out something else you know how to do? put another column in or something
(Experimenler tells subject she needs to enter a formula)
Just tell if what you want it to do? So if you type B2 minus A2 then you have to press F7 because you've
got TEXT if you press CARRIAGE RETURN it will just put that in, so that changes it to NUMERICAL to
tell it that you want it to do something with the figures now if you press CARRIAGE RE1URN, I don't know
if[ result appears in C2 ]
ob it does, well! So if you didn't press F7 it would think that you were entering TEXT because the flfSt thing
you entered was a "B" so it would just put in what you had written so you have to change it

Copy formula
So now instead of going through the whole process you can just COPY the formula so if you go F8 for
MENU and then select COPY
pressC?
Yes.
[ Copy from area: C2 1
Right you want to COPY - yes, that's right. just press RETURN
[ Copy to base coocdinate: C2]
now to you want to move the cursor down
we want to do it for all of them?
No if you just move it down 1, C3 and then type a colon in because that tells it that you want it from C3 to
and then you move the cursor to where you want it [C7]
REWRN?
yes.
[ Copy Values All )
You want to COPY ALL
(selects ALL. CR)
[ Copy Relative Absolute Prompted ]
RELATIVE - otherwise it would just copy thirty [result in C2] and be useless.
(It would copy the formula. but not adjust for rows)
[ result displayed in C3 - C7 1
It's done. is that right, yes. so that is your profit calculated.

Change attributes
Now you see bow that is sort of to the right band side of the column, [right justified] so square them up thal is
FORMAT so type F. if you select ATIRIBUTES
[ NUM [R 2 -] LCRI[????????] 1
now this LCR is LEFf RIGHT and it's on RlGIIT at the moment so so it's inserting [positioning] them to tbe
right of the column
Which one says it's to the righl?
(points) this R here- that's is what it's set to RlGIIT with 2 decimal places. So if you press the SPACE BAR
you'D see tbe question mark change, that is LEFT, so if you press again, CENTRE, when you do that ... so if
you press CR.
{ Format applies to area: ]
You want it to apply to, you want it from A2 to, press colon, to C7
So we can do it righl across the square?
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yes - I hope so (laughs) RETURN
(numbers A2 - C7 centred ]
ob we should bav~ done profit [text label Cl] as well, so if you select FORMAT again and just press CR and
ATIRI~l.J!ES·. JUSt p~ss RETIJRN because it is already on CENTRE, just press CARRIAGE RETIJRN
because tt IS asking wbtcb AITRIBl.ITES you want it to use and it is the ones you've already done, so(CR)
[ Format applies to area: ]
and then asks you what area so Cl.
[text label in Cl centted]
We could put pound signs in, so if you select FORMAT again and ATTRIBUTES again,
[NUM (R 2 -1 LCRl[????????} ]
if you move the little cursoc along [the question marks] you see bow it [display to left of question masks]
changes, if you keep going until

so that just tells you the dijferenl things you can do
yes you can put pound signs. dollar signs, deutscbmarlcs or percent sign so just press the SPACE BAR and it
changes and we want the pound sign. so if you press CR.
[ Format applies to area; Cl 1
Right you want it to apply to, no we don't want it on the titles so

we want il on all these like we did before
(enters A2- Cl)
[ pounds signs put in front of numbers in A2 - C7]

Insert row
We could have a blanlc line in between because it is quite squashed up isn't it. So if you go to INSERT, just
type I, right
[ Insert Row Column 1
a ROW is that way [horizontal] a COLUMN is that way [vertical] so if we just press ROW,
[ Insert Row(s) starting at 7]
if you go up it will INSERT on top of 2 there so press CR,
[Insert bow many rows? l
just one

[new row insened between rows 1 and 2 I

that's neater, what else can we do

Formula

can we work out a percentage profit? .. I know Jww to do it but you'll have to tell me Jww to do it on
here. What you do is, um does he know Jww to do it? Yes it is 30, profit over the cost price times 100
so we've got 15% .. is that righl?
yes .. yes you can

no if you don't want to .. because then we can compare them - how much profit you're making on each
one. This doesn 't tell you much, you're making the same amount but ..

ok, so get out of the MENU, press UNOO, so you want to divide C3 by A3?

yes and multiply by 100 (moves cursor to D3)
Just type C3 divided by B3.
(does)
well try it can only go wrong .. do you want to see if that works first
can we undo it afterwards?

·

yes we can blank it out. So you have to change it so it doesn't just enter it as TEXT, then press CR.
[result displayed in C3]
Yes it does ..

but that's, yes, 15% so we want to multiply it by .. you know like we did in the first thing where we
made a mistake, we could just do it again (enters instruction, CR)

instruction displayed)
ob, you left it as TEXT, just type it again and then do it
Fl? (retypes, F7. CR)
[result displayed]

Copy formula
yes ... right so you don't have to type that in for all of them, you can just COPY the formula

like we did last time?
yes, so if you go into the MENU. select COPY

1 can't remember how to do this now, go down here, right
yes, you want to COPY AIL of it, RELATIVE
[copied to D4-D8]

Wf:JW!
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Cbange attributes
Now we could put a percentage sign in

so thal's FORMAT again?
it is quite complex because you end up with loads of zeros on the end ATIRIBliTES again
ther~'s something here for decimal point can we change that?
yes, decimal places, because if you type a percentage sign in it knows that you're multiplying by 100 so it
adds zeros on the end

oh right
[ NUM [R 2 -] LCRl[????????] ]
if you just move over and lmd the percentage, if you try and enter percent and then press the SPACE BAR. try
and do it just for 1 and we11 see what happens

(selects "%H)
Just press REIURN.

[ Fonn.at applies to area: D8 ]
Just do it for the last one, in case it goes wrong
[numbet in D8 displayed with "%" and two added zeros]
right it hils multiplied it by 100 ...
so what you bave to do is divide it all by 100, all those figures by 100
like the original thing we had
yes, we didn't need to multiply by 100. So if we divide

shall we go back and do it all now? (moves cursor to D3) C3 divided by 83, and leave it at that
just type D3 divided by 100 and you'll end up with the same thing instead of doing all the calculations again ...
[no • the new format only applied to D8 so far. Even if result may seem the same at the moment, changing the
formula as suggested by co-experimenter is the only "sound", and fast, way to do it]
(follows subject's instructions and changes formula)
Right so if you COPY that for all these

(copies to D3- D7, changes DB separaJely after that DB needs to be centred again, does)
FORMAT again to add the percent sign ...
[could bave done that at the same time as centring entry in D8)
get the percent sign

(toggles"?" to "%", CR)
[ Format applies to area: D8

can I go back up?
yes

(enters "DB:D3", CR)
[Improper coordinate. Bad syntax or out of range]
oh you can't, you can't go back up (somewhat surprised that it doesn't work) press UNDO, so start at the top
[D3- D8 displayed correctly with percent signs]
Save
If you select Q for QUIT and SAVE, just type Q, if you go to OPTIONS - ob - it didn't ask us whether we
wanted to SAVE ...
[not aware tba1 model is always saved when exited and not been saved before]

Subject 18
[empty sp-eadsbeet]
(pointing at screen) We've got the columns going down this way and the rows going across so eacb one like Al
or B2 or B13 or whatever is a cell and the cursor goes where you want it to go and you move the cell by
pressing the cursor keys.

Enter text
So if we have a row of, first of all if we make up about 5 names in column A of the people who are doing the
running, so you move it into the A column
(enters text label in A4)
and then move the CW'S<X' down to the next cell
(enters text labels in A5- AB)
Enter numbers as text
If we do a row along here, in the 3rd row say 100 metres, another 200 metres, another 400 metres up to B3,
sorry yes B3
So, 100 metres?
100m, or whatever
(types "100 metres", CR)
[illegal character]
oh. Is that because of the 1? I think ... it's numerical ... Press UNDO F2,
(does)

[warning beep, edit mode]
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now what do we do? If we just put in hundred- H-U-N-D-E-R-D ... oh no delete all I don't know what
[diagnoses problem correctly as a text/numerical one, but it doesn't occur to her that she could toggle it to text]
-(types "hoodred m")
yes and then CARRIAGE REruRN
(th!s)

[ text label appears in B3]
Right if you go to C3. yes two hundred

(types "two hundred m", CR)
[text label appears in C3, one character too long for colwnn]
ah - never mind If we go to 03 and do four hundred
(enlersfour hundred in D4) That will be even more out ...

Change width
oh yes, you can make the columns wider, if you press the MENU key F8 - It's FORMAT, I think it is,
WIDTH, CARRIAGE RE1URN.
(does)
[ Set width of this column to: ]
I dunno, 15, will that fit it all

(enlers 15)
[How many colunms to this width?]
just press 1 because you just want 1 colwnn
[cursor in column D, points to column C) We should do that one as well. tough that's cut off ... Can we do

them both at the same time?
no, I don't know ... [could do more than one, but it would affect only columns to the right of the cursor; since
cursor is positioned in column D, it would not widen C] - (proceeds)
[D set to width 15]
if you select FORMAT again to do it to the next column, WIDTII again,
[Set width of this column to:]
ye.••. do 15 again

we're still on the same column [D] Can I move the cursor? (tries)
[warning beep]
[cursor needs to be positioned before MENU, FORMAT, WIDTII is selected - user needs to know 4 steps
ahead of this one. Other FORMAT options allow to
define the "area to which selection
applies" inconsistency]
we're on that one, oh no, if you just press CARRIAGE RETURN (doing column D again)
if you move the cursor now [cannot move cursor while MENU is displayed] oh no get out of the MENU, press
UNDO, move the cursor to C3 then press the MENU, select F and then CARRIAGE REl1JRN and WIDTII,
15, 1.
[width of column C cbanged to 15]

Enter numbers
Right, if you just put some random figures in

(enters numbers in B4- D8)
If we do a column here [E] to fmd out, bow many races each of the people have run, if we put the cursor up in
FA, no E3, and then do say number of races

(moves cursor and enters text label)
right and then, I've forgotten how to do this, ob you have to count ... you have to .. so ..

(moves cursor about)
Formula
there is a formula you can do, I think you have to toggle it to numerical but I've forgotten how to do it, I
think it's F7 and then you have to ..

(tries F7)
[warning beep}
{since nothing to toggle at cursor position FA]
ob how do you do it? Formula. so if you put in COUNT, that's obviously .. no what is it .. COUNT then open
bracket, so you want to cooot from B4 to D4
it doesn't matter that there's nothing in D4?
no, I don't think [correct] colon, FA close bracket

(enters formula)
and then F7 because at the moment it's in text, just letter, then to make it numbers, then RETURN
[ result displayed in E4 1

Copy rormula
I think, I've forgotten .. right, there's a way of doing it for all of those and I've forgotten how you do it .. oh
COPY that's right so press MENU, F8 and then COPY
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(selects COPY from menu)
[ Copy from area: )
right so you want to copy from area no you want to COPY from E5 to E8 if you put in E5 ...
(starts typing)
no, no- sorry, so if you put in FA, because you're copying the formula from that
[ Copy to base coordinate: ]
then you want to copy it from there to there so it will be E5 to E8
(enlers)
and CARRIAGE RETURN
[ Copy values all ]
dunno ... ALL I think it is, I think it's ALL
what's the difference
(laughs) I don't know
let's try ALL (selects ALL)
[ Copy Relative Absolute Prompted ]
and then RELATIVE I think
[copied to E5 - E8] is that right, yes it's right
it would be dij]icull to tell [since the result is- correctly- 2.00 in all cases) so what does that RELATNE
mean
I suppose it means - what was it RELATIVE or ABSOLUTE, we did RELATIVE, urn, I've forgotten what that
means, sorry
doesn't matter, seems to have worked

Formula
And then if you want to say fmd the average of all the different times ...
If you move the cursor back to say A 10 then put in there say, AVERAGE,
(enters text label in AlO)
right if you move it into B 10 and then select the MENU F8 (reads MENU) oh no, hang on, what am I doing oh no don't bother with that press F2, if you put in MEAN, open bracket, what do we want to do, mean B4 to
B8, CARRIAGE RETIJRN
(does)

[formula displayed in B10]
ob no sorry I meant to do F7, because we want it on NUMERICAL so can you type that in again
IS there any way to get it to do that itself?
Don't know ... probably [there is- select EDIT and toggle it] (retypes)
And then press F7 so that it's NUMERICAL
(does, CR)
[result displayed in B10]

Copy formula
then if you want to say COPY it for all of those, do the same again, F8 to get the MENU to COPY the
formula into these two [CIO and 010] you select COPY, COPY from BlO, you can either do it just by typing
in ClO or move the cursor, that's it ClO and then press the colon and then move it along to DIO and then
CARRIAGE RE11JRN
ALL?
yes, all again, RELATIVE
[copied to CIO and DlO]
Change attributes
Can we get rid of these decimals [in column E)
yes you can do it, I don't know, just type it in 2, 2, 2 [that's what co-experimenter did - default is with 2
decimals]
but there's a way of doing it I can't remember bow to do it now, ob what was it, was it FORMAT, try

FORMAT,
(selects FORMAT)
I don't think this is right, but A1TR.IBUTES, try ATTRIBtJfES, don't know what I'm doing ...
(selects ATTRIBUTES)
[ NUM [R 2 -1 LCR1[????????1 l
Oh yes ...
What are those question marts?
they're to do with ... if we move the SPACE BAR
(presses SPACE BAR once)
[ "R" over flrst "?"changes to "C"- from rightjustifled to centre]
I just can't remember that, sorry
What's under the 2?
under the 2, I've forgotten bow to do that bit
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(moves cursor under "2", toggles)
I don't know what that means ...
Shall we just forget that than and do something else?

Filler character
Press UNDO, if you wanted to divide it up, like a graph, you could do INSERT a line or, if you wanted to
INSERT a line if you press F for FORMAT, yes select FORMAT, I think it's FILLER,
(selects FORMAT, FIUER_CHAR)
[ Set filler to: ]
bang on, what am I doing? oh I know what I should have done

undo?
YesUNOO
(presses F2)

Insert row
If you move it up to A4, if you wanted to INSERT a line there, I've forgotten, ob yes, it if you want to
INSERT a line it does it above the cell or the cursor, so get the MENU, select INSERT, then you want to
INSERT a ROW, so it's on that one yes, bow many rows, 1 row, yes, right,
[row insetted between 3 and 4)
say you wanted to do a line along there to underline it, you select FORMAT now and :ALLER_CHARACIER
and then SEf TilE FilLER TO, you can use any character, you can use an asterisk or whatever, to do a line,
(selects"-")
if you just wanted to do a line, format which area, A4 and you want to go to E4 so press colon then E4
[line of filler characters inserted]

Save
shall we save it
Yes, select QUIT/SAVE I think
(does)
[Quit and Save: Options Context Save_Backup Save_New_Model ]
Is it SAVE BACKUP or SAVE NEW MODEL? SAVE NEW MODEL I think,
(selects) thal makes sense ...
[ Save to what model: ]
save to whal model?
ob, sport ...
(enters "sport", CR)
[ Ftle B:Sport.FMD already exists J
[selected option to save a copy to other than current filename]
ob well ...

urdJ?
UNOO, shall we put a different name in race, sportl
(saves copy as "sportl ")
[returns to spreadsheet}
[bemused that model is still there, but doesn't seem to realise that they have saved the same model to a different
name, but not saved it under it's original name] -bow do you get out?
(thinks)
QUff and SAVE again?
[Quit and Save: Options Context Save_Backup Save_New_Model]
OPTIONS - and then go out into the operating system

Subject 19
[empty spreadsheet)
You could select a list of 5 items which you buy daily, like milk, bread and the price of each of them, bow much
you spent oo each of them each day.

Enter text, enter numbers
So if you just printed in bread, there, if that's what you buy,
(starts typing)
if you print it down there [input line] and then press RE11JRN, and in order to do something else, in order to
do your second item you press that [CURSOR KEY] and the, I can't remember what it's called, this thing tbe
pink thing [cursor] down and ok so margarine or whatever
(proceeds to enter text labels inAJ-A5, numbers in Bl-D5)
How can I change that? [entryl
Well the way I would change it would be like this (presses SPACE BAR, CR), so it would be clear again, tben
print in what you want, but I think there is another way of doing it.
[doesn't have to clear cell ftrst, couldjustoverwrite]
Now we go to the MENU which is that one (F8) OK now because we want to change the FORMAT so I think
we make this little blue thing go to there and you do lhat by pressing this button. OK, now press RETIJRN.
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[Format Width At~butes Ftller_char Data_type]
(reads _MENU opttons) OK - perhaps, could we go back to MENU again, press F8, I think
[ wammg beep)
ob press RETURN
[ Set width of this column to: )
[selected ftrSt option by pressing CR]
ob bow do we get out of this, press UNOO then we'll get out of it sorry.

Insert row
I don't think that is a very good idea, I think we should choose INSERT instead.
[ Insert Row Column ]
Better go, yes we want an extra ROW, or two
[Insert row(s) starting at: 5]
where do we want our row? At 1, press 1 and so press REfURN
[How many rows/columns: 11
we just want one row so press RE1URN
[new row inserted above row 1]
so you've got an extra little row there, I mean we could put an extra one in there if you want and so we have
extra space. So we've got items and then a space. do you see wbat I'm saying? So you do tbat again on your
own

(inserts another row and adds text labels)
Change attributes
Do you want to move the noughts, I think the noughts are looking a litUe distracting, so if you get back to tbe
MENU again, and (mumbles) bit of a tricky one, can't really remember this - I think go to FORMAT
[Format Width Attributes Filler_cbar Data_type]
and we go to FILLER_CHAR
[ Set filler to: ]
no we don't. we don't do that
shall I press UNDO?
We go to FORMAT again, ATIRIBUI'ES, try that.
(selects FORMAT, ATTRIBUTES)
( NUM [R 2 -] LCRl [????????] ]
yes that's it. we want to get the noughts out, can you press that
(moves cursor onto second"?")
no don't want that
(moves along)
yes it's that one, yes that one. press, we want that because you see it's got a litUe nought there, press F7
because we don't want(F7) [confuses toggling ofTEXT/NUM (F7) with toggling "?" (SPACE BAR))
[nothing happens]
yes we want that one, did you see the litUe zeros come up then, press that one and RE1URN.
[ Format applies to area: D 11
FORMAT APPLIES TO B3, I think, B3, just put B3 . We'll try B3 to D - you have to do that SHIFf colon
sorry, 06, hopefully that will work
Shall we do it column by column? There is a way actually ...
No, let's try to do it all at once. (enters B3:B6}

RETIJRN.
[entries B3:B6 without decimal places, but not B7 and C7]
Yes, we've got that.

It's missed out the carrot ...
I don't know why it's done that· oh because it's- we'll bave to do those two separately.
Perhaps you should have done D7?
yes, that's it
(does B7:C7)
Can we work out how much we've spent on bread?
Formula
OK. So if you print in COUNT, just a minute, move the cursor so, well I think perhaps there would be better
(moves cursor to E3)
then print in COUNT, then you need brackets so gosh B3 colon to 03, bracket

(types "coulll(b3:d3)")
then we have to, at the moment we're in 1EXT you see, so we've got to move into its kind of NUMERICAL
thing and that is F4 and you see the NUMERICAL thing has changed.
(hasn't changed]
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I think_ if you do that. press RETIJRN, it might come up, no it doesn't, 1 don't know what I've done wrong.
(expenmenter tells her its F7 to toggle, and the formula is SUM)
SUM, it's SUM - so if you print in SUM and then brackets
OK so it's the same, ... (types "SUM(B3:D3)")

Then you have to press the calculation key again
(F7, CR)
(result displayed in E3]
(instructs co-experimenter to enter formula for other rows)
Copy formula
Can't we copy thLJJ?
Yes, OK so do you want to do the same for all four? OK we'll try copying the formula. Press MENU. Then
go to COPY.
[ Copy from area: E5]

From area - B6
[ Copy to base c<XX"dinate: E5]
copy to?

07
D7?

[does not realise sbe only has to copy the formula]
I don't know, I think, I can't remember. We11 try this and then if it goes wrong we do it the other way
["45" appears in E5]
All. Hasn't done anything has it?
No it's put 45 there [E5] That was blank wasn't it, it difin'r have any characters did it

No, right-o. Press COPY again, oh we'll have to try and delete that flfst.
(experimenter intervenes and tells her bow to copy)
OK goi.O COPY
[ Copy from area: ]
from area, well we're copying the _formula_ aren't we so I think I'll have to try actually copying the formula
which we used for that
(still cannot get the defmed what needs copied where to - experimenter gives stop-by-step instruction)
[formula copied]
Do the MEAN for Monday [B column] We'll have the mean down here, so print in MEAN, OK
(enter "mean" as text label inA9)
then print in MEAN again then bracket, B3 to B7,
colon? (types "meanB3:B7")

Yes, bracket. then press F7, RETIJRN,
[result appears in A9, overwriting previous text entry]
right well we've printed it in the wrong place ...
Save
We want to get down to QUIT and SAVE, OK, press RE1URN,
[Quit and Save: Options Context Save_Backup Save_New_Model]
I'd go to SAVE_BACKUP, REltJRN, OK press RETIJRN.
[returns to spreadsheet]
Press RETURN.
(Quit and Save: Options Context Save_Backup Save_New_Model 1
It's gone back again hasn't it. Well we'll go to OPTIONS, we've already saved it. We want to get out to the
system so try OPERATING SYSTEM. OK That's it.

Subject 20
I have to tell you what a spreadsheet is, well you can do graphs and that sort of thing. 1ust, and then you can
change the information easily because it's a computer[empty spreadsbeetj
If we're doing a shop - if we put the items down the side, and then we can put tbe number items along Enter text, enter numbers
So, to enter the items across the top you got the higblighter [cursor] on Al so that's where it will enter to start
with. So you just write 'tea' and it will come up there
(types "tea")
if you leave a few lines at the top then you can put beadings, so get the highligbter [cursor] down by pressing
the arrows.
(moves cursor to A4)

right, now RETURN (does)
[entry in Al]

ob - (laughs) Never mind leave it now we can get these lines later.
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[entry are entered at cursor position at the time of first keystroke)
(instructs co-experimenter to enter text labels)
(overwrites entry in A3)
Where did the last one go to? oh yes we forgot to move the cursor down so it went on top. Right so move the
cursor down again from now on (instructs co-experimenter to enter text labels in A2-A5, and number in B 1-C5)

Insert row

If we just leave it at that and then try and get rid of the noughts and put some things on top, right? So you
need the MENU, which is F8, right to get rid of the noughts - ob I can't remember that one, we'll get another
line in here first so it is FORMAT - no, INSERT, so you can either press along with that or you can press I
so just press I - whichever is quicker.

(selects INSERT)
[ Insert Row Column 1
We just want a couple of ROWS
[Insert row(s) starting at: 5]
starting at - no, so we've got to move the cursor to where we want to start it so, yes fine and
[How many rows/columns: 1]
ob how many rows, 3, in that case, yes now change it to 3 and then RETURN.
[3lines inserted oo top]
Right now - (instructs co-experimenter to enter text labels B2-02)
You've got to change it because you've got to take the MENU away by doing UNIX> and then move the cursor
along.

Change attributes
I see if I can remember how to get rid of the noughts, so if we went back to the MENU and then it was
FORMAT so either For just move along

(selects FORMAT)
[Format Width Attributes Filler_char Oata_type]
ATI'RIBl.ITES, yes,
[ NUM [R 2 -] LCR 1 [????????] ]
now you can move this along with the SPACE BAR- (presses SPACE BAR a few times, toggles ftrSt "?") ob
no SPACE BAR changes each one in the - well you can move that into the CENTRE of the column, so this is
for where it is in the column, LEFT, and CENTRE, yes. (toggles first "?" to "C") You move it along here
with the (ARRROW KEYS] yes I think it's that one, if you try the SPACE BAR again to get to the nought.
carry on, get back to nought

(toggles decimals "?"to ")")
I think that will work. So we're going to have it in the CENTRE and nought. so if you press REfURN
[ Format applies to area: C2]
and it applies from there so you want to move the cursor back to [B4} and in order to say FROM an area TO
another area you need a colon and you want it to apply to there, well to the end of this section [C8] and
RETURN.
[numbers in ~8 centred and without decimal places]
That's a relief! (instructs co-experimenter to enter another set of numbers and text label in 02)
Formula
To calculate it - if you write MEAN here. then you do a bracket. from the area, hang on - yes from the area you
want to do it to so B2, no B4, yeah to wherever it is, D4 and close brackel

(types "meQil/J4:D4" at cursor position D2)

·

Urn then you've got to change this because at the moment it's on TEXT because it takes it from the ftrSt letter,
you have to change it so it's doing calculating and you do that with this, F7 which will change this,

(presses F7)
[entry at input line toggled to NUM, cursor remains on 02]
(looking at 0 column, expecting something to appear) Ob I thought it would - (looking at input line) yes it bas
done. changed it to NUMERICAL (points to input line) and if you move the cursor down to the right place

(moves cursor to D4)
and press RE1URN it will calculate the average- hopefully.
(CR)
[result appears in 02. overwriting previous entry]
Ob-

it's gone back to where it was before ...
Yes, I don't know why, that was there [on 04]

before I pressed RETURN, yes.
Let's try putting it there first or something

(moves cursor to D4)
now do the same again, MEAN and open bracket and then change it to NUMERICAL and then try pressing

RETIJRN
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[result displayed in 04]
Copy formula
Good! (instruct co-experimenter to replace text entry in 02) Then we want to do the same for all of them. So
you want to COPY it into all of these [05-08] relatively according to what is !here so that we've got lbe
average for all of them. So we need the MENU again, MENU key. So there is one to COPY. yes.
[Copy from area; 02]
FROM AREA - we want to COPY from this area so move down the cursor
(moves to D4J
and then RE1URN key
[ Copy to base coordinate: 02]
TO - and we want to COPY it from the:re to there E5 and to, with a colon, E8. Just cursor to it. then

RE11JRN.
[ Copy Values All ]
Yes we want to COPY ALL. so move to ALL
[Copy Relative Absolute Prompted]
then RELATIVE you want to do it RELATIVE because obviously it's different numbers in each. Right and it's
done it. good.
Save
Right if we swii.Cb it off and SAVE it so to QUIT/SAVE is what we want Just do Q.
[Quit and Save: Options Context Save_Backup Save_New_Model]
And OPTIONS
(does)

[applications menu)
Oh dear- has that saved it? [was expecting choice WITH SAVlNG/ WITHOtiT SAVING] so if you go down to
OPERATING SYSTEM.
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Spreadsheet Comparison Group
Comparison-Subject 1
[empty spreadsheet]
Right this is the spreadsheet, it's like an array of rows and columns. so you fill each row or column with
either TEXT or a NUMBER or a FORMULA
just like a table
yes it's just a table, but computerised, so if you'd got a sheet of paper which had got rows and columns marked
on it then just flll in the beadings or the numbers so instead of having to work out manually what the totals at
the bottom of the columns are you can get the computer to do it for you, you just fill it in the way you would
a piece of paper, so say you wanted 10 work out hours in a day, say you were doing three projects and you've
got five days in a week. so if you type column A a day beading, so if you type in day
Enter te:xt
so just type in day?
that's TEXT, you see it's got text down there so if you hit RETIJRN and just insert that, that will be the
column that starts the days of the week. you can then change 10 a different cell by using the cursor keys again,
so to get to the next cell along you select the right key
this one?
yes, you get to column B, you can get round the whole table like that, you can have quit a lot of tables like a
few hundred rows by a few hundred columns
so it goes further than this
yes it goes right along, you can scroll A to Z then it goes AA AB AC AD and carries on. haven't got to the
end yet, so if this is a worked on project A, say type in the project A ...
(types)
when you type something down there [input line] it displays it there, space, hit REIURN. If you cocked it up
you can either type it back in again or you can use the menu and edit it, you now want to fill in the column
for Project B so you can go along instructs to enter text labels in Al:Dl, and A2:A6)
Enter numbers
You can put the numbers in later on, at the bouom say you want to total up what you've done for each project
for the whole of the week, leave blank line, go down twice, then put total
(enters "total" in AB)
Formula
now if you go across one, you can make it automatically, once you've typed some numbers in, add up all the
figures that will be in this column here [B) and that one and that one there so you want to do that there's a
command called SUM.
You type in SUM, type in open bracket to say you're giving it a list of coordinates now you want a list from
B2 to B6, you reference by column frrst then row, for a specific cell so you want it from B2 so to say its a list
rather than just one cell you put a colon, then B6, the bouom of the row, now close the bracket, now so far it
thinks that's TEXT (points to indicator left of input line) so to make it realise you have to change it to a
NUMBER, so if you bit F7, it is in fact change key so if you press that it will switch that to a NUMBER
formula.
(F7)

See it's changed from TEXT to NUMBER there
what would happen if it was in TEXT?
if it was in TEXT it would just sort of print that on the screen there, like it printed Friday, Thursday, that lot
If you bit RE1URN now it will come up with question mark-n-question mark because it's saying there is
nothing there so it can't print anything out at the momenl
[ "?n?")
Now if you go along you can do SUM for C2 to C6 Copy formula
ob you can COPY the formula across, if you press the MENU key F8, it will give you a list of different
options you can use down here, what you want to do is COPY what's in this [B8] the formula in this, so if
you hit C you can COPY
(selects COPY)
(Copy from area: B8) so input from, you're in area B8 so you want to COPY what's in that area. so
you bit RETURN there,
[Copy 10 base coordinate: B8]
10 C8, 08, so if you do that C8, colon, if you want to COPY it to more than one, 08 hit RETIJRN again it
will give you a now a set of lists
[unclear whether this refers to list of base coordinates the forthcoming options)
[Copy Values All)
you want to do ALL of them, do everything in that, so you want ALL, just move the arrow and hit RETIJRN,
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[Copy Relative Absolute Prompted ]
you want to do it RELATIVE because what that means is it will change those values from B2 to B6 when it
copies it to C it will do C2 to C6, in D it will do D2 to D6, so you want it RELATIVE so you hit RETIJRN
now, if you had it ABSOUITE it would put the same value you'd got there, B2 to B6 again

can I check thaJ I've got it righl?
yes, if you move along and gel the MENU which is F2, if you move along with cursor til you get to the
square, if you want to start filling in the numbers (instructs co-experimenter to enter numbers in B2-B6)
Recalculate
so far the total is stiJj blank, if you go down to the total at the bouom, go to the MENU, press F8, there is an
option called RECALC which will recalculate so if you hit R [Recalculate equations over area: B8]
CALCULATE EQUATION OVER AREA B8 which is that one which is what you want to do, so hit
RETIJRN,
[result displayed]
you've worked 14 and a half hours

(starts to enler numbers C2-C6) Besides SUM, whaJ other things can we do?
you can use anything - multiplication, addition, there are a few specialised ones like sine, cosine and arctan but
anything you can do with a matbs equation you can do with that. you can fill up the whole line [input line]
using brackets and plus and minus [means formulae can be as long and complicated as you like?]
you can make your own equations up

so if I go down again and recalculate, so that's right isn't it (performs RECALC on CB) (enters numbers in
D2-D6) (performs RECALC on DB)

Formula
say you're in business and you're charging money for working on certain projects, 2.50 for A, three quid and
four quid on that one, if you put another row down the bottom say on row 10, call it cost

(enters text label in AIO)
it's 1EXT so it bas come up as cost, if you now move along to B, you want to enter a formula here so you
could do, that is area B8 so you want it to apply to B8 then you want multiply, and the symbol for
multiplication is the asterisk so if you put asterisk, shift?, and it's 2.50 an hour so you multiply by 2.5

(types "88*2.50")
hit RETURN
[formula printed in BlO]
oops - we didn't change it from TEXT, so we made a mistake, you have to change it to NUMBER format, so
if you hit the MENU, there's a thing called edit, if you hit E. now if you want to EDIT change it from TXT,
must be F7
(F7)
[entry toggled to NUM]
so if you hit RETURN now, as the figures already there that has entered the result automatically, now you
want to COPY that formula across (instruCts co-experimenter to enter same formula with different multipliers in
ClOandDlO)

Change Attributes
Now that looks a bit messy, it's all down the right hand side, you can actually FORMAT it so it's justified into
the middle, under the middle of each heading, so if you go up to this one bere, then hit MENU, there's a
command called FORMAT which will adjust the format of each sort of block, F for FORMAT, and bit

REIURN
[Format Width Attributes Filler_char Data_type]
you want to change the AlfRIBliTES of the cell so move along to ATIRJBUTES, hit RETURN
[ NUM [R 2 -] LCR 1[????????] ]
you want to change that from being RIGHT justified, which is what the R stands for to CEN1ER. which is the
C so if you F7 is the change key, [toggles with F7 instead of SPACE BAR]
so if you F7 it goes L, C, leave it, now so hit RETURN
[Format applies to area: B2]

these are all the way across?
not yet, just that one at the moment

(CR)
[entry in B2 centred]
it's only done it for this one [B2] so what you want to do is COPY that format to the whole area here,
so if you go back into FORMAT again, bit RETIJRN again, back to ATTRIBU1ES, that's bow you want it
set up [since cursor is on B2] so hit RETIJRN it will say using ATTRIBU1ES from what entry
[Format Attributes using attributes from what entry: B2]
[default when CR without changing any attributes]
so you bit RETURN again and COPY it from area B2 down to area DIO so if you put colon, DlO bit
RE1URN now it will COPY that format to the whole of the table, so it's nicely CENTRED up
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[ditto]

(instructs co-experimenter to enter text label in El) You want to SUM from B2to 02
(enters formultl in E2)
it's got to be a NUMBER so if you change it
(Fl)

now hit RETIJRN and let's find out see as we didn't COPY the FORMAT down to that column, it didn't, so
we can change it later on.
Copy formula
Now we want to COPY that FORMULA relative for each row down to the bottom there, so it's back to the
MENU, COPY, just C
[Copy from area: E2)
that's it, that area there
[Copy to base coordinate: E2)
The quick way of doing it is if you move down to the next cell it changes it there you want to COPY to tbal
cell down to tha1 so put a colon now move down to the cell you want to COPY the formula to

(nwves cursor to EJO)
so you want to COPY it to that cell first (E3] if you COPY it down to that one [E6] it will give you loads of
silly equations because there's nothing in that row [7 and 9) we'll do it bit by bit, if you bit RETI.JRN now
[ Copy Values All 1
go to ALL,
[ Copy Relative Absolute Prompted 1
well do it all RELATIVE, we want to change all those figures for each row
now you want to COPY that equation again (instructs co-experimenter to copy to E7 and E9, and centre the
number in E)
Save
to SAVE it you've got an option called QUIT/SAVE so if you go down to that
[Quit and Save: Model_Selectioo_Meou Options Context Save_Backup Save_New_Model]
you want to go for MODEL_SELECTION on that menu, so hit RETURN again, and it will SAVE it, as it's
your ftrSt one [means ftrSt time exited?)

Comparison-Subject 2
(selects existing spreadsheet ftrSt)
Now the spreadsheet bas come up. The spreadsheet is a way to show up formulas and such you can put your
numbers in, it's like having a formula built in for you, you can put your NUMBERS in along with TEXT it
will come up in this sort of format, a page of TEXT it will come up like that and you can put your NUMBERS
in, formulas within these spaces,
Enter tex~ enter numbers
it's all arranged in blocks if you go around like this, (demonstrates use of cursor keys) so in each block you
can either put a NUMBER or formula or TEXT, so when you do a spreadsheet you put your basic numbers in,
your base ones, it will work out all the formulas and come out with results, yeah?
so now if you look as you go around here, if you look at the bottom it prints in that box [next to input line]
TXT stands for TEXT so it's just printing TEXT which is Thursday. as it says down there if we go across to
there, which is 3, it says there NUM wbicb is NUMBER and it's got 3 which is a number and that's 3 and all
those numbers ...

so can I have a go at trying to set one up?
[empty spreadsheet]

you could do something like pupils in a class, they'd have different exams, say 5 exams, they all get marked
out of 100, so 5 pupils get 5 results
with the cursor keys you can move around the screen, you can move the block around

so I've got to think ofputting in a table-type form
yes, it's best to have the courses across the top and the pupils down the left hand side

(types "course a") so if I hit RETURNthat will go there [B 1]
righll want to put "course b"
you want to move the cursor ftrSt, move the block to the next one

right (types "course bH in Cl, student~UUT~es in A2-A5)
now you've got the names in, so within the spaces here you can put the results in

so if I just put a number in (types number) thaJ's different there isn't it?

yes, now if you start off the input with a number it automatically assumes you've got a number, another thing
about it, there's a button, that button there [F7] change, it will vary it from NUMBER to TEXT
right, I want it as a number (enters number in B2-C5). Now I've got things in, nownow it depends what you want to do to them, if you want to add them up for eacb person, their totals for the
two courses, fmd the averages or something

well, like the average mark for the course tluu would be quite useful wouldn't it?
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Formula
for average marks you want to sum the whole marks for the course, so you want to go below if you put total
there

so total, can I work out the average
yes you can, so it depends if you want

so ca.ll it average (enters text label in A7) RighJ so lww do I do this then?
Rigbt if you come along to be underneath [B7] now you want to do the fonnula for it, now what you want to do
flrst is add all the numbers up and divide by four, the number of students, to give the average. Now the way to
add all the numbers up is SUM, open brackets, now you have to look where the column are that's B (points to
screen) and it's B2, B3, B4 and B5, so you put B2, the colon, B5 and what that represents [SUM(B2:B5)] close
the bracket, the sum of colwnns B2 to B5 so it adds all those up, now you want to divide by 4,
[does not seem to know there is a formula for average] press RETURN[formula SUM(B2:B5)/4 printed in B71
now you see that's gone in there now so that's showing you that
so how dlJ I get the number
Toggle display
to get the number you want to go to MENU again, that [F8] comes up with the MENU, you want the
WlNDOW option so if you press W, V, the way you do it is go into the MENU W, V for VIEW, now
RETURN [Equations] [thinks it's printing the formula because it's in other mode]
[still formula in B7]
It's done the wrong one, (presses some key), now try it again, press MENU again, W, V, RE1URN maybe
it's on the, printed that again - I don't know
(Experimenter points out there is something wrong with formula)
Oh yes I see what it is, right mistake there, get out of that MENU, the fonnula you've put in, it thinks it's
TEXT, so if you type it in again, because you put an S in first it automatically assumes it's TEXT, so what
you need to do is put the SUM in and change, put it in again [instead of editing it] -(does)
Now the change key which is that one [F7] that will tum it into a NUMBER

now hit RETURN?
[formula displayed, since it's currently in that VIEW mode]
yes, that's done it - it doesn't show everything in the formula but now you can toggle it
you can toggle it again, so MENU, W, V, RETIJRN,
[result printed in B7]
now it's come up with a number
right, I'm assuming that's right, now if I want to do that for this one here, do I have to do it all again or
can I copy it?
Copy formula
You can COPY it- as there's only one you could do it again, but use the COPY anyway, press c for COPY
[Copy from area: B7]
now it asks you what AREA you want to COPY FROM -it states B7 because the cursor's on B7 and that's
what you want to COPY from anyway just press REfURN there
[Copy to base coordinate: B7]
now it says the base co-ordinate, where does it want to COPY to, which is COPY all to C7, so if you delete
B7 and put C7 in, press RE1URN
[Copy Values All 1
now it's asking whether you want just VALUES copied or ALL copied and you want ALL so press A
[ Copy Relative Absolute Prompted )
that's, I always use RELATIVE for the time being when you're messing around with formula, the
ABSOLU1E it would copy the exact fonnula across the relative what it would do now is "Bs" to "Cs" so just
press RETURN

right so, now it doesn't look very tidy, what can I do about that? I mean it's all, it's not undernealh il is it
Change Atributes
that's the TEXT - you could take the TEXT and try and put spaces in front of the TEXT for course
[pretty messy solution]

you can't put it in the middle, so these come down the middle? because that would look better wouldn't it
if you can I don't know (Experimenter tells him bow to do it)
is it FORMAT? Rigbt.
There's an f for FORMAT, now something which ought to be, could be
ATI'RIBUI'ES, so type A.
[ NUM [R 2 -] LCRl[????????] 1
I haven't seen this before, I don't know what it is Is it in here, in the attributes?
So there's an R there which means it's all RIGHT justified, so if you want to change that to C you've got
choices there of L, C or R so change that to a C and it will make it in the CENTRE
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it gives you an option of what you can press there so try change, now it 's come up with the L which will
make it left justifi1'.d
so !want C
C for CENTRED, yes
thal's it is it I don't hit RE7VRN or anything?
try it I think it's alright
[ Foonat applies to area: B7 ]
now it's CENTERING, do you want it to centre everything or just the numbers?
well/ think the names are Ok but not the numbers
both those columns completely. Right so you want the centre from Blto Cl. don't you so if you delete B7
and put B1, delete B7 again and put Cl. What that's doing it's specifying those two from there, yes? so it's
going to change all those if you press RETIJRN.
[text entries in B1 and C1 centred]
It didn't do il
il moved those [Bland Cl]
ob of course we specified those two [B 1 and C1] 1 was assuming it would give you another co-ordinate as well,
so if you do it again,
back to FORMAT? it was AITRJBUTES wasn't it,
now if you cbange that. yes press RETIJRN
[ Foonat applies to area: B7 ]
so 1 wanr to you want to put tbe area of text in and you dOn't want to change the flfst two [B 1 and Cl] so you might as well
just do tbe numbers so that's B2
B2, now I want to go down to here, can 1put area C7
yes if you put colon C7, press RE11.JRN,
now it's changed everything
Save
To come out of this you want QUIT which also SAYES, so if you use Q to come out for QUIT,
[Quit and Save: Model_Selection_Menu Options Context Save_Backup Save_New_Model ]
and it gives you options you want that option because the rest are something else, that will take you back to
the OPTIONS, so press RETURN, it should automatically bave saved it.

Comparjson-Subject 3
[empty speadsbeet]
Now this is the spreadsheet you've got numbered rows and each letter represents a column. You can use the
cursor keys to move around like that, and you can move all the way across and it goes onto new ones.
(demonstrates) There's quite a few of those. That position, it's B2 it is classed as because it's B there and 2
there and that pink strip is called a cell.
This is tbe input line (points) so whatever you want to go in that cell you type it on that line first and then
you press RE11JRN and it will go into that cell so you can type in TEXT or you can type in NUMBERS or
you can type in FORMULAS to manipulate numbers.
Enter text, enter numbers
Government expendiwre on something so we want to do some beadings flfst so move into that column there
[A1] we need a beading for the countries, so type in "country" farst.
(does)

It's come up oo the input line which is right and the TXT means it's TEXT and the L shows it's left justifJed
which is alright so you press REnJRN and it will come up on there
[entry printed in All if you move it across to there [B l] you can type something else now.
(types ''defense H) How do you spell it?
Now press REnJRN again.
(enters heading in CJ, starts typing)
you have to move it aaoss farst
(moves cursor 10 Dl, finishes typing. CR)
[entry printed in C1, overwriting previous entry)
Don't know what happened there- never mind ... [entry goes where cursor was when farst char was typed] you'll
have to type it again
so if 1 type it again (does, enters heading in Dl, enrers names of countries in A3-A5, and numbers in B3-

D5)
perhaps you'd like to add a few together to get the totals there for each country?
yes so you want to put a title there saying total
(enrers label in El)
move down to the next few lines there [E3] that's it, then do a total
do I have to add them up myself?
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Formula
No you can type in formulas to add up all these rows and columns, so if you wanted 10 add all this again you'd
type B3 plus C3 plus D3, and rhen that would add all those up and put it in there type B3 plus C3 plus 03 but
don't press RETURN yet because you typed B flrst it considers it TEXT, formulas have to be entered as
NUMBERS, you have to change it to NUMBER so if you press F7 that's the change key and that will change
it to a NUMBER, so you can then press RETIJRN, it comes up
[result printed in E3]
now it's come up, it's added tbem up
so if I want to do it for France now do I do exactly the same again?
Copy formula
well you can do that, but you can COPY the whole formula so it will change the numbers in the columns for
you, so if you press tbe MENU button which is F8, press C for COPY,
[Copy from area: E3]
you want to go FROM AREA E3 'cos it contains that formula. so you just press RETIJRN
[Copy to base coocdinate: E3]
and you want to COPY it into FA, then E5, if you type E4,
(OOes)
that's the start of the area you want to copy to and if you press colon and now type E5 that means copy the
formula from E3 into E4 and E5, it does E3 through 10 E5
but I don't want the same formula. do I?
wbat COPY will do, it will change it, whereas that was B3 plus C3 pus 03, it now changes the 3 to a 4 for
thalline and the 3 to a 5 for tbat line, so it will work properly.
[Copy Values All]
You want to copy everything, you don't just want to COPY VALUES, just use ALL
[ Copy Relative Absolute Prompted ]
and we want it RELATIVE
whlll does il do if it's relative?
I'm not sure, it must COPY RELATIVE to a base address, actually so that's the way it converts the nwnbers

it won't do 83 plus C3 plus D3
no it will do B4 plus C4 plus D4 and then the fifth line it will do B5 plus C5 plus 05. [does not know or use
SUM]- (CR)
[ results printed in A4 and A5]
Save
There it's added tbem all up now. It's probably best to back it up onto disk now, so you want QUIT/SAVE, just
typeQ.
[Quit and Save: Model_Selection_Menu Options Context Save_Backup Save_New_Model]
You get the SAVE MENU up, you want to move onto SAVE_BACKUP, then if you press RETIJRN tbat
will save it to tbe disk and that will make sure that if you do somelhing wrong it will be saved on disk and
you'll get it back.

so I've defmitely got what I've done so far
yes.

so, I've done the total up there, can I do something on the bottom as well?
yes, first you bave to press UNOO, that will get you out of this MENU and then you press the arrow
Formula
so wluU if I want to find out the average, I want the average they each sperui
wbat do you mean by that, add them alliOgether and divide by

yes could I do that, is there a .{unction to do thai?
don't know whether there is a function - you could add them all together and then divide by however many
countries there are, you could do that if you want
(enters texJ label in Al) so we want to add together B these {83-85 ], then divide?
yes so you add together B 3 plus B4 plus B5
(types in "b3+b4+b5")
then you bave to use the divide, the divide is higher priority than ampersand (sic) so flrst of all it would do B5
divide by the number of countries and then it would add onto the figure you've got B3 plus B4

so I don't want to do that
so if you delete tbat and put brackets round that., so type bracket, then type B3, plus 84, then close bracket
then divide by three wbich is the number of countries.

you don't have to change that thing?
because it's a bracket [as the first char] it now thinks it's a number so you don't have to change it so you can
just type RETURN
[does not know or use MEAN] [result printed in B7]

so now if I want to do the same again I can just copy it over?
(instructs co-experimenter to copy 10 B7-E7)
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Change attributes

now it doesn't look very good it's not too clear the way it's set up so
that's right. . It's pro~ably best to move these [text labels B l-EI] so they start at the end so if you the country's
probably alright so If you move onto defense, (still have menu up). you're still on there so if you press undo
frrst and now move onto [Bl] if you select the MENU again there's an option on there called FORMAT,
choose that,
(Format Width Atttibutes Filler_char Data_type]
you want to FORMAT the ATIRIBlTfES which are various things about each cell, so press RE1URN
[ NUM [R 2 -] LCRI[????????] ]
now this flfSt one is the one you want, to justify it and we've currently got it LEFf justified which is shown
there and you really wmt it to be RIGJIT justified so if you press the change key (F7] F7, until you get the big
R there, that's it, now press RETIJRN
[ Fonnat applies to area: B 1]
this js the area it applies to, you want it to apply to B 1 through to El

colon?
yes type El

why is that coming up why does BJ come up
it just puts that there because it's the square you're on at the moment. just change it yes
[entties in Bl-El right justified]
and now it bas justified tbem all to that level
is there anything else 1 ought to know
Recalc
I suppose you might want to change some of these numbers some time
if you get rid of that by pressing UNDO again and if you move onto any of the numbers we can change it
(changes a some numbers)
see all these values [results of formulae] are wrong? so to change it you type the MENU key, now you want to
use the RECALCULATE option so type R and that will do it. Now you really want to RECALCULATE the
whole table so if you press the button F4 [All] it will do it automatically, it will change the numbers and you
can do that for any of them
[recalculated]

now what about if I need to add say if I wamed to add Germany
well you can either put them in there or you would have to move this up, so you put "Germany" row 6 for a
start
(types il in and adds data for Germany)
shall I just RECALCULATE?
no, because the formulas are now different. you see because we've got an extra thing so these would be different.
so if you want to add it say, move on to F6 and we'll copy that down
(copiesfonnula to E6)
unfortunately, with these [B7-E7] we have to change the formula now. (instructs c~xperimenter to move to Bl)
you have to get the MENU first. press the MENU, you can use the EDIT command now
so how do I change it now?
you can use the arrow keys

so go back
yes, now type plus B6, then close the bracket

(does, CR)
can't see it now
it's overwritten it [with the new result] that's why (instructs co-experimenter to copy formula to C7-E7)
Insert line

Is there any way of moving them, to get a blank line?
I think we can use the COPY command again, but I'm not sure about that
(experimenter tells him be could insert a new line)
we can always get help on it
help?
yes if you use the arrow keys to move onto this cell, that's it now type the HELP button there and that will
give you belp on INSERT which is the right thing to do
(both read help entry on INSERT)
that's right, that's what we want

so do I want insert? (selects)
[ Insert Row Column ]

I want to insert a ROW?
[Insert row(s) starting at: 7]
yes 7, starting at 7
[How many rows/columns: 1]
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just the one
jt:st the one, yes
[new row inserted between 6 and 71

Save
it's moved it down, well we just have to SAVE it again, QUIT/SAVE, just type Q, move onto the
SAVE_BACKUP again
we do that even if we want to exit?
yes, it's always best to SAVE it first
(it would ask whether to save before exiting, so it is not necessary to save a backup]
if you want to exit you can do it from this menu too, if you want to exit you just use the OPTIONS command
and that will exit for you
save backup?
and then it's SAVED it you want to quit you can do Q and then just type 0 for OPTIONS and that will get us
out that's it you're out of the spreadsheet

Comparison-Subject 4
(decides to sbow co-experimenter existing spreadsheet first)
OK so we've got a spreadsheet loaded in, gibberish but never mind, each, it consists of rows and columns, 6
columns and each like block is referenced by the name of the column and row, so here would be B4, there would
be Cl, so if you want to do, this here is telling you where you are, the current, so it's telling us we're in AI,
you can move this, highlight the block around the cursor keys, to move round It's telling you down here wbat's
in the squares is a number

Enter text, enter numbers, enter numbers as text
as I said we want to, press, square just change that 601 to 521 or something like just type the number we want.
just press return to enter that in the square, it's changed that, you can put TEXT in alternatively

lww does it know it's a number
it just checks the first character, so if you put a few minuses there it knows it's a NUMBER. but you don't
actually want it to be input as a NUMBER (demonstrates) it gets confused if you do, put minus signs in then
press RETURN

return
yes, it should give a nasty error, yes, so now just press UNDO to get a menu, the menu comes up

lww would I get tlwse to be alternative then?
yes, now you've got change what it thinks the input is, change is f7, so it now thinks it's TEXT, so if you
press RETURN now, it puts it in there as TEXT, but if you just type a name it lhinks it's TEXT, it looks and
thinks it's TEXT
so if I want to do my own spreadsheet ...
[empty spreadsheet]
I suppose exam marks are quite easy, just a couple of courses and averages or something like that And so set
up tbe columns
shall I do some columns for courses?
we want to label them don't we, so maybe come down maybe students down here [A) and subjects across
so those are the columns, and rows (enters names of courses in BI-D 1, names of students in A2-A5, IIUlrks

in B2-D5) right so tlwse are the marks now what can I do with those?
·
Formula
say you want to find out what the average mark was for french, just label the column average
(enters text label in El)
now we want to, if we go into the square where we're going to calculate the results [E2] now we tell it tbe
formula that calculates the average, we tell it the columns rather than put the numbers themselves in, the
columns it's got to take the numbers from so you want to add them and divide by 3. I'm not sure, you must be
able to, if you just put the formula in using

so I want to add tlwse and divide by three
yes, and you have to put bracket in !here

(types "(b2+c2+d2)13") just press RETURN?
[result printed in E2]

right now I want to do it for the others as well
Copy formula
you can use the COPY for that just copy tbe formula in that square

so it's copy? (selects)
[ Copy from area: E2]

E2?
[ Copy to base coordinate: E2]

that's right now I want to copy to
you want to copy to a range, it's more than one cell so if you put the first one, and to show it's a range you
use colon and then the end of the range
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E.5?
REIURN
[Copy Values All ]

VALUES or AU
you don't want to copy the values so ALL, you want,
[ Copy Relative Absolute Prompted ]
(thinks) RELATIVE- I hope that works
[results printed in E3-E5]

that seems to have worked doesn't it what else?
Recalc
you could change some numbers now and recalculate ...
what if I've made a mistake, say, entered Mary's mark wrong
just overtype it
so if I go to Mary's, if I just type it in now will it do it
yes
(types new figure) so if I hit RETURN. Oh it doesn't do it [recalculate} automatically
no, which is really peculiar, 'cos a lot of them [spreadsheets] do but you've got to tell this one to
RECALCULATE which is another MENU option
so it's down there so if I move down (selects RECALC)
[Recalculate equations of area: 03]
we've got the equations but we need to put the range, we've got to tell it where we're recalculating, if we're
recalculating all you tell it the top left hand corner and bottom right band comer, and it will do everything in
that square
so what do I want to recalculare now?
E2to E5.
[recalculated]

Right. Now so is there anything else, I can just do other things if I want to ??
Save
right SAVE the thing using the QUIT/SAVE option
[ Quit and Save: Model_Selection_Menu Options Context Save_Backup Save_ New_Model ]
if you want to carry on working on it just save it as a BACKUP or if you want to change it SAVE it under a
new name, SAVE NEW MODEL, I don't what context is ...
which do we want to do
I suppose SAVE it and then you can get out, just press RETURN, so it's QUITTING now, and it's also
SAVING it.
Has that saved it?
I hope so- nonnally it asks whether you want to QUIT before or after SAYING ... [only if model has been
saved befCR]

Comparison-Subject 5
[empty spreadsheet]
Enter text
Right. this is, each one of these is a cell on the spreadsheet which you can move around to select which one you
want, it goes from A to Z along the top then AA, AB, AC, as long as it's got memory, this side it's just 1 ton,
so all you do is select which cell you want using these and then you can type either TEXT in - to do TEXT you
just type some letters or characters, say if you wanted to do for example, ok say if you want to make a sheet
where the thing that calculates the expenses for a company or something like that so what you do is give it a
title to start with so just type some TEXT, say "Expenses for Company" (types) and that will come up there
[cursor position] now each one of these columns and rows can have formulas attached to them so they can
calculate what values are to go in there either from different cells or you can enter numbers directly for OCher cells
to calculate from so say if you wanted in this row, this column, money for travel, then enter the title (instructs
co-experimenter to enter text labels in A4-A5, and B2-E2)
Enter numbers
Right, let's say that the flrst one we want is travel in January, say the travel costs are five hundred pounds
(types "500")

andRE1URN.
[entered in B4]
Enter formula
Now say the travel cost goes up by 10 per cent each month, you want this one, the next cell to add 10 per cent
to the previous cell and put the new total in February, so to do that you have to set up a formula for February,
which uses January total to calculate the new total for February by adding 10 per cent so to do that to do a
formula you type in a bracket fl.rst. then the formula so this would be, this is cell B4, so if you type in B4 no,
you're adding 10 per cent to that- I think we have to move this fJist- (deletes what has been typed so far, moves
cursor to C4)
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so you've got to get to the cell you want before you start
yes, ok so if you type in bracket to signify that's a formula, [formula does not need to have bracket] now you
want to use this cell, wbicb is B4, so type in B4 and multiply by 1.1 which is 10 per cent, then close bracket
and press RE1URN
(chts)
[result pinted in C4]
so that's added 10 per cent to that and it's stored it in the new cell and move if you move along to D and you're
using C4 to add ten per cent to

the same thing again? do I have to type it in explicitly orwell I don't know I haven't tried that out
(enlers formula)
right and tbe same for April, so bracket first
why do I need the bracket first?
because otherwise if you just type it in that will be TEXT
·
oh it's TEXT, right, so I type a bracket to do it as a number (does not seem to know F7 to toggle
TXTINUM]
Recalc
yes if you change this one to say - 50 (number in B4) then you have to change all these don't you (C4-FA) What
we have to do now is RECALCULATE so you press the MENU and then use the cursor keys to move on the
RECALC and press RETURN.
[Recalmlate equations of area: B4]
Now wbat you want to do is RECALCULA1E the whole sheet up to there so you want to recalculate from Al
-I mean, B4 then FA, you don't have to type them all what you can do is say colon, E4. See and that's
recalculated all of them. Also you could do the same for food
lww do I get out of this (the menu}
just press UNDO, so do some formulas for food
(enters number in B5-E5)
well. say if you wanted to add up the total spent for each month then what you would have to do is consider
tbe columns instead of tbe rows and then do another formula for adding up the amount spent each month
so totals yes? (enters text label in A6)
now move along to and put in tbe formula using tbe brackets
I want to add that one to that one don't I

Formula

you can either use SUM, if there was a lot of rows down here rather than type in B4 plus B5 you could use the
sum command so if you type in SUM wit the bracket. now you could type in B4, B5 or B4 colon B5
(enters "(sum(B4:B5)) so if I had a lot more ?
it would save us a lot of time

did you say could I copy them over because to actually do the same thing ??? is there a way ofdoing thai
Copy formula
I don't know (calls up menu and studies it) COPY. [Copy from area: B6]
COPY FROM AREA B6(CR)

( Copy to base coordinate: B6]
try copy to C6, type in C6
[Copy Values All ]
do I want to copy the VALUE or ALL
t.be whole thing [ALL].
[ Copy Relative Absolute Prompted ]
Now you don't want to COPY it ABSOLtJTEL Y because you don't want the same values so that changes t.be
column that you, so it must be RELATIVE
(result Jrinted in C6]
I haven't lried it, but that must be how you do it
now are there any other functions can we insert a space here?
Insert row
INSERT if you select that. now say you see where these are right next to the numbers it migbt look beuer if
you space it. so select a row
[ IDsert Row Column ]
press REI1JRN
[Insert row(s) staning at: 6]
now you want to insen a row starting at
B4 won't it
well A4
just4?
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yes
(How many rows/columns: 1]
well if you say you wanted 2
[2 rows inserted]

oh I see, so now it's moved it down it's put in some blank rows ...
you could do the same under the title as well, and it's changed these relatively as well, (formulae bave picked up
new numbering] you don't have to change the rows
I don't know how to use that properly, the only ones I've done properly are the edit., help, insert, name, quit and
save, recalc, they're the only ones r ve done. I don't lcnow how to use these pcoperfy
there's 110 way of lih, well we hmi the sum function are there any other things you can do

Formula
well yes different math functions, there's say you select the, undo, select a cell, 08, now say you wanted to fand
the larges value between these two cells here, type in the formula. it starts with a bracket. then type in MAX
t.heo txackets, you can type in any amount using the colon of cells or just two cells using a comma and you'D
fmd lbe maximum number SURd
so if I put in B8,C8 (efllers "(MAX(B8,CB))")
[result pinted in 08]
it will put tbe maximum of those
are there any others
there's. if you go to ?? and start bracket if you type in INT then open bracket F6. close brackets. ob so that's
not a formula is it. type in the bracket again

(enters "(1Nf(F6)))
[?n?] 'cos that's not a fonnula say if you wanted to add to numbers together you wanted an integer
result type brackets I-N-T and a number, type in D6 and type in plus and then int F6 I think this is
how you do it and close the bracket

(enters "(int(D6)+inl(F6)))
[result displayed in E8]
that's just given the integer value for tbis
Save
SAVE - right press for MENU, RETURN. go to where it says QUIT/SAVE and RETURN, now
SAVE_BACKUP o f tbis
[badrup saved]
it's just SAVING now to the filename you've g iven it it's going to SAVE press it again RE1URN, just
MODEL_SELECilON it will save it

Comparison-Subject 6
OK starting from basics if you tbink of a spreadsheet as a matrix (grabs papers and sketches a grid) just like
battleships, you've got a grid, a matrix of cells and each cell, you can address it, it is something you can put a
piece of information into. So you've got to have some way of addressing the information in the grid. so lbe
way lbe computer does it. the way it sets it out, in this case is to have numbers for the rows. and across lbe
top it labels this A. so for example if you want to address this, this unit here, this is B3, just like with
battleships, so if I just get this going.
[empty speadsbeet]
I'll explain tbis in a minute but it's easier to start with if I show you wbat a spreadsheet is, it will be easier if
we get a spreadsheet. basically you type in to tbe machine. Ole so you can move round, this window, this area
here is just a window on a full size piece of paper but because you've got a fanite screen you can't see the wbole
thing at the same lime so this obviously is showing the fust 6 or 7 columns and the fust 18 rows so to go to
the next, to move round the whole piece of paper we can use tbe cursor keys (demonstrates) and if you bold lbe
SHIFf key down and tben use them you go down a whole page (demonstrates) or the whole six columns or
whatever it is across. Now tbe size of tbese columns isn't tied, you can vary the width of these so for instanoe
if you put some data in. It might be easier if, do you know what a spreadsheet is used for?
No

Enter text
OK you've got different forms of data into tbese cells, you can put TEXT data (types some data). Now as I'm
typing, it's coming up on tbe command line here. So you can edit by typing, so you can change what you're
actually putting in before it actually goes into that particular cell, this big marker by the cursor, purple bar 1
guess. the TXT is telling you it's a TEXT field because I started witb an "a" it recognised it as a cbaracter as
opposed to a NUMBER so it knows that that is a TEXT field, so if I press. well RE1URN in this case it will
stick whatever I put into this field and recognise it as TEXT.

Enter numbers
HI do the same thing with the next one down but say "10" then it's recognised it as a NUMBER. this here is
just indicating how the format is for instance this here is two decimal places, so when I press RE1URN or
recalculate something ru get 10.00 accuracy. so that's all that is.
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A spreadsheet just enables you to format a lot of data in a very well pre-defined way so that you can see all the
infonnation at the same time and you can organise it in a logical way so that the some data relates to other data.
so for instance, the example we're doing if you have to make something, if you have to make a keyboard say it
has a lot of constituent parts and the total cost of the whole keyboard for manufacture would be the sum of the
constitue,ot parts but if you have to calculate that on a weekly basis, say, to make sure that you're not going to
make a ltJSs tben if the price of the sub-contractor's keys or something goes up by changing one entry you don't
have to recalculate the whole thing by adding that much more in, it may be more complex than that but in a
simple case, so what a spreadsheet does is make the layout how those keyboards may act, what it's made of,
what the constituent prices are, how the data relates to each other and if you change elements then, if say one
key goes up, it will recalculate the whole cost of the keyboard as opposed to you having to sit there and add all
the numbers up again.

Formula
So another thing can go in is formulas so say I wanted to add two numbers, if I put a number there, say in B4,
say I put in 2 there and if I want a result. say next to answer, now if I type instead of text or a number, if I
type a formula Tbe easiest way to identify a formula is to put an open bracket flfst. it says it's a number but
it will treat it as a formula relative to those two [A4 and B4) so if I then put A4 plus B4 then it will now
calculate the sum (types "(A4+B4)", CR, result displayed)
So it's a bit more clever than that because if I have a whole line, you know if you have a ledger, a whole line of
information that's tbe same as the next line, it's just adding up rows and columns, if you want to do the same
for the next two, I'm going into a bit of syntax here, how do you use the spreadsheet so, it's based on a window
environment so if I using these function keys, it's not very nice because the exact mapping of these keys to
what they do is not 1 to 1 so, for instance help is Ok that does that. but print doesn't print it does something
else because the software and keyboard don't match up exactly. Il's a bit confusing at flfst but once you
remember what's what - the important ones are easy. So if I press MENU I'll get a window of OPTIONS and
the way that it's set out is, these are all options and I can go to an option by going through (with the cursor
keys) or I can press the letter of the initial of the option, o say l want HELP, if I press H (does) I get a help bar
and it will tell me what keys I can use to use the help function the UNDO which is UNOO surprisingly and do
which is finish F9 that doesn't run it ?? but if you can remember that that's about all you have to use, the
arrow keys so I can go through more help information, if you press CARRIAGE RE11JRN or this key, 00, F9
at any stage it will invoke whatever you've highlighted
if you ever get stuck, you think oh bow do I get rid of this UNDO it and you'D go back a step it wiD always
come out of that current section, so if you panic just press UNOO and go back to the previous position. If
you get stuck and you want information on a particular aspect of something if you press Fl for help at any
time it will give you a window
so say if I was
yes if you were entering something, entering text or something I can press HELP and it will give me a list of
options on what, press HELP again you get another window, that, with this it is easier, you can only explain
so much without someone seeing how you actually play with it. What next, well, I could go tbrougb some of
the tbings you can do with il
if I start just trying an example and you just show me

Blank
if you can try adding a few number together so if you stick in say some TEXT, say A. B and C, you've· got
three numbers, do you want me to clear that page first? Right it's got a funny way of doing it, if you want to
clear something BLANK it. B (selects BLANK)
[Blank what area: B3)
and wbenevec you have to define the area, it's got to know what area to operate on so
you don't have to blank it all you can just blank
yes, if it's asking you what area you can either do a square, say you defme the top left hand comer and top right
comer so for instance you have A3 is top left and you have B4 so the area that defines that syntax is a colon
between A3:B4 and that defmes this area here
so you do a square or a rectangle?
correct, so if you type colon B4 it may stick up something else, because the cursor's on A3 it's trying to help
you by looking for what information you want. so you don't really want A3, press, that's the BACK SPACE.
sorry, and t.ben 4 it will blank out those four things
(enters "A3:B4", CR)
[Verify blank area: A3:B4)
verify because you're deleting and it's done il
If at any stage you come to that and it says area you press the ALL button F4 you will do everything on lhe
current worksbeel The s/s works by not storing everything that will come out on a massive piece of paper, it
doesn't store everything but only the bit you use, it knows at any one time how much of the area you're
working on so you can press the CALC button and it will only do the bits that you're actually calculating you
haven't got to bow far the s/s you go across. Do you want me to do an example first?
well, I'll type it in and then I can get used to using the keys
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so I just put anything in as the sort of headings
yes, put in some text - say nuts bolts and washers
. ri~hl (e"!ers text labels in B3-D3) so these are my column headings (enters text Labels in A5-A6)
1f you JUSt stick some number in now
(enters number in 85-D6)

Formula

The things you need, I can put the SUMS in, if you imagine trying to add things up you could say that the
SUM of this row is B6 plus C6 plus 06, if you imagine having more rows it becomes tedious to type that
out, so there's a quick way to do it so in the formula instead of typing A6 plus B6 plus plus you can type
SUM A6 and then colon. B6 and it will add up those two columns
that would be just if I was adding two so that corresponds to the last one
sure, yes, it takes between the limits of that row, if you want to add all these numbers together you start from
the top left which B5 to D6
so say I wanted to do the total quantity and put it in here so
do you want to put a label first. do you want to put that above
(enters tat label in E3) so now I come down, and I want the sum to go in here (moves cursor to E5)
if you type bracket fust and then SUM then bracket then you want B5 to E5
(enters (SUM(B3-B5Jr) so lww will it do that, will it do it straight away?
[result printed in ES]

Change attributes
When it in sticks data in it sticks TEXT in left justified. so this column is on the LEFf band side and the
NUMBERS, integers whatever, RIGHT justified it would probably be easier to look at if you do it CENlRE
justified, I find it easier to see what is in what column, a relatively easy way of doing that, if you go to
MENU again and go to FORMAT
[Fmnat Width Attributes Fuler_cbar Data_type]
you want ATTRIBliTES, now here as I say, you can change the column WIDTH so if you have a big amount
of data and all I'm doing is pressing the initial letter of the option I want so it's FORMAT followed by

ATIRIBUTES,
[ NUM [R 2 -] LCR }[????????] ]
so, now this looks confusing at fust but it's quite easy, LCR, you remember this thing I showed you, NUM

means it's a number format and it tells it bow to format the actual numbers to bow many decimal places and
then tbe number itself which in this case is 5. Now the question m.arlc means it's wanting 10 know information
it doesn't know, so because the cursor's on LCR I can press F7 wbicb is change in this case, I know it's
confusing as well, it confused me, now I've gone to L which is LEFf and C which is CENTRE and it's teUing
me 1 can use keys left, right, change do and undo, change is F7, do is F9 and undo is F2, (CR)
[ Format applies to area: C5]
so if I do that it wants to know what area this applies to, well we want the whole thing really so calculate and it
will do the whole thing
[numbers centred in columns B-E]
the only thing about this program that I don't like is once you've done that if you enter another number even
though that's applied to the whole area in that square, if I stick in say 4, it will stick it right justified again
unless there's some other way of doing it.

Save
So now to tbe implementation of bow to use the machine side of it, if at any stage you get stuck, and you
want to come out of the sis, QUIT/SAVE, so q for QUIT
[Quit and Save: Modei_Selection_Menu Options Context Save_Backup Save_New_Model]
and it will tell you MODEL_SELECTION. if you come out of that - press do or RE11JRN
[saves]
it should have saved it, hopefully
lww do you check that?
if I select I want to fmd a flle, I type in first which was our original name, do you know about, ob I won't go
into that and it's found the fde so no problem and that's about it, unless you want to sit down and play with iL
say I wanted, I'm just thinking now, it would be nice if I had like a total cost for each of tM~. like lww
much tM nuts were, can I do that, because I want to multiply them together don't I?
yes, if you can work out, if you wodc out the B5 times B6 enter it as a formula, so you start with the bracket-

B5 titMs B6 (ty~s "(B5•B6)", CR)
[result displayed in B8]

Copy formula
rigbl. say you want to do it for the other ones, rather than typing it and doing it, if you can imagine COPYING
this to here then you have to know whether you want to copy this RELATIVELY, i.e. whether you want the
formulas to stay ABSOUITE, which would mean exactly the same so this would mean B5 times B6 or
RELATIVE, it would add one to it so this becomes CS times C6, so, it will ask you that if you go to MENU
again, C for COPY
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[ Copy from area: B8)
you want to COPY FROM what AREA, so in this case, copy B7 to D7, sorry C7, D7, E7, OK? so I copy
from B7 to, because that's where it's highlighted.
[Copy to base coordinate: B8]
and I want to copy it to Cl, E7, and whenever you defme an area you put the colon in again, it wants B7
coming up, so D7 and that will COPY if from there to there and it will also ask you now [ Copy Values All 1
I don't want to copy just tbe VALVES because it will just copy 1.5 which is a waste of time,
[ Copy Relative Absolute Prompted )
I've got to know whether it's ABSOLliTE, RELATIVE or PROMPTED Just to make sure. So you want it
relative so that's OK
[formula copied to C7-E7]
rww if I go back, say now I decide that I've got, undo, so now if I go back and I change the bolts, say I

change tluJt to 6, rww they're all going to be wrong
Recalc
so lhe way you RECALC1ULATE the whole thing is F8 which is MENU, recalculate, well RECALC there
wbicb is R.
[Recalculate equations of area: C5]
you want to recalculate, well you might as well just press the CALC button and it will do everything.
[recakulaled]
See it's worked out that it's Al to E7 because that's our total area

Toggle display
If you want to see what formula you've got in there, the thing that's actually producing that, so if we go to
WINDOW, W and then you want VIEW because you want to see a different VIEW and just press RE1URN it
will toggle between equations, so it will show you equations
[equations displayed)

Enter numbers as text
so if you want to go the other way it wiU toggle between, if I put it in the other way it will go back
If you want to sort of border this out a bit, for instance there's no circumfencing lines or anylhing I can put in the columns are a standard 15 I think- (types line of 15 dashes) [standard widlh = 12) so that's a line to go in
that segment, if it's oversize it doesn't matter because you don't see the rest of it anyway, so wbat rm
attempting to do is put a line across here, so we have to do it bit by bit because each one of these cells is a
window in itself so if I put a big line in here it will just chop a bit off so to make it recognise it as a string or a
piece of text because I put a minus sign it recognises it as a NUMBER so you've got NUM bere I'll sbow you if
I press REWRN, so it's come up with a problem and beep madly and F7 will change its type to NUM (CR,
line of dashes printed in B4) (instructs co-experimenter to copy to C4·E4)

Save
ok if you QUIT out of it, it should say,

[Quit and Save: Model_Selection_Menu Options Context Save_Backup Save_New_Model]
weU you can do it this way if you SAVE BACKUP it will save it for you but I think it should prompt you
anyway it will say SAVE without or SAVE WITH changes, so SAVE the BACKUP. Now we've got out of
it it won't ask the same question again, it will come straight out back to lhe original menu, if you want-to
come out of that to switch lhe machine off I think you can do it directly but if you want to you press UNDO
again and you1l come back: to the main menu, high level MENU and if you go to the OPERATING SYS1EM

Comparison-Subject 7
[empty spreadsheet)
Now this is the sis itself, you can move around the s/s using the ARROW KEYS. That teUs you where the
pointer is at, that is or helping wilh using the COPY function so you can copy blocks of the text from one
part of the sis to anolher, so if you had a set of figures there and you wanted to just COPY them over without
typing them again
now what

Enter text
Ibis is a new model so we want some headings for what you want each one to do so say if you wanted incane,
outgoings, like personal finance, or you could do a company one, aU different staff costs and things like that.
You just type any TEXT in or NUMBERS
if I~ here it just goes in thai box/cursor} does il
yes it goes in the box and wben you type in it comes up lhere [input line] first then press RETIJRN, wben you
press RETIJRN it comes up in that box
so why is that?
it's so that you can edit it, get it how you want it first before you actually put it back into lhe s/s. So you can
sort it all out fU'St without going backwards and forwards. So just create a column for monlh, just type in
month
(does)
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you can edit it normally as you would using nonnal keys and press RETIJRN and it will come up there.

(CR)

[text printed in Al)
Ok now you can move around put some more headings in or put some numbers in using the cursor keys again,
you've got the beadings so you'd have the figures below them, each one
(enters text label in Bl)
OK just carry on like that. do you want to put some figures in frrst or put a couple of months in so you've got
something basic in first .
(types nex1 text label)
Ole wbat you have to do once you've got from each one you have to move on because here you would overwrite
onto there again because you haven't moved on you can see it's highlighted tbere [Cl] and you're inputting again.
so if you just delete that and just press RE11JRN now see bow it overwrites it. just type feb again, press
RETIJRN, then move on to the next one and type in mar. OK that should be enough headings for now.
If you come back down here put something in for what the rows will be so put something like "incane", just
a basic example, RETURN and now we can put some figures in to make the sis look like il's doing something,

Enter numbers
Now if you want to move under "January" [B2] just type in a number
(does)
if you see this it say NUM which means a number when you've typed in a beading it says TXT which is for
TEXT so you know what type of information you're putting in if it's TEXT or if it's a number
suppose you want both

Enter numbers as text
you can't really have both in tbe same box you can only have a number or word, the only difference 10 tbal is if
you want say, if you want a date, just type in a date and you can change this to TEXT. Ok you see that's taken
that as a number if you want to change that to TEXT just press F7 which is the change key and it swaps over to
TEXT and if you press F7 again it will change to a NUMBER. Because if you just type that in straigbt away it
will handle tbat as a number and you can perform things like addition and subtraction which you wouldn't want
to do with a date, not really anyway so you just change it to TEXT. OK? So you want to type in some numbers
(instructs co-experimenter to enter numbers in B2-02)

Formula
OK now we'll do something with these numbers so if you want to go down into the next row go to the
beginning again. Just move it under January [B3] you've got the income for the month so we'll just wo« out
the income you get in each week, say there's four weeks in each month, so what you can do instead of typing in
45 again you just type in the box that is in which is B, column frrst, the letter always comes first, and the row
is 2, so put B2 which specifaes a row and divide, backslasb and 4
("b2/4")
just to change it into weeks, you can see it says TEXT, but what we really want is a NUMBER because it's an
equation so just change it into a NUMBER
(f7)

press RETIJRN
[result printed in B3]
you see it's worked out what 45 divided by 4 is.

Copy formula
What we could do now, instead of doing the same for each of these, we can either COPY, do the same tbing C2
divided by 4, 02 divided by 4, what is easier is to use a special facility within the sis so if you want 10 go into
the MENU, which is F8, the label's on the key and use COPY wbicb can copy, as you'll see you can COPY
areas from ooe part of the screen to another part.
[ C~y from area: B3]
first it asks you for AREA TO COPY FROM and this is the area that's got the equation, press colon, then
just press REIURN because you just want that one box [colon not required] then, just press RETURN
[ C~y to base coordinate: B3]
and now you want to copy it from that area to another area so move tbe arrow key to the area [C3] you want
colon again and now move it to the last what you want it to [D3] which is the last box and just press RETURN
again.
[Copy Values All]
You want to copy everything, if you just copy VALUES it will copy 11.25 to each of the boxes but you want
to copy the equation so change it to ALL
[Copy Relative Absolute Prompted]
Ok ABSOLUI'E would copy that equation into each box so you'd have B3 divided by 4 there which is not
really much use, what we want is RELATIVE so it will change the box there instead of being B2 when it
goes in C column it will be C2 and if it was in rows if it was B4 it would copy it to BS so change it to
RELATIVE, prompted it will ask you if you want to change it RELATIVE or leave it ABSOLUTE so you
can mix botb if you want to, so just leave it RELATIVE for now, so just press RE1URN
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[formula copied to C3 and D3]
It's copied both of those across, press UNDO to get rid of the MENU you can actually see tbat it's, UNDO is
F2, if you move across to there you can actually see that the equation has changed to C2 and D2 so it's worked
that out.
Formula
Wbal we could do now is go down and do some more equations so we could subtract one from the other. add
tbem boCh together oc we could sum along the whole column if we wanted to. If you move along bere we can
do a sum along tbe whole row. If you go up here [E2] so we have it on the income row, if you wanted to sum
a whole row or whole column of numbers instead of typing in B2 plus C2 plus D2, it's ole for small amounts
but if you've got a long list of numbers it gets more awkward so you can use another built in function, so you
can just tell it to sum from tbe flfSt one to the last one

we've only got 5 anyway
yes but it makes it easier then because it's a simple one it doesn't look as though it's doing much but when
you've got, if you bad a whole year of figures along there it gets a bit awkward to type in 12 lots of numbers
added together so if you just do SUM, type S U M, open brackets now then shift and, tell it the fust ooe
which is B2. colon wbicb means to, and D2 which is the last one you're using and then close brackets and
there you can see it bas set it as TEXT and you want to change it into a NUMBER, so F7 and just press
REI1JR.Noow
[result printed in E2]
Copy formula
and it will work out the whole sum along there which is a lot easier to use than typing B2, C2.
And again you could just COPY that down to there as we copied it before when you go across because the
spreadsheet is very large you can't get it all on the screen at the same lime so after it reaches a certain amount
it starts moving the rest of tbe sis to on side, the sis is still there it's just moved it along a bit. If you think of
it as a very large piece of paper and at tbe moment you're working in the top corner, so you can just move back
again and you can see that it's still there, the figures are still there, and you can do the same thing, just go
right down, because it goes past that and it goes into AAs and BBs and all that, see how it's jumped up to the
next part. it's come back into the sis.
Toggle display
Let's try and think: of something else to do, ob if you want to, instead of seeing all the figures all tbe time.
you want to see formulas go to the MENU again and press WINDOW, w for window o:r you can use tbe arrow
lceys, it will be easier to press W in this case because it takes ages to get to it, you see if you just press the
fltst letter, and we want to VIEW it, and we want to see the EQUATIONS, you see it's changed from
NUMBERS back into EQUATIONS, so if you wanted to you could just leave the equations up to begin with,
while you fill out tbe whole sis and then when you start putting the numbers in, enter tbe numbers and it will
work out the numbers for you.
Ole to cbange back again, you just do the same thing again, w then view again, press RE1URN, DOW see it
swaps between the two if it's on equations it swaps to numbers, on NUMBERS it swaps to EQUATIONS,
same as the change key where you're changing from TEXT to NUMBERS and back again.
Delete row
If you decide that you don't want that row you can DELETE the row so you have to select the MENU function,
d fa delete
[Delete ROW COLUMN )
DELE'IE ROWS or COLUMNS, ok we want to delete this ROW, so you just press RE1URN because it's
already highlighted.
[Delete Row(s) slalting at: 3)
Now ROW 3 is tbe one we're on
[Delete row(s) starting at: 3]
and that's the row we want to delete so just press RE1URN
[row 3 deleted)
It asks you which row, you could change tbat if you wanted to
and there's ooly ooe ROW we want to delete so we can just leave it as I. ole. that gets rid of the row

could I get thol back now?
I don't think so, not that I lcnow, DO you can't. so you'd have to retype it in again, it's really if you typed iD
something- and you realise it is all totally wrong so you want to get rid of it or if you type something iD 8Dd
there's a whole bundl of text you want to get rid of or get rid of useless columns or useless rows
Save
OK, if we want to SAVE this we go back into the MENU, you'll get used to seeing the MENU a lot, this
time we want to QUIT/SAVE so press q for quit it takes the first letter so even though it's QUIT/SAVE it does
a QUIT and we want to SAVE this model
[Quit and Save: Modei_Selection_Menu Options Context Save_Backup Save_New_Model]
it's a new model so we want to SAVE_NEW_MODEL so you have to move across tO it because we've got 2
beginning with S, ole., just press RETURN
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[Save to what model: ]
and we want to save it to "mark" because that's what we called it
won't it do it to the same one?
well yes, I think it will, yes it does, just my mistake
[this option is for creating a new flle)- (types "mark") shall I do this or not
yes it will just overwrite it as whatever it was before, see it's called it the same as what it was
[Ftle B:mark.fmd already exists] [won't overwrite]- changed its name
it is just cbaoging it to a name that it knows, B is for the drive it's saving it to the second drive and tba1 is just
a bit of text for it so it realises it's a sis data not a program, it's told you it's got this already so it gives you an
error message, so because it's a mistake just press UNDO, ok go back into QUIT/SAVE
[ Quit and Save: Model_SeJectioo_Menu Options Context Save_Backup Save_New_Model )
Go to the menu [Model_Selectioo_Menu] it automatically saves it [since it's not been saved yet]

Comparison-Subject 8
[empty spreadsbee(]
virtually it's just a list of columns and list of rows and you can put entries of characters, formulas into eadJ of
these spaces, any of those you can stick in words or say a mathematical formula You can move down with
them as weU. And each column and row is referenced using this pointer (points to bottom of spreadsheet) if
you're deleting things the pointer's different to the current pointer.
let's do different sizes of panes of glass [classroom example]

Enter tex4 enter numbers
if you want to type in the top left band comer, say "length" to start with,
(starts typing)
you see that's come up with 1EXT, TXT down here, so that means the word itself, press REfURN, now you
can go along to the next column using the cursor key again. You can type in "width", TEXT again.
REfURN, it's put it in that block.. (instructs co.experimenter to enter numbers in A2-B2, and text label in Cl)
why do I have 10 press return, just to put i1 in?

Formula
yes. Right go down one [C2] and work out the area using a formula. Now to work out the area it's column A.
row 2, so put A2, now put multiplied by, shift and star, it's for area select so it's B, row 2 again, B2, now
that's in TEXT form, you don't want it in TEXT you want it as a NUMERICAL formula to multiply these
two numbers together, so to convert it to numerical press F7, right now it's gone to NUMERICAL, if you

press R.ETIJRN
what's it mean, NUMERICAL and TEXT
NUMERICAL it sticlcs in a number or a mathematical formula and if you just do it on TEXT there it will just
put in A2 times B2, whereas with a NUMERICAL formula it's going to multiply these two numbers together,
press REfURN key now,
[result pinted in C2J
see it's come up with 12.
Toggle display
If you want to display the formula go to menu which is the F8 key, press tbat, right now you've come up
with the sis selection menu, wbere is it. now press w to show the formula
you can use those but it's quicker, if you use those keys it's going to take you all the way through the menu,
you can just press w, WINDOW and v for VIEW and just press REfURN now and it should display tbe
formula you just put in tbat box.
[does]
(instructs co-experimenter to enter text label in 01, and number in 02, text label in El, move to E2)
right we'll do another the formula - the volume will be the area times the thickness, so it's C2 again and to
multiply by the thickness which is 02 again, now it's in TEXT form again ... (F7 and enter) it displayed the
formula again now to display the nwnbers go back into menu

what dots all this mean
it's just different options you can use, do a copy in a minute just to underline things, go back to WINDOW
again to put the numbers bact on tbe screen, VIEW again so V and press the RE1URN key, that's displayed
tbe numbers again and back onto MENU.

Enter numbers as text
Now for a bit of TEXT, if you want to underline the whole line you underline the first section by pressing lbe
minus key a few times,
(li>ts)
OK, and that's in NUMERICAL form because it's a mathematical symbol, we want it in TEXT form because
you're only underlining, so press the F7 key again to go back to 1EXT, that swaps between TEXT and
NUMERICAL.
Right now if you press REfURN k:ey again
[line of dasbes entered in E2. overwriting previous entry]
tbal's put a line right now to COPY tbat you've got to go to menu
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can we - we lost something there
don't know, do you want to stick the number back in- well do you want to put the formula in again? C2 by
02,
(types formula, CR)
foonula printed in E2]
that's it no that's TEXT, type it in again, you're in TEXT form and you want NUMERICAL, press F7 change
to NUMERICAL.
[result printed in E2]
Now we'U underline something, go down a line and back to 1, now stick in the minus signs now you want to
go into 1EXT, so F7, now press RETURN and you've got a lines.
[printer in A3]

Copy formula
Now to COPY that you've got to go to MENU which is F8 right and you want to go to the COPY function
[ Copy from area: A3]
Now it will ast you which block you want to copy, you just want to COPY that block, so if you press a coloo
key and RETIJRN, that means you're going to copy that block [colon unnecessary
[ Copy to base coocdinale: A3)
and it's asking you where you want to COPY TO so you press colon keys again and you want to copy these
minus signs all the way across to e, you press the cursor key now if you notice this is going up as weU. When
you press lhe RETIJRN key now that should copy these minus signs all the way across that line.
[cq>ied to B3-E3)

Insert row
If you want to stick in another row, so if you want to stick another line in above these minuses use the
INSERT
[ Insert Row Column 1
you want to insert a ROW so just press the RE11JRN key
[Insert row(s) starting at: 3]
and you want to start at row 3 because you're going to start above that one so if you press R.E11JRN key again.
[How many rows/columns: 1)
DOW it asks you bow many rows you want to insert so 5 maybe, REl1JRN
[5 rows insetted between 2 and 3)
and that's set that down by 5 rows. If you want to stick in some more numbers in the length and width
columns we can copy formulas (instructs co-experimenter to enter numbers in A3-B5, moves to C2)

Copy formula
OK now we want to COPY a formula in a minute so we1l go to the area column, we want to transfer the
formulas again so go to menu, right now w again, WINDOW, VIEW, v and RE11JRN, now it's showing you
the equations on the screen again.
[not required to copy them]
Now if we want to COPY this formula for all of these we're going to get A3 multiplied by B3 in this one A4
multiplied by 84 there, you want C to COPY that formula,
[Copy from area: C2)
DOW you want to just COPY that formula there so you press the colon again, RE1URN, [colon not necessary}
[ Copy to base CO<Idinate: C2]
so it's just copying that one formula, now you want to copy it so colon again, (gets :c2) you've got to delete
that, delete that you want to put C2, colon, then press cursor key because you're copying to that one, now

press RETI.JRN,
[Copy Values All }
now you want to copy ALL the values so go across to ALL, that's it. press RETURN,
(Copy Relative Absolute Prompted ]
and you want it RELATIVE to each, so it's not giving you A2 by B2 in all these you're going to get A3 by
83, A4 by B4, right so you want RELATIVE so press RETURN again and that should give you those.
(formula copied to C3-C5)
It bas, if you want to display that back up on the screen again (instruct co-experimenter to toggle, numbers

displayed)
Blank
If you want to put blank boxes in you can use the BLANK function
[Blank wbat area: C2 ) say if you want to get rid of a whole row, say row 3, go down and aaoss to
the flfSt block in that row
(moves cursor to A3)
and press colon key, move across and it should get rid of that whole row, press RETURN, hopefully, maybe
not
[Verify blank area: A3:F3]
yes press RElURN, you've got to verify it.
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Change Attributes

Ole to tidy the columns up you've got to use FORMAT so if you press F. lt will ask you what you want to
do,
[Fmnat Width Attributes Filler_char Data_typeJ
you want to change tbe A1TRIBUI'ES,
[ NUM {R 2 -] LCRl[????????J ]
that's it, it's given you a string of question marks here so if you press the F7 right that Lis LEFf you don't
want that so press tbe F7 and you should get C, that's CENTRALISING. Now if you press RETURN key oow
[Format applies to area: F3]
it will ask you which columns you want and you want to move these numbers across so if you move the
cursor key to this fust column, and if you press colon key now, go down three and across 5, so it will
incorporate all these numbers now, press RETIJRN key now they should be centralised ok?
[numbers in cohunns A-E centred]

so how do you keep copies of it
Save
got to go to MENU again, if you want to SAVE something there's a QUIT SAVE function down here so press
q.
[ Quit and Save: Model_Selectioo_Menu Options Context Save_Badcup Save_New_Model )
If you press MODEL_SELECTION_MENU it will save it, because it's the f1tst time we've used it, if you
updated that it would ask you if you wanted to get rid of it WITHOlJf SAVING or if you want ro SAVE it

ftst.

Comparison-Subject 9
[empty spreadsheet]
this is tbe sis itself which you11 be entering data into, so you have to have this table as it were to manipulate
your data in, so you can enter column or row beadings along tbere using TEXT, do you want to enter
something a name or something I don't know what table you want to produce. and some NUMBERS wages
perhaps or something, payday or sanetbing

Enter text, enter numbers
sba1I we enter some names farst, so just put employees or sometbing.
(enters text label in AI)
If you move along one and put wages.
(instructs co-experimenter to enter text/abel in A2. and numbers in B2-B4, text labels in A2-A4 dMs not
move cursor to next cell)
that's going to go over the same one [cell] you'll have to move down.
(moves cursor, CR)
[entered in previous cell, overwriting previous entry]
whaJ happened there?
Did you move it?
(moves cursor before typing next entry)

Formula
right you can manipulate your data by entering formulas if you want so I don't know wbat you're going to
have in there, income tax or sometbing [in C column] move up ro there and put income tax or something.

Change width
If you get headings too wide you can widen thing~. Use MENU there, got a whole load of things here yoo11
find WIDTH under FORMAT so if you go into F.
[Foonat Width Attributes Ftller_cbar Data_type]
Here's WIDTH and A TIRIBtrrES so you can centre things so, it's on WIDTII now so just
[ Set width of this column to: 12]
and press RE1URN again we don't actually need that

what's tluJI
it's already set at 12 you cao change it if you want but there's no need ro. just press that again.
Formula
To get out of that you've got to press UNDO again so now move down, for bere (income tax) you could have
some sort of formula say 25% of the wage. So if we enter a formula in there then we can copy that down.
Entering as TEXT, so put a bracket in. Type a formula, 25% of, so 25 divided by 100 I suppose. We ought

ro use a bracket in case Yes type a bracket, it makes things a bit clearer
(types "(25/IOO)•al"), then enter.
[result pinted in C2]

Copy formula
To copy it go to menu again, COPY,
[Copy from area: C2]
from, you want to COPY that AREA so press the colon and then just RE1lJRN [colon unnecessary]
[ Copy to base coordinate: ]
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and then copy it down from there down to that one
Why are we doing this. what will hnppen?
~ou're going ~o COPY the formula you bad in there into the number boxes without entering the data three
~es.. Now if '!"e go to the top again [C2] and then put a colon that gives you the start and go down to where
at s gomg to fimsb [C4] then RE1URN now. You always want top left then to bottom right and that'd give
you tbe wbole area.
[Copy Values All ]
VALUES will copy 11.50 through ALL will give you the whole equation which is what you want so move
the column.
[ Copy Relative Absolute Prompted )
RELATIVE will move it so instead of doing it from B 1 B2 as you go down it will go B3 and B4, ABSOLUIE
will just do B2 each time and I've never used PROMPTED so you want RELATIVE. (instructs co-experimenter
to enter text label in Dl, formula •(B2-C2)" in 02

RETURN?
No you don't want 1EXT you want to invert that so it's NUMERICAL and I think if you ENTER. if you
badn't changed 1EXT you'd end up with B2 minus C2 in there so you need TEXT (instructs co-experimenter to
copy fonnula)
To fmally QUIT this whole lot. you need QUIT

Save
[Quit and Save: Modei_Selection_Menu Options Context Save_Backup Save_New_Model ]

M for MODEL_SELECTION_MENU, go to select now, and you can play again or would you JXefer to get out
select your same one again so mark2
(re-enter spreadsheet]
Blank
If you press MENU, there's a few more things you might want to use BLANK will delete a whole area
[Blank: what area: ]
we could delete the last row so enter A4 to D4, and press RETIJRN
[Verify blank area: A4:D4]
how do you verify thai?
just press RETIJRN
[row 4 blanked)

Change Attributes
You can CENTER those numbers it's in MENU under FORMAT, so if you go to FORMAT and
ATI'RIBUTES you can CENTER it from there.
[ NUM (R 2 -] LCRl[????????] 1
If you use the change key (F7) LEFT CENTER and RIGHT, so you want CENTRE
(toggles to C)
and then just RETIJRN,
[ Foonat applies to area: A4]
then over the wbole area so from there to there,
(ellkrs A4:D4)

press REfURN
[no change]

sorry- wbere did you do it from? It needs to be from there I suppose B I and ENTER, go from the top, and
toggle and down to bottom right and that CENTERS it or you could have moved it all
LEFT, using that key so do you want to leave this, I don' think there's anything else,

ro the RIGHT

or 1o tbe

Insert row
ob you could bave INSERTED if you missed something out you can use INSERT there
[ Insert Row Column ]
and that will put in another ROW or COLUMN. let's put a row underneath
[Insert row(s) starting at: 3]
that'll put the row underneath so if you move that key [to 2] and then press RETIJRN
[How many rows/columns: 1]
and tben you want the 1 column, or change it if you want
[row inserted between 2 and 3]
Rigbt so you can INSERT something in there if you want Another name perhaps.
Well we could DELETE tba1 now so if you go to DELETE.
[Delete ROW COLUMN]
Row again.
[Delete row(s) starting at: 2]
yes
[Delete bow many rows/colwnns: 1J
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Save
and ooly 1 so, that does all that so if we QUIT now.
[Quit ~d Save: Model_Selection_Menu Options Context Save_Backup Save_New_Model]
again, JUst JXeSS RETURN and again AFIER_SAVING. Press RE11JRN. You could have done it WTrnOUf
SAVING if you didn't want any of that If you go to OPTIONS -

Comparison-Subject 10
[empty~]

Enter text
You start off with your rows and your columns, the frrst row and column, the title as to what they are and you

can keep them on the screen all the time if you want, so if we start up a s/s for booking seats in a cinema the
ftrSt one, the first cell I suppose you'd call it AI, we put in there "row"

(types "row") Has that gone in yet?
no. not yet you have to press RETURN, then everything under there is a row so if you move the cursor down
one wbicb is down arrow and it puts that pink blob [cursor] over the next cell you want to flll in, so rows in a
cinema are usually a,b,c aren't they

(types "a") and RE7VRN. Then move down agaill As many rows as you want,
(tillers "b" in AJ, types "c", CR)
["c" overwrites previous entry "b" in A3]
ah - you didn't move down then

what happened to it?
it just wrote over il Just do the flrst three. Right the next column b, you can move that around just using
the arrows. Say bow many seats are in each row so you can put number of seats.

(enters text label in BJ)
Enter numbers
Tben next to the columns bow many seats there are, about 30 seats to a row. You can put a different number of
seats in different rows.
(enters numbers in B2-B4)
Now what you've got now is two different types of cells on the screen, you've got the number of seat the rows
and the lettets, they're all TEXT, and here you've got a NUMBER, (points to indicator above input line) wbeo
you've got a NUMBER it gives certain options like right hand justified, it's got two decimal places and minus
numbers you can change that later on.
Other things you might want are the price of the seats and the number of seats that you've sold.
(enters headings and numbers inC and D)
(text label in Dl exceeds 12 char) it's a bit wider, you see it's gone over but that doesn't matter because we can
widen the column later.
Now you can put another column in which will say ... how much money we got from each row and then we can
total it up at the bottom
(enters text label in El)

Formula
come down to the next cell [E2] we now need an equation which will multiply the price by the number of the
seats, so to do that the price for this row is in C2 so C2 times D2, we're multiplying the two rows togetber,
so 3 pounds times 26

so what do I put here
you just type C3, C2 sorry, D2.

(types "C2•DZ")
Now initially that put that in as 1EXT so what we do now is press MENU, which is F8 on the rigbt band side

what does the menu do?
It gives us a whole lot of options of things we can do, what we need to do is FORMAT one of tbe cells,
FORMAT is
the easiest way to get to it is just press F, you could also use tbe arrows to move around.
[Fc:xmat Width Attributes Ftller_cbar Data_type]
Now we oeed to change the OATA_TYPE because we've got it as a TEXT cell and we need it as a NUMERIC
cell, so if you just press d, set it to NUMERIC, it's already on NUMERIC so just press RE'IURN.
[ Format applies to area: E2)
And say this format applies to bow many cells, it only applies to E2 at the moment so just press REnJRN
and
it's given you how much money you've got in that cell.
[would have been quicker 1.0 just toggle the formula using F1 before entering]
Copy formula
now what we can do, is you can COPY it, all the way down, so if you press F8 again, press c or you could
use the arrows to get across to it.
[ Copy from area: E2]
From area, well you could COPY a whole block of trext, like you could copy from A2, the area you want to
copy could be A2 to B4 but what we want to copy is E2 so if you just press RETIJRN.
[ Copy to base CO<X"dinate: E2]

mere,

mere
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~ you want to COPY it to is E3 to E4, you can either type that in or you can use the cursor keys you type
m E3, and a colon E4,
[Copy Values All ]
and it's saying bow do you want to copy, do you want to copy the VALVES which would put 60 in those two
or do you want to copy ALL so you press the arrow
so whal's the difference
VALUES it will just sticlc exactly what's there so it will put 60 in these two but you don't want to do that so
press REWRN now
so all will copy what
[ Copy Relative Absolute Prompted )
tben it gives you another choice, RELATIVE ABSOLliTE PROMPTED, RELATIVE is saying if that was C2
times D2, down here it would be C3 times D3, in there, ABSOLUTE it still gives you C2 times 02,
PROMPTED asks you if you want to put the actual number in. So you actually want RELATIVE. press

RE1URN,
[f0110ula cq>ied to E3 and FA]
then that gives you the, you've got the different values, if you go down to the bottom of that column, ah you're
still in the MENU so press undo.
Formula
You can now put another equation in here [E5) which will give you the total amount you've taken. But it's best
to leave a line under there which we can fill up later with just minuses or something.
(nwves cursor to E6)
You now want another equation which is SUM of yes just type SUM, bracket and then you want all the
numbets in E2 to E4, so E2 colon E4, bracket and then gives the sum of everything E2 to E4
(types "sum(E2:E4)")
so press RElURN, now again that's TEXT we want a number so press MENU, then FORMAT again (changes
toNUM through DATA_TYPE)
[F7 would be quicker) - you've got here something cut off, so can you
yes you need to widen that slot [D] that column which is FORMAT I think so press REI1JRN again

so formalting does what?
Change width
formatting changes bow everything reacts in each little cell, like to start with that said SUM(E3:E4), DOW it
says a NUMBFR. because we changed the FORMAT and that's actually an equation. So the FORMAT of each
one can be changed and we want to change the FORMAT of this one to make it longer so FORMAT WIDTI{
[Set width of this column to: 12)
and the width is already set to 12 we want it to be - another two and a space after it. another three, to get the so
if you type 15, that gives you a column width of 15.
[Set bow many columns to this width: 1)
How many columns this width - just one.
[column E set to width 15)
I think we did it to the wrong column, we did it in E it should have been D, sorry that's my fault, if you press

UNDO

So if you put it baclc onto column D which is the one you want to widen, press MENU again, FORMAT,
(sets coliUTIIl D to width 15)

Change attributes
yes to CENTRE numbers we want FORMAT again and ATTRIDUTES,
[ NUM [R 2 -) LCR1 [????????] ]
now you have a whole lot of choices, the LCR is LEFT. CENTRE or RIGHT justified, well for this number
of seats sold it's best to have it in the CENTRE of the column so you just press CHANGE twice I think
CHANGE is f7, you want C so that's right, then move across [the question marks] using the arrow, tbal gives
you PI, to fmd out what they are just press HELP, F1, it tells you bow to move around (moves across ··rs)
Tbat's bow many decimal places do you want, number of seats, you don't want any, press CHANGE oocc tbal
sbould give you nougbt it won't give you any decimal places, if you go across again you could have dollars,
deutschmarks, pounds <X" per cent and you want the pounds for later on for prices of seats so move along.
[ Format applies to area: D6)
Area it applies to, if you move the cursor up to the top. move it down one sorry, then press coloo, did you see
bow as you moved the cursor tbe number changed, move it to the bottom again. Right that's tbe area it
applies to. you could move it aaoss columns as well so press REnJRN now
[nwnbers in D centred and DO decimals]
and all those nwnbets tbere are CENI'RED.
If we come back to the price of the seat now [E) Now if you go up to the top, you can actually CENTRE tbe
name price, put it in the CENTRE of the colunm, do the same as we did before this time it's (instructs co.
experimenter to CENTRE number in E)
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Filler character
Another thing you might want to do is to put in a FILLER like an equals line tlle tlling to do there is if you
move the cursor across to it [E5] and you could type little dashes or what's known as a FILLER. so go to
menu, FORMAT, FILLER
[ Set filler to: ]
set filler either underline or a minus, it depends oo the preference.
[ Fonn.al applies to area; E5]
Yes that's the area it applies to. There you go.
[lines of dashes )Iinted in E5]

Recalc
If you go back to MENU, you've got loads of things you can do there, RECALCULATE is an important ooe,
if you change some of these numbers those will stay the same until you RECALCULATE and it gives you
the choice as to RECALCULATE the whole table wbicb is easy to do now, being a small table but if you get
a very large table it takes a long time to RECALCULATE everything, so it gives you an area to recalculate
over tells you wbal you need to know about,
INSERT is to insert a COLUMN or a ROW if you suddenly decide when you've got the column in there that
you want to shift tbal across one and it will also change all the equations for you, or DELE'IE will do the
opposite
so if you want it between B and C everything in C will be in D and D in E etc etc. You can INSERT both
COLUMNS and ROWS, DELETE just does the opposite.
Save
Another important thing is to QUIT bow to get out of it, just press q and that gives you SAVE OPTIONS,
[ Quit and Save: Model_Selection_Menu Options Context Save_Backup Save_New_Model ]
you can either go back to the very beginning of the whole program and it will SAVE it for you if you do tbat.
SAVE BACKUP but it's just if you're doing a long one, a large one - you might want to keep saving different
bits of it to make sure if anything does go wrong you've got a BACK UP, SAVE NEW MODEL, if you
change an old one and want to keep it under something else
so which one
just MODEL_SELECTION_MENU.

Comparjsoo-Subject 11
[empty sp-eadsbeet)
well that's your actual spreadsheet and it will go down a very long way, you can try it keep going down it will
scroll around. There's the letters and they go a to Z and then it goes AA AB AC, so there's all kinds of entries
you can use

Enter text
It's just like a matrix and each of these entries you can enter DATA or TEXT, you can either input 1EXT or
DATA or FORMULA because then it will work out from previous entries so have you got any actual particular
thing ..If you put in a number of items, how much each one is. You want text at the top so type in item,
number of items
(types

"number of items")

it might not fit in there [column could be widened) so try and abbreviate it to N-0, that should fit in
(changes to "no of ilems", CR)
yes it's telling us it's TEXT, as that box !here is full you can move over to the next one [Bl) using the cursor
keys and then bave another column here of cost

(enters "cost" in Bl)
later on 111 show you how to use simple arithmetic to work: out a total cost
(starts typing "total")
sorry you have to move across flCSt.
(moves cursor to CJ, fmishes typing, CR)
[entry in 82 overwritten)
We sbouJd have moved across flrst before, so start again, total cost, move across first ...

(sorts tat entries out)
Enter numbers
I'm trying to think of any other columns I could do. We want to arrange it so you have all your columns going
down with different values put in.
(insttuct co-experimenter to enter number in A2)
(does) What's thal? [NUM]
weD it's a NUMBER and tbe number of decimal places is two, I'm not sure what the others mean
so how do you make it NUM then, or TEXT

Enter Dumbers as text
well if you wanted to type in, you see that just thinks it's a NUMBER, but say if you just wanted to type in 10
rather a TEXT 10 you'd got to the MENU. press MENU there then it's WINDOW, so W, then it's - [tties to
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to~gle di~play instead of data type] sorry I'm confusing you there thaL's completely wrong, so if you make a

nus~ like that press UNDO tc go back to the start again you can actually change it by pressing that ooe there
[ wanung beep ]
type in 10 again, that one, that's it so we actually want it as a number, Ok now move over to the cost,

(insttucts coexperimenter to enter number in B2)
Formula
and total cost would be number of items times cost, so move across [to C2] so now you've got a formula you
bave to work out, and that would type in by looking at the values in the formula which in this case is A2,
that's tbe box A2, so just type in A2 press multiply which is that one - asterisk, and you bave to multiply by
tbe cost which is in B2. Now as it thinks that's lEXT, because it sees the "a" but we want it as a formula so
you bave to press F7 to change it to a NUMBER. Now press RETIJRN
[result displayed in C2]
it's wOt'ked it out for us.
Copy formula
Now if you don't want to do that every time, moving across and typing the formula every time you can make it
a lot simpler for yourself by COPYING it down the page, let's see, press MENU
what is it thai w~ ar~ trying to do?
well what you want to do is say you've got 10 lots of different items say A3 time B3 in the next row you can
make it a lot easier for yourself you can COPY that formula there 10 times. If you wanted to COPY it press c
for copy,
[ Copy from area: C2]
now it's asking us for the area, in fact we want, that actually says. it's asking how far across. how many
columns we just want one column, so it's C2, press a colon, shift and that that starts at column C2, tbere
where you want it to go up to, column C2, if you wanted to copy two columns say, column C and column D
you'd put C2 and then 02, but we just want that so press RE'IURN.
[ Copy to base coordinate: C2]
Tbe base co-ordinate, that's telling us how many rows, so we're going from row C2, there which we want so if
you press colon again, now if you press the cursor keys again to keep going down, the down key, bow many
rows we want is down to 10, just press RETIJR.N.
[ Copy Values All ]
Now then that's telling us either to copy all the VALUES so print down 25 or ALL whicb tells us tbal we
want ALL, in other words formulas and everything formulas not the actual VALVES. so press ALL which is a
[ Copy Relative Absolute Prompted J
Now I'm not sure what the others mean here because I've only ever used the RELATIVE. So we just want
RFl..ATIVE here
you don't know why though?
DO I

don't

["?n?" printed in C3- CIO]
Ob it's put up these query marks because we haven't actually inputs the values here so now if we went back to
these columns and typed in something. you bave to UNDO it first, every time you've finished with the MENU
press UNDO, so just go down and all the empty spaces put in
(enters data in AJ-810)
Recalc
ok as you can see it still basn't actually worked out the total cost because we haven't told it to do that yet so
when you acllJally input it all, the values you want to work: out you have to go back: to the MENU again and
actually teD it to wOt'k out the values foe you. So go back to the MENU again
(does)

(reads) which one is it? RECALCULA1E - so you have to press R

this will do
yes it will do all the calculations. It's a lot easier way than working out where you want the values to go ro.
If you just press F4 which is CALCULATE it will worlc out all the values for the whole square, foe the whole
mabix that you've got.
(OOts)

yes tbal's it so it's actually worked it all out, it worked out all the values there. So if you want to get back
out of the MENU again press UNDO.
Now then, the pointer here [below spreadsheet] is actually which square you're in so in this case it's B10 and
the current one if you were using COPY, if you remember we started up there and moved the cursor alllbe way
down to the bouom. Now at that stage the pointer would bave showed !.bat as C2 and the current would bave
been at C10. This tells us you've gone from C2 where the pointer was and the current position of the pointer,
sorry the cursor C10. You understand tbat?
?? total cost it's working all out here now, but cost is over there and number there can you
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Change attributes
you can actually FORMAT it to malce it look nicer, yes. Or an easier way is just put a lot of spaces in before
cost to move that aaoss. It's cheating a bit really but if you want to FORMAT it better it's quite complicated
to actually do. I'm not sure how you FORMAT it. I tend to leave it. If you did want to bring that across go
back up to the top .again (moves to B 1) and put in lots of spaces, like that (types a number of spaces tben cost)
and it would actually take it across because when it actually works out these values it puts in two decimaJ
places, there are ways of changing bow many decimal places you've got and the actual decim.al pointer to the
box

so there's a limit to the number you can put into each box?
well for cbaracters and that you've got the whole of that box, is actually that. but you'd only actually see that
bit. I think there's about 12 cbaracters across there. You only actually see 12 characters in the screen for that
box but you could have that many. You could try it if you want, try putting a really big number

in here (does)
yes. See what happens, does it take iL Oh it's actually abbreviated it to 1.23 and the "e" stands for. exponent
But now you see it still hasn't actu.ally worked out the cost for us
so how do you do that
so we'd have to go back again and RECALCULATE it which was the MENU, recalculate and over the wbole
area so it was CALC, see it's quite messy because you're using big numbers

Delete row

ok. say you didn't want any of those values any more you have to go down to the row you want to DELETE.
go back to the MENU again and press DELETE,
[Delete ROW COLUMN]
it's asking do we want to DELE1E a ROW or COLUMN and we want to DELETE a ROW.
[Delete row(s) starting ac 4]
a ROW starting at 4, which is the one we want to DELETE
[How many rows/columns: 1]
we only want to delete 1.
[row 4 deleled}
That's deleted it and moved all the others up

so what's happened now
it's deleted the row wbicb we didn't want and all the rows below it it's shifted up 1. In the meantime it's
recalculated all these, all the formulas here and the formula for that could be quite complicated and it will stiU
work out the new formula since it's shifted it up one.

Save
Now say you've done all the sis now and you wanted to SAVE it and you want to come back to it again the
way of saving is getting back to the MENU, it's QUIT/SAVE so press q,
[Quit and Save: Model_Selection_Menu Options Context Save_Backup Save_New_Model ]
now it's asking us wbat we want to do. we want to actually SAVE THE NEW MODEL, sorry
MODEL_S.ELECTION_MENU, go to that menu and it will ask us [opening menu]
it's come back to tbat - because if you do that first time it will automatically SAVE it.

Comparison-Subject 12
Right wbat you c.an see there is actu.ally the sis itself which is divided up into columns which are labelled with
letters and rows wbicb are labelled with numbers. in each of, ok you can put virtUally each of these is a ceO. you
can put virtually anything into it. 1EXT or NUMBERS, and if you imagine say a shopping list right, at the top
you'd have a title saying item and then price and then a whole list of numbers with prices and at the boUom
you'd have a to1a1 and you can, this sort of ide.a is the sis
so you can put different things in the columns

Enter text
so for example I'll just show you bow to move round it, just use the arrow keys so you can see the cursor move
around. So if you put the cursor toward the top somewhere and if you type example spreadsheet,
(dots)

Change width

press REnJRN you11 see it's aciUally entered it onto the sis. Now as you can see it has actually gooe over two
columos and that's because the column width is narrower than the text you've put in. If you want to tidy that up
for example so it fits in the column you press the menu F8 key, this gives you a menu of all the optioos
available to you and whal we're interested in is FORMAT, so if you, you can either move tbe bar around using
the cursor keys or you can type the first leuer of the option you want. ole so if you press f.
[Fmnat Width Attributes Ftller_cbar Data_type]
Right now we're interested in the WIDTII so if you press RE1URN,
[ Set width of this column to: 12 ] it tells you the current width is 12 and so you can set it to 20 [need
not have done this unless be wanted to enter something in B 1]
(does)
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[Set how many columns to this width: 1J
and it gives you the option now of setting all the columns to width or just leaving it at that one so we'll just
leave tha1 one, so it's widened it
We~ for example if you, th~ usual way is of costing, trying to work out how much something's going 10 cost.
you ve got a num~r of vanables and you can juggle with the variables to see the effect eacb one has oo the
fmal outcome so if we try something like • if you move down a number of columns

(moves cursor)
Ob sorry wbat's happened is we're still in the MENU so you type UNDO Lbat gets rid of the MENU and now

the cursor moves around the sis. Right now if we're talking about something like building an extension of a
bouse and you give it certain parameters like how much floor space, how many doors and windows, you can
work out a rough cost so for example if you move down and put a beading, floor
(types "floorH) so what happens here, you type there and it goes into there [input line]
yes, enter tbat in,
(lhes)

Enter numbers
that becomes your beading if you move down under there [A5], that's it you now have to specify wbat you
want to give it. now in this case it's going to be a NUMBER you want to put in, so if you type in a number,
(lhes)

say 10 or whatever, you see it's come up there it says NUM for NUMERIC if you press RETIJRN you11 see
tbat it's RIGHT justified so it's right to the other end of the column. And that on the end is a thing called tbe
ATTRIBUTE and we11 see what that is in a minute.

Formula
Right. Next if you move across 10 the next column you can put a formula in there, now that is actually a
calculation using data that is in the sis already or if you want to work out Lbe amount of concrete needed 10
cover the floor area you do, you want the data you've taken out of there, so it's stored in cell A5 and you index
it by the column first and row and then for example say it's two kilos of concrete to cover 1 sq. metre, then
you'd type here A5 times 2 that's the basic formula, we could actually enter it into the sis. At the moment it
thinks it's TEXT, we baven't IOld it any different, if you press the F7 key, that's actually the CHANGE key
and that will change it to NUMERIC, enter that now, it will actuaJiy do the calculation and you've got your
answer tbere. And tbat's basically
soil does ???

Change attributes
yes, if you move up to- say this title here using the cursor [A 1) you can see it says it's definitely 'TEXT and it's
left justified, see that's NUMERIC and it's right justified, you could use this to actually tidy up the
FORMAT of the thing so it will all appear in columns. We're looking at this this is the ATTRIBl.ITES of
the number you're looking at and if we go 10 the main MENU again which you get to by pressing MENU and if
you type f for FORMAT now
[Format Widlh AUributes Ftller_char Data_type]
if you move the bar over ATfRIBl.JfES and press R.ETIJRN,
[ NUM [R 2 ·1 LCRl[????????] 1
rigbt. this is a bit. it's double dutch really but it's alright once I show you what it is. It's an aUribute of
NUMBER this one for example is the number of decimal places after a number, that one is wbat the figure
represents, for example dollars, pounds or percenttage, and that one is set up so it's RIGIIT justified and to
change it you just use tbe CHANGE key [uses F7 instead of space bar]
so LEFf centred, RIGHT justified th.e flfst column so if you press that to say C, that's it now press RE11JRN.
[Format applies to area: B5]
What you've selected you said right I want to CENTER the column and it's asking you what area 10 apply it 10
so you can either leave it as an individual cell, or apply to a whole area, the way you specify areas you use
colon to delimit so that's the lOp left hand comer and you'd have to set the bottom right hand corner. For tbe
moment. you can leave it just as a single cell so if you press RE1URN
[entry in B5 centred]
right and it's done what you asked it and CFNTERED it.
Using tbe ATfRIBUTES you can set up to, you could have, it would recognise it as pounds or pereentage or
things like tbat.

Formula
Right. OK. so we'll try something next, if you want to move to the next column, still in the MENU so UNDO
that's it. now if you want to enter say you said that if cost two pounds per kilogram of concrete and we've got
the floor area and the amount of cooaete we're going to use so we want the IOtal cost of the concrete so right if
I said it's two pounds for a kilo of concrete, what's the number of kilos we need then you enter a formula to
cooaete tbat

so whaJ would thaJ be? 85 times 2
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that's it. great tbere we go .and if you go to the MENU and select FORMAT, you want to change the
ATfRIBl[fES to show that ts money so use, that's it to move through until, yes, that's tbe options. that's it.
~ow you JUSt want that cell for the moment. good. Next thing. Trying to think what to show you next
if you move the cursor to actually,
(moves cursor to A4)
you ~ it says TXT for TEXT and actually treats it as just a piece of TEXT. as far as we're concerned it's just
a h~g for a column to make the layout easier to understand, for example in the next column you could put
say kilos of concrete used and. that's it so if you.
(ensers text label in B4)
press RE1URN
and again the column's not wide enough so you could widen that
(does)
Right so if you go out from the menu then if you change some variables for instance floor area. so if you now
type, 50 say, enter
(does)

Recalc:
you see it's actually put it in the spreadsheet but it hasn't recalculated the values and to actually get to do that
you have to go into the main MENU again. There's an option tbere RECALCULATE, right now it's asking
for an area. There's two ways of selecting areas you can either type the area you want to recalculale into, for
the moment all we've got is this area here with figures in so that would be A5, colon, and then C5, right.
So if you press RE'IURN now,
(does)
it's updated the values.

Copy rormula
It's actually set up to be large and you can move in either direction but you only see a part of it As I was
saying once you've got one row sorted out you can expand that. if you wanted to say compare several options for
the same thing instead of having to go through all the process again of typing in the formula for each, under eacb
.beading and putting figures in you can COPY tbe whole lot down. so if you go baclc to the main MENU you'll
:see there's a copy option wbicb is C,
[Copy from area: AS]
it's the same idea again with an area. so if you select the area that we've put numbers into
it actually asks for an area there so you want a colon in between and then the column.
(Copy to base coordinate: AS]
What it says bere is base co-ordinate so once you've told it the area it knows the size of the data so all it wants
now is the new position for it. so say for example we just move down one column and go, no what it needs is
actually the one co-ordinate for the area. so as I was saying now it knows the size of the area you want to move
so if you give it the top left hand corner it can fill the rest in itself
[Copy Values All]
now what you can do there is you can just COPY the VALUES which is what you see here or if you use the
otbez optioo which is the more useful one, ALL- that will COPY all the formulas you've put in and relale all
tbe dala togetba,
[ Copy Relative Absolute Prompted 1
in COPY there's three ways of doing it, RELATIVE which means that - for example we're copying down a line
it will COPY all formulas down by a line and it will increment the values for example tbis formula in bere
relates to tbe data in bere so 85 equals I think ifs A5 times 2, move it down using the RELATIVE option it
will go to B6 equals A6 times 2, ok, if you use the ABSOUITE option the formulas stay the same so you11
be copying it again, and tbe last one is PROMP1ED and that's used when for example you put a constant value
up bere. for example, the cost of concrete per kilo because that doesn't change throughout the calculatioos so
you can leave it in one place and if you used this option to COPY it would actually change the address of that
cell and it wouldn't be able to find the data. At the moment we haven't got any constants so use tbe
RELATIVE optioo.
Saving it well there's an option on the MENU QUIT/SAVE so if you type q wbicb is the ftrst leua-,
(Quit and Save: Modei_Selection_Menu Options Context Save_Baclcup Save_New_Model ]
just press return for that

why?
Save

eacb of these different options, that one, sorry this is actually leaving, you typed QUIT to leave the sis., this if
you hadn't made any changes type RE1lJRN now it would just go directly baclc to tbe selectioo menu, fm not
sure what the options do but these two here that SAVES A BACKUP copy under a different name so you can
keep a record of what you've done before you change i~ that is SAVE A NEW MODEL, wbicb is what we're
interested in. You'll find. if you go baclc to the ftrst opt10n and press RE11JRN, because you've made changes
and haven't actually saved it already then it should come up, oops, sorry
what's happened?
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I think we've just lost it
A-have you

I'm not sure
A- why do you think you've lost it?
it did on my model wben I did that before
A- you were waiting for quit before and after saving were you?
yes
A- bas it saved it now?
?? I don't know
A· you could look up what you've actually got on disk now couldn't you? Try to load that one up again
(does - model is there)
A- so why didn't it ask you to quit BEFORE or AFfER SAVING
was it because it was a new model

Comparison-Subject 13
[selects existing model from disk]

This one looks like, right, this is what I meant by the rows and columns and the information in the rows
so it's like a table really?
yes that's right, it looks like marks or something, exam marks or something. See these are the names and
that's what John got on course A and course B and then you see that column's the average, the average would be
worked out by adding tbose up and dividing by 4, because you can, this, that, you move that again with the
cursor keys and then, yes, because tbese are like little boxes labelled A2 or something, which we're in at the
moment you see? and then this [pointer] tells you where you are as well it goes from a to z and then starts again
aa, ab, ac

however much you want?
Enter text
yes it depends bow much space you've got in the row or on disk, it probably goes down quite a way as well, I
don't know you can just and then as well, see it's got 97 there [above input line] that's because that's where it is
at the moment, this means number because the 97 bas gone in as a number you see because if you write. go
down here, and then you can put some TEXT in just like for instance, and this means TEXT, and lheo, this is

C9

so how did you do that, how did you get to that
this, just by moving it, with the cursor
and you just type anythillg in arui it will come up, ok
Enter numbers
so it does it itself that and you delete it with that, I'll show you and if you want to put a number in, like 67 see it does it automatically
and you just press RETURN and it goes int he table?
yes. You see that's gone in to the right of that. I don't know if I can remember how to CEN1ER it again
actually. We'll leave that there for a moment. And then press the MENU button, that one and it comes up with
all tbe options you can do, I don't know a lot of them, what they actually mean, but. let's see which one was
it I didn't actually use a lot of these, the COPY one's quite useful so and also

whal does the copy one do
that, yes if I just, - right there's a thing called - if you toggle it you can see because you can put in formulas as
well. Now see for this- it's obviously added these and then divided by 4. We can write in like this would be
B2 plus B3 plus B4 plus B5 then the whole lot divided by 4, you can write that in so

can you get the average here by telling it what to do with this?
Toggle display
yes and you can see the actual formula you've put in by going to the MENU first, press w for WINDOW, and
then v for VIEW, and then EQUATIONS and tben CARRIAGE REI1JRN
[saeen toggled]
oh I see
and then to see, if you press the UNDO button that gets you out of the MENU so you can see better, yeah,
and if you move the cursor- to highlight this one [formula) see it doesn't all fit in on the saeen but it canes up
there and that's, there's a SUM command and that means SUM B2 to BS, yeah, divided by 4 and that's bow
you can do it and then, see that is obviously the SUM of C2 to C5 and COPY.

Formula
Yes say, if you go over to tbe top there, tbe next column [D l] say you wanted to do, say you wanted to SUM
the two marks, course A and course B, so you could write in there SUM so you know what the column
means. And if you wanted to make it look a bit neater you could put some spaces in fust then put it in lhe
middle so try it again. 1ust put that, four spaces in

thai's bener
yes, and so sort of what would you do to add those two up then do you think?

I suppose you say 82 plus C2?
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yes - so you w~t that to go in this box [D2) because that's where you want the result to come out

_can you do 11 so you only put one command in, and ir does ir for all of them
yes if you use the COPY command to make it go down you see so if you go down, because that's where you
want the result to go and then, yes, just write
diJ you use that, surely it will just print it up on the screen
DO because if you just put B2 to C2 because that's what you wam it to do
(types)

you put it in, when you put in a formula they have to go in as NUMBERS see it says TEXT at the moment
because you've written a letter o it thinlc.s it's still going in as TEXT, in which case it would just print it in,
you can see for yourself if you just do it
(CR)
[formula printed in 02]
that's not much good is it? so just do B2 plus C2 again, and then press that and that changes it to NUM that
NUMERICAL bit and it knows that that's a formula and it bas to do something with it and then RE11JRN.
[formula printed in 02]
Ob - ab why bas it done that? (thinlc.s) I know - yes it's because we're still displaying the formulas so 10 get
bact to displaying the values you have to go through that process we did before which means you press the
MENU button and then W, and then V again and then RETURN again, that's it, you see it's done it
automatically and the thing you have to remember as well is when you put in formulas when you're using
values in the cells there have to be values in there already or it will just come up with an error [would print
"?n?"} and it won't do it because there's nothing in there and it's trying to do it, it won't do that

Copy formula
and then tbe COPY right
[Copy from area: 02]
that's right. that means COPY FROM AREA, you're in 02 at the moment as we're only going down it's just
from 02, say we wanted to do sort of, more than one row and column then say you wanted to do it in E2 as
weU for instance, you'd need to go from 02 to E2 down to there so you might want to go and do the next two
columns, l1l show you that in a minute but for now just press RETIJRN because we want to go from 02
[ Copy to base coordinate: 02]
TO BASE CO-ORDINATE, that means and the last co-ordinate you want to go to so if you press the colon,
yes that means from 02 and then you can change this with the cursor keys so if you move that 10 wbere you
want it to COPY TO [05) down again, yeab, and then, well it won't
[Copy Values All ]
DO so if you just go up one, press RETIJRN, then we want AU.. the values to be copied so press a.
[ Copy Relative Absolute Prompted ]
and then just press REI1JRN for RELATIVE, I don't quite know what these things are, that's just what we use
and then it does it automatically you see. If you wanted to see the formula you could toggle it again by going
to MENU WINDOW VIEW again, if you want to do it just so we see it's done properly.
I think we can see that

Change attributes
right, so that's the copy. What else, yes, I think we'll try and CENTER this, it's FORMAT so, if you press
UNDO fiJ'St and then UNDO again, now if you go to this value 67. I hope I can remember bow 10 do this DOw.
Press the MENU. F for FORMAT
[Foonat Width Attributes Flller_cbar Oata_type]
then you want the ATfRIBUfES so A, yes
[NUM [R 2 -] LCRl[????????] ]
let's have a think, maybe F7, try it because you want this to come up, it goes L, R and CHANGE, wbicb one's
CHANGE, Fl. try pressing F7, is that
is that change - you just have to bww that do you?
we've all been given the information about the. Yes it's just changed to L that would LEFr justify it, that
means it would be printed to the LEFf, you need to do it again, that means CENTER, so if you press

RE1URN,
[ Format applies to area: C9]
R>RMAT WJDCH AREA. we're in C9 so if you just press RETURN
[eolry in C9 cattted]
Recalc:

it's centred it Quite clever isn't it. Oh to change values RECALCULATE something we could do that
so you just go to a box and change il
so press UNDO to get out of the MENU. Right. what sball we give her (types 60 in one of the columns f<X"
marts), rigbt, it won't RECALCULATE automatically, you have to tell it so,

press MENU?

that's right and then, yes and then you ca_n eit_her tell it do a set.area o~ to RECALCULATE everything that's
there you press that one [F4] and it does hke nght to the end. Its done 1t see.
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.
so this is showing you how to put things in and store them, what else can you do I suppose ??
tt real~~ depends, you know what I said about the glass manufacturer (classroom example] ?? accompany 10
show Its figures and profits, so it's quite useful for accounting purposes as well.

Save

If we look at one of the others on there, SAVE it
so .how do we do that?

pressMFNU
andexil
no QUIT
[Quit and Save: Model_Selection_Menu Options Context Save_Backup Save_New_Model]
MODEL_SELECTION_MENU, that means we want to go back to the MENU, so you want that
[Quit Before_saving Witbout_Saving]
WITHOUT_SAVING?
yes. Rigbt (decides to maJce up a new one]
[empty~]

so that just gives you the basic table
yes that's rigbt Try to think of something now. You could, I don't know, days of the week and then some
sweets you buy or something
say if I put Monday, Tuesday WednLsday Thursday down
yes if you want to do that go down the rows first and leave the column beadings until later. Go down one fust.
(enler text labels A2-A6)
right so we've got 5 days. Along the top you could have names of different sweets or something and then in
the columns the number, bow many you buy
Right so if we got to here, so put the column beadings in ... (instructs co-experimenter to enter column
headings in Bl-E1, and numbers in B2-C6. and E2-E6)
if you wanted the computer to work out the price then how could you do that, you know the price that you
spent on Monday.
well the price is 10 pence say and then you can add up how many packets he's bought times lOp and that will
give you bow much be spent
that's in a week though but if you wanted to tu1d up all what he spent on Monday on different things
ob I see then you'd have to have a column in here price times 10 times number of smarties. If you want to just
delete this tben, just enter nothing, just put a space and press RETIJRN. Leave that there I suppose, it will
just ignore it. Right, so if you put here money spent if it will fit in.
(dek~s current ~xt label, and enters "nwney spent" in Dl)
[could bave inserted a new column]

Formula
Ob just, and then a formula for tbe next bit to tell it bow to work it out. Go down one. Right say you have
tbe value in B2, times- put bracket first, times, 10 then bracket plus

bracket
actually you can use lbese.
(types H(b2*10)+(c2*10)", CR)
[bad syntax at entry D2)
I didn't put the (closing) bracket
just press undo. (tbe machine beeps)
.
I think 1 pressed RETURN rather than SHIFT, try pressing RETURN. oh that's ok

Copy formula
and then to COPY down to make it
so lww do we COPY, do you have to go back to the menu?
yes, c. right just press RETIJRN, move the cursor, that's it, can you remember which one
values, all (fmishes copying)
that's done it and like you say you could tell different things now, say bow much money be's spent in a week.
there total, sony, UNDO first, move down again to make it look a bit neater. Yes just put TOTAL. Now
you have tbe SUM, sum. you want the SUM of D2 to D6
I just write SUM?
yes, then bracket. D2, colon, press F7 10 make it go onto number

andREIVRN?
[result printed in 08)

Save

now pess the MENU and Q for QUIT/SAVE
[Quit and Save: Model_Selectioo_Menu Options Context Save_Backup Save_New_Model ]
right you want this again [Model_Selection_Menu] and it asks you whether you want to do it BEroRE or
AFIER SAVING, press RETURN.
[ returns to spreadsheet main menu ]
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Ob, it does it automatically

it saves it

~es. it only asks you wh~~ you've ~tered it. like if you went into it again, if I just show you. Press RETIJRN
It was called percy wasn t 1t. If we JUSt change one of tbe values make it six packets of polos for example, and
!ben RECALCULATE the values again.
(lbes)
it's done it so ~·s been altered you see so press Q and ENlER, you want it AFTER SAVING so you press
RElURN agam. So it SAVED it. initially it always SAVES it and then if you alter it it asks you

Comparison-Subject 14
[empty speadsbeet]
Right this is the basic spreadsheet design it will give you so many columns A to whatever, I,J, I don't know,
however many you need for your spreadsheet

so whaJ happens if you get to Z and you want more columns?
Enter text
I don't know. I'm not actually sure ... [AA, AB etc.] and we've got all columns down It's just the cursor to the
left or up/down. Right so say for example you put in, start of by heading it to give you some example of
what we're going to put in, say if we call it I don't know - glass. (starts typing) What we actually type in gets
recorded in this box [input line] and what goes onto that white line is what it's going to record in then when we
press the RE1URN key

why glass?
it's the sis we bad to do for a project. [classroom example] So then say as an example we could put different
sbeets of measurements for different sheets of glass so we calculate the density, bow much they'd be per sheet
and tben tbeir cost price and that sort of thing. Press ENTER
[entry printed in AI]

Enter numbers
and it deposits what I first typed in into there, that box. Right. so then we can carry on down if we start
putting in the length of the glass sheet so if we type in length (instructs co-experimenter to enter text labels in
A2 and B2, and numbers in A3 and B3) Right. if we want to calculate the area of that glass say length times
height then we'd take A3 which is that figure in that column and than we'd take 83, so A3 times 83 right?
(types heading "area", enters in C2).

Formula
Now to put your formula you type in say A3, these three letters mean it thinks it's 1EXT, you want it to be
calculated as a NUMERICAL formula so you toggle between TEXT and NUMERICAL, just shifts it one to
the other. Right, which is F7. (does. CR)
[result printed in C3]

Toggle display
So you want A3 times B3, right it's input into lbere, it's taken A3, B3 and you get the result. if you want to see
what formula you've put in, MENU. that is standard, this is just so it will show you what formula you've got
in each box, so you can check the formula, w,

w?
v, yes, W gives you the WINOOW VIEW
thaJ was in the MENU was it?
yes, and tbeo so we want EQUATIONS, so lbat you can just check our formula [she could see formula displayed
above input line if cursor is positioned on cell in question]
let's get out of bere, we get out of the menu by pressing UNDO, I suppose we ought to have the width really.
WeU we can do a spreadsheet saying, we could do the cost price times area by a certain number of panes to fmd
the cost of that sheet of glass, so do cost

(starts typing, realises cursor is in D3, moves cursor to D2, finishes typing) I thai all righl now?
yes

(CR)
[entry printed in 03]
ab weU, you11 just have to type that again, and write over that one [in 03] so say we want the average price, I
don't know say per square metre, so what you want to do is take the number of square metres we've got hele

thaJ's C3 is it
yes, so we take C3 times whatever we choose for
OK (types "C3*2.50")
right that's gone in as TEXT so toggle it. F7, tben just RE1URN,
[formula printed in 03]
thai's just the fonnula
Toggle display
yes if you want to check whether il's gone in we know that's two, the area's going to be 2 metres square, just
check that it's right. just do MENU. tbis is just a reverse way of doing it

whaJ was iJ - WINDOW?
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now v, just a standard, just RETURN. If you remember MENU, w, v, RETURN and it just goes through the
stages.
[toggles to display result}

how do you, can you put the numbers so they're in the centre of the columns? Because it looks a bit
funny on the end there.
Change attributes
good question. I haven't aaually done that you thought it was FORMAT, right?

yes
(selects FORMA1)
[Format Width Attributes FJ.Uer_cbar Data_type]
(reads options) WIDTH, ATTRIBUTES, FILLER CHARACTER, DATA TYPE,
FIU..ER_CHARACfER I suppose.
[ Set filler to: 1
Maybe not. We won't try to do that one then (quits menu).

we'll go for

Copy formula
Right, so now you've got those two formulas there, you now want to repeat the calculation for say a list of five
different widths of glass. Right so if we go back and start with the two formula windows, what you can do is
COPY the formula down the column, where that one is A3 times B3, you can have it there so it goes A4 times
B4, A5 times B5, without having to do any more individual calculations, so if you go back iniO MENU, ok and
press COPY.
[Copy from area: C3)
So you want to copy from C3, so you put C3 colon C3, that gives us that area
[Copy to base coordinate: C3]
So press RETURN- oh that's to base coordinate, ob tine. OK we'll go back to, MENU, start again, press the
ftrst character see it piclcs up ??
[Copy from area: C3]
so we want from area C3 so you put C3, C3, because we want to start from that,

(enlers"C3:C3" as instructed)
that's fine press RETURN.
[ Copy to base coordinate: 1
Right copy to, so bow many do you want to copy- down to row 10?

ok
right so you're going to press colon and you move the cursor down to where you want your list of aJl, to go
down to- row 10?
ohl see
so you get C3 colon ClO. You press RETURN.
[Copy Values AJI ]
Right you want to copy All..
[list of "2.00" displayed in C3-Cl0]
OH it's given you a row of two's Right, we'll go back to the MENU again
~
[ warning beep l
we're already in MENU, Right if you go back to formula again and it will obviously do (tries WINDOW,
VIEW, CR. no change tries again. nothing changes). Ob dear. I don't know what to do.
(experimenter explains that she bas overwritten the formula by copying the result over it)
(enters formula again, toggles display to show formula)
[which bas nothing to do with bow it is copied)
[Copy from area: C3]
so from area C3, I think we got the copy from and to bit right
[Copy to base coordinate: C3}
we want C3 colon, just go down as far as 10

and RETURN
yes

ALL
yes.
[ Copy Relalive Absolute Prompted ]
Right RELATIVE, ABSOLUTE or PROMPTED. if you get RELATIVE as it goes down it will change the
row to A4 aod as it goes down each one it changes the row number, A4 times B4, AS times BS, so you want
RELATIVE.
[adjusted foonula printed in C4-C10)
Ob good ooe so you want to do the same for cost price (instructs co-experimenter to copy formula in D3)
right so we've got those formula in, so now we could say go away and find me different sheets of glass, if we
were entering in the length and height down there it would calculate it, it will just give you their area and cost
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price. Right I_ think you ~ught to enter some different values for length and height (instructs co-experimenter to
enter number m A4-B 10) tt would calculated the actual area until you recalculate it
Recalc
So if you take the cursor back to the top now, right so if you look in the MENU.
RECALCULATE. the values, so press R. that selects tbe one witb R as a capital,
[Recalculate equatioos over area: A3]
equations over area so you want A3, then colon (moves cursor so it reads A3:Dl2, CR
[display moves, but still displays foonulae]
Oh! right um
do you have to get the formula - take the fonnula away

you want to

Toggle display
it's worth a try, right. Perhaps we ought to get rid of the MENU No we don't want to get rid of MENU, we
want WINOOW VIEW, F7 will give you just ???

(Ykcts WINDOW)
and we want VIEW ...
(results displayed]

it's done iJ
Recalc
If we cbanged the values, say we changed 10 to, let's try it, change, change that number say to 31hen so you
want to see, RECALCULATE (repeats recalc on another example). So if you bad an area and one figure
instead of going all the way through altering that one figure and then it would alter the rest of tbe column or
the row for you
but what about the other things. like delete, you could just delete a single cell or so~thing could you?

Delete row
yes, it gives you the option of deletins a row or a column, just d, so which row shall we cto [single cell:
BLANK]

[Delete ROW COLUMN J
it wants to know row or column ftrst, ok just press REfURN for row
[Delete row(s) starting at: 10]
so it gives you the option there of deleting the ROW you're on
oh you have to move the cursor do you
yes it says you're starting at row 10 so if you just press RE1URN -

won't iJ just delete one row. or deletes all the ones after the one you've deleted
yes, it's swting at so say if we give it a colon ... (CR)
[Delete how many rows/columns: 1]
I said swting at row 10, it says bow many rows so we say l , and it's gone.
[row 10 deleted]

Save

right if we want to say fmisb the spreadsheet because we've done as much as we want to do, you go to QUIT
and SAVE
[Quit and Save: Model_Selection_Menu Options Context Save_Backup Save_New_Model ]
right MODEL_SELECI10N_MENU that's wbat we want to do that will then bring up tbe section you saw at
the beginning
why doesn't iJ save, though?
Should have been SA VE_NEW_MODEL? let's just see if it's been saved right, right F3 gives you a listing,
yes there you go, our one there, at tbe end of any session it gives you the option of saving the file so you can
use tbat or you can SAVE it updated so say if I altered that, went back and altered that file name

yes
I could save it as a new name as opposed to

Comparjson-Subject 15

s

[emptyyou've
sp-eadsbeet]
.
. the cursor keys. o tbe 1'dea IS
. Just
. to put
Wben
got tbe spreads beet bere you can move abo ut JUSt
usmg
data in
but into what?
Tbere is different cells. you can access- you can have a table of data ... So if you start by, we11 bave to think of
something you can use, say we use one which we did last week, different sheets of glass, so start with tbe
thickness so if you type in thickness, just type it in because you're in tbat cell at the moment
so this liM is a cell
well, if you imagine sort of a table
liU columns and TOWS

Enter text
so if you type in thickness as the beading for the flrst one
iJ's down here [input line]
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right and that tells you what's in the box . Press RETURN and it goes into the box. We want some kind of
length so if you go along using the arrow keys to the, now move along and do width and then, say, area for
the sheet.

(enters te.xt labels in B2-E2)
F;nter numbers
We11 just leave that for the moment If you can imagine for these values - you can have different values whicb
the user will input then if you put a formula in for area it will calculate the area by itself. So if you move
down to the next row [B3] if you move to thickness and imagine some thickness, say 0 .1 or 0.2, anything

really
and you're defining thicknesses in this column ? (enters number in 83)
yes and the same for beigbt and width. It could be anylbing, say 10 or 5 ...
(enlers numbers in C3 and D3)

Formula
right for the area it allows you to input a formula. (points to cell) so if you imagine that !bat's C3
thai's like co-ordinates?
yes - so if you type in the area for the co-ordinate, C3 times D3 (starts typing) won't it just put C3 illlo the box?

no - well if you leave it as TEXT - because at the moment it's TEXT but input C3 times that and before you
bit RETURN press
(finishes typing)
if you press the integer key [F7] it will convert it to NUMBERS
(F7)

andREIURN
[result printed in E3]

Copy formula
so at the same time, if you type in loads of formulas or numbers if you get the menu wbicb is that one [F2] it
allows you to COPY the values down the table, so say for formula you've got C3 times D3 there it allows you
to COPY say formula C3 times D3 but allow you to change lbe values so in Ibis row it will be C4 times 04
and just carry on down like that
I see
so if you select COPY you know how to do it using the cursor keys, but you can just press C,
[Copy from area: E3]
so if you, let's think

so it just copies the formula so when you put numbers in it?
it gives the option of whether you want to COPY lbe formulas absolutely or just the numbers so depending
on bow many numbers you want to put in - if you press RETIJRN now
[Copy to base coocdinate: E3]
then move tbe cursor down onto

what shall we do, just 5 ?
yes

(moves cursor to E7)
theopessRETURN
[ Copy V aloes All)
if you leave it as VALUES, it will copy a 100, just the value 100 if you move the cursor onto All. and it will
copy tbe wbole formula
[ Copy Relative Absolute Prompted ]
and you want it RFLATIVE so it's relative to the different columns, different rows I mean

what do you mean?
well it will copy it down and change all the 3s to 4s and 5s and so on RETIJRN
["'?n?" printed in E7]
oops- what's going oo. 1bere's also a help facility so if you press HELP ... (reads HELP entry on COPY)
did you put the righl notation in?
I think so, try again, type UNDO to get rid of that window, lben press RE1URN I think,
[Copy from area: E3]
right, so, press RE1URN,
[Copy to base coordinate: E3]
now if you move it down to

(moves cursor) that's what we did before, though ...
1 don't know why it hasn't worked, press RE11JRN (makes same selections as before)
[display tmehanged]
ah yes, that's it I remember, it's copied the fonnulas but it hasn't got any nwnbers in. (Correct] so it's not
actually copying the - so if you

so we've got to put some data in ?
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well you'll bave to put some values, (instructs co-experimenter to enter numbers in B4-D7)

Recalc

Ri~ht. ~now it hasn't calculated any of the fonnulas so if you get back into the MENU, there's a RECALC
which Will RECALCULA1E all values in the table, so if you press r [RecaJculate equations over area: 07]
~ Y~ ~y ~ant to recalculate all values so if you start with this, E4, tben press RE11JRN
[ ?n. pnnted m FA] [formula was only copied to E7, so there is notbing ro recalculate]
then, oops(experimentel" explains)
rigbt try the copying operation, press c,
[Copy from area: FA]
we want from area. can you move that up to [E3] the press RETIJRN
[Copy to base coordinate: E3 ]
if you move move it down to E7
El?
yes, so if you move lhe cursor down
but is's already there isn't it?
yes, it should work - ab. I see press UNDO we should - press COPY again
[ Copy from area: E7 ]
move it up to E3 then colon E3
(enttrs "E3:E3" as instructed) Uusr E3]
then RE11.JRN
[ Copy ro base coordinate: E3]
then move it down to E7 - then colon E7, so if you press REIURN
[Copy Values All J
ALL
yes
[ Copy Relative Absolute Prompted ]
RELATIVE
yes
[result printed in E7]
arrgb(experimenter explains bow to defme target coordinates)
(does it again, works)
rigbt, so there's also a way tbat you can actually see the formulas which is - I've forgotten wbat it is now,
shows you bow much I used it [Window, View]

what, you actually get it to print out somewhere what formulas?
yes, you can flick between the formulas and numbers so you actually see on the screen wbat the fonnulas are, so

so you press one of these, let's see if we can guess which one, is it window ?

Toggle display
yes WINDOW, so if you press W , VIEW, so V, then EQUATIONS so just press REWRN and it sbows you
equations.
If you want to get back it's just exactly the same, view then equations, then so you can go on like tbat
And you can all different. we've used multiplication, if you want to have a total, say of all the thicknesses use
the, put the formula in say total, in there and theri like

so it wiU add up something in a column
yes, it will add up the whole column
what if you want to add up just those two, or the last two in

a column can you add up part oftM column?

if you want to select things out of columns
yes it should do I think, yes because if you specify the separate elements - say B6 and B7 so if you
shall we have an - add colUIM
yes if you put totals
(enlers text label in A8)

Formula
rigbt now if you want the equation is, you've got to type SUM fU'St then brackets then if we start at B3 then
rolon aod tben 87
so what does that do, add 83 and 87
tbat sums from 83 to B7
oh the whole lot
yes and close the brackets and then change it to fonnula

F7?

yes, so then RETIJRN.
[result displayed in 88}
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Copy formula
So w~ should be able to COPY that along relative to the rest so try another COPY (laughs) (instructs ooexpenmenter to copy formula)

and you can put any algebraic fonnula in you want really?
yes, .there's also some other fWlctions, there's o ne called MAX so you put MAX and bracket so it will find the
maxlD'Ium say you want C and D it will give you the maximum value

in thaJ column
between the two of them, say there it will be height maximum so try that move to column F
(moves cursor to F3)
so you put MAX then brackets then say C3 colon D3

so it compares those two (CR)
yes, oops [entered as text] • I'm not sure bow to edit it. 1 suppose the quickest thing is just to type it in again

(enlen correctly)
Save
so save you select QUIT/SAVE. so you want
[ Quit and Save; Modei_Selectioo_Menu Options Context Save_ Backup Save_New_Model ]
is it this one, SAVE_NEW_MODEL?
1think if you just press return on MODEL_SELECfiON

it automalically saves il?
it automatically saves it the farst time but the second time - if we go to it the second time you get tbe option of
saving it after you've

Comparison-Subject 16
[empty sp-eadsbeet]

so whal really do you use a spreadsheet really for then?
They're useful if you\ ·e got a 101 of equations that have got a lot of variables in, adjusting one thing, or a lot of
other results - the one I've just done is a maths one for plotting the ttajectory of a projectile because there's a lot
of figures. there's a lot of variables so you could simply edit t.he variables and then get it to recalculale, it will
recalculate the whole projectile trajectory in one go rather than sit lbere going through step by step.

so il's like presenJing daJa
yes presenting and processing it ... I have seen bener ones than t.his [spreadsheet package) for presenting it it's
one I'd use for myself, but n01 to sbow results to someone else it doesn't look brillianl Basically it's divided
into cells which are these blocks which are referred to by co-ordinateS.
so thaJ would be AI
that's AI yes. Down bere it tells you which your current cell is. Each of these cells can hold - Well this
particular spreadsheet cells can hold, as far as it's concerned either NUMBER or TEXT. TEXT is just basic text,
a NUMBER can either be a straight number Jike 21, 16 or an equation and so you could use that to specify if
you wanted something to be the result of another two cells multiplied toget.her you could say that that one was
At times A16. Have you got any sort of application you want to do?

Enter text
Basically, you move around with the arrow keys. (demonstrates) When you want to put something in, you just

type it in
just type it in?
yes just type it in. If you did a spreadsheet say, what's a simple example. Say unit costs, unit quantities - total
cost for that unit. it is a universal initial example. You can set up the text for the heading. So the farst one bas
got to be cost (instruCts co-experimenter to enter text label in AI -Cl)
To jazz up the presentation, it doesn't do a lol, you can do a Jjne of single dashes so if we move down and back
[A2] you can just put a line of minuses in

(types line of"- H)
the only troUble with that is because you've put a minus in it thinks it's a NUMBER so it would try to evaluate
minus minus minus ...
oh righl, so you put a dash in do you
well you could leave it as minuses or press the F1 key it's got int [label) on it it but this one is CHANGE and
it will change, down there it tells you it thinks it is a NUMBER, if you press it it now thinks it's TEXT and
won't try and evaluate anything it will just put it in as it is, that toggles between what I tend to do is, instead
of puUing in the rigbt amount [of cbaractets)l tend to put it more 1ban enough it will display it over [tbe width
of the ceU] as long as tbete isn't anything in these two [B2 and C2] so just put a longer line to underline the lot.

well thai's well underlined (line is too long)
you can FDIT. rather than retype it if you press MENU, which is F8 these are all the different commands you
can give to the spreadsbeet AUfO, BLANK, COPY, - COPY if useful for copying lbings. obviously, 111 sbow
you, which ones - HELP is quite useful, I was quite surprised, you lcnow if you are stuck, call up HELP and it
will give you a bit of belp on what you are doing or on somelbing you're not going (laughs) but you've also got
EDIT, the same use the arrows or just type the first letter

so if I put e ...
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yes, they all start with a different lener, you can now delete that (deletes until line is righllength, CR)

Enter numbers
now these~ are just going to be figures and these ones are just going to be figures, so just type in whalever
you want (mstructs co-experimenter to enter numbers in A3-A6)
can you get them in the centre of the column?
Change attributues
yes, in between these square brackets it shows how it is going to treat the number, different ATfRIBUTES, I
don't know I've only found out about this one .. this means where it puts it in the column, R means it's RIGIIT
aligned so capital L means LEFf aligned, capital C CENfRE, PADDING, change tbat by pressing tbe
justification key but tbe F7 hasn't got a justification key, SHIFf F2, that moves it to the next one which is L,
press and it will cycle through [instead of going through FORMAT, ATTRIBl.TTES]
press il again?
yes, that's got to, press it again and it will cycle back right through the whole
/see, yes

you can if you want everything you want to be centred there is a set-up section on the menu press S,
ATTRJBUTES, slight problem it starts with so you have to move along so SET NUMERICAL
A1TRIBUI'ES, tbeo get the ATfRIBUTES, try DEFAULT ATfRIBliTES ab yes, that's returned it to tbe
default ... (repeats farst part of process) GET ATTRIB~. it's going to take attributes from a certain cell,
you can ammge which cell
and then il adopts those

yes

so I just press REIVRN now
yes and you've set the DEFAULT ATTRIBUTE
but il's not changed it,
those ones you'll have to change manually
so I've got to do it three times
I think you can probably do it whal about FORMAT
you could probably try going through to FORMAT, yes, ATTRIBUTES,
[ NUM [R 2 -] LCR1[????????] ]
now this gives you 8 or however many there is
whal
eight ATTRIBUTES -each question mark stands for an attribute and these tell you the alternatives so there
you've got LEFT CENTRE RIGHT. LEFT PADDED, so you can move the cursor to which one you want,
which is in fact that one [farst "?"]
CENTRE?
so press CHANGE which is F7 til it goes to a C. that's all you want so press RE1URN
[ Fomw applies to area: A6]
then you can specify the area you want it to apply to, you specify the area by giving two co-ordinates, the top
left and bottom right I think you can sometimes do it by pressing ALL. but you better do it from bere to here
top kft and bonom righl?
yes. You can sometimes do it different ways but it doesn't always work in some of the COPY funcUoos. In
this ca<;e we could probably specify the bottom so you could say, from A6 to A3, to specify the range you put
a colon between them and then you can either just type it which is sometimes quicker or move tbe pointer to
wbere you want it to go to (enters "A6:A3")
[lmpropet c:omtinale. Bad syntaX <X" out of range]
ab, improper - it bas got to be A3 to A6. If you've got a problem it will come up here [window top of screen]
if it's a problem wbicb you've made in the program it will be one like this, if it's a system problem it's a
deeper window with junk numbers on, well they mean something to someone, to cancel it you press 00 or
UNDO. UNDO is F2
is thai whall want to press then?
and then you can
(corrects co-ordinates to A3:A6)
now you can put the quantities in (instruCt co-experimenter to enter numbers in B3-B6)

Formula
right now this column [C) is going to be dependent on these two (A and B] and to put an equation in specify,
you type in ordinary maths equations but instead of numbers put the cell
.. multiply those two together?
you move tbe pointer to the cell you want it to occupy [C3] and then type what you want so in this case it will
be B3 times A3
(enters formula)
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the only trouble with ~ is because it starts with an A it thinks it's TEXT now, before it thought it was a
NUMBER when we dtd underline, now it thinks that is TEXT so you've got to change that to a number using
theF7

so press REFVRN?
[result pioted in C3]

Copy formula
Now that equation can be copied down but you can't just COPY it straight down because otherwise you'd just
get 20, 20, 20, 20 so if you use the COPY command
[ Copy from area: C3 ]
you want to copy from C3 which is correct

so I press RETURN
[ Copy to base coordinate: C3]
to, from C4 to C6, that would be the next 3 - so if you move down, move down to say C4 which is wbere
you want to copy to and colon to specify the range and then end of range
t~n prus

RE1VRN?

[ Copy Values All ]
now you can either copy the VALUES which will just copy 20 or copy ALL of it which includes the
equations, just a
[ Copy Relative Absolute Prompted ]
now these you can either copy RFLATIVE, ABSOLUTE or PROMPTED. ABSOLliTE means it will copy the
actual ones you've put in, like it'll copy A3 time B3

so you don't want that
RELATIVE will change the rows so A3 will be become B3, A4, B4 and so on. Prompted is if you want to do
a mixture like on the one I've just done, some have got gmvity as a consrant

so it asks you?
yes it asks you do you want this one to be RELATIVE [results printed in C4-C6]
oh/ see

yes but in this case you want them all RELATIVE, press RETIJRN

oh, it's doM it
Formula
and then you've got, we could probably do with a header but if you want to put the total cost, you've got to
add up all these. Now you could put say B6 plus BS or C6, plus CS ... but there is a command it accepts,
SUM, wbicb takes a range, if you put say the total, say you go down one more we'll put a line there to, later
I'll show you bow to tidy it up, type SUM, there's a bracket in the brackets you can specify it as a range so
you can say C3 to C6
(types "SUM(C3:C6)") then it adds up all 4 numbers? (CR)
[focmula printed in C8]
yes, it bas taken it as TEXT so you have to edit that (selects edit from menu and changes it to nwnerical)
[result printed in C8]
there are a lot of these functions that are useful - sine, cos

so it's just like a calculal.or really
yes, the functions you'd have on a basic scientific calculator. What else is useful about it The COPY routine
is pobably the most complicated and the most powerful, you can copy say formula, down there you can copy a
whole line.
Insert column
INSERT it lets you insert rows, or -

so you could insert a column
thai would let you insert a ROW or COLUMN if you want to do that. just move to I [Insert Row CoiWIUl]
INSERT a COLUMN, so C
[Insert Column(s) starting at C]
starting at A if you want it to go at the front.
[How many rows/columns: 1]
insert 1, if you want to just change it
[new colwnn inserted before A]
and now it bas moved it over, the equations and everything
LOCATE I don't know what it does, NAME I don't lmow wbat it does, ORDER, PRINT will print it out but
we haven't got a printer or you're not connected to a printer.

Save
QUIT/SAVE very important that. it allows you 10 save what you've done onto your disk
ok. so QUIT, so
[Quit and Save: Model_Selection_Menu Options Context Save_Backup Save_New_Model]
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so SAVE_NEW_MODEL?
this will also decide where you go back to in the spreadsheet if you say MODEL SELECilON MENU it will
save it then let you go back to the start of the spreadsheet
so il saves it automatically
yes, if it doesn't cbew tbe disk
RECALC is important. if you change all these figures and then RECALC these figures you. if you just go to
cbange tbal figure and that figure are wrong

(changes one number) so it doesn't do it automatically
Recalc
no it doesn't it just do it on its own - you can select R which is RECALC, that will ask you for tbe area that
you want to RECALC over and if you've only got a few you can specify the area but what I usually do is press
F4 which is CALC and it just does the lot

Comparison-Subject 17
[empty speadsbeet]

Enter text, enter numbers
You see there are some columns and rows each space we call cell to contain some element you can use the
ARROW KEYS just to move it along and then I'll show you some test. very simple (moves cursor to B3. types
"glass", CR) then it appears here and we can have some number (enters number in C3 and C4) also, we can
apply some formula
Formula

what do the number mean?
well, this column can be the cost. and the next column can be the price you can put a title on the column later
and we can apply some formula for example we can bave - I think we need some more data (enters numbers in
C5 and C6) SUM, C3 to C6 (types formula in)

so what are you doing now?
you can for example- if you want to know the total for this column-

so you're adding them up
I want to just apply the formula to the spreadsheet
so that's something the computer recognises
yes SUM, that now sums up from C3 to C6
soil's a the range, so you put a colon in to include all the numbers in that range
actually the computer will just recognise this as TEXT because sometimes it will have so we will transfer it to
a fonnula by pressing key 7 and see NUMBER there, so this means formula not TEXT OK, then you see (CR)
[result pinted in C7]
il has added il all up
Recalc
it is possible that you want to change this data. for example (changes number in C6) so you need to

RECALCULATE
il hasn't gone in has it, it hasn't changed il, oil yes
now we need to RECALCULA1E so we just put MENU and then for example we can do this and if you press
this special key for all the data. if you want to do just a certain area you type in the range
so this button does everything but ifyou've got more than one thing to do you can specify ou of thou

things at a time by using
Toggle display
and if you want to get rid of this MENU every time you want to leave some menu you press UNDO, also this
menu bas several facilities for example, WINDOW (selects) (selects with this means we can translate this 10
equation, for example sometimes you want to

oh 1 get il you can get il to prinl up there - the equations? how do you do thai again., show me again
alright. MENU and then you choose the WINDOW, then VIEW, this time I think we go back to the numbers

I see it swaps it back to eqllillions
Insert row
that is the basic idea and also sometimes we can, we forget to put the tille here, so we want to INSERT a title
here, you want to INSERT a COLUMN. you want to shift this down a little bit. so MENU
[ Insert Row Column ]
you can INSERT a COLUMN or ROW

so you want to put a space in, you want to insen a row, I can either press RETURN[Insert row(s) starting ac 2]
yes, starting at. you want to INSERT it here
[How many rows/columns: 1]
bow many - I want two [ two new rows inserted ] now for example bow many

it moves all these down, yes? so that helps you present it
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and data you can see there automatically adjusted
Save
If you want to QUIT (selects)
[ Quit and Save: Model_Selection_ Menu Options Context Save_Backup Save_New _Model J
before you leave usually we have some cboice, for example to SAVE that to a me, or SAVE to a new flle or if
you want to SAVE into another,
but usually we just, ro SAVE it to Ule file (selects
MODEL_SELECTION_MENU)

so it just saves it automatically?
Yes (returns to spreadsheet)
Ok so you can try yourself ( ...)

and if you wanted to put a title on top of the column, so if that was price (enter text label) and total there,
umm can you CENTRE these, put these numbers in the CENTRE of the column?
actually I don't know but I thinlc you can -just put the spaces in

what does all the other commands do?
Copy formula
wen actually I just know a few of them, for example, COPY you can just copy this to the other part ...
do you want to show me thai?
[ Copy from area: CS 1
for example move this data from C5 to C9
( Copy to base coordinate: C9]
no, move it bere, move E5 move the cursor to the ceU containing
[Copy Values All]
right VALUES means data, AU. means the equation also,

tbe location

so ALL
[ Copy Relative Absolute Prompted ]
RELATIVE means there are - for example this equation for C5 to C9 but if I move to E, E5 to E9, the
equation will be linlced to the location
[data copied to E5-E9]

and lceep the SamL equation, yes OK
I think I shall show you the equation (toggles WINDOW, VIEW, EQUATION) see it is not copied as C5 but as
E5 to E9 every time you move the cursor there is nothing here

Comparison-Subject 18
(selects existing spreadsheet)
This is the spreadsheet here, if you press the right button

what's tht spreadsheet, is it just a table that's got numbers in?
Right it's put in tabloid form. you put the numbers in here where you want the numbers and then a formula,
you put a formula in using these numbers that you put in and it will calculate that formula and give the correct
answer. You can SUM numbers, you can SUM those by putting a simple formula in, you don't have to work
them out by band, you just sum them all, you can multiply certain numbers. divide, working out percentages
of numbers

so you can do anything capable ofcalculation
you can do l()(S of calculalions very simply

how do I alter ...
right, just move around the spreadsheet ftrst to f~iliarise yourself with it, your columns ABCDEF, they go
aaoss. if you press the right band button, the ARROW KEY pointing to the right, then go across to the right

(does) so that's the column and those are the rows
yes, column A. column B, ... press it quite a few times and it just goes across ... keep on pressing ... see it
moves across, so you can see what's to the right it just carries on ... go back with the left, left ARROW KEY
and you're back where you started from. It does in fact go quite a distance ... you can put in a massive
spreadsheet. it goes weU past AA you can move down the rows ... (shows co-experimenter bow to move around
the spreadsbeet) each particular box is uniquely defmed, see this one says current pointer A5 column A row 5 so
you can fmd yourself, it changes, at any time you can look at that and it tells you ... an infinite number of
rows. you can do down as far as you want. until you run out of disk space

so what do I do now?
Enter text
if you want to input text into a certain row

is thalliu a column heading then or does it treat that as a number
that there, if you look at this particular box here, 85 [current cursor position] it will teU you wbal's in BS just
down here [above input line) so it's NUMBER and then it gives what is in lhe box [the entry)

and what does the R mean
that just means RIGHT justified, you don't really need to know that it just means that the whole thing is
moved over to the right band side of the box, not the left band side, if you bad an L there it would mean that
the whole contents of the box were over on the LEFT band side
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so ifthere were an L there the 2 would be over here underneath
beigbt yes. you can also CFNfRE it into the l"liddle of the box, let's stay with RIGHT justified for the moment
because it's easiest when it is automatically done (tells subject to move about and see bow entries are displayed
above input line)
This one is a formula. it's worked out by multiplying those two numbers together, we'll come to that in a
moment. you don't need to worry about that
Rigbt if we want to input TEXT, as opposed to NUMBERS we just type in from the keyboard normally we
could set up anodler beading if you want - wholesale price, or something like that or just, anything, wbolesale
price, wbolesale, just type something in
( S'tiJTtS typing)
as you type you can see it comes up on this line here [input line) so you can see what you're typing. I think

wbolesale will do because wholesale price won't fit into that box, so just put wholesale, if you make a mistake,
you can just delete the couple of characters
how do you do that
that key there [DELE1E] if you press that once the r goes
so I have to put in only as much as will fit in one column
you can type in as much as you want but it won't come up on the screen {it will unless cell to the rigbt
contains entry)
if it doesn't fit in, you can change box WIDTIIS but that's quite advanced so we'll just deal with what is going to
fit in the box. As you typed that it came up here with TEXT then LEFT justified if you press F7 - just once
(tkJes)
it comes up with NUMBER so you've got two different types of TEXT, press F7 again, so you can have
TEXT or a NUMBER in a box

so Ji7 swaps between TEXT and NUMBERS ...
We want to input TEXT here so we then ... put it into that box on the spreadsheet, press RETURN
(tkJes)
and wholesale is therefore promptly moved into the spreadsheet

so now you've ntatle a colwnn heading so we could put another one by the side
we could put ooe wherever we want just by moving the arrow keys so
(enkrs kXllabels "retail" and "profit") and weve got to make a table ...

Enter numbers

Right, numbers - you've learnt bow to put in TEXT, now you can put in some NUMBERS (instructs c~
experimenter to enter numbers)
Formula
OK so we've got 2 sets of figures there and then you need to work out the profit or the loss right if you wodc
out the formula fer yourself what is the formula going to be?
well you have to take the difference between the two?
rigbt there isn't an actual thing for difference between them there's just SUM, no you can't use SUM ob dear, I'm
lost ...

you have to take this one from this one don't you?
so you need to do the retail price minus wholesale price, right if you move up to there the first retail price, with
the arrow keys
(tkJes)
right you see the box number is B 15 right so we need B 15 minus the wholesale price, what's the box number for
wbolesale price, move along

Cl5

so we're going to have a fOflllula B 15 minus Cl5 so you

want to put that into the box, so move along to the
box you want to put it into, so you can just input into that box there so if you just type

(starts typing)

it comes up with TEXT at the moment but we'll change that to
Just type B15 minus ...

a NUMBER in a second using the F7 key.

(finishes typing) REfURN?

not at the moment, you see it says TEXT here because you put in B first which is a piece of TEXT so it
automatically assigns it to TEXT, we want it to be a NUMBER so we use F7, change it to a NUMBER ...
(does)
press RETI.JRN now, it automatically does the calculation ...
[result printed in 015]
and puts the answer up there
so to do this figure here [Dl6] we do the same the same again
there is another way to do it and I'll describe how, actually we'U do Ibis first, do you want to run through lba1

(repeats process for BJ6 minus C/6)
any questions so far, anything you want to recap on?

yes, everything we've done so far is quicker if you use a piece ofpaper
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yes ~use we'v~ bee~ doing very simple calculations, the more advanced you get or the more calculations you
do, lets say you re domg a 100 down here but all you need to do is write in one formula here and then ask the
computer to do the calculation for alllOO

so I just put in one formula
yes instead of that you could have put in one formula and then told it to do exacl.ly lbe same for all of tllem ...
so if we try to put that formula there [16] for lbis line here, just rub that out, just blank it out, press the
SPACEBAR
space? (deletes resulJ in D/6)

Copy formula
yes and lben RETURN and that wipes out that space, if we try it now that formula on that line, move up one
it will tell you what that formula is here, B 15-C15 right, press F8 which is MENU and it comes up with loads
of operations you can do on this, what we want is COPY. there are 2 ways to get copy, use your ARROW
KEYS or you can press lbe first letter you see, because it's in alphabetical order, so you can just press c
[Copy from area: Dl5J
what we want to do is just input the bounds for the COPY operation FROM WHAT AREA to what area. so
the area we want is just 015 on its own, isn't it so what we want to do, because it automatically put 015 in
so you want that there, colon, you need to press SHIFf, hold it down, Ok let go and it automatically comes up
tbe same, see if we just want that one box
[D15:D15]
what I'm doing now is copying here to here as though I've got 100 of them
but we only want to do it for that one
can we do it now (for 100)
you can't do it now because we haven't given it the numbers here. You can do it

but
if we do it 5 times it won't actually work because we haven't got any numbers in
what happens if I haven't put the numbers in, but I'm going to put them in
well do that then, we'll put the calculation in five times and I'll show you what happens
The formula is in 015 isn't it, so that is what we're copying, so it's given the area from, so press RETIJRN
then
[Copy to base coordinate: 0151
and we want to copy it from that location down 5, we've got the first coordinate, DIS so then you want colon
again and then we want to go down 5 lines, you can either do that by inputting the formula by saying D20
instead of 015 or you can use your arrow keys and move to the bottom location, as you do it you'll see this
changes here pess RETURN again
[Copy Values All J
it then asks if you want all VALUES, just VALUES, or everything. You want everything, so press a lben
press REI1JRN
[ Copy Relative Absolute Prompted 1
right it then asks whether you want RELATIVE. ABSOUITE. PROMPTED or MATH, we want RFLATIVE,
if you move down one the formula changes from 15 to 16 and then to 17 and 18, so if we're doing ABSOLUIE
it will just cq>y the answer down tbere but we want the formula to change as we can down
[result printed in 016, "0.00" in 017-D20 1
it bas worked right, so it is giving you the answer, it bas worked out that one, we haven't supplied any details
here so it just gives nought anyway

but we need to know total profit
Formula
total profit, right, so wbat you want to do is work out SUM over this number, this number, this number ...
[015-020] it could be just that plus that plus that and so on but there is an easy way you can range, you can
type as your formula SUM in capital letters then round brackets and inside range like you did before, you give
lbe first co-ordinate colon the second C<K>rdinate

Dl5 toD20
put an input formula in tbere [D21 1
(types "sum") space?
just type sum. you don't need a space, round brackets

(finishes typing)
10 fmisb it, now look at tbe left band side, as you've put in a formula it tells you that it's 1EXT
soF7(~s)

you're now entering a f<X1Dula
(CR) and it gives you the SUM over that range you've just given
Save

right, you've fmisbed, let's say you've fmisbed, you want to save it back to a disk, clear away then come back
and use the same one, ok to SAVE it you go into the MENU

F8?
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yes F8 then look on this you see QUIT/SAVE, you can either use the arrow keys or press the fltSt letter, Q,
{Quit aN1 Save: Model_Selection_Menu Options Context Save_Backup Save_New_Model)
right it says MODEL_SELECfiON_MENU which is just - if this is the first time you've saved it it wiU save
it automatically, if it's not it will ask you whether you want to save or not save and come straight out and
there are other options, SA VE_BACKUP in case you lose it or SA VE_NEW_MODEL under a new name. It
automatically comes up with MODEL_SELECTION_MENU so use

it just saves it?
just SA YES it. it then asks you do you want to QUIT SAVING it or QUIT WlTiiOUT SAVING. Right you
can QUIT, if you quit the s/s you can quit
oh 1 see it hastl't saved it
it hasn't saved it yet. It wants to know whether to save it or quit anyway leaving the old one there
if 1 press RETURN now it will save the new one, QUIT WITH SAVING
that's tbe way we want to do it. so press REWRN again

Comparison-Subject 19
[empty speadsheetJ

Right now lbal's the spreadsheet so we've got to think of something to put oo it You could do something like
the one we did, measuring things out like big glass. [classroom example] You could do carpet, like size oC
different sorts of carpet. You could put a title at the top, so if you want to put a title move across to wbere
you want tbe title

so this purple thing
Enter text
that's where you put your input in there so to do that you'd sort of type it in there

what title shillll say
Carpet Manufacturer's Spreadsheet, something like that
(moves cursor to B2) OK is that right?

it will appear down here flfSt [input line] you can delete it as well if you make a mistake
so that's like the liM I just type in there and when I finish sort
wben you flD.ish sort of editing you put it in there. , That's small type [lowercase]

I don't mind (continues typing)
it accepts 12 [characters] at a time. See if you put a big one in it sort of puts it on the screen but when you go
off it doesn't exactly exist, I don't understand it It's, when there's a big tJling there it doesn't actually exisr. it's a
bit weird. Put that for now see what that does.
(CR) it has come up

Enter numbers as text
yes that's fme. We could sort of put like some underlining.

(types in liM of"-") RETURN?
No(has already pressed CR)

[Syntax error at 83]
DO DO you see you get an error because it treats that like a minus sign - like a NUMBER, so if you press
UNDO - if you get a mistake press UNDO, press it again, right what you do is, if you want to make that into
TEXT, press F7 it sort of toggles it between TEXT and NUMBER ...

(toggles to NUM, CR)
[line of"-" printed in B3]

OK so this, do I put like a table there with the figures for my account
Enter numbers

well initially you'd have to make some sort of figures up like lengths for the carpets and width and you make
those up initially and then things like area and cost and that you sort of derive from that so we cao do &bat

eventually ... a bit further down
I could put down if I make this January, this February and then we can have like different sales underneath,

you know if I sell3 carpets in January (insUucts co-experimenter to enter text labels in B5-D5, and A6 and A7 and numbers in B6-D6)

Formula

let wort out VAT so you don't want to work it out you want the spreadsheet to do it for you. So you're using
that one there, column B row 6 so you're going to use that now to work it out, 86, so it would be, to be 15
percent, like .15 times that number, so what you put is .15 then times is that star thing,

(types ".15*") 86?
yes - but you're putting that in as TEXT so it will ignore this as a piece of irrelevant texr. so you want cbat as
a NUMBER
(F7)
yes it will print it up as a NUMBER up there so press RETURN

so it's worked out that because I've done that there
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Copy formula
it's wOlked out that for you o::o it is s10red in memory that that equation is in there. You could do that for each
of these but wbat you could do instead ... what you could do is use a COPY facility on it so you press the
~button and then you use the ARROW KEYS to select COPY. Right and you press that.
JUSI press RE!VRN? (does)

[ Copy from area: B7]
So wbal you need do, is that equation is s10red in there what you want to do is COPY that equation 10 these
two, ... so you press the RE11JRN key there
[Copy 10 base coordinate: B7)
yes, then you want to copy it to those to, so it says COPY TO - so you want to move the purple cursor thing
on to the first one you want to copy it to [C7)

(moves cursor) and we wanl it here /D7] as well
yes you want it there as well so what you do is put colon. shift and that
so il knows to copy from to here
so it started there and then colon and finishing there so move your liule thing across to there and press, D7.
(CR)
[ Copy Valoes All ]
What it's doing there is it says VALVES or ALL. VALVES will just copy 60 to there but you don't want tha1
you want the equation so ALL
[Copy Relative Absolute Prompted ]
right. You want RELATIVE because you want it relative to what column so

I see you don't want to do it to that one ail the time
no you want it RELATIVE so you just press the RETIJRN key for that It bas done all them

Formula
OK How do we get a summary of everything, all the figures, do llulve to read that that and that ... total
sales and total VAT
so you want to have tbal column here
surely if I make a formula it doesn't matter where I put

no you could have that down bere somewhere
so what do I do?
get rid of the menu ... so you'd have to add up those 3 columns [C-D] wouldn't you

yes or these ones as well, that I haven't put in yet
so you move that over there
(enters text label) where I'm going to put my result
yes, and you, like we did an equation for that one there and you'd have to do an equation for this one as weD ...
yeah I don't know how you do that ... I think you can let's get the menu up (does, reads menu) for those you
could put B6 plus C6 plus D6 but it's monotonous - but I've forgotten how to do

wellli/ce copy, you can copy from to ... can't you add up from to, not copy
yes I expect you can I haven't really used that yet ...
I can make that bigger can't I - I mean I want to give to somebody just a little list, a summary of

everything, so the total sales over the year, so I add this and this which is January, February, March. add it
all up and just get one figure ...
(Experimenter intervenes and suggests they put it in column E)
you could use a blank command, so if you want to get rid of something like that you just use UNOO, right. so
if we're going to do tbal the easiest way of doing Is just pressing SPACE BAR and RETIJRN
(does. moves cursor to E5 and enters text label. moves to £6)
rigbt you want to get a total for that. there should be a way of doing that, but I'm not too sure bow to do it I've
e<me across it yet

what about in the other direction adding your sales but as a company you're only interested in the sales so
we can leave ouJ vat and just add these up.

so that's just B6 plus C6 plus D6 ... [doesn'tlmow SUM]
(moves cursor) and IWW I put B6 just plus? (types "B6+C6+D6")
yes. What you want to do is change that to a NUMBER because it is not TEXT, the INT key [F7] and you
press RE1URN to print in there
[formula printed in E6]
it's put il up. Ok so I want like this here and down here a cumulative total for the year
Right so if you wanted to total VAT for the year you'd use exactly the same equation so you could use that
COPY command, but it's just as quick 10 type it in just move down to there ... B7 plus C7 plus D7

surely there's an easier way because if I pUl it all in 1 have to do twelve of those
yes, there is I'm not too sure bow to do it {SUM]

Save
Right we'll save ... so you press the MENU key then select QUIT/SAVE there,
[Quit and Save: Model_Selection_Menu Options Context Save_Backup Save_New_Model]
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they don't go down they sort of go across, right now press the RETURN key. Right so you've already selected
a name earlier on so you don't need to so we want SAVE_BACKUP because we want to save tbe me you've
already got. if you choose SAVE_NEW_MODEL it'll ask you for a new name

(moves to SAVE_BACKUP)
then just press RETIJRN.
[returns to spreadsbeet] Right so that should bave saved it
thai saved it?
you could test that by like quitting this and loading it back in again

Comparison-Subject 20
Right now the s/s, I'm not sure of the maximum size but imagine you've got a huge paper there and you can
go anywhere along tbete and you can pick any co-ordinate by, you've got numbers alongside
is it divilkd inlO squares
yes- and so you start off with say lA and then your rows can go on along and you use this arrow to go along
as you get to the eod the screen sort of moves across so you're on J now say so you can actually pick your coOidioales and you can also go down

theu nwnbers are changing what's that
I think that's your actual position so that's MIS so that's where you are so if I move down (does) t.bal's M16

Enter text
If you go along you're at row 16 and you go [column] R Lhen S so you see you're told. Now if I go back bere
and that's back to AI. Now if I want to put something in the spreadsheet. Let's say we give it a title fJISt. right,
so we can go anywhere on the spreadsheet. So we'll give it a title just about there (moves cursa- to C4) To do a
nice layout (instructs co-experimenter to enter a text label)

(stans typing) Is that righl?
Yes -effectively what you type here is what you want to put in !here so if I type somelhing !here and press
RE1URN it bas put it in there, so if I move away it's there, if I go back and want to erase that, I bit space.
lbat TXT [above input line] is for TEXT so what you've done is you've actually put some TEXT in tbere,
letters your numbers are also characters if you just want them as numbers but say if you've got a set of numbers
and you want another column and that bas a relationship with this set of numbers say twice that

I see so like this column is times 1 and that column is times 2
If you like yes, if you've got a set of numbers there and you want !his column two times this, instead of
having to input eacb number separately working them out and typing them in you can make, aeate a formula
and that will save you having to do all the working out, it will do it for you, you'll just have to type out the
formula I'll sbow you bow to do that in a moment so say if we call it FRED, underline it

(enters text label in C4)
and say if we want to underline it

(underlines using a row of"M"s)
Enter numbers as text
you can do that. but I wouldn't recommend M because I mean something like say minus (types a row of
minuses, CR)
[Bad syntax at entry C5)
what's happened here is wben I said minus it assumes that I'm using not lEXT but I'm going to put a formula
in that it's a NUMBER - I want to erase it so what I can do is, press DO or UNDO to continue, well there's
your UNDO so if you press t.bal yes I think whenever you have an error you usually - well what you did last it
will undo it it assumes you've not done it
if 1 make a mistake and I realise it I can say escape and then it will take me back
yes to the step before that I'm not sure what that does

it still says, umm, so I press UNDO again
press UNDO again yes as if you've just put that. You don't want it in, like I said before you cao put it in
TEXT f<Xlll and it just puts it or as that there as a formula. At the moment you don't need a NUMBER so to
change that into TEXT you press F7. You can keep changing from TEXT by pressing that (demonstraleS) so if
you'd like to pess RETIJRN
Enter numbers
Right. now say if you do a sis underneath that, say if we have a type, price, qty. and then product price. so if
you if you type price there (instructs co-experimenter to enter text labels in B9-D9, underline Bl0-010, and
numbers in Bll-Cl5)
Formula
Rigbt now if you go along there and up one [D11] for the first one you want that [B 11 Jtimes that [Cll) to be in
there [011] so wbal you've got, you pick the co-ordinate Bll and Cll. so what you do is Bll times Cll
just type it? (types "Bll*Cll")
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Well if you pre~s RETURN, here I'll show you, it will just print that because it thinks it's TEXT so it
assumes Y~ ve JUSt pu~ some characters right what you want is it under the NUMBER that will put it as a
formula so if I do B 11 times C11 and change this and that will give you the product
[result printed in 011]

Copy formula
you can <f? ~t f?£ each one but there's a COPY facility, you can actually pick a MENU at any time you want
when you re m tbis sort of slate, press F8 for MENU and what you want to do is COPY

I've got a formula here

and you want to COPY that formula all the way down there.

So if you press the ARROW KEYS and

RE1URN
[Copy from area: 011]

it says COPY FROM well you want to COPY FROM below there don't you.
RETIJRNnow

No sorry that's what you want to COPY press

copy this, thal is the square isn't it (CR)
[ Copy to base coonlinate: 011 J
now you've got to specify the area that you want to copy it to, so you want to copy it there to there

D12?
that's right. 012 to 016 so if you go down one with the arrow, that's it you've got Dl2there, colon, shift 016
and you go to the co-«dinate, tbat's it then press RETIJRN
[ Copy Values All J
I know you want AU. I'm not sure why, what VALVES means so press REI1JRN there
[ Copy Relative Absolute Prompted ]
I'm not sure what this means I'd use RELATIVE but press RETURN again.
[results JXinted in 012-016]
back on the MENU now, it's got all, 5 eights are 40 yes it's got it righl
Delete row
What other things - if you go to edit what that means is that you can go back to, press RETIJRN, press
RETURN again, you're now back into the spreadsheet so edit you can go back to the spreadsheet carry oo
putting characters in, so if you press the MENU again there's - DELETE you can erase - if you want to erase
any character or number or whatever [only whole rows or columns] so if you try that, left arrow, REWRN.
[Delete ROW COLUMN 1
you can rub columns out or rows
so I can blank out lots ofboxes at once?
Yes - you can erase that column there, not just that that whole column, you can erase just that if you want or a
row, so
well shall we just erase thai bottom line here?
so we want to erase a ROW don't we? so press REfURN, if you want it on ROW, just press return
[Delete row(s) starting at: 111
it says delete rows starting at ...
you don't want it to start tbere so if you go down [to row 16] it will actually change it, press RETIJRN,
[How many rows/columns: 11
it says bow many rows or columns so if you bad say another 3 rows there and you want to erase all three, tbeo
you type 3 in this case you only want to erase one row so it's on 1 anyway just press RETURN.
[row 16 deleced]

it's gone, so it works ...
Save
That's about all I know of there, oh and to SAVE your file, now to save your file what, your spreadsheet
you've crealed is just on the saeen at the moment and to get it onto disk so you can use it later you go bact to
MENU, F8 and you've got QUIT/SAVE there so go to there using the arrows, I think it [cursor] only goes lett
or right) [but could type "q• to select] press RETIJRN there
[ Quit and Save: Model_Selection_Menu Options Context Save_Backup Save_New_Model 1
if you wanted to SA VE_NEW_MODEL it means you'd save it and you'd have to type in a name so you
actually want to, go to SA VE_BACKUP
SA VE_BACKUP, so do I just press return
tbat's right.
-that's just saying ...
That's that done, if you just want to you can leave now [MODEL_SELECTION_Menu would have saved
automatically just lake the disk out and switch off

Transcripts-113

/

Database Study
Subject 1
1. FILE
Like a book. it's individual, it's not related to anything around il, so I can individualise that one file.
Whal about the structure ofa file in the DB?
Pieces of information ... I suppose the advantage over a book is that you can update it and set the order, you can
pre-set how you want it to be set out ...

l. Field
Column ...

3. Record
Row ...

4. Entry
No.
S. Difference Field/Record
You get some are numbers, some are names, they [records] are different as opposed to all the same ...

6-10. Data Types
Ot.ber sorts of information? Numeric numbers, and then I can't remember ... text
We distinguish between different types ofnumbers - the one you poinred to are decimals.
It's just information (no manipulation) ... dates ... infonnation that relates between different rows and columns?
11-14. Query Language
FROM, LIST ... no, second one umm, ...

How about SELECT
Ob yes, SELECI', WHERE, ... and ORDER

18. Task 1
(types FROM CUST SELECf NAME,ADDRESS,ZIP,CITY,STATE)
What does FROM address?
FROM that file

And SELECT?
The NAME- lbe field that I'm interested in.
19. Task l
(types FROM CUST SELECf NAME,CONTACf,PHONE) and then we want WHERE ... OVERDUE equals

FALSE?

FALSE?
Ob sorry, yes TRUE

(adds WHERE OVERDUE=TRUE)

So what does WHERE do?
Tbat then specifies whicb parts of the fields it wants it restricted to ... sections of records ...
lO. Task 3
{types FROM CUST SELECf NAME,) Are we going to send them an invitation?
No, we just want the list - we want to know how much they buy.
So that's PURCHASES (adds PURCHASES) I can' remember I want it in an order. do I, WHERE ... I can't
remember tbe fourth line ...

ORDER

oo yes, ORDER (add ORDER) Equals descending?·

Qwe wouldn't specify anything, it would order them by company name -

Yes I want it sorted by PURCHASES

(uplains ascending/descending)
(adds -PURCHASES)

DIFFERENCE DATABASE/SPREADSHEET
A spreadsbeet I'd use for, well I'm not going to update it, when it's fixed, like exam results or it would be
peJbaps ooe would use once a year for each year, sort of thing, but this would be a constantly updated on-going
situation and wbere I would want to achieve, like this, parts of records ... like mathematical

Subject 3
1. File
It's a collection of information put under a certain heading and about specific things, which is probably sbowo in
tbe beading. You can have as many files as you want depending on bow many specific things you want to
show. It just holds infoonation which you can collect things in, at random.

What sort of things have you had in your files?
You bad names of companies, names of contacts, and addresses and phone numbers and tbe amount of mooey
they've paid. invoice numbers
What about the structure?
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3. Record
Every line is a flle, mm every line is an individual piece of infonnation but I can't remember how it goes now ...
Can you remember what it's called?
No.
What about the columns?
l. Field
4. Entry
(Doesn't know term)
I don't remember that

5. Difference Field/Record
(looking al example f11e) The record holds different information about one thing, about one company whereas a
fa.eld is ooe aspect of all the companies.
6·10. Data Types
How do you mean?
If you compare the NAME field with the DATE field and the PURCHASES field, you've got differtlll sorts
of in[ormalion ...
Some are text, some are date and some are numerical ...
Is there lliiY differelll between the numerical data you've got in PURCHASES compared to ZIP or and
invoice ruunber?
Some of them I tbink, tbe zip codes, well those are decimal numbers because those ones can't be used
numerically for adding and subtracting them they have to be put in as text so you have to write them in
quotation marks
So you would say the zip code is text rather than a number? What about the date?
Does tbal come liDder a separate type date?
11-14. Query Language
Well it consists of just normal words ...
What are the words?
FROM, then you put the ftle name, SELECT, when you want certain things, and then you can make conditions
as well, using WHERE so and so is equal to or greater than When you use select, what are you actually selecting?
Yoo're addressing one of the f.elds
Any other one apart from FROM, SELECI' and WHERE?
I can't remember tbe one ...
Ord!r?
Ob yes.
18. Task 1
(types FROM CUST SELECT NAME, ADDRESS, CITY, STATE, ZIP)
19. Task l
(types FROM CUST SEJ...ECT NAME.CONT ACT,OVERDUE.PHONE. WHERE OVERDUE=TRUE)
(FIELD WHERE NOT FOUND]
It says where is not found.
It says field where not found ...
WHERE is a command. I've got a comma after PHONE (corrects it)
[dme}

20. Task 3
(types FROM CUST SELECT NAME.PURCHASES

You hav~forgotun to order them
It's ORDER. is it? How do I tell it to order them in numerical order rather than ...
By what db you want to order it?
PURCHASES (adds ORDER PURCHASES)
[listed in ascending mlet]
Explains ascending/descending

Subject 4
1. File
A piece of memory in tbe computer in wbicb you can store information. You can load ftles into the computer so
you can store information in a flle and then transfer that file into tbe computer screen by, througb lbe disk drive
Itt the particular illformDiion we've got here ill the database, what have we actually got ill the fik?
Iofoonatioo about a cer1ain ... the files are, information about a a certain ... data about certain cbaracteristics?
3. Record
A line?
It's called a record. Could you tkscribe what a record is?
A record is a - well you've got the subject of a record, you've got data about whatever subject it is whicb
describes and tells you something about the subject
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Field

Infonnatioo field?

It's caiJed a record
5. Difference Field/Record
Will a fi~ld always be numerical? A field contains a field of alllhe same type of infonnation, so just JXice would
cbange, JUSt tbe value would change, not the actual attribute lhat it's describing, would change whereas the record
will include many of tbe different fields.

6-10. Data Types
Types? You mean like purchases?
What different data have you got here?
Well, it's just a name ...

Or a string of letters ...
Ob yes string ...
What about tM others?
Numerical ... not just any numbers, dates ...

What about "PURCHASES"?
Just numerical, just numerical value for each name, each company ... OVERDUE - whether it's in debt or DO(,
wbetber tbe payments it owes no as long as it ...

How many possible values can it have?
Yes, ob sort of binary.

11-14. Query Language
If wanted to retrieve romething FROM this file, what sort ofcommands could you use?

You can retrieve the companies that are overdue ... so you SELECT that from the menu
18. Task 1

Put FROM CUST ... new first, ... FROM CUST puts you into lhe database. It's just names and addresses? So
you retrieve, just retrieve name

What is the command? What are you trying to address now?
Two of the columns ... fields ...

How do you get those? ..• SELECJ
Ob SELECr ... name, address. Then just ...
[dooe]
19. Task Z
(types FROM CUST SELECT NAME, CONTACT. PHONE - WHERE ... Can you just put where payments

overdue?
Can you? WMre's that informaJion whether paymenls are overdue?
It's in tbe overdue column true or false, where overdue equals true or something? It's just (types
OVERDUE=lRUE) tben just F9
[dooe]

10. Task 3
(types FROM CUST SELECT NAME, PURCHASES Greater than or equal ?

no, its ORDER
DIFFERENCE DATABASE/SPREADSHEET
Don't mow.

Subject S
1. File
It's a set of information - each me is like a specific reference to a certain thing, like a names me and purchase
me. and another file you could cross reference between the files, information that goes between tbe two.
Z. Field
Tbese are fields. different fields.

3. Record
An entry in the file?

4. Entry
Actually, an entry is ... an item, an individual item.

S. Difference Field/Record
A field is all dealing the same sort of information, like all the names, all purchase records, and a record is dealing
with all tbe features of a certain, in this case company.

6-10. Data Types
We've got text, wbicb is like the letters, the names, decimals is a term that keeps coming up (laughs)

What else?

Dates, nmnbets - numerical data - qualification, true or false ... so what would you call it, true/false? And daleS

11·14. Query Language
Wbat ways of getting ... I don't know. I could go tbrougb and fmd them out, like do SELECT ...
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18. Task 1
(types FROM CUST) For the customer file (adds SELECf NAME We want the names of the cus10mers what
else do you want?

For a mailshot?
(adds ADDRESS,CITY,STATE,ZIP)

You have used two commands from the query language now FROM teUs you which file you want. a cus10mer file or an orders ftle . SELECT the fields that you want

19. Task l
(types FROM CUST SELECT NAME,CONT ACT, PHONE, OVERDUE) Is overdue a true or false column? So
that's all I have to do- (adds WHERE OVERDUE=TRUE)

lO. Task 3
(types FROM CUST SELECf NAME.PURCHASES Do you want me to order the purchases? Can you use
just order plus purchases? ...

It's minus (explains)
(adds ORDER -PURCHASES)

DIFFERENCE DATABASE/SPREADSHEET
The information in the spreadsheet was like trapped within the spreadsheet. You could do calculations outside
that and you couldn't actually change round the information within the spreadsheet- that's probably a load of
. rubbish ... but you seemed to have the columns after the information that you kept adding on rather than
extracting more information from it ...
(with sis not db?) ...
... like mean, average .. .

Subject 6
1. File
It contains all lhe information on certain, a variety of clients things like that so all the purchases they're making
and their business details.
In more general terms, whaJ does a DB file consist of?
It's- bow do you mean? specific information?
3. Record
They are all the individual companies - these ones are the records ...
2. Field
Don't know.
4. Entry
Don't know.
FIELDS/REC
Well a record contains each side of the business and the field is one specific thing that refers to all of them.
6-10. Data Types
Tenns again? 1be ... don't lrnow
What type ofdata have you got here?
You mean like text, ob, decimals, date, il's actually dates, not really decimals ... that one's either TRUE or
FALSE

Zip codes?
There's no real restriction, as long as you have only five numbers, five figure numbers ...
11-14. Query Language
Initially we list, call up the menu ... that's what we're in now, it depends what we're calling up ... so you don't
want to be in CUST necessarily at all ...
18. Task 1
(types FROM a.JST SELECT) So the names and the addresses? (adds NAME, ADDRESS,CITY,STA'IE,ZlP)
19. Task l
(types FROM a.JST SELECT NAME,CONTACT,PHONE,OVERDUE PAYMENTS as well?
If a c!Unt's payments are overdue, where would iJ say?
TRUE or FALSE. Wbere OVERDUE is TRUE or FALSE, is that it?

You only want the ones where it's true.
(adds WHERE OVERDUE=lRUE)
Whal does FROM do?
Thefde.

SELECT?
The records?
And WHERE?
A partiaJJa" reoord ?
20. Task 3
You'd have to get a list of all flfSt ... (types FROM CUST SELECf NAME,PURCHASES

Now we want a list with the biggest customers ... lww would it list them now
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In alphabetical order. We need to put in something WHERE PURCHASES ...

We don't want to select particular records.
I can't see bow you do it

we wanJ to change the order in which the appear

You have to tell il to order them (adds ORDER -PURCHASES (after much prompting)
DB/SS
You can, oo a spreadsheet. alter what's there on, you can put in take out individual bits of information. You've
got much more control you can alter things while having an overview of it as distinct from ... you can have it
all up oo the screen and ... you have to go back into the menu ...(screen mask - db vs ss) it selects out for
specifiC informatioo which you couldn't do there ...

Subject 7
1. File
It's eithez a term you use for the complete lot - it is isn't it? And it contains lots of records which consist of

fields.
l . Field

A field is, in this case an example would be NAME.
3. Record
An example record would be AA Aerospace.
S. Difference Field/Record
Records contain all the information pertaining to one particular company in this case, fields contain all the
various companies' particular characteristics i.e. pertaining to ZIP code or purchases made
4. Entry
No.
6-10. Data Types
We've got date, data, we've got numerical, at some point something, I can't remember the teChnical term but it's
basically binary so it's going to be TRUE or FALSE.

We've got numerical ones - are all the ones with numbers the same?
Ab yes. I know what you're getting at, because this is not a - you cannot manipulate these [order numbers]
matbematically whereas these you can add and average of but I can't think of the name ... it's a different type of
numerical.

11·14. Query Language
FROM, SELECf, WHERE, ORDER.

18. Task 1
(types FROM CUST SELECf NAME.ADDRESS,) You wanted the name and address?
Pojf(JJ address

(adds CITY,STATE.ZIP)

So what does FROM do?
It refezs to the flle

and SELECT?
selects tbe field.

19. Task 2
(types FROM CUST SELECT NAME,ADDRESS,PHONE

Wt don't really want the address.
(edits address out by typing CONTACT. OVERDUE, enters query) Ab -I've forgotten (adds WHERE

OVERDUE=TRUE)
So whal does WHERE do?
WHERE picks out the, what's it called ...
20. Task 3
(types FROM CUST SELECT NAME,PURCHASES WHERE Do you want the top ten
No.
Can I skip the command, not use WHERE? adds ORDER PURCHASES Now I've got to order the purchases,
will that just do it?
The M/DJill is ascending order.
(goes back inserts -)

DIFFERENCE DAT ABASFJSPREADSHEET
This package seems to be, perhaps because we haven't explored it. but less easy to set up. It's designed f~ a
eoo1pany emp&oyee wbo isn't going to make radical changes whereas tbe ss tba1 we bad was actually, appeared to
be much easier to create fields and files and also you could do more manipulation oo the ss. You could do mae
mathematics ... (db v ss) you can swap between files quicker, query language is easier, other than that I don't see
what you can do here that you couldn't do there, it's got the same set up ... yes, you canD<Jt. yes you can actually
zero in oo things.
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Subject 8
1. File
A ~Je is sort of se~ exp~anato~, it's anything that incorporates information about certain things, so you can~
go ll and find out tf you re domg a file about tax balances or whatever, you just keep that file and can go to tl
whenever you want It bas sort of beadings and things, like it refers to purchases or whatever, tbaL's a ftle is it
2. Field
Ftelds
3. Record/4. Entry
An entry? No an entry is what is in the fields isn't it? ... yes right, a record.
5. Difference Field/Record
A f~eld's just like a column gives you one sort of information whereas a record gives you right across everything,
a combinatioo of ftelds.
6-10. Data Types
In this file? Decimal, and text, ... so you're asking for 4 things?
11-14. Query Language
Yes- is it FROM,SELECf,WHERE,ORDER?
18. Task 1
(types FROM CUST SELECf So what are we looking for)
Tells her
(adds NAME,ADDRESS,CITY,STATE,ZIP)
What dots FROM do?
Information about ...
And SELECT?
fields
19. Task 2
So it that the same that we've just done, or is it different? (types FROM CUST SELECT
NAME,CONTACT,PHONE So do we have to put a WHERE statement in? Do you just put OVERDUE?
How is the information whether they are overdue or not encoded?
TRUE and FALSE. So is it WHERE OVERDUE equals? (adds WHERE OVERDl.JE=TRUE)
So what does WHERE do?
The entry?
20. Task 3
(types FROM CUST SELECT NAME,PURCHASES Is l.here something else [field} you want? WHERE
something greater than something?
We just want a listing of how nwch our customers bought.
So you don't bave to use ... (deletes WHERE) So it's ORDER ...
You're ordering them by the size of their purchases.
So just PURCHASES?
(Explains ascending/descending)
Ob I see • (adds ORDER -PURCHASES) So the order command you can do things like find out people's
balances ... you want them in tbe order of preference
DIFFERENCE DATABASE/SPREADSHEET
They are very similar in the sense that they can work: things out, you don't actually have to work them out
yourself, it will work it out and everything. It's hard to think of what difference there is. Ass will actually sot
of, what we did was trying to fmd out averages and things like that, but we haven't done tbat here so fm not sure
if you can do it ... this can't do it, but the ss can work out averages and things I think a ss can do much more I
can't think of wbat this can do ... you can't actually separate select ... how come you've got two different
sySiem..S, they're very similar wby can't you get one that does everything?

Subject 9
1. File
A file's part of a computer memory where you go for information which is stored within it and it's broken down
into various pans so you can access that file and by pulling in another name of whicb part oC the me you want it
will go direct to that pan of the file.
2. Field
Tbey bave a fale as a name which is how you get into the actual ftle, you access through a name. From that you
select what are called fields, field names within the file and you can have more tban one field, depending oo bow
mucb information you want from that file you can run so many fields together to get the information you want
A field is a blodc of infoamation ... so that is one field, that is another (points to fields on screen)
3. Record
A row.

4. Entry
A piece of information (laughs).
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S. Difference Field/Record
A record takes more tbsn one field, takes part of every field which is stored in that, which bas been put into tbe
ftle. Whereas a field bas one type of information that goes through and associates with every piece of ...

6-10. Data Types

Text and nmnerical data
lVhal sort ofnumerical daJa have we got here?
Most represent money in !he sense of finance, you have dates and as well ... [I'RUFJFALSE] I know wbat it is,
I know what it's doing ...
11·14. Query Language
FROM
And what does that do?
Addresses the mename. SELECT which field it would go to, and ORDER, puts it in order if you want the
figures in order or the companies in alphabetical order ...

And? .... How about WHERE ?
Ob yes. It gives tbe conditions of the field entry ... you subdivide the infonnation
18. Task 1
So you're going to tbe customer file ... (types FROM CUST SELECT NAME,ADDRESS,CITY,STATE,ZIP)
That's all
19. Task l
So you go the customer ftle again, SELECT NAME, CONTACT, PHONE and OVERDUE, yes? (types FROM
CUST SELECT NAME,CONTACT.PHONE,OVERDUE)
Anything else?
What was it you said we want?

A list ofall customers whose payments are overdue. We're not illterested ill the ones who have paid.
Ob no - WHERE OVERDUE equals yes, or TRUE. (adds WHERE
OVERDUE=TRUE)
20. Task 3
Haven't you already got that?

NAME. PURCHASES. BALANCE?
PURCHASES is sujficienl. What else do you have to do?
Order it with the largest ones on top. (types FROM CUST SELECT NAME,PURCHASES ORDER) I don't
know bow to do this, actually.
What do you want to do?
Order them by the size of the purchases.
So the field that we wafll to order by is PURCHASES. By default it would sort ill ascending order.
So we need a minus.
(adds

-PURCHASES)

DIFFERENCE DATABASE/SPREADSHEET
This ooe [DB) is easier to use for a start. A spreadsheet is when you want to sort of print out, mate up a
presentable package as it were that you can show somebody else, this is just extracting information quietly and
just a form of keeping records so you can touch a button and have, umm ... Can you do the formula thing oo
this one? This [DB] to me is storing information rather than actually working information, you can't do
calculations, it's just like you might as well, instead of having the ftles you can actually store it on the disk.

Subject 10
1. File
A c:ertaiD set of infonnation, the computer allow it under a single name

DaliJbase file?
RepMS, and fields (cool)

l. Field
...wbicb are columns

3. RECORD
You ~011 records rather than reports?
Yes records ... tbe rows
5. Dilrerenc:e Field/Rec:ord
A faeld will be say updated it will give you say a date, which particular company, customer was updated whereas
a record will give you information about one particular customer, so say for AA Aerospace it will give tbe dare
updated and all that ...
4. Entry

rve fO"gotten
6-10. Data Types
In terms of text, dates ...
What would you call [PURCHASES}
Numbers.
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(explains they are decimals) And whal are those [TRUE/FALSE]
Is tbat binary, wbere we've only go• two types of entry

11-14. Query Language
FROM, SELECT, WHERE, I'm stuck ...

FROM?
The ftJes.

SELECI?
Particular fields.

WHERE?
What you want from those records- with purchases, say, you'd have where somebody bave over a thousand
pounds watb of purchases. Say where purchases is greater than a thousand ...
What do you actually get?
Particular entries?

Last OM is ORDER.
18. Task 1
So is it only tbe address that is required? (types FROM CUST SELECT NAME. ADDRESS, CITY. STATE.
ZIP)

19. Task Z
(types FROM CUST SFLECT NAME.CONTACT, OVERDUE, PHONE WHERE OVERDUE="'RUE')

20. Task 3
So you just want me to list the purchases? (types FROM CUST SELECT NAME,PURCHASES ORDER
PURCHASES)
(explains ascending/descending)
(inserts"=")

DIFFERENCE DATABASE/SPREADSHEET
With this you can draw particular information out With the ss it just gives you all the colunu1s. Wbeo you
input [enter] information into this, you just see the information as a single little block whereas with the
spreadsheet You can see the entire ss, you can see what you're doing ... (ss not db) you can order this, set it out
in certain ways, you can't print this out can you? You can work out means and averages [with ss}.

Subject 11
1. File
It's a collection of records. Eacb bas the same structure but containing for all different people or all different
items within a me.
3. Record
A record is like one for this company.
Z. Field
Well fields are wbat tbe record consists of. Fields are the individual items like NAME, ADDRESS
4. Entry

An elllry.
5. Difference Field/Record
Tbe field's more specific to - like a little part of the record, the record contains all ·the fields.

6-10. Data Types
Text, like this [NAME] is text, that's a decimal [PURCHASES}, numerical, or is it codes, tbey are just positive

or negative numbers, but not actually decimals. And then the date which is a date. And the OVERDUE ooes
wbich are FALSE or 1RUE where you've got two alternatives.
11·14. Query Language
FROM, SELECT, WHERE, ORDER

FROM?

From wbicb file
SELECT?
Wbkb fields you want to have taken out

WHERE?
You can resttict it further like saying where balance is above a certain ... the number of records

18. T ..k 1
(types FROM CUST SELECf NAME,ADDRESS,CITY,STATE.ZIP)
19. Task Z
So tbal's the OVERDUES then, NAME, OVERDUE and PHONE. (types FROM CUST) Does it mauer wbicb
order I put it in?
Tirey will list the Mlds in the order thaJ you type them in.
(adds SELECT NAME,OVERDUE,CONTACT,PHONE is about to press 00)
How many records will thai give you?
Ob- WHERE OVERDUE equals TRUE (adds WHERE OVERDUE=TRUE)
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20. Task 3
So you want it to see who put the biggest purchases? (types FROM CUST SELECT NAME,PURCHASES
WHERE) _No (deletes WHERE) ORDER (adds ORDER) Can't remember - is it a negative sign?

(explains ascending/descending)
Is it just minus, or?
By what do you wand to order it?
PURCHASES (adds -PURCHASES)

DIFFERENCE DATABASE/SPREADSHEET
With the db you can pick things out and ask it more specific questions and it will just give you what you want
to know, ass I suppose is more useful if you want to be able to just see everything at one time
What can you do wilh a spreadsheet that you ca11110t do with a DB?

Formulae.

Subject 12
1. File
Isn't it the thing that the information is stored in? Everything like the customer and invoices which is contained
in the computer, split down into fields and customers and orders
l. Field

Whllttlse?
What in the fields? say like the customer's name and address, orders, invoices with numbers, products (points out
field) tbat's tbe main field and just when it was last updated, the zip code, postcode
3. Record
A line? where they are all relating to the specific customer, the line goes across for the whole customer ... a
ream?
4. Entry
Don't know- an item?
5. Difference Field/Record
A field has say all the names of different custome rs but the record is just details of one specific cust001er.
6-10. Data Types
Numerical and text data
What sort ofnumerical data is this [PURCHASES)
Is that something that the computer, well it's worked it out for itself? This is just like standardised really.

(explains decimals) What about these [DATE]
DATE ... and fact. TRUE or FALSE
11-14. Query Language
FROM, SFLECf, WHERE, ORDER

Whal does FROM do?
It tells you the field you want to get infonnation from like the name field or order field, purchases field
What does SELECT do, then?
SELECf? - the specific information you want from that field, say you said from customer you'd get the
customer f.eld and say fran customer purchases you'd call up the customer field or the purchase field and you'd
get wbere, say you wanted purchases over ten thousand pounds you'd say only information in the purcba.ses field
that is over teo thousand pounds relating to the customers and then from select where, say from rustomer, ...
that's the customer f.eld
(explains that FROM addresses a file)
Ob file, sorry, customer file ... then SELECT you go to the customer file and then select say their addresses and
maybe their purchases and say and then you say where the purchases are say over ten thousand pounds ... select
picks the fields

And what does WHERE do ?
It specifies what you want, the infonnation you want within a specific field ... infonnation within the field ... ob

tberecml ...
18. Task 1
{types FROM CUST SELECf NAME So you need a comma? (adds ,ADDRESS,CITY,STATE,ZIP)

19. Task l
So you want all the customers who haven't paid?
All the ones whose paymenls are overdue.
(types FROM CUST SELECT NAME.) How do we find out about be invoices?

(poinls to OVERDUE)
{adds OVERDUE.CONfACT,PHONE WHERE='TRUE')

10. Task 3
(types FROM CUST SELECT NAME,PURCHASES ORDER PURCHASES)

Explains ascending/descendjng)
(nts "-")
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DIFFERENCE DATABASE/SPREADSHEET
Well you can't call up, it's different. what did we use it for? I can't remember. Well on the spreadsheet we used it
to wodc out averages, highest, lowest. you don't seem to do that wilh this. This you can call • wilh the ss you
couldn't call up an individual pupil and ask for their marks in different subjects but wilh this you can relate it to
individual clients. It didn't seem to work on the basis of - ... couldn't divide it into individual parcels, couldn't
call up individual names or individual subjects and look :;pecificaJly at l.bem you'd have to look at the actual
wbole thing. With this you could add to things separately at lhe end, you could add new invoices from separate
flies, you don't have to work at it as a whole, you can work at it separately . ... you haven't made changes ...
you could have that on the ss ???

Subject 13
1. File/2. Field/3. Record
A file's a whole load of information and it's got a name, say like customer or orders or somelhing like that and it
contains records - I've forgotten the name of the columns, fields, it contains them.
5. Difference Field/Record
Fields go down in a column and then you have data that is sort of the same subject matter foe each thing,
whereas a record goes across and it has different sort of subject matter but it is relating to one sort of firm oc
persoo. Wilbin a field they are all of the same type but within a record they vary because they contain an eotty
within eacb field ...

4. Entry
Don't know.

6-10. Data Types
There's numerical data. and there's letter data - I don't know what to call it, words ... text yes. Numerical digits
with decimal places as well, and the non-decimal - or is that !.he same because it's .. .
What aboUI these?
Dates ... and TRUFIFALSE sort of yes/no.

11-14. Query Language
FROM, SaECf, WHERE, ORDER

FROM?
you tell the computer which me you want to look at.

SELECT?
Which fields you want to look at
WHERE?
If you want to, say, for instance, pick everybody whose money is due, in or OVERDUE or something like that.
you can put where that equals true or false or something. You want to actually select - you're picking out

records.
18. Task 1
(types FROM CUST SELECf NAME, ADDRESS, CITY, STATE. ZIP}
19. Task 2
(types FROM CUST SELECf NAME, CONTACf, PHONE, OVERDUE) That's all we wanted?
What would you get so far?
We would get everybody - so I need the WHERE OVERDUE ... (adds WHERE OVERDUE) I can use lhe equals
sign, can't I? (adds= TRUE')
lO. Task 3
Do you just want the list of customers and then see who's got the most?
You wanl to list them in ...
Can you actually list them so that the people who have spent most money come out on top?
Yes.
(types FROM CUST SELECf NAME,PURCHASES Is it WHERE then? How do I make it so it puts it in
ORDER?

ORDER
(types ORDER) Order by PURCHASES?
(E:qJlains ascending/descending order)
(adds -PURCHASES)

DIFFERENCE DATABASE/SPREADSHEET
This is a lot easier I don't know if actually on ass you can call up individual records ... so you'd use this to
locate things you~ to fmd where ass you would use to keep track of all your.data ... (calculatioos) we did
them oo the ss, I don't know can you do them on this, because then you could do like all matbs and stuff oo tbe
ss ... but you couldn't here ...

Subject 14
1. File

What is a me, it's a collection of information about certain things - a collection of items about one particular
company or something like that.
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What things do all DB file s have?
A mask?

2. Field
Records Of' is it columns?
No, this one's called a.f~eld.
Ob yes.
3. Record
Attack?
No, this one is a record
4. Entry
Don't know.
5. Difference Field/Record
A record is more specific, it's more - a field contains more information.
6-10. Data Types
Text, ownerical.
What sort ofnumerical di;ua-like here in PURCHASES.
Decimal values.
And these [DATE]
Are they text?
And tiiLse [TRUE/FALSE]
They are positive oc negative.
11-14. Query Language
FROM,WHERE,SELECT,something else .. .
What does FROM adduss?
The me.
A.ndSELECI'?
The title of tbe different fields.
And WHERE?
Does that go to one recool?
And the fourth one is ORDER.
Ob yes.
18. Task 1
(types FROM CUST, presses 00)
[file displayed)
Ob I need SELECT (adds SELECT NAME, ADDRESS, CITY, STATE, ZIP)
19. Task 2
(types FROM CUST SELECT NAME, CONTACT, PHONE, OVERDUE wants to press DO)
Ah, but this will give you a list of all of them - you only interested in the ones which are overdue.
So we need WHERE? (types WHERE) Tbe ones that haven't paid, so TRUE? (adds TRUE)
But what is TRUE?
OVERDUE (adds OVERDUE=TRUE)
20. Task 3
(types FROM CUST SELECT NAME, PURCHASES) And that's it?
You could makL it easier to read ifyou ordered them.
So WHERE purchases are over ... oh no - ORDER (adds ORDER -PURCHASES)
DIFFERENCE DATABASE/SPREADSHEET
I would use tbe database fOf' storing information and the ss for working out calculations and things like lhaL

Subject 15
1. File
Sometbing with lots of data in, sort of data listed ...
3. Record
A column - I don't understand wbat you mean
Each line contailu informaJion about a particular company - wluzJ do you call those lines?
Doo't lcoow.
1. Field
lnfonnatioo ...
You call those jU/ds ...
Ob? I'm learning somedliog bere.
4. Entry
Don't know.
5. Difference Field/Record
A mead contains all the information about a company or whatever, whereas a field just contains one part of it ...
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6 - 10. Datatypes
3 [different types of data], dates, text, and decimals,

What about these [TRUE/FALSE]?
That's text, isn't it?

Well it's teXl, but il will only accept true or false.
That's four [different types of data]
What about zip codes
That's integers isn't it ...
Is there a difference between zip codes and those numbers [anwunts]?
They [amounts) are decimals decimals, aren't they?

11-14. Query Language
FROM, what ftle you're actually going to take the information from ... SELECf, what part of the information
you want, fields. ORDER ... WHERE, where certain things have to be met for that to be brought up, ORDER can't remember. Yes which way, whether you want them in alphabetical order, bow the order is there ... or you
want the biggest number at the top... the ORDER of recocds

18. Task 1
(types FROM CUST SELECT CONTACT,ADDRESS,CITY,STATE)
I think you forgot the name.
Ob, I thought you want the contact name.
19. Task Z
(types FROM CUST SELECT NAME,ADDRESS,CITY,STATE,CONTRACT WHERE) I have forgotten how

to do now ...
How do you tell it to retrieve all that are overdue?
Is it PAYMENTS?

Is thai where you get the information from whether they are overdue with their payments or not?
Oh- OVERDUE- if overdue is true. Do you just put (types OVERDUE=TRUE)
[Field contract not found)
Ah corrects typing error.
20. Task 3
(types FROM CUST SELECT CONTACT,ADDRESS,CITY,STATE ORDER) Its PURCHASES, isn't it? Do
you want the smallest or the largest?

Largest(adds PURCHASES) Is that it, is it? Is that positive or negative?

Thai will list them in ascending order.
(inserts minus before PURCHASES)

If still got another problem You want "pmcbases" there, don't you? (inserts PURCHASES after SELECf)

DIFFERENCE DATABASE/SPREADSHEET
A spreadsheet you can only put actual data in - you can't do things wiith it Like this actually pick it out and
move it around unless you want ... It's easier to put stuff in - you can actually type on the actual spreadsheet
where you can't with this you have to actually enter things. You can work things out with a spreadsheet, like
minimum and maximum.

Subject 16
1. File
Certain amount of organised information that's repeated, they've all got names and - I don't know how to desaibe
it.

DB files?
You mean the fields?

2. Field
They are aU little sections of information - different categories.

3. Record

Is it a record? What is the difference between a record and a file?
A file is this whole thing?
I see- recmls are individual
4. Entry
Is it an entry? I was thinking in terms of those [records] being a file .. so can you have lots of files in a db?
[thinks a db is one file1

S. Difference Field/Record
Do you mean the numerical and that sort of thing? They are the same [in fields] and different [in recools].
6-18. Data Types
Things like that, decimals, alpba-numericals - is it that, don't think there are dates - are they just numerical?
Sort of opposites aren't they, TRUE or FALSE.
(explains numbers other than decimal)
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11-14. Query Language
FROM, SFLECf, WHERE, can't remember the last one
The last one is called ORDER. What does FROM do?
The ftle.

SELECT?
The individual field. like address or something.
AndWHERE?

.
You specify what you're actually looking for like purchases under a certain number of something ... doesn't it
narrow it down even fwtber?
18. Task 1
So is it FROM CUST? (types FROM CUST SELECT NAME,ADDRESS,CITY,STATE,ZIP You don't need
WHERE this time do you?
19. Task 2
So what's lhat NAME, OVERDUE ... is it just OVERDUE or is it BALANCE as well? (types FROM CUST
SELECT NAME,OVERDUE,CONTACf,PHONE, presses DO) Should we just have done a WHFRE? (adds
WHERE OVERDUE=TRUE)
20. Task 3
Do we bave to put a certain numbez or do we put them in order? I've forgotten bow to do that (types FROM
CUST SELECf PURCHASES,NAME)
Now you IUJve to puc them in order.
So is it ORDER. not WHERE? I thought you had to use WHERE.
(explains tiUJt WHERE is optional)
How do you invert the order?
(explains)
(adds ORDER -PURCHASES)

DIFFERENCE DATABASE/SPREADSHEET
lbis one seems much wider, there are more things happening. I can't remember what the ss was like. Didn't we
have to write out formulas with ss, it's done here isn't it? This is just about keeping files. keeping information.

Subject 18
1. File
It's a part on a disk, where a program or where, I don't know bow to describe it. where something is stored ...
consist of recoo1s and fields.
2. Field
A field is like a column saying you know whether something is overdue or purchases or giving you information
like in a column.
3. Record
Records ... a record is like a line with everything about a certain customer or a certain company.
4. Entry
Do you mean whether its numerical? Don't know.
5. Difference Field/Record /6-10. Data Types
Fields you can have 5 different sorts of things [datatypes] - that you can work on, numerical or decimal, dates,
TRUE or FALSE
11-14. Query Language
FROM. SELECf. WHERE, ORDER
FROM?
1be name of a file

SELECT?
1be fselds that you want
WHERE?

you select whether it has to satisfy something like - if you want a certain field that bas entries that are ooly
greater than or less than a cer13in limit.
18. Task 1
(types FROM CUST SELECf NAME,ADDRESS,CITY,STATE,ZIP)
19. Task 2
(types FROM CUST SELECf NAME,OVERDUE,CONTACT,PHONE presses do)
You're rwt really inlerested in t~ people wlw have paid ...
Mm. sbould have dooe the WHERE (adds WHERE OVERDUE=TRUE)
20. Task 3
So would you do it using the ORDER'! (types FROM CUST SELECf NAME,PURCHASES) Can you go
straight on to ORDER? (adds ORDER -PURCHASES)
Why have you put -PURCHASES?
Because otherwise it would have just put them in alphabetical order.
If you put ORDER PURCHASES?
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Alpbabetical.
No (explilins).

DIFFERENCE DATABASE/SPREADSHEET

'!ou'd u~ tbe ~~ more for retrievi_ng information, and the spreadsheet more for designing ways of showing
mformaboo. Like tf there was sometJung you wanted to lcnow, like you wanted to make a bar chart or if you
wanted to show Lhat say the exams [ss example fLies], in order to show which students bad a certain percentage or
whatever you'd use the ss rather than this ...

Subject 19
1. File
A ftle is something to keep information in. I presume it's called a file because - I mean, it is the easiest way for
people to relate to what it is on a computer, rather tban calling it something else. I mean because people use

flies in offices and so a me on a computer ...
What does a dlJJabase file do?
If you've got different, there are different parts in a me which you can follow up, which you can go down to like
invoices, customers and things like that and you can select one of these within the file, but not all files will
necessarily have the same components.

3. Record
No.

2. Fields
I know that those are called FIELDS
4. Entry
No. I didn't read the instructions.

S. Difference Field/Record
Fields would only oootain something, all the postcodes, whereas records contain a multitude of infomtation, all
relaled 10 one particular thing- like so I mean these aren't really related.

6-10. Data Types
WeU the different types of data are like purchases and payments -

PURCHASES and PAYMENTS contain the same type of dala It's not a date, it's just bow mucb money ... to do with their address, but they're all related 10 one particular ...
1bese have to be changed all the time whereas this wouldn't have to be changed ... so that's ... well if it's
overdue or something like that. These ace the things you work with whereas these just relate 10 .•• you could
only get tbal. as a derivative from that ...

11-14. Query Language
No.

18. Task 1
All of them [customers). You get the customer file • shall I do it? (types FROM CUST SELECf
NAME,ADDRESS,CITY,STATE,ZlP)
You've used two things from the query language- what does FROM do?
That addresses it to a particular me
... and SELECI?
Fields.

19. Task 2

We'd get the name and phone number, and also OVERDUE (types FROM CUST SELECT

NAME,PHONE,OVERDUE,CONTACT WHERE .OVERDUE=TRUE
Do you want anything else?

Do you need anything else?
This immediately tells me whether they are overdue or not -

But they will list all companies regarding of whether they are overdue or not- you're not inluested in the
oMs which aren't overdueSo wbere OVERDUE equals TRUE (adds that)
20. Taak 3
We have 10 get their name, purchases. and then it's either ORDER or minus order
(explains ascending/descending)
(types FROM CUST SELECI' NAME. PURCHASES ORDER-) Doesn't work
(explilins how to use ORDER)
(adds ORDER -PURCHASES)

DIFFERENCE DATABASE/SPREADSHEET
This bas ready-made fields, I suppose you can make fields. Mnun can't work things out ... with a spreadsheet
you can do the average and things like that. I don't know perhaps you can do it and so from that point of view this is only information whereas the other thing also did have the capacity to

Are things you can do in a DB you can't do in a spreadsheet.
It can't order things in the same way can it, or can you? It's not done as easily, is it. You can't select
information in the same way. I would have thought this has much beuer practical application, you lmow for an
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office f~.:;.:.!?suppose if you just wanted to print, just do basic calculations and lhen prim it out ... is this a
type 0

.,.~ .

Subject 20
1. File
A piece of a computer where you can keep information ...

And if you think abow dauJbase files ?
... data. information- f.elds ...

z.

Field
A field was each line, no eacb column
3. Record
Can't remember.
4. Entry
An entry.
5. Difference Field/Record
Fields contain the same information but for different fums or lhings and records contain the information fe6 one
particular ...
6-10. Data Types
Numerical, text, dates - anything else? ...

There are dijferenl types ofnumerical data?
Decimal and just I can't remember, ... TRUE or FALSE, yes ...
11·14. Query Language
WHERE, is one of them, FROM, can't remember the names, SELECf. it's FROM, SELECT, WHERE• ...
ORDER

FROM?
You put the flle

SELECT?
Various fields

WHERE?
Where, is that tbe flflDS or the name or ... ?

18. Task 1
(types FROM CUST SELECT NAME,AbDRESS,CITY,STATE.ZIP)

19. Task Z
(types FROM CUST SELECT NAME,OVERDUE,CONTACf,PHONE) Is that it?

What are you going to get now?
All tbe cuscomers who are overdue.

Really? I think you'll get nwre than that ...
But we've put there OVERDUE, so that should be all right

If you use SELECT, it will give you those fields, and it will give you all records for those fields.
It will not just give me tbe ones that are overdue? OVERDUE is TRUE? comma TRUE?

Equals.
(adds WHERE OVERDUE=1RUE)

20. Task 3
(types FROM CUST SELECf NAME,PURCHASES) From WHERE purchases equals?

You want a list and then decide ...
Shall we ORDER it? (adds ORDER PURCHASES)
(explains order)
DIFFERENCE DATABASE/SPREADSHEET
A spreadsheet is more for storing infonnation. I suppose the dat.abase is as well, I'm not sure ...

What can you do wilh a database that you cannot do with a spreadsheet?
I'm not sure ... you go and look: at the ss, whereas here you can find just the information that you want ...

What can you do wilh a spreadsheet that you cannot do with a database?
Averages, that sort of thing ...
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Prolog Study
Subject 1
1. person(annie, remale).
Ifyou type in person(anniejemale). what should the a!lSWer be?
That she could be a parent. a?
You llTe actually putting the question to the system whether there is a person annie who is female
Sony, the answer would be yes (correct]
2. person(X,remale).
So try tluu, yes, if you type in person(Xjemale)., what should the answer 10 that one be?
Should give a list of alllhe females. [correct] So it should be 7 females.
3. parentOenny, Z).
Ok if we look at the second block of rules you've got the parent relationship type parentljenny,Z)., whaJ
should the answer to thai one be?
Thal she is a female, or ...
whal have you got in those parent relationships?
Ob, tbe husband sorry
No it is, the first object is the parent and the second is the child, so what do you get if you type in jenny,
Z?
Any cbildren
... thai jenny has he's got, so (enrets query)
(X = harry, X =james, X = kathy, no ]
So sbe's got 3 children
4. parent(carol, rosie).
Now ifyou type in parent(carol,rosie) if you look at the facts what should lhe answer to thai one be?
Yes, because that's indicabng that they are mother and daughter. [correct)
5. parent(sophie, rupert).
Now if you would type in parent(sophie, rupert).
That might be yes or no.
you can actually look it up - so what should the answer be?
No, because it's wrong. [correct]
6. child(rosie, X).
Similarly, if you would type in parent(rosie, Y).
The answer would be no because rosie's got no children. [correct]
7. all daughters (conj. - TT)
Now slightly more tricky, if we wamed to retrieve all the daughters ...
All the daughters?
And obviously we can't do thai by just referring to one of the facts, if we wanted the system to list us all
the daughUrs how could we do thai?
pessoo(X.female)
And, th/Jl is one condition they would have to fulfil to be female, the daughters, what else?
They musn't be a parent
Well we don't really mind
They just fit the person category
But they have to fulfil another condition as well. If you are a daughter, a you must be female, but wluu do
you have to have to be a daughter
A name?
No
A parent?
So you would have to type in a query that somehow assures that you get returned a person who is female
and also has a parent.
Can I just put in capital letters parent (X, Y).? (types parent(X, Y),person(Y,female).
So wh/Jl should th/Jl rerum for X and for Y now?
'That should list all the females from the parents
Yes but what exactly does it return for X andY
In each caseY would be tbe daughter and X would be the parent
[cmect]
8. test rule
Apart .from these two blocks offacts there is a rule at the end of the database and thai rule defines whaJ a
father is, the rule actually looks like this it says a person is a father to a child if that person is a parent to
that child and if the person is a male person.
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So if you just wanted it to give you a list of all fathers and their children what would that query look like ?
(types parent
No you don't have to do that because you 've got the rule so all you have to do is ... say father (enters falhet(X,Y))
[X=eric, y =jenny1
9. placeholder
Ole now if you would put in the same query all the people who are fathers but you don't really want to know
the tlil1MS oftheir children how would you do that?
Just say father X
But the structure of your quuy has to match the header of the rule, so you have to have 2 objects, bus
instead of putting in a variable for the child's name, if you say ok they've got children I want to know the
falher's 1lil1M but don't want to know what the names oftheir children are. Any idea whal you do?
List father?
Thai wouldn't be a question would it?
/fyou ty~falher(X. -now say I know there is a variable here but don't tell me what iJ is?
Oh do I just put an Wlderscore?
yes, OK,
(types fa.t.ber(X,_).
yes rerum that now

10. Repetetion
{gets X=eric.X=eric.X=eric]
That signifies he's got 3 children

11. Analogous rule
And al the end is the father rule, now if you would write in exactly the samL fashion the rule that defines
who is a mother
(types motbet(Mother,Cbild):- person(Mother,female), parent(Mother,Child). [correct]
ll. New rule ('IT)
Thai's righl. Now if you wanted to define what a brother is ...
Bromm?
yes
(types brocher(Person.Child):· persoo(Brotber,male), person(
I think that actually there are two conditions that that person has to meet the first one we've listLd
That it must be a child?
You should have put, you know if you say "Brother" here, you've defined that the brother's got to be male
so thal should be Brother
Oh Person should be Brother
Thai's right, because that's got to be the same variable, because you've got to make sure thai the brother is
actually male ... no the brother has got to be male. I think it would be better to have it the other way
round. a brother is Brother to a Person if say Brother with a capital 8 now
(types brotber(Brother,Pers):- person(Brother,male), person
So the brother's male?
Brother has got to be male, yes, doesn't matter what sex the Person is you can be brother to a sister or
brother to a brother.
(types brother(Brother.Male):- etc.
Whal does that variable do there why have you called it Male ? You want to say that brother is Brother to a
Person?
Perhaps just say person
Yes well but you've got to put a variable there. Like here you say a mother is mother to a child if the
mot~r is femLJle and a parent ofthat child and the same thing you say here a brother is brother to a person if
brot~r is a male person and then we start thinking aboUlthe second condilion.
so persoo lbete (typeS brother(Brotber,person):- etc.
No it's a variable
(types broeber(Brother,Person):- etc.
OK now comes the tricky bit - what is the second condition?
Brother is a person, brother is male, person is a brother if he's a male, person
No if you just say it in English. what is the other condition ?
1be brother is a person, tbe brotber is a male, the brother is brother of a female
No he can be the brother of a male person, what is the second condition you have to meet if you are going
to be a brother?
A person, no, sorry can't see it ...
Well there are essentially two things that you have to be in order to be a brother of someone, you've got to
be male and what actually links you to that other person if you 're going to be a brother? If you are a brother
to
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Someone else, someone who is a relative,
What relfllive?
brotber or sisrer

No what is the link between you and that person you are brother to?
A relative

Which relative
Parents
Thal's right -so what about the parents
He must have ooe,sorry it must be the same parent
Thal's right you must share and we are not fussy here about brothers or half brothers so you must share at

least on parenl. How would you do that?

I can't say parent. comma. same?

No, because the system doesn't know what same is bur you can actually make it realise that both of those
people have the same
(types brodlet(Brolher,Persoo):- person(Brother,male), persoo(Parent
So who has got to have the parenl

Pesson
Right
(lyJXS person(Parent,Pm;oo)
I think you might want to change the predicate at the beginning of that line
ohpesson?

you want to say the person's got a parent so you use the parent relationship because parent comes first in
the parenl relfllionship then child so you're saying here person has got a parent but the relationship's called
parenJnot person. The first one is but not the second
( t)1XS persoo(Petson,parent.Person))
No, you say the person's got a parent, the relationship is called parent - you are referring to the second block
offacts there which list parent, open brackets, name of the parent, name ofthe child
(types parent.Person) )
can I do it for you, perhaps you'll see it then types parent(Parent,Person),)
so the person's got to have a parent and the brother has got to have the same parent (types parent(
So it's capital B for brother and small p for parent
No, the brother is a child as well, but he'll come in second place in that relationship and the parent comes
first and since you want them to have the same parent you give them the same variable name as you did

with the Person.
Brodler?

yes

Subject 2
1. person(.annie, female).
So the first question would be person(annieJemale). what should the answer to that one be
that's a trick question isn't it. it would come back and say yes [correct]
2. persoo(X,female).
OK, if you typed in person()(Jemale). what would the answer to that one be?
It would come out with the answer X= annie, jenny, zandra, carol ![correct]

3. pareot(jenny, Z).
Ok if you look at the next one the parent relationship,

if you type in parent(jenny,Z) what would the answer

to thai one be?
Z =barry, james and kathy

4. pareot(carol, rosie).

That's right, if you typed in parent(carol, rosie). what would the answer to that one be?
Yes. [COO'CCt1
5. parent(sophie, rupert).
And ifyou typed inparent(sophie, rupert) ?
No. [correct)
Why not? why would the answer be no?
Because there isn't one. sophie isn't a parent

6. parent(rosie, X).

She is actually there but she's a child raJizer than a parent. And if you said parent(rosie, Y) ?
That would come out no as well. because there's no rosie in the firs t part of the relationship. [correct]
7. all daughters (conj. - TT)

Right, now if you wanted to retrieve all the daughter that we've got in this knowledge base how could you
do thai?
Start of with persoo(X,female)

And then?
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With the names that you've got, you have to write them down

You're saying you run that query first and then you writ~--the names down and check which of those are
daughters?

Yes
Surely there is an easier way ofdoing this?
got to start :in the same way Well if you type in thai first query
(types persoo(X, female)
and i[!ou think about it, if you want to tell the system, tell me all tlwse who are also, what is the second
condilwn? !0" nearly said it, the second condition they have to meet?
Use the same X m the second column there to match it up?
Well you can run two queries at the same time, can't you, if you want more than one, ifyou want to meet
more thai one goal you can just link those two goals, you can just say this has got to be true and that has
got to be true
You've

Just a comma after the ... ?
That's right
(COOlpletes the query to give person(X,female),parent(Z,X).)

Yes that's right,. so now what would it return for X and what for Z?

For Z it will return all of those
All of those?
All of lhose wbo are female?
Not quite, which ofthose parents will it return?
Ob, those lbat bave got a daughter, where X is female ...
That's right so iJ should return the name ofparents with daughter for Z and for X?
It will return the names of the daughters
And it should go in pairs, right -just do it - so it says X is jenny so jenny is the daughter and ann~ is hLr
mother, ok then you've got jenny and eric (etc)
So annie's a grandmother?
yes that's right
8. test rule
Now if there is a rule at the end of this database which defines what a father is. The rule says
fathLr(Person,Child):- parent(Person,Child), person(Person,Male). So that means a person isfaJhLr to a
child if the persons a parent to that child and the person is male. OK? So now ifyou wanted to test that
rule and ask it to tell you all fathLrs and their children. could you type in a query for that? ·
Start off with father?
Yes
(types father() Two variables? (completes query)
So now so you get ... ?
fal.ber
The faJher first for X and child.
9. placeholder
Now if you type in the same query but say I only want the name of the father I don't care what the names of
the children are, just give me a list of all the jtuhers and don't tell me what the children are, Jww would you
do that?
Small y and big Y?
No, because if you don't put in a variable you'd have to put in a proper object. You have to put something
there, that's righl because you have to match the structure of the rule that you are addressing because we've
got two things in here, but how can you get it to return. if you just say I acknowledge that there is a second
variable but I don't want to know what it is right now. any idea?
Put something like Person in lhere?
No, that would just be another variable. You an just hold the place by ...
Do you use a space?
An underscore it is, because you have to use the underscore to mark that space, so ifyoujust try that
(types fat.ber(X._).
[X=eric,X=eric,X=eric.X=martin etcJ
10. Repetition
So it said eric three times, then martin twice, then norman three times then rupen once. so why does it do
IMI?
That's because eric's got three kids
11. Analogous rule
If you go to the end of the file you can see that rule that we've just been using ... now could you write the
rule for mother, model it on the father one
(types mothet(Mother, Child):- person(Mother, female), parent(Molher, Child). )
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12. New rule (TT)

Now could you aJtempt to write a new rule, a slighlly different one that would define wlull brother is
(typeS brot.ber(
it's got to be Brother hasn't it

Well does it mtJiter what you call it? If you wrote the correct rule but instead of putting Brother with a
capilal B you pUI in Piglet or whatever and you ran the query
You'd bave to run lhe query wilh Piglet not Brotber
N~, not ~eally, ~I mea:z if you called it piglet here then you queries would always have to match piglet but
wllh v~riables 11 doesn t really matter, you could call them X, Y or A, B, Brother, Person - by the name it
doesn t really mtJiter. There is no connection as such between these two, so it's only for you to understand
if you look at the rule again, and you look at the variable names and the variable is meaningful rather than
X andY but you know e.mctly what slwuld be in the phrase, which variables should be, thai if you get an
object returned for a variable that you know whal it actually mean
So could you go capital X there and comma ??
Yes and put a second variable, instead of Mother, Child you could put X, Y if you wa111, I don't know which
you prefer, try it that way
(typeS brotbei(X,Y):/f
(types pe1'SOO(X,male),

Now if you just say it in English, say he's got to be male, that's the first condition he's got to mut to be
brother, what is the other condition? what makes
He's got to be a child

Yes, thai's right, is that enough, you've got to be a child and?
Not an only child

BUI how would you get thai? If you try, if you said, nor an only child. if you try to, how else could you
say that. to express it in a different way?
Brother <r sister?
Yes you have a brother or sister, and what makes someone your brother or sister?
Same parents.
Thal's righ.t, so, that is the way you have to write it oo•
By parent?
You would somehow have to get the system to make sure that they have the same parents, you use the
parelll relationship, that's right
(types parent(
Do you have to do mOiber and father?

We'll say, we count half brothers as well so if they share one parent that is fine by us thai makes them a
brother, what do you put in there now?
Capital Y?
Well you've already used Y up there in the header, what does theY there scan for? what does brother(X,Y)
mean?

The X is brother and the Y is

What is Y?
Obdear!
If you look at the mother/father rules, you've got two variables there as well so what does the second one
stiJ1IlJfor there?
It's a child but ???

Well the header of your mother rule says if you put say mother(X. Y) you would read that as

modlet and her child
So X is mother of Y if?
So Y is a different brother or sister

Thal's right so tlulJ is the person they are brother to, now if we get back to the pare111 thing you can't reaUy
uSL y because you use y for the variable for the the person they are brother to so what do you do about the
parent?
Another one Yes just give it another variable name, that's right

X,Y~ that's, ok now we tell il go and search and look for parent of Y and make sure it is the pare111 of X
I see
So you need one more line in there, you've now told it the pare111 of Y
So you need t.be parent of X? (completes typing to produce as end result brotber(X. Y):- person(X,male),

parent(Z,Y), parent(Z)()o)
b'--'· 10
So that should do the trick, if you just insert one or two wr~ mes
just written (saves it)

..J
I
,
now save tt ww test the ru t you ve
0

0

O o

__
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I see now, looking at it

Yo~, see what the system will be do!·ng. ok fi~e, so if you just run a query now to test thai particular ru~. I
do t know whether you want to ptck a part,cu/ar test or just get it to tell you all the brothers and person
they are brother to
(types brotber(X.hany).

Subject 3
1. person(annie, female).
Ifyou type in ~rson(ann~Jemale). what should the answer be?
~~ person(anrue.female). If there is one it will just be yes. (RE11JRN)

l. persoo(X,female).
lfyou type person(XJemale), whal do you think the answer should be?
a list of all the female people.
·
[list oC all females]

3. pareotUeony, Z).
If we loolc at ~he second ~lock offacts then, if we type in parent(jenny,Z), what should it cell you?
(types query) It will say who Jenny's children are. REI1JRN
[barry]

RETURN
[yes]
You should have typed in semi colon to get the others ...
4. pareot(carol, rosie).
Ifyou type in parenl(carol,ros~).• what should the answer be?
Yes- sbe bas got a child called rosie (enters query)
5. parent(sopbie, rupert).
If you type in parent(sophie, rupert).
(types query) It will say no because it is the other way round. R.E1URN
[oo]

8. test rule
WhaJ we're going to do now is add a rule which says a person is a father of a child, if you cell me in normal
English what are the conditions that have 10 be met so that a person is the father ofa child
That it's male and it's got children.
So ifwe do that using the facts we've got in our knowledge base. 1/you say father(
(types father( name? does it have to be capitals?

Yes ...
(types Name, closes bracket)

You want to say a person is the father of another person
So you I need another person as well? (adds Cbild)

If- right what do you want to do first, the person or the male bit?
The male bit so name, can it go tmder name, or under father again?
where have we got the informaJion about the sex of the person?
(types rule) fathet(Name,Child):- person(Name,maJe), parent(Name,Child).

11. Analogous rule
lfyou write the same rukfor mother(types) motbet(Name,Child):- person(Name,female), parent(Name,Child).
Now if we now save and try those out ... so if you say father(X. Y). What does that do now?

encers query
{X=eric, Y=jermy]
it's saying that eric is tbe father of jenny (tries a few more) and that's giving other fathers and their children

if you wanted to have the names ofall the mothers?
That's tbe same - just the mothers' names? (enters query and gets those)

ll. New rule (TT)
If you now try to write the rule that defines what a brother is. What conditions have to be met for someone's
brother?
It bas got to be male. and it's got to have a parent with more than one child ... I don't lmow bow you do that it
bas got to bave the same parents as some other people, otherwise it wouldn't help ...

How could we do that? We have to make do with the facts we've got in there ... We are happy with half
brothers and sisters, so all they have to do is share one parent • stan with the first bit
(types brotbet(Name, Do I want to lmow the brother and the other person as well?
You want to know whose brother they are as well ...
(adds Persoo), Do you have to bave parent, X, Name then parent ...
just type in what you just said
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(completes rule) br~r(Name,Person):- person(Name,male), parent(X,Name). parent(X, Which variable name
shall I use? Name agam?
(explains whalthe rule so far dces) So you want to say they should also be parent to- which variable name
have you used?
person (adds Person).
Save it and try il out. Which query will you use ro test it?
brotber(Name. Person).

You can either ask it to list you all brothers or people they are brothers to, or you can ask it to list the
brothers of a specifiC person, or you could ask to list the person that a specific person is brother to
If you wanted to find out a person's brother you'd put Name, and then the name of the person (types
brother(Namejames).
What should the answer be?
barry. just barry
[harry-> james -->1

and it returns james, if you think about it logically because james shares the same parent with himstlf so if
we dcn't, the program actually returns that as an answer
10. Repetition

So wby does it do it twice? Because they've got got two parents?
Yes because they share two parents ... If we don't want it to return as an answer people themselves, we
could do something to our rule to nUlke it now do that, if you say it in English what would you have to tell
them?
The person is not called james, the person we are looking for is not called tbe name
do you want to try it?
(edits and types by adding another line) Person\=: Name.
(types query) tl'olber(Namejames).
[harry twice1
harry twice, but doesn't retumjames any more

Subject 4
1. person(annie, female).
The first question, ifyou would askperson(anniejemale).
(types persoo(annie,female).)

Ok what should the answer to that one be?
It's going to be yes, it's just asking if it's got a female person called annie. [correct]
Z. person(X,female).

If you would ask it person(Xjemale).
(types persoo(X,female).)
All the people's names who :are female. [correct]

3. parent(jenny, Z).

Now similarly if you would do that for the second block. let's say parentUenny,Z)
parent's name of jeMy which would be barry. james sorry, no

It's the other way round, it is the parent first and then the child so
Ob right, sorry, annie, no
No, if you substitute the second one and say parentljenny, Z).
It would say jenny is the parent of someone else would it? barry james and katby. [correct]

4. parent(carol, rosie).
That's right, it would list the kids, if you said parent(carol, rosie), what would the answer to that one~?
It would be yes. [correct]

5. pareot(sophie, rupert).
And if you said parent(sophie,rupert)?
No

Why is thai no !'
Because that's saying that wphie is the parent of rupert. but rupert is lhe parent of sophie. [correct]

6. parent(rosie, X).

Right and the last one in thai, if you said parent(rosie,Y).

lbat's wrong because that's asking it the name of rosie's children, and rosie hasn't got any.

7. all daughters (conj. - TT), 9. placeholder

Now from this database if we wanted co retrieve all the daughters how could we do that?
Do we put N as a variable for name inside the bracket
yes. You could obviously put a rule into the program that wou~ define what a. daughter is but we haven't
got thai there is no rule in there tm:-t tells you .what a daught~r 1! you have to ;ust, but you could actually
get it to list you all the daughters ;ust by puttmg one query m, if you could find out what that one is. In
terms ofthat database what conditions does one have to meet to be a daughJer?
Female and be a child
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That's righl ...
Ah so you put in person(Name,female) semi-colon
ComiTill. if you want to connect it
comma ...
And then? ok you can stan off with tlult type the first pan in
(cypes persoo(Name,female),

Ok so that's a first condition and the second one is - you said they've got to be a child
Wouldn't work if you put parent ... ?
Try it
pareni(Name,-) because you want ...
parent(Name,-)?
Because you want that side of it [the relationship], so ...
So ... you're very close there
person maybe? person(- ... because I can't see how you can put in ...
You watU to get at the last thing in the bracket don't you, tlult is really wlult we want, but you use that
reliJlionship thai is rig hi, it is just that you worry wlult to do with the first
Oh you've got parent outside
17wl's righl
You put parent in front of the brackets, dash then Name?
Yes thai's righl, because if you do it the other way round you said parent(Name,-), tlult would actually get
you mothers wouldn't it?
adds (__.Name).
[Name= jenny, jenny, zandra etc.]
Oh - two jennys ...
What are you wondering about?
10. Repetition
Why it bas come out twice
Why has it come out twice that is a good question. Well here it is actually quite logical why it comes up
with the name twice
... because tbere are two parents.
8. test rule
Ok, now I've put one rule into the dlltabase which defines what a father is. That rule says a person is the
father ofa child if that person is a parent to that child, using those facts, and if that person is a male person.
So if you would ask it now to list you all fathers and their children, using this rule ...
So it says father ...
Father has got two variables in the header so ...
So it would be
You can call the varillbles whatever you like. It should return you if you put father, you've got two in there
because I've written that so that is says a person is father to a child so it should be able to give you the
name ofthe father and ...
So if you put father, name of tbe child and name of the father (types father(Name,Cbild). RETURN)
{Name=eric,Cbil~jermy ,Name=eric,Cbild=martin etc.]
11. Analogous rule
OK if you edit the file now and you could write the same rule for defining what a mother is?
(types mother(Mother,Cbild):- person(Mother,female), parent(Mother,Child).)
12. New rule (TT)
Could you write a rule that would define what a brother is?
I've got a brother myself? (types brother(Brother,
sister?

You have to put something there but sister would be because you can be brother to a male person as well.
Call it something gender neutral
Can I put Brother and Sister?
Not reaUy. because you want to wrile a different rule for Sister. Ifyou put Sister here as a second varillble, il
is not really true because in the case of lulrry and james or wlultever it would tell you that james is lulrry's
sister and that would not be righl would it? It would just be a very unwise variable name so call it
something neutral ...
Just neutral?
Person or something like that
(typeS brocber(Brotber,Person):The next line is quite easy as well ...
(typeS persoo(Brother, male),

Now we come to the tricky bit wlult else do they lulve to do?
Have the same parents, same families ...
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I _was j~st going ~o say we can make it a little bit easier because we haven't got any half brothers or half
Sisters 111 here so if they share one parent that will do
So parr nt outside the bracket then Brother?
Yes. Brothe: has got to go somew_here i_n there, that's right. Try to think what you are addressing. here you
are addressmg a person fact, eariter on mthe program, here you are addressing a parent fact, iJ's just a TTlllJier
of Ieeeping in mind what stands where ...
So parent for Brother and the other will be the same variable - underscore, parenl's name?
You have to put something in there because you want to link brother to person through the parent and the
way to do that is to assign the same variable name to both the parents, to put one variable flllme in there and

then brother and the system can link that to the person
ObI see.

Yes. so you can do it in two lines really
Wba1 aoodler line as well?
&cause as I say you have to once link a parent here and then you have to link it to Person because they are
children, as you righlly said they are second in the bracket so what you have to do now is assigning a
variable to the person, to the parent ...
Just X or something?
that's right
(typeS parent(X,Brotber), parent(X,Person).))
So that should work shouldn't it?
Right, do you ufllkrstand that now, what you've written
Yes brolber is brother to a person if the brother is male person and parent of the brother is X and parelll of the

person is X

Subject 5
1. person(annie, female).

OK. ifyou would ask it person(anniejemale). what would the answer to that one be, you've got a print out
It would be either yes or no

You've got a print out of the program there ...
So you want me to type it in? (types person(annie,femaJe). So it should be yes then. (correct]

2. person(X,female).

If you would ask it person(XJemale).
It would give a list of all the females . [correct]

That's right
3. parentOenny, Z).

And similarly if you would ask it parent(jenny,Z), what would the answer to that one be
Yoo could answer yes female

If you said pt:Uenl?

ob sorry, if you said parent, it's going to answer whoever jenny is a parent to, james. kathy ...
Andhany
Is it, hany as well?

4. parent(carol, rosie).
That's OK. ifyou would ask it parent(carol,rosie).
Either yes or no - yes
5. parent(sophie, rupert).

And ifyou ask parent(sophie, rupert).?
It's going to say no because of the relation, rupert is the parent of sophie. [correct]

6. parent(rosie, X).

And if you aslced parent(rosie,Y).
It would list all the children of rosie which would be ... oh she isn't a parent, so it would say no

7. all daughters (conj. - TT)
Ok. if you would try to retrieve all the daughters we've got in that little knowledge base how would you do
that
ob all tbe daughters it would be person(X,female), parent(!.X). as long as the X is the same for both of tbem

Yes you have to use the same variable fllltne - if you ;ust try that one ...
person first?
yes

You want all the daughters so it's going to be (enters person(X,female).parent(Y,X).)

OK so what, it is returning now for X
... is telling us who is the daughter and Y is the parent of that daughter

8. test rule
·
OK, fine, what I've done is to put a rule at the end of that fi~e to define what a father 1s, the rule says a
person is father of a child if the person is a parent ro_that_chtld a~ that person 1s a male person, so you
could now ask it to give you a list ofall fathers and thetr ch1ldren usmg that rule -
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Yes. fa.tber(X,Y)- sball I do that one?
p~

(eoters f.alber(X, Y).)
[list of fathers and children]
~u would say now I want a list of all fathers but don't want to know the brats' names, how would you do

9. Placeholder
You could put a small y?
You have to do something about the Y but

Ob underscore, if you just do a barYes thai's righl so ifyoujust type it
(types fat.bei(X._)
It's an underscore, thaJ's righl
[X= eric eric eric manin martin rupert]

10. Repetition
would you like to comment on thai list ?
It means that eric, martin and norman have more than one child and rupert only bas one
Yes, because, whal is happening It bas filled in alllbe variables for the bar without giving them names

11. Analogous rule
... and look at the father rule I'm sure you could write the rule for mother now ...

Wonderful, so fve got to write it for mother now

Yes if you just try thai
(types motber(Mother,Oilld):- pecson(Mother,femaJe). parent(Mother,Child).)
ll. New rule (Tf)
Yes, thallooks good doesn't il. Now, could you write the rule that defines what a sister is
(types sister(Sister,female):- person(Sister
Ob wbat bave I dooe bere
I was going to ask you thai She's got to be a child though hasn't she?
I mean if you look at thai one thai actually means mother is mother to a child if
So ...
what you want to put here in the second place is, well it is the same thing. it must be another sister to
Thai's righl you have to putA child isn't it
Well you can call il, I don 't know what seems reasonable to call it - you could call it sibling with a capilal

s

So distinguish between the mother/child relationship
Thal's righl
But will child work. there if you put it in?
Yes you could try it, if you just
Because child is like listing all those people
It won't really matur what you call the variable, you can call it banana and it will still work if you put the
variable name ill the righl place
So not female ...
Not not femak because that goes into the ne.u line
So anything, well you said sibling so Wei~ at least when you look at it again you know what should be going in there if you use a meaningful
variable 1IQ1I1e
(types sister(S isrer,S ibling):- person(S ister, fe maJe),
Ok so that is the one condition they have to fulfil, they have to be femak and whal other condaions do you
have to list?
Something to do with tbe sibling isn't it?
It has got something to do with the sibling, yes. What do you have to say, if you would say il in English
now, what is the other condition thai we have to Female and a relation
And what do we use to maJ.:e that relationship, how could we explain that
In terms of finding a common parent Exactly
So. parent (types parent( The ones that's common. so second one's going to have to be sister, no ...
What does stand in the first place in the parent relationship?
It's either the mother or the father ...
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Yes you can put that in, well there are really two ways you could do this, eirher you could go 10 tile output
Jr_omfalher or mother, now you could actually instead of saying parenr you could have saidfalher and then
linked say the sibling and the sister to the faJher, or you can say parent because we know thai whal stands in
the first part there is going to be parent as well ...
But you have to call it something different. because some might be listed under father and some ...
It ~esn't really matter, you can do it this way it's just what you've got to think about now is which

variables go whLre because whal stands first in the parenl relalionship is always the parent
So you won't - rould I just put mother in
I don~ know we call it X or Parenl with a capital P or whalever
(types parent(Pareot.Sibling).)

Is that enough really, I think you need something else
So person's got to be
You've linked the sibling to the parent now but you still haven't linked the sister-

Right. so I've got to have parent again, sister

Thai's right
(adds parent(Parent,Sister).) I'm not all that sure wbat's going on

Well try to think about it, we are trying to define now
Well the farst defmed what the actual sisrer was ...

What it will do is, you've got the first line here and it starts, you say now sister(X,Y) you want to know
who the sisters are, it goes to the person facts it gets the first female name and puts the name in there
instead of sister so now that line reads person(anniejemale), then it jumps down to the nextlin.e and this Yes I see now
And this line now reads parent(annie ... you11 get a name in there
Now it goes and looks for a parent ofannie and puts that name instead ofparent and when it comes down to
the nut line now it gives parenl that name and then it finds a sister and checks whether that is actually the

same

yes I see tbat

Subject 6
1. person(annie, female).
The first q~Ustion would be person(amuejemale). So what should it answer to that one?
Must be yes, I would have thought [correct]
2. person(X,female).
If you tyJN in person(XJemak). - what should the answer to that one be?
It will list all the names of the females. [conect}
3. parent(jenny, Z).
Now the next block of reliJtionships is the parent relationships so if you put in parentljenny,Z). whal should
the answer to thai one be?
It will give the name of whichever parent it is - annie is it?
Yes - any more? il's (jenny, Z)
Ob, so barry james and kathy. She's tbe parent of them (tries it and it works)

4. parent(carol, rosie).
Ifyou would say parenl(carol,rosie).- whal should the answer to that one be?

Yes (enrers query)
[yes]
S. parent(sophie, rupert).
And to pareTil(sophie,rupert).?
No. [correct)

6. parent(rosie, Y).
And if you would ask parent(rosie, Y).
pareol(rosie,Y)? No.
Why not?
Because sbe's not got any children down here.

7. all daughters (conj. • TT)
Ole., now slightly more tricky, if you wanted to try to retrieve all the daughter you've got in there how
would you do that?
Daughters ... you'd have child, we can get an answer to that., and then wbether that child is female

How e:uu:tly would you do thai?
"child" outside the bracket and X comma Y inside the bracket and then ...
Ok, try it
(types child(X,Y)) It's all capitals - does it matter what letters are?
What variable names you use, no as long you know that if you mean the same variable you have to

use the

same one
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and then (types :- at the end)
Ah - are you trying to write a rule ?
Give me the child if that child is
OK, so yo~ would actually put in a rule that would define what a daughler is, in which case you could write
a "'!le wiUch wou~ defUU! daughler, you would have called it [the predicate/ "daugluer", but whal you're

trym~ to ~o here ,IS, you could write a rule and we'll actually do that later on but if you look a1 those
relllt101J!hlps you ve got there you can still without writing a rule retrieve all the daughlers by just
addressmg the facts you've got there

Daughter- you do daughter, in this,

so it where you put it in the bracket?

So whal does thai mean if it's in the bracket?
That's tbe cbi.ldren
That's right thai means they're the child of someone ... and females
You'd have to select females yes, could you do that, you can actually do that in one go can't you, you can
actually askt"M system to return only the female children.
So, you put child outside the bracket

Well you can't if you haven't got a child rule or any child facts you can't very well oo that can you?

So this is all the infocmation is ...

That's all you've got, but you can still get it return you, just by putting in a query now rather than by
writing a new rule
There'd have to be a variable there of some sort ...

yes and what else
It's what's outside the bracket. that's the thing, if you can't use

Well the name of that rellltionship, if you address
Use daughter?
Ifyou're addressing thai relationship you have 10 use that relationship nameSo, parent?

yes
X, coouna, daughter or?

With a capital letter or ...
WeU can you use the word daughter tben?

Yes you can, well it depends would you spell it with a big Dora small D
BigD

Yes, I mean if you use a capita/letter you can use whatever variable you like
It would aut<matically know wbal the word daughter means?

No it wouldn't, but it would help you to remember what you were actually looking for. Ok if you start off
with that, I mean if you tkcide you can call it X, Y or you can give it meaningful variable names but they
are meaningful only to you they don't mean anything to the system.
(typeS parent(X.Daughter)

OK so you've tkjined thal the person's got to be child ofa parent and what else. what other condition has to

be met?
Female.

Yes how do we say that then?
You couldn't. you just use the word female in that instead of daughter

Not reaUy. where is the information about malt and female. where is that actually encotkd in our dalabase?
that's in this part (points to person-relationships)

So you would have to address that particular relationship if you want to retrieve that information
So you mean when daughter is, I don't know how you would do it to get that really

It ooesn't really matter, you could do it both ways round you could have said that the person's got to be
female first or whatever but how do you get it to meet both of those conditions at the same time. any idea?
You could use pecsoo instead of daughter
Well if you want to retrieve any information from those person relationships you actually have ...
You actually have to use the word person but there's no really
Yes OK but you have to link those two don't you, those two goals that you're listing, how do you do that?
(types,)
OK yes comma
do I need to go down [to the next line]

It doun 't matter, you can write it on the same line
persoo(X.femaJe)

What would you get then - think about it
WeU it wouldn't be X but it would???

Because you've already used the variable X here. Let's see ifbecomes clearer (deletes the typing), let's see if
you give them both meaningful variable names (types parent(Parent,Daughler),). OK?
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(types person( You stiU have to have female in there
Yes
Would that be enough? or you'd have to have X, female, or whatever

Well somehow you have through the use of your variables to link those two, which variflbk 1Ul111t would
you use?
Daughtes
Yes. What you said before was when you had X, Daughter, and you said person(X- thai would have given
you the mothers ... because it would have retrieved the female, if you say X, Daughter, then X, female thai
will actually give you the nwthers, X would have been mother then
So you still use X as a variable?

No you've decitkd to call that variable Daughter, so you have to call it the same, how else do you link the
two enquiries

so female
Well which way round do they have to be?
Daughter, female
Yes because the name is first in the bracket and then the
(typeS eod ofquery to give pu-ent(Parent.Daugbter),person(Daughter,female).
Why must it be lower case
Because you've already got tbe variable name haven't you
Yes and you don't want it to be a variable name there you actually want it to be female, you actually put the
object in here because female is the condition we want to be met. Ok so ifyou run that one
OK so now it tells you Parent =norman. Daughter =kathy, Parent =jenny, Daughter = kathy, so it lists
you all the parents with their daughters now so you see just by running in conjunction where you specifY
two goals which have to be met it sons out only the ones that meet both those conditions.
8. test rule
lfyou go towards the end of that file now. You see you've got a rule there that defines what a father is, can
you try to interpret thai rule, what does this one actually say?
Is it to fmd all the male children?
What does it do, what does it say a father is
It's saying

Yes? According to that rule which conditions have to be met so that someone is a father?
Does it say that they have to have a child ftrst of aJI, that child bas to be male ...

Who's got to be male?
To be a father he bas to have a child, that is one ...
What exactly, which line does state that? You've got to have a child to be a father? Which of those lines
does say that in that rule?
The third line

Yes you have to have a child to be a father, what does the line above that say?
That Falher bas to be male

That's right, it's quite logical really isn't it. This rule just says I've given it meaningful van·abk names
here, thai someone is a father ofa child if that someone is male and that someone is the parent of the child,
Yes?

Yes

see those two variable names, so you can actually query it and il will return name for a faJher and 1lllnte for a
child, could you write, modelled on that now the rule for mother
11. Analogous rule
it will be almost tbe same but with different names (types mother( so it will be Mother ...
If you are consistent you can use X Y if you want to or Pineapple Banana or whatever, it doesn't really
matter what you call the variflble ... (laughs)
Well you have to say
Ifyou don't believe me you can type in Mother, Child which is nice and easy because if you look at the rule
you always know what you actually want to take this variable's place but it would work if you put in
Eeyore and Piglet it would work just as well
So I just put X and capitals isn't it
Put X and Y and see.
(types mother(X, Y):~) So X is the mother of Y if, return, you can use the tab to indent it if, it bas to be person
(types person(X,female), parent(X,Y).)

Ok ifyoujust add another blank line after this one and if you save the file so we can try it. Now ifyou ask
it to give you the names of all mothers and their daughJers as soon as il's finished
All mothers and their daughters?

No all mothers and their children -you don't have to narrow it down to daughters, just all mothers and their
children
So it will be parent?
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No you've just wrilten a rule called moeher so you can
So we use modler?
Yes you Want to test whether this rule actually works, whecher it accual/y recurns the correct answers
So I can put mother? (types mother(X, Y).) RETIJRN
[X=annie, Y=jenny, X=annie, Y=martin etc.]

9. placeholder

Now one last thing if you wamed it to list mothers but not give you the names of the children what could
you do?
parenl(Molber

No you want to do exactly the same thing but you don't want to know what the names of the children are,
how would you do thal?
modler, just the mothers, mother(X
But you have to hold the place for the other variable
u~

Yes, so if you do thal as the last thing
(types motber(X...J

Yes, REIVRN and if you keep pressing semi-colon
(gets annie 3 times, jenny 3 times zandra once, carol twice)
10. Repetition

Because of tbe number of children

Subject 7
1. person(annie, female).

If you type in person(annieJemale). What should the answer be?
It will come out with yes. [correct]
2. person(X,female).
Ifyou type in person(XJemale)., what would the answer be?
It would cane out with yes X= annie, followed by jenny, zandra
(cmect)

3. parent(jenny, Z).
If you look at the parent relationships now if you type in parent(jenny,Z).
It will come out with yes Z = harry, james, kathy
(corea]
4. parent(carol, rosie).

OK. if you type in parent(carol, rosie). [correct]
S. parent(sophle, rupert).

And if you would type in parent(sophie,rupert).

No.
Why not?
Because there is a parent rupert,sophie not sophie,rupert

6. child(rosie, X).

And if you typed in parent(rosie,Y).
No it would say no because there is no rosie in the frrst position.
7. all daughters (conj. • TT)

Now slightly trickier, if you wanted to retrieve all the people from this database who are daughtus how
would you do that?
All the people wbo are daughterS? You could put in person(X,female)
Yes ...

How are these parent relationships worlced?

Parent comes first then child
I see so you, and are the ... yes ok. that's the only way
Well the beginning was obviously right so if you type in the first part that you just said
(types persoo(Z, female). R.E1URN)
(Z = annie, etc.1

That gives you all femalt, but what other condition do you have to fulfil to be a daughter
You have to have a parent
That's right, so try again, what do you do?
So it's going to have to be a conjunction between person and
(types persoo(Z.female),parent(Y:Z).)

What would it return now for Y and for Z?

It would return for z all the children who are female i.e. daughters and for Y those respective parents, you could
ignore if you were strictly answering the question you put a blank

A blank?
Because the question's asking you to extract the daughters not the parents of those daughters
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Ok_ifyou run tlw~e fir~t because that is actually an interesting point
so It says parenJ Jenny IS the daughter ofannie, and (etc)
9. placeholder
So ifyou typed it in as you just said without knowing the names of the parentsDo you want me to actually do it?
yes please
(types persoo(Z.female),parent(_,Z). REfURN
[Z =jenny, Z =jenny , etc.]

10. Repetition
~ou see it said jenny, jenny, zandra.. zandra, kathy, kathy, rosie, rosie, sophie and sophie, why do you think
u returned every name twice?
Because each daugbler bas two parents and if the database is correct it answers eacb daugbler twice
8. test rule
Ok there is a rule at the end of that database which defines what a father is, it looks like this
father(person,X), so a person is a father to a child if thai person is a parent to thai child and thai person is
also male. Yes? so that defines what afarher is, so if you want to use thai rule now, 1/you want it to give
you all fathers and their children or just give you all fathers, whichever way round you want to db iJ
(types fatber(Z.X).) tbal would give you the father and the child [c<nectJ

11. Analogous rule
Now ifyou edit the program and actually write in another rule for what mother is
(types motber(Motba,Olild):- person(Mother,female), parent(Motber,Child).)

ll. New rule (Tf)
Right if you wanted to write a rule to define whal a brother is, if you think about it, just say it in English.
what conditions do you have to meet to be a brother?
Person is a brother if be is male, and a child, so he has to have a parent. are all lhe parents and all the children in
tbis database? ... Right. so he's got to fulfil two conditions in that he has got to be male but a parent is also a
brother, no hang on, are you assuming, you see you could argue that every parent if he is male is somebody's

brother
Not necessarily
They could be a single child, ok so you want me to stick to tbe children in wbicb case you would have to be
male but also be s001ebody's child

But you could be an only child ...
So in tbal case be bas to be somebody's child and his parent must have more than one child so if we find all the
parents ...

Well what we said here is, ifyou look at the mother and father ones, person, variable, is mother to a child if
so if you sum of in the same way, saying somebody is a brother of a person if the brother is male and ...
you're sort of puning up a relationship lilu! saying a mother is mother to a child if, in the same way if you
say brother is brother to a person if the brother is male and ? what else do they have to have in common?
Same father ...
... or mother, equals parent, they need to share at least one parenJ
Ab, could we use tbe existing rule that we have here, no -

You could actually but it is probably easier if you just use the parent fact
So somebody's got to be male

lfyou start writing the rule, the header and the male, just think about
(types lx'odler(

.

If you say brother, comma, person or name of X or whatever it is
(oontinues typing brolher(Brotber,Person):-

now you said the brother's got to be male ...
(oontinues typing person(Brotber,male),

... and those two have to have the same parents. How do you achieve that?
Both brother and person have to have the same parents.
By just using the same variables in the right place you could actually link those two to the same parent,

you have to stale that the brother is the person ofthat parent and the person is the ...
Got it. got it (typeS parent( the parent is the first in the bracket is tbat right?
you could call it Parenl with a capital P if you want
(continues parent(Parent,Brotber). parent(Parent,Person).

Subject 9
1. person(annle, female).
lfyou asked it person(annieJemale). -what should the answer to that one be?

person, ??• sorry
If you would just type in this question what answer would the system give you? with the knowledge base
you've got in there
annie? I don't see what I'm doing - I really don't understand
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Yes.

Well ifyou type in that as a question which would mean have we got a person who is female called annie
what will it say

Yes. (enters query)
[Yes]

2. person(X,female).

Yes thm's right, if you type in person(XjeTTUJle).
anniejenny.zandra.carol,kathy, sophie. (enters query, gets predicted result)

3. parent0enny, Z).

F_ine, now ifwe went to the second block, if you asked it parentUenny,Z), what would happen there
harry James kathy [correct]

4. parent(carol, rosie).

And if you said parent(carol, rosie), what would the answer to that one be?
peter - is it parent ...

carol. rosie
Yes.
S. parent(sophie, rupert).
And if you aslc parenl(sophie,rupert)?
No.

Why is the answer no?
Well, sopbie, it doesn't actually say who her parents are ... oh yes it does - parenl(rupert.sophie) ... but it's that
way round not the other way round

So il would say no
So it would say no because the relationships not right

6.parent(rosie, X).

Yes, so, if you would ask it parent(rosie, Y). - what would it say to that one?
No, because rosie is the parent. [correct]

7. all daughters (conj. - TT)
OK now the next thing, if you from this little knowledge base you've got there, if you wanted to extract all

the daughUrs
All those ones (points to person-relationship).

Could you persuade the system somelww to give you a listing of all the daughters
person, no ... you'd have to substitute daughters for female ... with a letter
And then
And ... parent, no you can't do that
Try il, I'm sure you can do it
Are you asking a question?

Yes. You're not writing a rule here, you haven't got a rule in tlu!re that defines what a daughter is bUJ
n.evtrtheless you could actually get
Because it baso't got daughters, sons

But with the information that you've got there you could still retrieve, you could still son the ones thai are
daughUrs from sons
Ob I know I think - is it person, this isn't easy you know ...
Well if you just say it in English, which two conditions does someone have to fulfil to be a daughter?
Got to bave parents ...
Yes she's got to have parents, and
sbe bas to be female ... so just parent female, parent X
Yes, you have to use both re/Q.tionships in your question
I'm trying to fmd out whether the female ...
You can stan with either of them - you can start by saying that person has got to be female first or that
she's got to be a child first
but it hasn't got child

No but who are the children, where are they
In this lot (parent-relationships]

Yes, so they are second to the parent relaJionship aren't they,
So this is going to be, you've got to have, do you need parent in there at all?

Yes you de, because otherwise you don't get at the child relation. In terms of our database she has got to be
a female person and has got to beparent(X,female), no because that's ...

No that's coming from somewhere else- but you can combine those two can't you? in your question, what
do we call that?

Conjunction.
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Yes t~'s right. so if you just run a conjunction in your question. All you have to do is put the variablu in
tN: nghl place. Start one of them, person or parent, whichever you find easier ...
obI tbinlc I know (types person( you don't have to have two [objects/variables) in there do you

You do

beca~ you've got

two objects in those relationships, so.

person OK (types person(X.female).
So thiJJ should show they're female and
(typeS pareot(Y, Is it female again?

No, whiJJ do you put in there now, because that thingy that goes in there now has also got to be tM female
thing, you've got to fTUJke sure that the variable links them. You've correctly said parent is Y because thiJJ's
not tilL pusan we're looking for, we're looking for the child, so?
Daughter, female?

No she's X, because you make sure that X is female and now you want to make sure that she's a child
Yes, sorry, I just realised- srupid me, I didn't realise they're the same people. (types parent(Y X).)
Now whiJJ should it return for X and Y?
X is those people tbere, the female and Y is the parent ofX, yes thiJJ's right, so if you could just run that one
(enters query) so jenny annie jenny
So jenny is tilL daughter and annie's the mother, that's right so
[jenny, eric,: zaodra, annie, etc.)

if you carry on

8. test rule

Now what I've done at the bottom of this little knowledge base, I've put in a rule that defines what a fat/JLr
is, I've said a person is a father of a child if that person is parent to that child and that person is a male
person. So you could ask il now by using that rule to list you all fathers and their children
(typeS falbel(X,Y).
[X = eric, Y =jenny)

9. placeholder
Yes, eric and jenny, where eric is the father and jenny rhe child etc . Ok, if you would ask it now, if you
said I wanl a list ofall fathers but I don't want to know the names of their children, how could you do that?
(enters fathet(X._}.
[X= eric,eric,eric,martin,martin,nonnao,norman,norman etc.]

10. Repetition
Would you like to comment on that
Well it's listed bow many children lbey have ...

11. Analogous rule

If you edit thiJJfue can you write the mother rule now based on the information you've got, if you just look.
at it ...

(typeS mother(Mother,Child):- person(Mother,
so it's, yeah
(carries on
.. .female). person(Molber,Cbild).

It should have had a comma at the end of that line, I think ...
Ob yes (changes. to, after female)
... and 1 think you've made a slight mistake on the next line you've used the wrong predicate
(changes person(... to parent(Mother,Child).)
ll. New rule (TT)

Now to be a bit more creative, if you write a rule now that would define what a brother is, would you try to

do that, if you want, we could discuss in English first what it actually is, what you have to do
It's a child of the father and mother
Yes, actually, I will let you off with just one of them
OK child of lhe falher then (types person(Brother,male),)
What do you do about a sister relationship?
Well what you would do is define brother and sister separately because they're two different things. What
you have to do though, is you have to say, in analogy to here, if you say mother is mother to a child if, so
we have to say brother is a brot~r to, I don't know what we want to call it
paeot?
well you're not brother to a parent, to a- let's call tl S1blmg for mstance, wtth a capitalS, we could say
brother is brother to a sibling if and then you've said Ok tM brother's got to be male and then we've got to
indicate whiJJ, father, you said saying father, so we've got to twist that as wei~ so we have to indicate they
have the samefathLr. I think it's easiest if you just start offwith the header and then the malt o~(types brother(Brother, Siblings?

Well it would seem a reasonable variable name co 1ne · you can call it what you want or an X or Y or
whatever

(types brother(Brother,X):- person(Brother,male), Is l.hat brotller again now or is tbat ·
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There are two ways you could do it, either you use the paren1 relationship again to indicate that the brother
is a child of someone or you can of course use the output from the father rule

parent wouldn't go outside tbe brackets would it., parent would be inside the bracket?
No - you still have to match the parent facts 1/ you would use the parent. 1/ you decide
mother you must use that to

momec

(I

10

go for father or

father?

Then you would have to match the header of the rule so you could say now father
(typeS falbel'

lower case now because you should have the proper definition of what it is. OK
So tba1 would be

WeU who's the child.
tbe cbild?

In which posilion does he go if you look at the header of the father rule?
sec::ood ooe
That's right, so you'd have to put something else to substitute for the father in here -

Y?
Yes thai's right
(typeS fatber(Y.

Is it child ,yes it's child isn't it

No, il's Brother because we're, because it's got to match that one because we're trying to define someone
who can fill this place, you've got to be consistent with the variable because we've said brother here and
you've also got to use the same variable name for the same person
(typeS fatber(Y,Brotber).

But this still doesn't, now you've said that brother's father is Y but you still haven't ensured that X's faJher
is Y as well and you want to do that because that is the link
So it's just tbe same, is it fatber(:X ,Brother). as well

No- X is the sibling not the father, the sibling is a child as well isn't it?
Yes so father, this is father X then

father yes - but X again like brother is a child so it goes
in the secood
(types fatbet{

X?

No, Y because Y is the father, you see father always comes first
ObYX

Yes, because X is the child andY is the/ather
(types fatbei(Y X).

And you have to put a conuna in there instead of a full stop (after line 3)
(corrects it)

Subject 10
1. person(annie, female).
The first question would be ifyou asked it person(anniejemale). what would it say?
Just annie - no?
Whal does that question actually mean person(anniejemale).
There is a female, annie ...

.

Well we haven't got, it is just a relationship and two objects if you put them in as a question, whal il really
means is "Have you got a person called annie which is female?"
So the answer is yes.

That's right, yes, if you try thai ...
(enters persoo(annie,female).)

[yes]
2. person(X,female)•

.And if you would ask il person(XJemale).
It should give you the list of females- annie, jenny ... [correct]
3. parentijenny, Z).

OK, so that's that, so if you would say parentljenny, Z). what would the answer to that be?

It sboold give you jeooy's children ... (enr.ers parentGenny,X).)
[X =harryjames,kathy)
4. parent(carol, rosie).
Whal would the answer 10 parent(carol,rosie) be.?

Yes.
S. parent(sophle, rupert).
And to parent(sophie, rupert).?
No.
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Why is it ne
Because be is a parent of sophie
6. parent(rosie, X).
And pareIll(rosie, Y)?
sbould also be no because there is no parent called rosie.

7. all daughters (conj. - TT)
Now iffrom this database we've got there we wanted to retrieve all daughters that we've got in t~re,i.r t~re
a way thai we can do that?
(thinks) You have to use a conjunction? (thinks) So ... something like parent(Namel Name2)
penoo(Name1Jemale)
•
•
Yes OK
(types J*Cnl(Namel,Name):You're net writing a rule, though, are you, just a question. To get a conjunction
(subject deletes second bracket)
No it:s all co"ect euept for you link those two parts of it, you're not writing a rule, just putting in a

quutwn ...

Olund
Yes just a comma, thai's righl
(eaters pareot(Namel,Name2),person(Name2,female).)
[ Namel=noonan.Name2=kathy)
So it gives you for Namel
norman, kadly
So for Namel it now returns what
Tbepareot
Yes andfor Name2 the daughter, OK (tries a few more)

8. test rule
OK I've actually put in a rule at the end of the database which defines what a father is, yes based on those
facts, it says a person is fat~r to a child if the parent of the person is a parent to that child and thal person
is male, yes? So you could actually use that rule now to get a list offathers and their children, would you
try lO do thai
(types falber(P (hesitates)
Capital P, capital C would probably do, it doesn't matter what ...
(fmisbes to give fatber(P,C)
[list of fathers and their children]
9. placeholder
Now you've actually gol them out in pairs yes? The name of the father first and tlu!n the child. if you
would say OK 1 wan1 a list of all faJiu!rs I don't care what the children's names are whal would you do?
Using the same rule? (types father(P,_) .)
So what should that do new?
It should give you a list of all the fathers ignoring their children.
Yes it shouldn't return anything/or their children, OK
[gets list of fathers- eric 3 times, martin twice etc.]

10. Repetition
Do you find thai peculiar, or ...
Ooly if you didn't know what was in there, in the program, you can see there are three parents caUed eric or
martin ...
But why do you get eric 3 times. martin twice, norman
Because they're in there for each of the children so it will come up as many times as they've got children.

11. Analogous rule
Now if you edit thal file you could perhaps write tlu! rule for mother modelled on tlu! faJher rule

me

(edits
and types motha(Molher,Olild):- person(Molher,female). parent(Mother,Olild).)
ll. New rule (TT)
Yes thai's right, could you also write a rule that would define what a sister is?
(types sister(SisterJ)augbter
Why are you calling thai second variable Daughter?
I don't know.
Well, what I did when l wrote this rule was said a father, this variable. is relaJionship to a child -you
wouldn't say a sister is sister to a daughter would you?
A sister to a child I suppose, or brother or sister ...
Well it is brotlu!r or sister but because you can be sister to female so I think it should be neutral.
I'll just put Child.

OK.
(types sister(Sistet,Child):- person(Sister,femaJe),
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I don't understand whall have to do - the sister is female, so ...

Just try to formulate it in English- now what contiitions does someone have to meet to be a sister?
Be a sister and sbe must have the same parents as well.

Now this is the difficult bit, how would you get the system to check whether two people have got the same
parents? Because you want really Sister anti Child to have the same parents so iJ instantiaJes a fUliTU! to the
variable Sister and Child. then goes off anti checks whether these two names have got the same parents, so
could you get it to, any idea?
parent(Sisler,Cbild)
1M problem is that in the parent-relationship in the first place what is there in the parent relationship
It would just give parents and children wouldn't it?

Thai's righl - so you've got the parent in the first place then the child but these two are both ?
Cbildren. So it would have to be Child
WeU, you can get it to match iJ up,

if you say parent, you put in a variable here Sister then write another
line with parent, same variable here, then Child, that would make sure thai when it fills in any fUliTU! for
Sister and Child thai it goes and checks whether these two have got the same parents here in the bracut
Sorry what was that
You 're referring to the parent relationshipYes, I know (types parent( just a variable P, so it would have to be, just Child).
No you've got to tnake sure that the sister gets the same parent, that only goes and finds the parent of thai
Child- Sister has got to be a child ofthat parent as well, so ...
So now I have to write another one as well
(fmisbes typing to give sister(Sister,Cbild):- person(Sister,femaJe), parent(P, Child), parent(P, Sister).)
Ok would you like to go and try thai one out now
(enters sister(S,C).
[S=jenny, C=jeony, S=jenny, C=martin etc.]
(kds puzzled)

You're about to say something
How can zandra be zandra's sister?

Th/Jl's a good question
Because it's just gone bade and gone through the families and paired them up

and that's fair enough really isn't it. Another question, it doesn't disturb you that you get zandra jeMy and
then zandra jeMy again? It does every combination twice, can you jinti an explanation for thai?
Is it something to do with the second line wrote in about the person being female? No?
No, it has got something to do with the parent ...
It has zandra as parent and so is jenny
No, but we've de[med they have to have the same parents and both of them have got two parents. all of
them have got two parents haven't they?
Ob yes of course they have yes. mother and father, so they'll give you both the father and the mother

Subject 11
1. person(annie, female).

Ok so first question would be person(anniejemale), what should the answer to thai one be
Yes. (carect]
So if you just try it It would just print out yes (enters query)
[yes]
l. person(X,female).
Thai's righl and if you would ask it person(Xjemale). what should the answer to that one be?
It will give you the list of all the girls- annie, jenny, zandra and so on. [correct)
3. parentijenny, Z).

Now the second block of facts concerns the parents so if you would ask it say parentljenny, Z). - what
would the answer to that one be?
james and kalhy

And?
Ob ban"y, james aod kathy. [correct]
4. parent(carol, rosie).
lfyou would ask iJ parent(caroVosie). whal would the answer to thai one be?
Yes. [carect)
S. parent(sopbie, rupert).

An.d if you asud it parent(sophie,rupert).?

No.

Why would the answer be no?
Because rupert is the parent, not the child.
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6. parent(rosie, X).
And if we put in parent(rosie, Y). what would the anSlver to that one be?
No

Because?
Because rosie isn't the parent

7. all daughters (conj •• TT)
!es thai's right, now, slightly nwre complicated, ifyou wanted to retrieve all the daughters that they've got
"' there have you got any idea how you could do that?
You have to do a conjunction so parent(X, Y) and tben is it comma for and, and then person(Y, female).
Exactly, so ifyoujust try thai one out so what will it now return for X andY?
X will be the parents, and Y will be all lhe female children

Yes so if you give it a try
(eolers query)
[X=oonnan. Y=kal.by; X=jenny, Y=kathy, X=martin, Y=rosie; etc.)

you see, which order does it actually take?
The ooJer tbal they come down here

so it picks lht girls one after another, from the first parent down to the last one. Yes very good.
8. test rule
Now fve put a rule at lhe end of lhis knowledge base whicb defmes wbat a father is. It says a person is father to

a child if that person is parent to that child and if that person is a male person. So I've listed 2 different goals, a)
that the person has got to be a parent to lbat child and that this person has got to be male. Ok. Now if you were
trying to use lbis rule to give you all lbe fathers and their children, if you want to test whelber tbis rule actually
works, what would the query be? ... It is quite easy

father(X,
If you actually wanl to use a rule you have to see that you match the header for it so since we've got two
variables here in the header
9. placeholder
father(X, and then 1mderscore.
OK fme you can try that
(typeS father(X, _).
OK what will the answer to that be, what will it actually say now when you
X will give you the names of all the falhers, that's all it will give llhink. [correct)
So is it going to give eric three times

Why do you think, do you think it might give you eric three times for each child, try it see what happens?
(gets eric three times)

So what do you think the next one will be?
martin
[martin twice, then norman]

10. Repetition
So that's wrong then, you don't want it come out three times ...

11. Analogous rule
well it is not necessarily wrong, it is just important to be aware of the fact that if you wrile it like that.
You can. there are actually things we can do about it if we want to, but this is basically how it works the
rule out. If you could edit the program now and write the nwther rule based on the model ...
(types molber(Motber, Child):- person(Mother, feniale), parem(Mother, Child).
12. New rule (Tf)

Yes that's fine, now we e.x1end our big family program here and try to define what a brother is(types t.othez(

lfyoujust said il in English how would you explain to someone in English what a brother is.
A person who's parent is also so and so's parent and the parent is the conunon thing,
And?
"Andis male

Yes thai's exactly right. Now in analogy to those first two rules where we say somebody is a mother of a
child if so with a brother you say somebody is a brother of a person if
(types brothet(Brotber.Persoo):- Is it alright to use person again but witb a liUle letter?
(types penm(Brotber.male),
Yts thal's the first condition ...
Must it still only have 2 parts to it?
Can you explain that a bil further?
Well inside the brackets just two ...
Two?
Conditions ... or ...
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We're trying to say, you said that before, that we have to tell it that tMy have to have tM same parents,
who has to have the same parents- now if we look at tM beginning of our rule
The Person and tbe Brotber

17ull's righl, so we somehow have to link tMm to tM same parent
So you put parent outside the bracket and then you put Brotber and Person in the same bracket?

WeU the thing is they're both children aren't they ? It is right that we use tM parent relationship but since
our parent rellllionship has got two objects in tM bracket, tM first is tM parent and t~ second is t~ child
we can't really say parent(BrotMr, Person) because you put tM BrotMr in tM place where the parent stands
in that relalionship and that can't be right can it?
parent ... and underscore? No ...

No- we need. you have to wrile two furtMr lines, you can't do it in one. All you say is that you make sure
t~ brother is tM child of one parent and that tM person is the child ofthat same parent and again lilu you
did in your queries before you have to link those l7y using the variable and that variable is?
X?
X is fine, whatever
So parenl(X,Brotbes)
(typeS parent(X.Brotber), parent(X.Pmon).

Now we'll go and try this rule out •
So if I put in brother and tben X and then say katby it should give me harry and james
Yes try that
(types brolber(X, Kathy).

I think you have made a slighl mistake tMre, what will happen if you do that
Ob I need to be put Brother in capital letters instead of X do I
No but lcathy is not a variilble that is a constant, if you put in 2 variables. if you type X, Kathy or X, Y it
doesn't malter, it will just give you a list of all brotMrs and IM person they are brotMr to, if you only want
kaJhy's brother, that's an object not a variable
So bow do I do that

You shouldn't have put it with an upper case letter

(cmects it ro read brodla(X,katby).)
[ X =harry, harry, james, james]

Why does it list harry and james twice
Because it does it for tbe father and tbe mother

Subject 12
1. person(annie, female).
The first question is person(anniejemale). - what should the answer to that one be?

Yes. (ccocct]
person(X,female)
Ifyou type in person(XJemale). what should that do?
(subject types person(X,female).)
Give out all the people wbo are female, jenny, etc. [correct]
3. parentOenny, Z).
Now if you look at the second set of relationships tMre if you would ask say parent(jenny,Z). say whal
should that give you?
Wbo jeooy is tbe parent of ... (enters query)
[X= harry, james,kalhy, no]

4. parent(carol, rosie).
Ifyou would ask it say parenr(carol.rosie). - whal would IM answer ro that one be?
P:wdoo?
parenl(caro~ros~).

Who is the parent of carol, no oh - yes, sorry
Right what does it actually mean?
Is carol the parent of rosie.

17ull's righl.
S. parent(sopble, rupert).
If you would ask it parent(sophie,rupen). -what should the answer to that one be

Sophie? No -because sophie's the daughter of rupert
17ull's righl.
6. parent(rosle, X).
And if you asked parenl(rosie,Y)?
No - because rosie's someone's daughter
7. all daughters (conj. • TT)
Now if we actually wanted to retrieve alltM daughter we've got in there is there a way rhal you could do
that?

Transcripts-150

Yes proba~ly,

som~thing ~e, parent. al~ the daughters, would you have to use this as a rule, and a conjunction

Yes- ifw~ do 1t now Wlt~u?ut- obv1ously you could write a rule which would define what a daughter is but
we haven I got that rule m at the moment but you still could retrieve it just by asking the righl question
couldn't you?
Yes, sary what was lhe question again
Whether you could get it to list you all the daughters
So you start with parent
It doesn't malter which one you start with.
(typeS person(X,female),

Yes. and?
I could just leave it at that couldn't I?
What would thilt give you?
All tbe daughters from here [person-relationships]
Would il?
Ob no, these aren't daughters at all (types pa No.
Why do you say not parents?
'cos I want the daughters
Yes
Could I do parent(X,X)? No, that would give me too much, it's just I want to get to bere but I don't want to do it
like tbis, parents ...
Well, it is right, you've got to use that relationship, there's two things you could do, either you could just
get it to list you the name of the parent as well as giving you the name of the daughler or you could say
weU I know they've got a parent but I don't want to know what their name is ...
(types parent(Z,x).
Yes, thal should give you what for X and what for Z now?
X will be the daughters and Z will be the parents ...
[X=jenny.Y =annie,X=jenny,Y =eric.X=zandra. Y =annie]
Ob dear I've got eric ...
eric is the parent
9. placeholder
So. right if you now say, what we just talked about, you don't want to have the name of the parent you just
want the 1UlRie of the d.aughler, what could you do?
Dash?
Thllt's right, underscore you mean?
Yes. (types person(X,female),parentL,X).
[X= jenny, jenny, zandra, zandra, etc.]

10. Repetition
Why do you think it gives you each of the daughters' names twice?
Because the X is tbere twice, don't know, it's taken jenny as a parent and a person, a female?

Yes, not really. If you just type in your previous query again where you didn't put the underscore and look
whaJ hllppens
(types pelSOD(X,female),parent(Z.X).
[X=jeony, Z=annie, X=jenny, Y=eric)
It gives the relationship for mothers and fathers, relationships for both, it bas given jenny for both father and

mother...
·
8. test rule
l'vr got a rule in there at the end of the database that defines what a father is. It says a person is father of a
child if the person is parent to that child and if that person is a male person, so zf you now just get il to
give you aU fathers and their children
(types person( Should I start with person? Can I try, and if it's wrong ...
Yes you can, but if you wanted to test that rule, let's see if it actually correctly gives you the fathers and
their children
fatbel" needs to be outside (types fatber(person.X).)
Why did you put person,X?
Because that's bow it is there [seems to be referring to the first condition in tbe father-rule)

Yes but that's, the first thing it should return is the father and the second variable should return the child, the
person they are father to. so if we wanted to have a list of all fathers and their children ...
It should have a capital as well, but I can still leave it as person?

Yes as long as you know what they have instead of Person, you could say Father with a capital F, and child
with a capita.l C, then it would say Father =, Child=
(types father(Person,C).) Do you want me to tell you what I'm expecting?

Yes
I'm expecting under Person for the father to come up and then under c ·ror the child to come up [correct]
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11. Analogous rule
there ;'ou've got the father rule that you've jusc used, can you wrice che rule for nwther now for thai OTU!
(typeS mother(Motber,Cbild):person(Mother,female), parent(Mother,Cbild).)

U. New rule (TT)
Do you think you could write a rule which defines what a brother is or could you just try to say whai thai
rule would say. What would you actually have to say?
I'd have to lhink about it
If you just say it in. English, what coTiditions does sotfU!One have to fulfil to be a brother?
Someone is your brothec if they have the same parents as you.
That's right, so the first line would be modelled on this OTU!, but how would you actually say they have the
same parents?
You have to use parentl and parent2 wouldn't you
We're not fussy here we haven't got any half brothers or half sisters here so we could actually say just if
they share OTU! parent
l doo't think I could say bow you could do it, I'd need to think about it for hours

Subject 13
Can I just ask a question - for norman. bow come he's got, is that person and that's the parent
No.
That's the parent and that's the person
That's the parent a1ld that's the child, so he's got 3Three children

OK, so if we just leave the editor ... also you've got a printout there ...
1. person(annie, female).
Ok ifyou would ask person(anniejemale)
Yes.
OK so if )'O!l try thal Does it have a capital letter, yes, doesn't it because it ...

It's not a variable
So it doesn't ... (typeS person(annie.female). answer is yes)
Z. person(X,female).
OK, if you ask it person(XJemale). - whaJ would the answer to that one be?
It would give you all the girls names down the thing
OK so ifyou try that(enters person(X.female).
[list of females1
3. parentijenny, Z).
Similarly, ifyou would ask it parentljenny,Z), what would the answer to that one be?
ban'y james.kathy [correct]
(tries it)
4. parent(carol, rosie).
Ok thal's[UU!, now ifyou would ask it parent(carol,rosie). -what would the answer to thal one be?
Yes.
5. parent(sopbie, rupert).
It's OK, if you say parent(sophie,rupen). what would the answer to thal one be
No, because rupert is sophie's father.
6. parent(rosle, Y).

And if you said parent(rosie, Y).
It would tell you no because rosie is a parent not a child.
7. all daughters (conj. - TT)
Yes thai's right. Now if we wanted 10 retrieve all the people in our database who are daughlers how could
we do that?
Do you want me to write a rule for it?
That one be one way to do it, yes, we could write a rule for it but you don't have to, you could just get it,
retrieve them aU by asking the right question
You couldn't ask it parent(X,female) .• could you?

No
No it wouldn't do that would it ...

No but that is essentially the information that you want, it is, they have to have a parent and they have to
be female, but how can you do that?
Could you find out all the females?
Yes?
What's the next bit? I don't know, if you asked it, if you found out all the females, would that help, and then
parent I think
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Yes that's righl and you don't have co do it in nvo separate, you can do it in one question by using what
·
You can put
. both sta tements, ~t· •s J~St
you have to put a comma between both parts of your question and'
then that s what we call a con}unctwn so by running a conjunction on your question we could do it so the
first part would be yes to fr.nd out who are female so
'
Is it person or .. .

'

·

YesAnd then it's ~~t paren~ bi~ X (types person(X,female Close brackets now (types ). do I put comma now?
Yes, that s nghl, whzch JS the second one we want?
JUeDt?

yes, that's righl
(typeS parent( ) Is it then another letter (types D), then female again?

Whal have you got in the second place in the parent relationship?
child
Yes
So it's tbe same letter variable isn't it?
Yes. eXI.lCtly
(typeS X).)

Now what will it return for X. you see for X it now returns the name of the daughter and forD?

Parent
D for parent, that's right.
[list of daughters and parents]
Ob, you find out wbo ber mother and father are

8. test rule
Yes, that's righl, OK, I've actually written the rule in there, at the end of the database that defines what a
father is, it says a person is father to a child if that person is parent to that child and if the person is male.
Now if you wanted it to give you all fathers and their children using that rule what would you do?
You'd type father to start with wouldn't you

Yes, so do you want to try it
(typeS father( ) And do you

use variables for the thing?

Does that maner?
No, I could just type in two things? (types falher(f,J).
[eric jenny,eric martin,eric zandra etc]
9. placeholder
OK if you wanted to ask it now give me the names of all the fathers but I don't want to know the brals
IUllneS, what could you do about that?
You type father and then just put the first variable in.

Yes, and?
Ob tben put a thingy in ...

Yes, so ifyou try that now(enters query falber(NJ.
[eric 3 times, martin twice, nonnan three times etc.]

10. Repetition
Why does it give you eric three times and ...
Because be's in there three times as the father of different children
That's right, yes, so even though it doesn't return the name of the children it returns eric
11. Analogous rule
If you edit that file now and if you could write the rule for mother
So I can make an exact copy of this [father-rule]?
To some extent you can, yes- so ifyoujust write the mother rule now based on that

So it's mother isn't it, is the flfSt line the same? (types mother(Mother,Child): - Can you use the same bit as

mere or not? (adds person(Mother,female), parent(Mother,Child). So I've got to out to query it haven't I
12. New rule (TT)
Yes- but before you do thal could you write another rule, can you define what a sister is
Sister is somebody wbo sbareS the same parent and is female ...

Yes that's right

So it's sister (types sister() The parent's not a variable is, they've got to have the same parents ... I don't know
bow to do that.

Well you can start with he easier bit, the female bit
Parent, Olild?
Yes, you can do it thai way
(types
· mot he r to a c hi'ld 1if
Nosister(Pa
you want it so the header states, that one says a person 1S
Sister if it's got the same parent, sibling isn't it?
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That would be a reasonable variable nam~ to use wouldn't it, I would have thought, I mean you could just
say
(types sister(sybli

You've got to use, the name that you want when you query it, first the name of the sister then the name of
the person they are sister to
Name, Sibling?

Or sister, sibling
(types sister(sister,sybling):-) And then you've got to put something in ...• but I don't .lmow if that comes now

You could do the female bit first
So it's sister, female?

Yes, but you've got to address which relationship. Which relationship contains the male IJIId femJJit
informalion
Name?

No, person
Yes, person, sorry- so if I type, if it's person person(name, sister?

You've already called it sister, but up here these are variables, not objects
Ob, so they've got 10 have capitals haven't they and this is a variable isn't it?

Yes tlult's righl
(types persoo(Sister,) female's not a variable (types female)

OK, so now we've lkfmed that sister is female and now we come to the bit you said they have to share the
same parent, so e.xnctly wlw, if we don't have a rule now, wlw has got to have the same parent
The Sibling ...

... and the Sister - yes they have to have the same parent, now how could you actually engineer it so they
get assigned the same parent
Couldn't be sister sibling parents. could it?

Not really, because the first object in the parent relationship is always the parent, and the child is in the
second and both sister ...
parent. you could do parent. variable for the sister, then parent. variable for sibling?
Thai's righl, that's the way to do it
(types parent ( ) Now that's a variable isn't it (types X,Sister) ). that's a variable isn't it?
Yes, we're still defining what it is so we have to make sure that always the same name is assigned to tlwse

(types ),)
Right. t.bal's one (types parent(X, Do I use the same variable?
Yes, because you want to make sure that you're using the same variable

(types Sybling to give a full rule of
sister(Sist.er,Sybling):- person(Sister.female), parent(X,Sister), parem(X,Sybling). )

you havt to have a blank line before we save it because otherwise it won't do the last line ... Ok so ifyou
savt it and try that one out now

Subject 14
l. persoo(annie, female).

If you would ask it person(anniejemale). what would the answer to that one be?
It would give you a list of all the females.

FJ you ask person(anniejemale). - not any, you know a lower case annie, the name
Ob annie, sorry, it would just give you this thing [prompt] back.
Would it? Try, just type it in
(types person(annie,female).) Or- yes, would it be?

That's righl, because you are asking have you got a female person called annie(REIURN)
[Yes]

2. person(X,female).
Now if you would ask person(Xjemale). - what would the answer to that one be
It would give you a list of all the females
Yes so if you try that one
(types person(X,female). Capital X? RETIJRN.
[X= annie]
RETIJRN
[Yes]
You should have pressed semi·co/on, if you try again, just type the same query in again
(does)
[list of females]

3. parentijenny, Z).
OK, if you would ask it parentljenny,Z). what would the answer to that one be?
barry and james
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And?
james ...
And?
Kathy

Yes that's right· Ok if you try that one •
(eoletS query)

[Z= barry]

RE11JRN
{yes]
It would have said james and kathy.
4. parent(carol, rosie).
OK ifyou would askparent(caroVosie).- what would the answer to that one be?
yes. [am:ct]
5. parent(sophie, rupert).
And ifyou ask parent(sophie,rupert).?
No.

Why is tM answer no?
Because lbere isn't sucb an entry in that [programme listing}
6. parent(rosie, Y).
and ifyou askpa.rent(rosie,Y).
No again

Because?
rosie isn't down as a parent
7. all daughters (conj. · TT)

Now ifyou wanted to retrieve all the daughters from this little knowledge base, how could you do thai?
You'd have to put person(X,female)- if using the colon and dash, parent(Name, just capital ...
What you wan/to do now is you want to put a question to the system, you don't want to write a rule, so we
are not using if·
So you just use a comma
Thai's right, you use the comma, so you put in a conjunction, if you try that one(types person(X,fema1e),parent(N Oh would you just use a capiralletter there?

Yes that's fine
(types closing bracket and fuU stop i.e. parent(N).

If you think about it - if you look al the parent relationships how many objects has tM parent relalionship
got?
Two.

Yes, so ifyou're actually addressing that fact you have to match the structure of it so you have to have two
objects as well, so? You put inN for the parent, what do you put in for the child?
That sbould be X then ...

Yes. because you want to match that with the female, yes, so now it should return N for the parent and X
for the daughter
(canpletes and enters query)
[X=jenny, N=annie]
8. test rule

I've put a rule in .at the end of that database which defines what a father is, that rule says a person is father to
a child if that person is a parent to the child and if that person is male person, so knowing that this rule is
in there now, if you wanted a list of all fathers and their children what would you do?
(typeS parent

You want to test this rule ...
SofalbeL?
Yes.
(types father( Would you use two variables?

Yes.
(types falhez(F,C),
Thai's iJ really because you have to match the header of the rule so it should actually work now(canpletes and enters query)
[F = eric, C =jenny]
RETIJRN
If you'd pressed semi-colon it would have worked, if you do it again and see whether it does(enters query again)
9. placeholder

Yes, OK, now if you wanted, if you say now what/ want is a list of all fathers but I don't want the
of their brats, so how could you do that?

fUllntS
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(types father(F,_).)
Yes that's right (enterS query)
[eric 3 times, martin twice, etc.)
10. Repetition
why dces it give you eric three times, martin twice, nonnan three times?
Because they've got three children or two.
Thai's right so even if you don't ask for the names of the children it still returns it because for each child
that rule btcomes true.

11. Analogous rule
FiM, if you edit that file now you could probably write the rule for nwther
(types lllOibez(Mothea",Child):- persoo(Mother,female), parent(Mother,Child).)
U. New rule (TT)
Yes, OK- if you, could you also write a rule thaJ defines what a sister is.
(types sister(Sister,
Just Person? (types sister(Sister,Person):- person(Sister,female), I don't need another rule, do I?
Wel~ what are the conditions for someone so thaJ you could say thaJ they are a sister of someone else?
That tbe person's female and if there's another child ...
Is that enough- what other child?
The child of tbe parent ...
TluJJ's right, yes, you've got to somehow engineer it so that the sister and the other child, which variable
have you given it here, you've already assigned the variable name to that other child Peooo?
Yes that's right so they have the same parents
(types parent(Sister,Person)
No, if you look at the parent relationship who is first in that?
The name of tbe parent ...
Yes, and sister can't be a parent can she?
No ...

So, sister is a child isn't she Just use parent. Person,
What do you want to put in as the first variable now?
parent of the different one, then comma, Person
(types ~t(Parent,Pefson).)

So that's m.atk the person a child of the parent, but not the sisterSo you have to have another one?
You have to have another one, that's right
So you need a different variable for that then?
Well, you want to have the same parent now as for Person but the sister's got to be a child as well, so,
you've got to make, il's very easy now
Is it?
Yes, because I've just said the sister's got to be a child of that parent as well, you've got to instantiilte,
you've got to connect the variable sister with the same parenr as the person has got soSo just put parent sister ... (types parent(Parent,Sister).)
OK do you want to save it and try your rule out now
(types mother(

Try sister out (types sist.er(S,P).
[jenny twice ]

Is that alright?
You can still see the rule, well you said the sister's got to be female and what you've said hue is that silL's
got to share a parent with someone and that is true, you know, so according to that rule you are a sister to
yourself
rigbt

Subject 15
1. person(annie, female).
If you would ask il person(annieJemale). - what would the answer to that one be
Sball I type it in?
Yes, but if you would teU me what the answer should beWhat, wbat I sbould type in?
Well type tilL question in, but before you actually send it off(types persoo(armie,female).
Can you actually answer
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Should it be capital?

Well this way if you actually put the objects in you are actually asking it if there is a person called annieObit would just say yes then. [correct]
Righi, try that

2. person(X,female).
Now if you said person(XJema/e).
You'd just get lots of female names, wouldn't you? (correct]

3. parentOenny, Z).
OK. similarly now if you would say parenr(jenny,Z), what would happen then... you'd get barry and james and kathy [correct]

4. parent(c:arol, rosie).
That's right, OK, now ifyou would say parent(carol, rosie).- what would the answer 10 that one be?
Yes. [carect]

S. parent(sopbie, rupert).
And ifyou said parent(sophie, rupert).
No.
why?

Because it's the other way round
6. parent(rosie, Y).
And if you said parent(rosie, Y).?
capital Y?

Yes, what would the answer to that be
No.
7. all daughters (c:onj •• TT)
Now if you wanted to persuade it to give you a list of all the daughters you've got in there what would you
do about that?
Write a rule?
That's one way to do it, to write a rule to define what a daughJer is, we'll come to that later but you could
ew:n at this stage, not having any rules in there just persuade it to give you a list of all the daughlers by
asking the right questions
You just want all the females don't you?
But not all the females are daughters ...
Ab, some females are the parents, no ...
Well if you think about in plain English for a while which conditions does someone have to fulfil to be a
daughter··· be female ...
... and?
... and have a parent
Thai's right, now if you think about these two bits of infonnation, feTTUJie and they have to have a parent, I
mean you've got that in there haven't you?
what?
You've got those two pieces of inforTTUJtion in there, yes? Because you've gor female information and
you've got·
Ob yes you can put person then the female, then the next one parent, yes? Because the conuna counts as "and",
doesn't it
Yes a conjunction, that's what we call that. OK try that now
We just want a variable so (types persoo(Z, female), parent Just two variables then
Yes there are two variables(types parent(Z,x).)
That that will give you mothers (types parent(Y.X.)
Hm ...
I should put tbe real things in should I

It doesn't matter
No, but it would belp to remember what I'd actually put in wouldn't it?

Thai's righJ, but you've got a problem, if you think thllt the persons we're looking for have got to be female
andachildOhyes

You're not quite linking tlwse two things, you said person(Z. feTTUJle), then parent(Y.X). - but you want to
link between
So we want Z at tbe end don't we?

That's right
Of course (retypes giving an end product of person(Z.female),parent(Y,Z).
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So that should now give you, Z is what?
Z is jenny

Z is the daughler and Y is then the parent
8. test rule
J!-ig'!J tve actually put o~ rule in tJJ;re that defines what a father is. saying a person is the faJher of a child
if his IS parent to that child and he sa male person so if you wanted to have a list of all faJhers and their
children now how would you retrieve that?
Cao you put father
You are trying to match the header of the rule, so you've got two objects in there Two variables
So you put two variables in there, that's right, OK
(types fatbes(Z,X) .)

So Z will give you faJher and X is the child?
Yes.
9. placeholder
Now if you want to say 1 want a list of all father but don.'rre/1 me the brats IUJITieS
You just want the names of the fathers?
Yes, how could you do that?
So I want. if you put it in lower case will they come up?
It's not lower case, you've got to acknowledge that there is something there even if you don't want to know,
if we do something with a capital in it will always come up with the children's names, but how can you
ac/cn.owledge that there is something but just say I don't want to knowYou're trying to find the fathers' names?
Yes, you still walll something returned for X but not for Y
Don't know
What do you do to just hold the place for that? for an object,

if you don't wanr to, you say I know it's there

but I'll ignore it now because it's not important
Put ooe variable
No, can you remember underscore
Ob the line, yes
Try thal one, see what happens
(types fatber(Z.J.
[eric,eric.eric, martin,martin, etc]
10. Repetition
Would you like to comment on that list you've got there?
Three falbers caUed eric
Why is that
Because be's got three children isn't it?
11. Analogous rule
Now if you edit that file you can probably write the rule for mother based on the father rule
You want mother (types motber(Mother,Child):- person(Motller,female), parent(Mother,Cllild).
ll. New rule (TT)
Righi, could you try to write a rule which says what a sister is
I could try (types sistor(

As long as you spell it consistently it doesn't mauer
So a sister is, a sister of a child isn't it

Yes or if you want to, yes I mean you could use child as the second variable or sibling if you wanted to, or
you could just say sister is the sister of sibling. or person or child. whatever you wane to use
(types sistor(Sistor.Cllild):- person(Sistor,female).

oow, she's not a parent
No, she's not a parent ...
She's a persoo, we've said that ...
What else is she?
Sbe's a sister ...

But we're just in the process ofdefining what a sister is ...
Right ...

Whal is she ?
She's a daughter

Well if you think about it what do we have to say about sister and child - you say the sister's got to be
female, but about the relationship between sister and child
The same parent
Got to have the same parent. yes ...

So put a variable
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Yes indeed
(types parent(S, Still a child though isn't she?

Yes, if you put the sister in there as a child now because the second position in the parent relationship is
reservedfor the chilLi, so if you put the variable sister in there that automatically makes her a child
Sister as a variable?

Now you've got a variable now for the parent to hold the parent's place, we've got to make the sister a child
and you make her a child by puning her in the child's place here
So in upper case?
Upper case, yes
Just child

Child, yes
(types to produce pareot(S,Olild),)

I wondered what you were trying to do, but it is still not finished now, that makes the child a child but
you've got to 11lllke the sister a child as well of the same parents, do you see what I mean, how would you
do that now, you've got that line down
So now persoo, no?
You have to make the sister a child as well, that's ole. Well you want really to link those two through the
Slln'fe pare111 to mo.ke sure so it's got to be the same parent so you've just got to stick an S and something else
Yes, it's parent, that's right
(types pareot(S,Sistor).)

You see because now you've said the sister has got to be female then you go and find a parent for the chilLi,
you find the parent for the sister who is the same OK?
OK now if you wanted to try the rule out

Subject 16
1. person(annie, female).

Ifyou ask it person(annieJemale). what would the answer ro that one be?
Would it just come up yes?

Just try it
(types person(annie,female).

[yes]
person(X,female).

z.

lfyou asked it person(XJemale).- what would the answer to that one be?
It would just list all tbe female ones. [correct]

3. parent(jenny, Z).
Now if we look. at the next set offacts where we've got the parem facts. If you say paremljenny,Z), what
would the answer to that one be
All the things that are paired with jenny -all the names. enters query (enters parent(jermy,Z).
[X= barry, james, kathy]

4. parent(carol, rosie).
What would the answer to parent(carol, rosie). be?
Is it if there's a relation in there like that it would come up yes?
Is there?
Yes tbere is. [correct]
5. parent(sopble, rupert).
OK and to parent(sophie,rupen). -what would the answer to that one be?
No - because it's the wrong order.

6. parent(rosie, Y).
Yes, and ifyou saidparent(rosie,Y).
rosie, no, sbe's not there - so no

7. all daughters (conj. - TT)

Now if we wanted to retrieve all the daughters we've got in this little knowledge base, how could we do
that?

Daughters? I don't lmow what does it mean by daughters

Well we haven't got a rule or anything like that in there called daughter but you could nevenheless by
ruking the right question get a list ofall the daughters.
Are all the daughters just female names?
Yes ...
I don't really uodetstaod
Well you'd have to do, you can'tWhat I'm really trying to say is I don't understand what that sentence means

That means norman is the parent ofharry
OK. so we're looking for female ones there. So what would • do, is that what you're saying?
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Yes
Could you not just do parent( ... - is it a conjunction or something like that?

Thai's right
Something like if X is female ...

Is that a conjunction. what is a conjunction
Comma.

Thai's right.
Could I do the same thing and X is female, shall I do that
Yes, please.
(types parent Is that right?
Yes
What do I put in if I haven't got a particular name?
Wei~ you could just use a variable
A different variable? (types parent(X,Y), Can you do equals[=], or?
No you just string the different things together, which facts are you addressing now
Obyes
So you just have to say which relaJionship you are addressing now
persoo(X.female)- eh, person (Y,female)

Yes, ~cause X female would give you the tnothers
111 bave a go then (types ...pecson(Y,female).
[X= norman, kathy, jenny, kathy etc)
So what does it return for X and Y now?
The )mentis DOJmaD and the daughter's kathy.
So it returns the parent ... for X
... andY for the daughUr, that's fine
9. placeholder
Is there a way you can just get the daughter?
Thai is an interesting question, I would lulve asked you tlult with the next one but we can do it now. What
would you do if you said give me all the names of the daughter but I don't want to know what their parents
names are. Just terminate that one. Yes you could do tlult you only lulve to clulnge one thing aboUJ tilL
query you have been running. Which is the crucial thing that we obviously have to change somLtiUng

about?
X
Thai's right
You don't put in the name do you - do you just put in another word without the capital letter?

No you can hold that - it would be
Obanwlderscore
Yes an underscore, so if you try(enters parentL Y),persoo(Y,female).
[X= kathy, kathy, rosie, rosie etc.)

10. Repetition
You've got every name listed twice now. Have you any idea why that is?
No not really
If you compare it to the query you ran before and the answers you got then ...
(enters pareot(X.Y),pe.rson(Y,female).
[X= norman, Y = kathy etc)

Yes, so why does it give you the name twice ? If you look at the answers you 've got now, jenny as a
daughter here say and here
Ob it's for both parents
Yes because wilh that query it lists both parents actually
As separare people
8. test rule
I've pUla rule in at the end ofthat knowledge base that defines what a father is, it says a person is father of a
child if that person is a parent to tlult chilii and if that person is a male person, now you coulii use that ruk
to get a list ofall fathers and their children for instance

Right
Sot/Us is the header ofthe rule, how do you actually test whether it works?
How do I test it

If you just want to see if it works how do you get it to give you the fathers and their chiliiren
Could I just do something like father(nonnan.X)?
Yes, and then see whether the answer is true. OK try it.
(types fatber(nonnan,x).
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[X= barry, james. kathy)

11. Analogous rule
Now if you edit thai file could you write a rule that defines what a mother is based on this one?
Mother persoo child, person cbild and person female
Yes ifyoujust go and do it
{types mothet(Motba,Cbild);- person(Molher,female), parem(Mother,Cbild) .)

U. New rule (TT)
Yes it looks fine. Now slightly more difficult, could you also write a rule that defines what a brother is?
With wbat we've got already <r just
No you'd have to write a new rule. Sorry perhaps 1 didn't quite understand you, what did you mean with
what we've got already?
Well there's been no mention of brolher or sister bas there? I don't know where to begin, brother is a child,
would that fit, as opposed to parent ...
You mean the first one. How would you start?
brother ...
And then what comes after the bracket?
Don't know

WeU this one says a person, somebody, well whether 1 put Mother here or X then X will it doesn't matter,
so X is mother to a child if, and the same you would have to say brother is somebody's brother

Is child right
Yes or whatever you call it, you can use X andY if you find that easier ...
brotber(X,Child) if, I don't know, you use mother and father do you?

Yes you can use the output from those rules, we're not going to be fussy, we say if one of them we'll be
happy
Don't know, I'U bave to think about it, if, do you say if they are cbiJd of the mother and child of the father, the
same one?
Who's got to be child of what?
Children of the same parent, bow about X child if person, male, and bas same parent ...
Just start off say, there are two conditions somebody has to meet in order to be a brother, the first thing is?
Male
Yes he's got to be male, and?
Got to bave the same parent
Same parent as wlw
as bis brother - or sibling
yes so perhaps you find it easier if you don't say child but say Sibling instead so we're sure what the
variables are standing for
Right ...

So you could say for instance brother(Brother,Sibling). yes perhaps you wouldfmd it clearer if you kept itt

mind exactly what they stand
If trother person whatever it was

person brother, male, yes take it as far as that perhaps you'll see, if you type those first two lines in, and
then we'll think about the rest

(types brother(Brotber,Sibling):- What was it Sibling. brother, male, now what did you say?

brother's got to be male
brother's got to be male

So, just the same as mother's got to be female
person?
Yes, because that's what we've got in the first one, we've got the gender infonnation
(typeS persoo{Brodler,male) parent(mother,Brolher)
Yes thai's righl that is the next line
(typeS parent(Brolber,
No - the other way round because the parent always stands in the first place, the brother is a child isn't he
So it could be either Mother <r Father (types parent(Mother,Brotber).
Ah that's not quite all (subject reads rule aloud) I don't know

. .

.

Well they're still not sharing the parent, you've got to make clear that the Szblmg has got to be a child of
the Mother as well
Ob so Sibling, and parent(Motber,Sibling)

Tluu's righl, yes
(types ... , parent(Mother,Sibling).)

Yes that should work shouldn't it
(types brotber(harry,X).)

OK, what should the answer to that one now be ?
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james
And?
I think that's all (RETURN)
(X= barry)

ObI see
(james and katby, then harry, james, kathy again]
Wby does katby come up?

~elllcalhy should give us the least headache because she is actually his sister so she is a sibling to him, he
u brother 10 her
'
Ob rigbt yes, I was thinking the other way round

Subject 17
1. persoo(anoie, female).
OK so if we would ask il person(anniejema/e)
([)'peS pcrsoo(annie,female).)

What will it answer 10 thaJ one?
It will just say yes. [correct)

l. persoo(X,temale).
Ifyou said person(Xjemale).
(rypes pcrsoo(X,female).)

It will list aU tbe names of females. (correct]

3. parent(jenny, Z).
Similarly, if you said parent(jenny,Z).
(rypes parent(jenny,Z).) It would give hany, james and kathy. [correct]
4. parent(carol, rosie).
Ifyou said parent(carol, rosie). -what would the answer to that one be?

Yes. [cocrect)
S. parent(sopbie, rupert).

And 10 parent(sophie,rupen)?
No.
Why would the answer be 110?
Because they're the olhe.r way round.
6. parent(rosie, X).
And if you said parenJ(rosie. Y).
No, because she's not in tbere
She's not ...
In tbe fU'Sl position
7. all daughten (conj. - TT)
OK. now, if we wanted to retrieve all the persons in our database that are daugluers lww could we do that?

Do you type persoo(X,female),?
inl
parent(

You're on the righl way, if you think about it for a moment ...
You doo't need to know the name of the parent?

I don't mind. honestly you could do it, if it easier, with gelling the parent, do that first.
Do you want me to do it? (rypes person(X,female),parent(Y,X).)
So what will that give us or what will that rerum for X and for Y
It should go through it and find all the ones that are female and then all the ones that appear in the parent as a
daugbt.et

Yes, as a child, and for Y it will give
The parent
yes, il goes, that's righl, OK, right
[list of parents and daughters]
9. placeholder
OK thaJ's jiM. now if as you just said, you didn't want the name of the parent listed, what would you do

about that?
Can you just put it in with a small letter
No, not a small letter but you've got to hold the place somehow, if you don 't walll the flll/ne of the parentCan you just put an underscore in?
That's righl. that's the way you would do it, so if you just try that
(types persoo(X,female),parent(_,X).
[X= list of daughters]

10. Repetition
Why is it giving you all of them twice ~
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Because they're down twice with two different parents

8. test rule

~I did at the end ofthe database, I actually pur in a rule that defines what a father is and I said a person
lS afaJher _
ofa

child if that person is the parent of the child and that person is also male yes? Now

if you

w~d a l1st of all the fathers and their children. according tv :he way that rule is wrinen. what would you
type m?
(types falbet(X,S).
[X =eric , S =jenny)

Mmmmm
Why are you saying mm

Because I asked it to give the child as well and you only wanted
no that doesn't tnalter
11. Analogous rule
Now if you edit the file could you write the rule for what a mother is modelled on the father rule
{typeS motber(Motber,Child):- person(Mother,femaJe), parem(Molher,Child).)
12. New rule (TT)

Yes that's right, now could you also work out the rule that would de[me what a sister is
(typeS sistet(Sister,

What are you going to call it?
What do you want me to call it?
Well, what do you think you might call it?
Does it mauer?
No I just wondered - it only matters in the sense that if you write. yes that would be sensible, sibling,
wouldn't it, you can call it whatever you want it's only so it makes sense so when you look aJ it you know
what it means ...
(continues typing sister(Sister,Sibling):person(Sister,female),
Are you saying that the sister's got to be female? Now what is the other condition that she's got to ... have the same parent
As what exactly? If you look at the beginning of what you've wrillen... as tbe Sibling
As the sibling, that's right. so how do you do that, how can you make it realiu that you want it to have the
same parent?
If you put the same variable in twice, will it look at the same thing?
I would think so, do you mean for the parent?

Yes
Yes, that's the way to do it. Now you've solved the dij]icu/t bit ...
(types parenl(X,Sister), parenl(X,Sibling).)
Yes that's fine, give it a blank line and if you save it now and try it our

Subject 19
1. person(annie, female).
now if you asked the program this first question here, to the query you asked person. annie, female, what do
you think that will retum? What will the system tell you?
that she bas 3 children ... would it?
try it, see whaJ is says
(enlei'S query)

[yes]
so all it has given you is the answer yes, can you see why that is ? if you look at the program again ...
all it's answering is yes, there is someone called annie and sbe is a person

2. person(X,temale).
ok, so if we put in a query person, open brackets. big X, comma, female, what will the system then tell us?
well it could tell us all the people who are female but that's only if it knows what X is (starts entering query)
right shall we try it? What do you mean, if it knows what X is
Well I mean if it doesn't have any, if it can't relate X to anything, then surely like it will just say hang oo here
... what are you up to? It will rebel. (types "person(x, )"
but if you put big x in
You saUl earlier you think this will come back and say, it will give us all the people who are
yes, I don'tlmow, or it could rebel, I don'tlcnow (enters query)
( X= annie --> ]
How e<me it comes up with annie?
Thai's whaJ I want you to tell me. why do you think it's going to miss annie? ... Or more importantly
when you typed in the small x. and I said go back and give it a big X what difference should it make?
I don't know, obviously that refers to somelhing different than a little x would
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Could ~ou ty~ it0 ~gain ("!pes query in again). well in fact what that has done because it is a valid capital
letter, 11 tells t1th1s IS a varUJble, so it will look in the knowledge base to find out what X could be to make
thai trw ...
why does it necessarily pick annie?
Well whal else could it pidc?
it could pic% anytbing couldn't it jenny or •

well why do you think it's picked annie then?
because it's tbe fust one?
so how do we get the others, jenny or whatever, see if you pressed return here you'd actually get annu

(IRsses RE1URN)

[(X = annie ··> ]

How would you get jenny?
mm, I don't know, x plus 1?
Ifyou press the semi-colon. right,
(does)

So whal do you think it will give us nexr?
zandra. carol, if l do the same thing (does)
and then if you come down to
cachy, tbeo there's rosie and sophie
right whal do you think it will do afterwards? after sophie
ob it might go back to the beginning (continues)
(DO J
no ... ob, it's rebelled
3. parent(jenny, X).
So if you look at the other one now, we've done this person and we look at parent, jenny. comnw, big X
It will probably have harry

harry? righl, any others
well if you do that semi-a>lon it will probably have james. then cathy

ot. we'll do thalthen
(eob's query)
[barry. james, kathy]
and IIOW whal will it do?

say no
[DO)

4. parent(carol, rosie).
so if you put in parent,forget about the variables now and put in parent, carol, rosie, what will that say?
it will say yes
is it, it's in the knowledge base?

yes
ok
S. parent(sopbie, rupert}.
How about parent, sophie, rupen?
It will say DO.
ShaU we try that?
(does, JR(licted result)
8. Test rule
So if we now asked father, X. Y, what do you thin.k is the first answer we will get?
noonan and barry?
right ok
(eoeers query}
[X= noonan, Y =barry)
norman and harry, ok, who will be the next one wejtnd?
noonan, james (correct} noonan, kathy (correct)
And the one after thai? then what would be next?
martin, peter ( cocrect)

11. Analogous rule
manin, peter, ot. thai works, so could you write the rule for nwther
(edit files) So you want me to do mother ...
(types motber(Motber,Cbild):- parent(Motber, Child), parent(Mother, fe~e).)
.
So what this rule is saying is that someone is the mother of a child if they are parent of that child·
... and female (corrects second line to read person)
12. New rule (TT}
Ole could you write the rule for, from that knowledge base, who is someone's brother, just call iJ brother
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(types brother(Brother, -hesitates)

Any word would do as long as it begins with a capitalleller(brothel(Brother.Brat):-)

So someone is someone else's brother ifFust if they are male. and then if they've got the same parents. I want to say if person, Brat, male, then I'd have
to say I could say person(Brat. male) (types that. thinks) ...

And they share the same parents
parent. BI'Oibez, Brat? No, Brother ....

You are_ trying to say parent of the brother is something, and something of the Brat and those two are the
same thing
Sooy wbal did you say?

Parent of the brother something, and parent of the brat is something, and those 2 somethings must bt the
same
I don't know
(types end ofrule to produce brother(Brother, Brat):- person(Brat,male). parent(Brother,Someone),
Can you write the next line?

parent(Bnu.Sooleooe) (types)
So if we go bact and try a query on this ... now look at the knowledge base and working out who's got a
brother, how would you ask who has a brother?
(thinks) ok, barry bas a brother so
How would you find out?
brother, brackets, barry (typeS)

You will need anotherok X what will the answer be
(enters)
[no]
harry doesn't have a brother
be does have a brotber

He should have a brother (explains that he got variables confused).

Subject 20
1. person(annie, female).
First question would be if you type in person(annieJemale) what should the program answer?

It would answer yes.
l. person(X,female).

If you typed in person(X, female) what would the answer to that one be?
annie

Just ll1I1Jie?
person, capital X, female? Yes. Oh no it would be all of the females.

Ole so if you try that
(enters query and gets predicted result)

3. parent(jenny, Z).
Now if we look at the next set of relationships, the parent relationships, we've got the parent first and then
the name of the parent and then the name of the child. So if you type in parentUenny,Z) - what should the
answer to that be?
harry james, and kathy (enters query and gets predicted result)

4. parent(carol, rosie).
Ifyou type parent(carol, rosie). what would the answer to that one be?
yes

S. parent(sophie, rupert).
And ifyou type inparent(sophie, rupert).
No.

Why
Because sopbie is, what did you say? parent (sophie, rupert). It is lhe otber way round, sophie is rupert's cbild.

6. child(rosie, X).
lfyou typed in parent(rosie,Y).
It would be no, because rosie is the child not tbe parent. [correct]
7. all daughters (conj. - TT)
lfyou wanted your program to retrieve all the people who are dilughlers, how could you do that?
Just the daughters? Do these link up at all, these two sets?
Yes they're in the same program.
Well persoo(X,female) then - hang on I'll start with that shall I? (types person(X,female) - I'm deciding whether
to put person or parent next. what was lhe question again - all the daughters that are female?

You want to retrieve all people who are daughters, so you've stated that.

Transcripts-165

I've stated that person .. .

··· that the daughler has to be female, so what is the second corulition they have to meet in order that ...

So you put parent(X,female) yes?

Not really, what have you got in those parent relationships?
You've got - oh so you can just put X, Y, no?

X Y, you put in 2 variables, that is correct
Tow capitals ...

Yes you put in capitals, but who has got ro be female? the daughler or the parent?
The daughter

So, where does the daughler stand in the parent relationship? Where is the child

second. ob X (adds 10 query to give: person(X,female), person(Y,X), RETIJRN
[no)

You had a slighl problem, you typed in the wrong relationship name in the second
(enters persoo(X.female),parent{Y,x).
[X=jenny, y =annie]

So tluJJ gives wluJJ now?
X is the femaJe daughter and Y is the parent

That's right so lhal says jenny is the daughter of annie and if you go on you'll get a few more combinations,
yes jenny is the tl.twghter of eric (etc)
9. placeholder

If you were going to run the same query now but you were going to say I only want to know the people
who are daughlers,l don't mind who their parent, what the name ofthe parent is, could you do that
Yes, start off the same way (types person(X.female), parent( You don't mind who the parent is?

No you've got to refer to the parent relationship in order to establish they are a parent, but if you don't want
the system to return their names- you just want the names of the daughters.
Well it doesn't mauer if it returns their names

But if you didn't want to, what would you have to do, can you remember?
Just put a dash or something

Underscore, so if you do that
(enters: person(X,female),parentLX).)
[X= jermy, X= jenny, X= zandra, X= zandra, etc.]
10. Repetition

Have you got any idea, you know it says X jenny,zandra.kathy, why does it always say the name twice?
Because there's two statements
Which two statements. why is it? Why do they get returned twice
I was expecting it really, but as you're asking for who is female, I don't know

It's because ...
... there are two lines

No it's got something to do with the content of tlze database
Ob yes, each bas got both the patents, each child has two parents

That's right and that's why it returns them twice, because they are daughter to like, jenny is daughur to two
people, she is tl.twghter to annie and to eric and so on ...
8. test rule
There is a rule towards the end of that file which defines what a father is, the rule says father(person,child) if
- can you interpret that rule
If, let's have a look, child, you're trying to find person. if the person is the child of the parent and the person is
male

Yes so you've got the first variable here says
The cbild is, the person is the child of the father if ...
No that actually says a person or a person X or whatever is a father to a child if ... if that person is the
parent ofthe child and the person is male
Yes that's right, ok so this rule is already in that program, so if you wanted it to give you a list of all
faJhers and their children. what would you do?
(types fatber(P,C).
[ list of fathers and their children J
11. Analogous rule

Yes, so it returns all those, that's fine. ifyou edit the program now and put in a similar rule to defilll! what a
mother is.
(types motber(Mother,Child):- person(Mother,female), parent(Motber,Child).)
12. New rule (TT)

Right so you are now saying a person. anyone in our database is the mother of a child. if this person is
female and is a parent of the child, OK now if you would say in normal English if someolll! is a brother of
somebody else, what conditions have to me if someone is a brother of somebody else?
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they have to be male and they have to be a sister??

No you can also be a brother to a male sibling can't you?
Yes, sony, and they have to be, no they wouldn't necessarily, they have to be male, they have

to be a son, they
have to be a child and, you need something else do you because they have to be a
There has to be another person, yes but what about the brother and that other person
They also must be a child
Yes, of what, crucial poinl
Thepareul
What parenl, what is it about the parent
They have to have two ...
They've got to share at least one parent haven't they, I mean the brother, the person they are brother to

So

if you would try to wrile that rule now .. give it a blank line first

(starts to type brother(brother so we're trying to find out who all the brothers are?)

You write a ru~ that defines who a brother is, you tell the system now what a brother is, if you don't give
it a ruk, it won't know, you're saying, I don't mind which variable names you use but
ObI forgot about the capitals (types brother(Brother, Person):Ok first thing the brother's got to be male
(changes beadec to person(Brother, Male)
No - I think the variable name you had before was beuer.
Petson? (changes it bade)
Ole now the first condition is the brother's got to be tnale ...
(types persoo(Brodler, male) I don't know ...
Well you've got facts about parents in there haven't you?
(types parent(
So who's first in the bracket?
The parent and tben the ... tbe child, so (types parent(Parent.Brother),
and. the lilst line?
(types pareol(Pareot,Person).) [correct]
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MacWrjte Study
Subject 1
The file trial click on it and then choose open from the file menu.
(Moves cursor over trial icon.)
We have to click on it.
(Does.)
And now to file {the menu file].

Wba'e?
It's at the top, there's a menu bar.
(Pops up menu.) And now to open? (Selects open.)
[Starts loading dJe flle.]
Ab.... [File displayed).
I go to edit I suppose. (Moves pointer over Edit, reads edit menu). can't undo can't paste ... (swts reading

instructions).
1. Save file

(Moves pointer to File), and save. . . . Selects save.
l. Change margins
The left one to 1.5, the right one to 6 .5 . .. .
Must be in the menus. (and starts looking in the manual).
Must be style, (moves pointer, reads menu) No. Format (moves pointer, reads menu). Align left? (Highlights,
selects.)
[Sa-reo redrawn.]
Go back up.
(Pops up the Format menu again, but doesn't select Reads instructions again .)
(Reads manual.)
Might be under Edit. (looks at Edit, the Format, then File menus.)
It's in Format.
Display beadels.
No, it's on top of the file, you have to see the ruler.
(Scrolls text to display ruler. Points at the spacing icons.) That one?
No, those? (Points to them in the manual.) There's one on the right aiUi one on the left. The little black
one. (looks in the manual again) That's the left margin marker, that's the right margin marker. They want
moving.
(Clicks oo and starts dragging the indent marker.)
To 1.5.
(Drags to 1.5 and lets go.) 6.5? (Grabs the right margin marker and drags it to 6.5.)
[Doesn't seem to notice the difference between indent and margin marker.)
[fext indented at 1.5, rigbt margin at 6.5.]
That seems to have worked.
[Doesn't notice tbat the left margin is still at zero.]

3. Insert word
(Moves pointer to insertion point. Clicks to position cursor. Inserts word.)

4. Delete characters
(Moves pointer. Clicks, to position cursor, and deletes: moves pointer to next word, presses delete.)
[Thereby deleting character in previous word.]

Oops!
You have to click it.

5. Delete words
(Positions cursor at end of word. Deletes by back-spacing.) This is like on an electric typewriter. you have to
hold it down.

6. Delete line
There must be a quicker way to delete a whole line. (Looks in the Edit menus. then Search menu.)
(Looks in the manual.)
(Starts looking over c~xperimenter' shoulder.) It's not under bow to select some text is it?
Maybe (Reads.) It says you can click iJ at one end, hold it down, and drag it across.
(He tries. Wavers a bit. but manages to highlight the line in the flrst attempt.) I've blocked it, and now?
(Reads.) Highlight, then choose cut from the Edit menu.
(Does, line deleted.) Ah!

7. Double spacing
I think that is at the top again.
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(SC£?Us up and inspects lhe ruler. Points at the 6 lines/inch.) Presumably !llis is an instruction here about tbe

spaC1Dg.
[~ lines/inch as a textual message, connection to the spacing icons is not noticed. Mixed representation,
differences cannot be represented.]
No, it's the boxes.
(Moves it into the 6 lines/inch box.)

No, thL other boxes.
(Inspects the boxes and selects double spacing.)
flbe text is displayed as double-spaced.]
8. Single spacing
(Moves to lhe ruler, points at the 1.5 spacing box.) Is it that one.
(Looks in the manuaL) No, the left one.
(Selects.)

9. Centre paragraph
Do I have to cbange lhe margins again?
No. Cetllre it.
(Points to tbe centre box.) Is it this one? Is that centralised text?
(Checks in the manual.) Yes. BuJ it's only for a . .. piece of text.
So we have to underline it flrst. [Means highlight.] (Moves to paragraph. Highlight it.) That was easy.
(Returns to ruler, and scrolls upwards, and selects Centre icon.) [Entire document is now centred.] Oh! (Looks
confused. Scrolls down, selected paragraph is still highlighted.) It's not like you have to click the centralised
fa.rst, and lhen have to say wbal you want to centre? [Cannot work out what to do.]
(experimenter points them to instruction, which says that a new ruler has to be inserted.)
(fries to undo tbe centring fllSt, selects single-spacing icon instead of the left-align icon.)
No, il's tluu one. {Left-align icon.]
(Selects return to paragraph to be centred. Selects insert ruler from the Format menu.) [Ruler inserted] Ob! I
see. (Selects centring icon.) [Text below ruler is centred, but highlighted paragraph bas disappeared.] (Selects
bide rulers from the Format menu. The ruler disappears but the text doesn't reappear.) We've lost it

10. Underline word, embolden word
(Points to tbe Style menu.) Do you think that's in Style then? [Is about to select underline.]
But we hlJven't actually told it what to underline yet.
Welllhe last time we did that we lost it. (Highlights word, selects boldface. Highlights another word and
underlines it

11. Cut and paste
(Reads instructions.) Cutting and pasting is it? (Clicks on Edit menu. Cut is greyed. Tries to select Cut.)
How do you get that?
(Reads manual.) As with most editing you have to select the piece of text before you can cUI il.
(Marks paragraph.) So cut. (Selects Cut from Edit menu. Moves pointer to the beginning of the text and
clicks.)
And paste it now.
(Selects Paste and the paragraph is inserted.) It works!

ll. Print
(Points ar the Hie menu.) Ah! There it is. (Selects Print. Reads the print options.) Lets have best (fries to
select best)
It's on that already.
·
Ob! I see. Do I just click OK. (Clicks on OK and the document is printed.) It works!
13. Quit document
(Click at tbe File menu. Tries to select New, but New and Open are both greyed. Nothing happens.) No, that
didn't work. I thought it would come up with tbe other one fllSt. or do you have to quit this ooe? (Isn't sure
whether to choose Quit or Close. Selects Quit. Reads dialogue box.) Do you we want to save the changes.

No.
14. Create a document

MacWrite options? Empty folder? (Clicks on the em~ty folder . Selects File menu and Open from the File
meou. 1be fol~ window is displayed.) Oh no! Thatts wrong. I want a new document (Closes the folder.
Selects MacWrite and opened from the File menu. A new file is displayed.) This could be it. (Starts typing
text.)

15. San a new document
(Looks at tbe Hie menu and highlights Save.)

No. Must be Save As because we haven't given it a name.
(Selects Save As. Types the docwnent name, hesitates, clicks on Save. The document is saved.)

Subject 2
1. Save file
(Goes straight to the File menu and selects Save.)
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2. Change margins
FonnaL (Clicks on Format and reads the menu.) Set page? Insert ruler?

(Looking through the manual. ) Yes. why not?
(Inserts a ruler where tbe cursor was.)

Can you use that to set that margins? Maybe we should go back to tile top.
(Clicks on Format. Selects Insert Ruler and inserts a second ruler.) I've got another one. (Selects Hide Rulers.
Can't work out bow to scroll the text to see the top of the document again. Selects Insert Ruler again. A third
ruler is inserted.)

How do you get rid of them?
(Clicks on a ruler and highlights it. Clicks several times. Goes to Format and selects Hide Rulers again.)

We should move the text up again because we can't see what we're supposed to do.
(Goes back to Format again.) Is that in there? (Reads Format menu.) Set page? (Starts leafing through the
other menus, and can't work out bow to return llO the top.)
What about the scroll bars? (Points to the screen.) Okay so the left one to 1.5 and the righr one to 6.5.

(Reads the manual.) You need to get the ruler back to do that.
(Clicks Format menu again and selects Show Ruler.) 1.5 and 6.5? (Looks at the ruler but cannot work it ouL)

(Reads the manual again.) You have to drag those things there across.
What, grab and drag it? (Moves the paragraph indent marker to 1.5.) What, do we drag it to 6.5 and then come
back here? (Lets the button go, and the paragraph indent is set to 1.5.)
Why has it done halfof it? [Only the first line ofeach paragraph.I
Selects Hide Rulers and then Show Rulers again. (Grabs the right margin marker and moves it to 6 .5. Fiddles
about but cannot fmd iL)
(Points to the left margin marker which is still at 0.) How about this one here?
(Grabs the left margin marker and drags it to 1.4.) Wbat did I do? (Starts fiddling with the margin markers and
sets it back to 8. Also, moves the window to tbe right by mistake.)

Where hils the scroll bar gone ?
(Uds around the menus.)

You have to move it [the window] back again.
Set page? (Selects Set Page from tbe Format menu. A dialogue box appears and be realises that it is the wrong
command. (Clicks around the ruler and selects 6 lines per inch.)
[They can't work out to move the window and so the experimenter re-positions the window so that tbe scroll bar
is visible.]

3. Insert word
(Tries to position tbe cursor by dragging the po'nter [and thereby highlighting].)
Well you have to click it there.
(Clicks the cursor and types in the missing word.)
4. Delete characters
Is thal in spelling? (Clicks on the spelling menu.) Checks spelling?
Don't think so. (Stans reading the manual.)
(Fiddles around. then presses the delete key.) Ah! That worked. (Tries to position the cursor by dragging again.
Highlights several words and presses delete, there by deleting several words.)
What happened?
I don't know. 111 put them back in.
[Struggles to position cursor.]

5. Delete words
Maybe we should use the Cut command from the Edit menu.
(Brings up the Edit menu, but Cut is greyed.)
You have to select the text first. If you come down and select the text. . . . You have to drag the black box
over these words.
(Marks a block of text and selects Cut)
6. Delete line
(Marks line and selects Cut.)

7. Double spacing
What does double spacing mean.
Well it means you have a blank line between every line of text.
Must be in Format musn't it? (Reads the menu.)

(Reads the manual.)
Do we have to put another ruler in?

Where was the cursor before you did it last time ?
Do we have to take it to the beginning and insert it there.

Do you want the double spacing for all of it or just that? (Points at the paragraph. Decides f or the whole
thing. In which case we should take it to the top again.)
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(fakes the cu_rsor back to the top. Looks at the ruler. Looks at the manual.) Double space box? (Points at tbe
doubJe space •coo and selects it.)

8.

Single spacing

(Returns to the top of the page and selects single-space icon.)
9. Centre paragraph

(Points at ruler in paragraph wbicb he has previously inserted.) What is that ruler doing there? (Selects Hide

Rule~.) Wbete sbould we put the cursor in to put the ruler? (Highlights the paragraph to be centred.)
I'!' not sure w~ happe1U!d to those rulers that were around before and whether it matters. We've got all
different margm.s. Was thal aU the OIU!S [rulers j we put in.
Yes, inadvertently
Maybe we get a problem now if we try and centre it. Try it anyway.
Sball I leave it highlighted like Lb.al? (Selects Insert Ruler.) [The paragraph which be bad highlighted bas gone.}
Here you go. that bas solved that problem didn't it?
10. Underline word, embolden word
(Clicks oo tbe Style menu.) Bold? (Selects Bold, but since no text was highlighted nothing happens.)
You have to marie il first.
Yes. but last time we did that it deleted it. It ate it [laughs]. (Marks paragraph and selects Bold. Marks a word
and underlines il)

11. Cut and paste
(Marks paragraph.) If I cut it ... (Selects Cut. Positions c ursor. Pastes.)

ll. Print
(Ftle menu. selects Print) Quality best yes. (Tries to select.)

The ofU!S thai have got the dot in are already selected.

(Selects OK. and the document is printed.)

13. Quit document
(Selects Quit from menu.)
14. Create a document
(Selects Flle menu and New Folder. Can't worlc out the problem.)
[Experimenter tells him to highlight MacWrite and select Open from the File menu.]
(Click around with the pointer. Highlights the ruler.) What have I done? I did that last time.
Experimenter explains that be bas selected the ruler)
(Sees the left margin to 20 and the right margin to 60. Selects Hide Ruler. Types some text in.)

15. San a new document
(Seleccs Save from the File menu.) Save current document as? (fypes file name and selects Save.)

Subject 3
1. Save file
(Clicks oo Flle and selects Save.)
2. Change margins
Change lbe left margin to 1.5. We have to look in the book to find out how to do that one.

(Reads the manual.)
Is tballbe ruJer?
Must be al the top of the page. You have to move up a bit.
How do I get there?

There is this scroll bar on the side.
Wbere is it? Do you go to File?
On the righl there is a scroll bar. Just click on that.
(Points to lbe page symbol on the scroll bar.) This one? (Clicks.) That didn't work. (Clicks again and drags the
page upwards a little. The bouom of the ruler appears.) Oh! I see. (Drags the page symbol to the top.) Oh ! I
see. What do I have to do now? Change the left margin to 1.5?

And the right one to 6.5.
(Studies the symbols on the ruler.) Well, it hasn't written out . .. 6 Jjnes to an inch? What does that mean? 2
incbes and 3 bits of an incb. Does it say where, which bit to change it?
(Reads the manual.) No il doesn't. ltjust says ruler for margins, line spacing, and text alignment.
So I pusb oo the tab do I? (Clicks oo the ruler which becomes highlighted.)
Click agaill.
[Ruler stays highlighted.)

Move it.
Where? (Sbe's trying to drag the left margin marker.) Does it really have adjustable settings fcx- margins?
Yes. you've got to move one of them to 1.5 and the other one to 6.5.
Yes, but I don't know where to put the cursor.
On the tiJb..margin marker
(She points to the paragraph indent marker and starts dragging it) 1bat one?

No. There's another one.
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(Sbe drags the paragraph indent marker off.)

There.
That doesn't do anything. [Because the ruler is highlighted.]
[Experimenter intervenes and tells her to remove highlighting.]
That one ~ere? (Tries to drag ~g~ marker, and. seleciS the ruler again. De-seleciS, the same problem again.)

Hold 1t down as you drag rt. Cizek and hold 11 down while you move.
Up<x-down?

Across you've got to drag it to 1.5.
(Drags lhe paragraph indent marker. flrst line of every paragraph is indented.)
Do the same to the other one on the right hand side.
(Drags lhe right hand margin marker to 6.5.)
Yippee.
No problem. I ought to move the margin up a bit. [She means she ought to move the text up.]
3. Insert word
(Moves tbe pointer to the insertion point.) What happens if I push this?
Okay.
(Clicks to insert tbe cursor atlhe insertion point.) Oh yes. lbat means I can insert a cursor. (Types word.)
How do I get rid of Ibis rursor?

Click somewhere else I suppose.
(Does.)

4. Delete characters
What do you lulve to do now?
Put the rursor there again . . . (Presses DELETE to delete a character. Positions cursor in front of the next
character to be deleted.) That's not quite the right place is it? (Positions the cursor behind the letter. Pushes

DELETE.
S. Delete words
It says you can mark the words with the tnouse and delete them.
Mark it with mouse ... Shall I put one [marker] at the beginning and one [marker] at lhe end? (Positions tbe
cursor at the beginning of Ule word. Moves the pointer to the end of the word. Then realises tbat clicking wiU
move t.be cursor ro the end of the word.) I don't know how ... How do you mark it?
(Reads the manual.) [Reads] "Position the cursor at the beginning of the text, drag across to the end, then
release the mouse button."
(Carefully marks one word.) Wow. [Wonderment.] If I press the BACKSPACE it will it just go away?
(Pushes DFl..ETE.) Oh, that's good. (Marks other superfluous words and deletes them.)
6. Delete line
(Marks line and pushes DELETE.)
7. Double spacing
Double spacing, ob dear! (Looks expectantly at the co-experimenter.)
Thai's some more do do withformauing.
So do we cbange the format at the top. (Moves the pointer to Format.) Where's the format. in here? (Reads tbe

menu.)
It's not there.
Style? (Reads the Style menu.) No. I don't know what Font means. (Reads the Font menu. Looks at lhe Edit

menu.)
(Reads the manual.) No, it's the ruler.
(Reads over his shoulder.) Double space bar, it's the third one [of the icons]. Shall I get this thingy down
again?
You lulve to go to the top again. it's the scroll bar.
Shall I push the 1 again [page icon on the scroll bar].

Just use the arrow.
(Does.) Right. (Looks at the ruler.) Double space bar is the right one. (Hovers with the pointer over lhe icon.)

Just see what happens.
(Selects, and the text is double spaced.)
8. Slngle spacing
(Returns to the top.) Which one is single-spacing? Is it the 6 lines per inch?

No.
Ah, it's that one. (Clicks the single space icon.)
9. Centre paragraph
(Clicks oo the Format menu.) Insert ruler. (HighlighiS Insert ruler.)
Wait, how does it know where to insert it? (Reads the manual.) What do you think?
Um, I have to move the cursor down there. (Still holding the menu .) But, I can't do that at the same time.
have to click that because I can't move the mouse.

You can move off and let it go.
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(Does.) So we put the cursor down here. (Clicks at the beginning of the paragraph.) Do I highlight this to the

tnf!

Don't think so. You want to insert the ruler above the paragraph, so you just have to put the cursor above.
Wbere?

Between thlll and the paragraph above.
(Does. Selects Format.) We11 see what it does. (Selects Insert ruler.) What do we do now?

(Reads the manual.) Well there is alignment. It is one of those little ... {alignment icons}.
(Looks at tbe ruler.) Which one is it the second one here? (Clicks on centre icon.) It's done the whole lot
[fext below ruler.] So I bave to put that back again, have I?

You have got to put the rest back.
Do I move the cursor somewhere down here? (Positions the cursor below the ftrst centred paragraph.) Align
left, that's wbat it was before wasn't it? (Selects align left icon.) [Everything is left aligned now.] I've done the
lot. I have to put this one [paragraph] back to centre. Where do I put the cursor? (Puts the cursor below the
ruler.) [Doesn't bave to position the cursor at all.] (Selects centre icon, the text is centred.) So I want to go
back to Formal again do I? Oh no ...

You have to move the cursor down first.
(Positions cursor.) So to get rid of it I have to insert a new ruler. (Selects Insert ruler from the Format menu,
selects left align icon.) That's all right, how to I get rid of those [rulers] now? Hide them (laughs). (Moves the
text up.) Could you delete them?
[Experimenter tells her there is a Hide rulers command on the Format menu.]
Hide rulers ... (is about to select it). Do I have to put the cursor flJ'St?

10. Underline word, embolden word
(Clicks on the Style menu.) There's the Underline and Bold. I have to put the cursor flfSt. (Highlights a word.)
Now I go to Style. (Selects Bold.) That didn't do anything. [Can't see the difference because the text is still
highlighted.]

It's done it if you click somewhere else ...

(Does.) Oh. I see. Now to underline. (Clicks the cursor in front of a word and selects Underline.)
That didn't do anything.
Oh, I didn't drag it did I? (Highlights a word and selects Underline.)
11. Cut and paste
So tbat is edit is it?

Have a look.

(Reads the Edit menu.) There's Cut, and Paste. (fries to highlight paragraph.) It didn't have Cut in there did it?
[Cut was greyed.)

Oh. it did.
(Highlights paragraph.)

What do you do now?
I want to cut it. {Selects Cut from tbe Edit menu.) Now I want to put it somewhere.

Yes, on top of the page.
(Moves to the beginning of the document.) Will it insert, or will it write over everything?

Presumably it will insert if you paste it in.
Don't you have to insert a new line or something? {Positions the cursor and selects Paste.) Oh well, that bas
waked
ll. Print
How do I print this? Ftle, or Edit, or Search. (Looks at the File menu.) Oh yes, it's down there. (Selects
Print. Reads tbe dialogue box.) Shouldn't I put the cursor at the beginning?
Well it says there the number ofpages you want to print.
I don't know bow many l've done.

It's currently on all.
So I don't have to do anything? So OK, yes?

Yes.

Pusbes OK. [Printing status box appears.] Do I push Continue [Which is greyed]?
I think you just leave it.
[Document printed.]

13. Quit document

Now I want to leave it. {Clicks at the Edit menu.) I don't want to save it so I just close it. Save changes? No.

14. Create a document

(Selects Open document, a list of files is displayed.) I want a new one. (Chooses a file in tbe listing which bas
New in its name.)
.
,
.
You've highlighted a current file name. You have to cltck somewhere else or you ll open 1t.
(Hesitates, hovers with the pointer over the list.) How about "S~ple Memo" . (Ope.ns.) That's not really w~
I wanted is it. (Selects Quit.) I can't see a space for me openmg a file on that list. Do I want MacWnte.
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(Highlights MacWrite.) Was it under File. (Reads tbe menu selects Open and gets an untitled document

Types some text.

'

'

·

15. Save a new document
<<:Je~ the File ~enu and bigb~igbts Save) What's "a s"? Oh, Save as. Do I do that or just save it? Do I have to
gtve ll a~· Presumably tt wants a title. (Selects Save. The save dialogue box appears.) I1l call it "Fiona's
cmuneots · ReiUrn? (The document is saved.) That's it is it? (Selects Quit from the File menu.)

Subject 4
1. Save file
(Selects Save from the File menu.)

l. Change margins
I suppose ~ is f~ _is it? (Displays the Fonnat menu.) Align left?
No, I think thai IS differenl from changing margins. (Reads the manual.) You have ro move the markers on
the rukr.
Where is it [dle ruler]?
You have to go to the top of the page. The margin markers are there and there (poinrs to the ruler in the
manual).
(Clicks oo the paragraph indent marlcer.)

You have to move it to 1.5. Drag the marker.
(Grclbs the paragraph indent marker, and drags it to 1.5. Moves the light hand margin marker to 6.5.) [Does not
notice only the flrst line of every paragraph set to 1.5.]
3. Insert word
(Moves the pointer to the text insertion point.) And now you just ...

Click it.
Ah. (Enters text) Just click it off?
4. Delete characters
Now you have to delete a few lellers. What do you think you have 10 do?
Position the cursor and press delete I suppose. (Positions the cursor in from of the character to be deleted and
presses DEI.EfE.) Type it in again. (Does. Positions cursor at the end of word and deletes other characters.)
S. Delete words
(Tries to mark word by clicking cursor at beginning and end of word.) That doesn't work.
(Rtads the manual.) You can drag the 11WUSe or use the SHIFT and ARROW keys together to mark a word
(Marts w<X"ds with the mouse and presses DELETE.)

6. Delete line
(Marts dle line with the mouse and presses DELETE.)

7. Double spadng
What do you think?
What does double spacing mean?
Well you have a blank line between each line of text.
Ob, Format I suppose. (Clicks on Fonnat and reads tbe menu.) No. I would have thought you could do it with
the mouse. Perhaps there are other commands at tbe top. (Moves up to display tbe ruler. Points at the spacing
and alignment icons.) Perhaps one of tbese.

One of them is double-spacing.
(Points at the double-space icon.) That one there.

Yes.
(Selects il)

8.

Single spacing

.

.

.

.

.

(Returns to ruler.) Is it this one [double-spacmg tcon]? Do you JUSt press tt agam?
No, the left one is single arulthe middle one for one and a half.
Oh, I see. (Clicks on the single-spacing.)

9. Centre paragraph
(Reads the instruction.) So we have to retum to the ruler. (Starts moving up.)

Wait.
Ob, of course. It's here at the top. (Points to Fonnat. Displays tbe menu.) Insert ruler ... (bigbligbts).
Ah, but where will it insert it.
. .
(Thinks.) Do you put a new line in? (Selects Insert ruler anyway. A ruler IS mserted one paragraph above
wbere it sbould be.)
No, wt'rt doing this paragraph. (Points to the paragraph below.)
. .
.
So we have to try and get rid of this then. (Look at the Fonnat menu.) Ob. btde tt. (Selects Htde rulers from
the Format menu.)
So. where will it [the new ruler] go?
.
.
Where the cursor is. (flies to drag the cursor witb tbe pomter to where the ruler should be mserted.) I can't get
rid of the cursor here. (fries to drag it and starts highlighting.) No.

Just go where you want the cursor and click.
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(Does.) Ob, right (SeleclS Insert ruler from the Fonnat menu.) [Both the rulers are displayed. The subject
can't understand this, so the experimenter explains the difference between hiding and deleting the rulers. Tbe
subject deletes the superfluous ruler.)

Now whal do we have to do .. . centre the text.
(Look at the menu names and looks at tbe ruler.) Which one is it?

It's the second one on the left.
(Clicks on it. The text below the ruler is centred.) That's centred now. Do we get rid of the ruler now?

You are only supposed to centre this one paragraph. It's centred everything below the ruler.
We can move the ruler to that paragraph and change it back.
[Can't wodc out bow to do it Experimenter explains that be must use highlighting plus menu option or two
rulers.]
{Insetts ruler below the paragraph. Tries to get rid of the one on top.)

No, 1 think you just align it now.
(Points to tbe align left icon.) Ab, that one now. {Clicks it Then, marks and deletes the rulers, so, everything
is left aligned. He doesn't notice this.)

10. Underline word, embolden word
(Click oo Style.) So, do we want something underlined then? (HighlighlS Underline.)

Bus which OM do you wanl to underline?
(Marks wool and selects Underline, marks another word and selects Bold.)

11. Cut and paste
(Looks at Style, Format, Font, Spelling.) Edit. (Looks at Edit menu.)

Ah. there's Cut, Copy and Paste.
I suppose we mark this paragraph then. (Does. Selects Cut.)
Now we have to put it at the top of the page.
So we are going to have to go to the top. (Does.) And then press Edit. {Displays the menu and is about to
select Paste.)

But, where will it go?
Ab, (Clicks cursor then selects Paste).

tz. Print
So. print it now? (Looks at Edit menu first then at the File menu. Selects Prim from the file menu. Looks at
the dialogue box.)

These are the options I suppose. Maybe we can leave it.
Yes (clicks OK).
[Printer status box appears.] (clicks on the Continue option, which is greyed.)
[Document printed.]

13. Quit document
(Looks at the Edit menu.) Quit I suppose. (Selects Quit.)
14. Create a document
(Clicks on the MacWrite icon.) Will this open this one do you think:? (Points to the icon of the previous
document.) Just press "Trial".
No, thaJ will bring the old document back. How about File.
(Looks at the Ftle menu.) Yes. (Selects Open.) Does this open . . . (Gets an untitled document) Wbere do I
stan? So I just start typing. {Does.)
IS. Save a new document
(Looks at the Ftle menu and selects save, a dialogue box pops up. He hesitates.)
We have to give it a name.
(Enters a name f<I the document and presses return.)

Subject S
1. Save file
(Clicks on file menu, reads options.) So it's Save. (Selects Save.)

2. Change margins
Cursor, that's that. (Moves tbe pointer about Reads the instructions to change the left margin to 1.5.) Edit ..
. or Format? (PoinlS at the menu titJes.)

It's more likely to be Format
Yes. (Pops up the Format menu. Reads the options.) Align left (Highlights Align left) Yes?

Could well be .. . (starts reading the manual).
(Selects Align left. Nothing happens.) Try again!

(Reads the manual.) Changing margins you use the ruler.
How do you do that?

You press down hold and drag the marker.
Alright, press and drag. (Grabs the indent marker and pulls it to 1.5.) [The flrs t line of every paragraph is set to
1.5.] And change the right margin to 6.5?
It hasn't done all of it has it?
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I'm not sure.
Try the other marker there (left margin marker].
(Tries to click on it and selects the ruler.) I shouldn't have let go.

See that [para~raph inde~t marker], if you move that, it sets these {first lines of every paragraph}, but the
others [other lmes] are stiLl at zero as is this marker.
Well I've done it but it's only gone as far as that [because the ft.rSttwo paragraphs consisted of one line each,
they seem to have the left margin set to 1.5]. Isn't there something on the menu to make it (the rest of the text]
adopt the fOIDlat of these paragraphs.

/fyou change it althe top it slu>uld go all the way through.
Okay. (Grabs the right margin marker and drags it to 6.5.)
See, thal has wor.ked. Try moving that one (left margin marker].
(Grabs it and drags it to 1.5, and the text is aligned to 1.5.)

3. Insert word
How do I do that? Is that Edit? (Looks at the Edit menu.)
(Reads the manual.) Inserting text ... try just moving the cursor and just type it in.
Witb this (moves the pointer about)? (Positions it at text insertion point.) Push that and it will explode? Ah,
the rursor is there as well. (fypes in the word.)

4. Delete characters
Why t:Wn't you do the same thing, but push DELETE raJher than inserting letters.
(Positioos cursor.) Could you just push the BACKSPACE key now? (Does.)
5. Delete words
It says you can select the tal and cut it instead ofbackspacing.

So, you use Cut from the Edit menu? (Pops up the Edit menu.)
Yes, but you highlight the text and then cut it. (Points to the menu.) See, you can't actually use it [Cut] at
the moment, because it is grey.

What. so you just highlight it presumably.

(Clicks the cursor at the beginning of the text to be deleted. then at

eud.)

/think you have to move it before you let go.
(Highlights several words up to the end of line, then moves to the next line and starts highlighting words there.
So. the previous highlighting is removed.) Through to there and then cut (Selects Cut The highlighted text is
removed.) Ab! Abab! (Highlights the remaining bit of text and deletes it as well.)

6. Delete line
(Highlights the line and selects Cut.) Bye-bye.

7. Double spacing
Is there anything there in the menus for that?
Format (looks at the Format menu, but can't find anything) style (looks at the Style menu, then at the Foot
menu).
(Looks ai the manual.) Ah, you use the ruler.
That's at the top isn't it? (Inspects the spacing icons, points at the single-spacing icon which is highlighted.)
So-, if I click on 6 lines to an inch it will change? So, which one of them? (Points at the justify icon.) That
one?

(Points a1 the double-spacing icon.) That one.
(Selects it) Oh, we've done it.

8.

Single spadng

1bis (points at the single-spacing icon) and selects it

9. Centre paragraph
But only for this paragraph. . . . (Goes to Fonnat and selects Insert ruler, the ruler is inserted at the cursor
position. Inspects the icons on the ruler.) Is it that one (points at the centre icon)?

It mighl be.
(Selects it. The text below the ruler is centred.)
I think thal we've done the wrong paragraph. We're supposed to do this paragraph (points to the paragraph

below).
(Reads the instructions again.) Only in this paragraph. (Changes the whole lot back to align left by clicking oo
the left align icon.
We've inserted the ruler at the wrong point above the wrong paragraph.
Go away rulet!
[Experimenter tells him that he can delete it by selecting it and cutting it]
Okay, so bow do we do this right? Will the ruler go where it's marker?

Yes, must be.
(Positions the cursor and inserts the ruler.) Hooray! (Selects centring.) Now put the ruler undemeatb it and turn
it back to what it was. (Highlights the ruler and wants to cut it.)
[Experimenter explains that this will undo U1e centring.]
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~o insert a ruler here . .. (positions lhe cursor below lhe paragraph and insens a ruler. Clicks on the align left
ICOD.)
10. Underline word, embolden word
(Clicks on the Style menu and selects Underline.) No. (Positions the cursor behind the word and selects
Underline again. Nothing happens. Highlights the word and selects Underline.) Hooray. (Marks tbe word and
selects Bold.)
11. Cut and paste
So this means we have to cut it (Highlights paragraph. hesirates . .. )

Select Cut from the Edit menu.
(Does.)

There's Cut and there's Paste, but not cutting in pasting in one go. Well, I presume you cut it first.
Well, if I cut it it11 go bye-bye.

(Reads the manual.) There is something called the clipboard. So, I presume that it kups track of what it
hiJs done. (Reads the manual.) Right, so when you cut it it goes to a clipboard, and when you paste it it
will retrieve it from that.
(Selects Cut) So, now it's on the clipboard. (Highlights the Edit menu.) And so now we paste. Oh no. We
have to tell it where to go frrst. (Positions the cursor and selects Paste.) Did it.
U. Print
Edit. (Looks at the menu.) No. (Looks at the File menu and selects Print. The dialogue box pops up and tries
10 select best, tries to select all, then selects OK. Starts to print.) Oob!
13. Quit document
(Pops up the File menu and selects Quit.)
14. Create a document
(Clicks at File.) New folder ... Open do you reckon?
How would it know what to open?
And what is MacWrite? (Highlights MacWrite and selects Open.) So we're going to write a letter. (Starts
typing.)
15. Save a new document
(Picks oo flle and selects Save. Reads "Save current document as ... ".)
You lwve to give it a name.
(Types in a ftle name.) And now what . .. (clicks on OK). Why is it untitled? (At the end of the saving
process it changes to the file name.) Ab, that's saved now is it?

Subject 6
1. Save file
It's in there isn't it? (Points in the File menu.)

It gives you different options.
(Pops up the File menu and selects Save.) That's that then.
l. Change margins
(Points at 1..5 on the ruler and clicks.)
It is almost cenainly on the ruler.
Fonruit? (Pops up tbe Format menu.) Align lefl? (Highlights Align left.)
No, I think tlwl's something different.
Set page'? (Highlights Set page.)
Why don't you try to do something with the ruler.
Insert ruler (highlights Insert ruler on lhe menu).
Well you've got one already.
..
(It's too late and the subject selects a ruler anyway. It is inserted at the currem cursor postuon.)
I think you wanl to go back to the top of the document.
.
(Returns to the top of the page and looks at the ruler again. Looks at the ruler.) Change the left margm 10 1.5.
I thought that would be Format though.
.
There could be something there [to change the margins}. How about those markers they seem to be allgt~ed
up to the text.
.
.
.
.
Tbese? (Points to the right band mru-gin marker. Points at the left band margm marker, clicks at tt and nothing
bappens. Tben tries to drag iL Drags the paragraph indent marker.) No . . .
Wei~ something's moving.
(Drags tbe paragraph indent marker to 1.5.)
Well, that's not quite it but it's moved some of them.
(Moves to the right band margin marker.) To 6.5. (Grabs it and mov~ it to 6.5.)
Well iftlwl triangle moved that margin then it must be the other mangle.
(Grabs the left band margin marker and drags it to 1.5.) Is that that?
Yes, you've done it.
3. Insert word
(Hesitates.)
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Well, I suppose you have to type a word in there.
(M~ve the pointer to the te_xt_ inse_n ion poin~.) Ente r I suppose? We have to put something up here again
(pomts to the menu bar), or ts 1t gomg to be Simpler again like it was last time?

Well you just type it in again using the keyboard.
(Starts typing and a character is inserted at the c urrent cursor position.) Oh see, it's gone in there.

What happened there? 11u:Jt's strange, what did you press "e "?
~ell, I thought it would_be in Format. [Doesn't notice the cursor flashing behind the character that be's just
tnserted.] (Moves the pomter back to the text insertion point.)

Well if you pus the cursor where it's meant to go.
Well. that's wbal I did last time. (fypes another letter which is inserted at the cursor position.)

T'hat's strange. (Tells the subject to hide the rulers.)
(Pops up tbe Format menu.) What does that mean, the squiggly bits [the keyboard accelerators].

Maybe it's something on the keyboard you can use instead if you haven't got a mouse.
(Selects Hide rulers.)

Let's go back w the [the place where the word is to be inserted]
I still don't think it's anything to do with the ruler. (fypes a third letter and it's inserted at the cursor positioo.)
I lhink. it will be Format I would have thought
[lbe experimenter explains how the cursor works.]
(Fmally inserts the word in the correct position.)

4. Delete characters
Let's think. (Positions the cursor behind the character to be deleted and presses BACKSPACE. Proceeds to
delete the other characters in the same way.)

S. Delete words
Well, that's what we did just now I presume . . . I presume you have to mark a whole block. Format again I

suppose?
No, try it with the cursor.
(Clicks the cursor at the beginning of the piece of text to be deleted, then clicks at the end of the word but slips
with the mouse and highlights one letter.) Well, if you covered a whole block like that . . .

Try dragging it.
(Marks two words.) Wbat now.

Same as you did before.
Isn't there another command?
Try it.
(Presses BACKSPACE and the text is deleted.) I wouldn't bave thought BACKSPACE is .. . would remove a
block.

6. Delete line
(Marks the line and presses BACKSPACE.)

7. Double spacing
Double space, do that mean a gap between each line? Fonn the start or just from bere on downwards [seems to
think a blanlc line should be inserted in between eacb line].

From the start I guess.
(Returns to the beginning of the document. Hesitates.)

Where do you think that might be, the instruction that does that?
[Because Hide rulers bas been selected there is no ruler at the top.)
Edit? (Looks at Edit.) Format. (Looks at the Forinat menu, then looks at the Style menu .)

It must be something in Fonnat. Let's have a look.
(Pops up the Format menu. Looks at it.) Insert rule rs?

Well, we've already got rulers. So. all we have to do is show them
(Selects Show rulers. Looks at the rule r.)

The black ones [icons} are the ones which are currencly selected the options.

(Looks at the icons and points to the double-spacing icon.) Yes , it's that there? Th~ lines ~e ~ore spaced out~
tbete. The blade ones are the ones we've got now? (Points to the one and a half hne spacmg tcon.) I wonder 1f
the lines are more spaced out on that one.

Try it.

.

.

(Selects one and a half line spacing.) [The subject is satisfied that the textts double-spaced.]

8.

Single spacing

(Returns to the ruler and selects the single-spacing icon.)

9. Centre paragraph
Centre text. does that mean both (indicates centring with hands)?

Yes, so that it's spread out according of the notional page.
Tbere was something on that thing on the top of the page.

I don'tthink you have to use the one at the top. We can insert another one.
(Pops up the Format menu.) Insert ruler? (Hesitates.)
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Why not?
(Does.) [The ruler is inserted at the current cursor position which is one paragraph above where it should be.]
(Looks at the rulers.) Change the widlh of the page presumably .
. My guess w~uld be it_'s one of . .. If you look at the icons on the righJ Jumd side of the line-spacing ones.
(P~mts to the abgru;nent 1cons.) These ones? (Points to lhe justify icon [in black]). That one, that's the one
weve got now. (Pomts to the centring icon.) That?
Yes,thoJ's shaped like centred teXl is.
We bav~ to mark which bit we want don't we. But only that paragraph.
I think the rulers do the marking. Try selecting and see wlull happens. Since that's wlull we did with thL
spacing . . . see what happens.
~Selects centring.) [The text between the ruler and the third ruler which was previously entered by mistaa
IS centred.1
Thal's done everything. I think it's the ruler that makes the difference.
(Clicks on the align justify icon.)
ut's have a Wok above the ruler and see if that's changed
(Selects centring again. SeroUs up in the text.)
See, thol's still different it's just below the ruler. So, we have to insert another ruler to stop it.
Two rulers.
Yes, let's try thol.
So back to lhat (selects align justify). (Points at the paragraph below.) That should not be centred. So now if
we hide the rulers fsrst (selects Hide rulers). And if we move it up because the ruler came in under there (points
to tbe cursor.) (Positions the clirsor at the top of the paragraph to be centred and selects Insert ruler.) Ob, there's
another ooe there [seemed to think that Hide rulers would delete the previous one].
Wei~ you can just set it wherever you want so it doesn't mauer where the rulers are.
(Selects Hide rulers.)
If you do thol it'll hide all of them.
Yes, but it didn't come in there anyway.
Oh it was. There was one underneath. It was there.
(Selects Insert ruler.) [There are now two rulers on top of lhe paragraph to be centred now.]
(Explains the difference between hide and delete rulers and instructs the subject to delete some ofthe rulers.)
(Deletes the extra rulers and is left with one ruler above the paragraph to be centred.) So we need another one
uOOanealh?
I would expect so.
(Positions the cursor below the paragraph and selects Insert ruler.) Ahah! (Clicks the centring icon on the ruler
above the paragraph.) [The paragraph is now centred.] So it only affects the text underneath the ruler. Now we
want to get rid of them again don't we? (Highlights lhe second ruler and is about to press BACKSPACE.)
Hang on before you do that, don't you just want to hide them? If you delete them you'll undo thL
formalting as well.
We doo't need two do we?
If you just have the top one it will just centre all the way down the page.
But we've changed it now.
Try it.
(Deleted the ruler.) [fbe text underneath is centred.] You were right Let's put anolher one in there again.
(Inserts a ruler back again and selects justify.)
(Explains that he should just hide the rulers if he finds them disturbing.)
10. Underline word, embolden word
Underline (clicks on the Style menu). Underline (highlights Underline), ab, hang on. We have to mark
something before we start
Yes.
(Marks a w<X"d and selects Underline. Marks another word and selects Bold.)
11. Cut and paste
To the beginning ... probably will be at the top will it? (Points to the menu bar.) It doesn't say that. (Pops
up the Format menu and shakes his bead.)
No, it's not in there.
Won't be Style will it {Pops up the Edit menu and tries to select Cut.)
I think you have to mark it first because it doesn't give you the option {Cut is greyed].
{Starts marking the whole paragraph.) Whal, cut the whole lot?
We mighl as well try it and see what happens.
(Goes to the Edit menu.) Cut.
Ah, there it is you can select it now.
Ab, Cut it? (So cutting will take it out and pasting where you put it I suppose. Selects Cut) Urn!
Fine. it's Cut il. Are you worried that it lias disappeared?
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WeU, I would have thought it wouldn't do one (Cut] ·m Ill
think this is going to work. (Goes 10 the top of the:: out . ~ otber [Paste]. We'll see what happens. I don't
inserted correctly.)
xt, postuons the cursor and selects Paste.) [The text is

Well, there you are. You were wrong. It did it.
ll. Print
(Pops up the File menu and is about to select Save.)
Prifll il first.
Ah, yes. (Selects Print) [The printer dialogue box appears 1 (Looks 1 Ill F
be Ill
·
·
Wbe • that the ? Can'
·
·
a
e rom w re e cursor lS flashmg )
res,
. n.
. t we prmt the whole thing (document].
·
. W~ re g~rtmg optzons tl~re. I suppose the highlighled ones are the ones that have already been selected.
So Jt will pnn~ ~e wh?le thmg I presume. But if it will print the whole lbing why does it say from to?
~~II, _thiJl s if you ve got a 1000 pages and you only wan~ to prifll a few.
·
Yes, tts eu.bef all or from to. So, what do we do go to OK?
Why not.
(Does.) .(The printer progress box appears.] Is it Continue? (The printer starts printing.]
13. Quat document
(Pops up the File menu.)
Why don't you just Quit. /think we've lost a word here. You're supposed to leave without saving the
changes.
(Does.)

14. Create a document
MacWrite? (Highlights MacWrite.)

And now you want to Open a file.
(Does. Types a document)
15. Save a new document

(Selects Save from the File menu.) [fhe Save dialogue box pops up.] (Types in a file name.) Then Save, just
that ooe there?
Yes.
(Does.) [The document is saved.)

Subject 7
1. Save file
(Moves the pointer about the File menu title.)

What are you doing.
fm trying to get into File. (Clicks briefly, and the menu appears.) Ah, that's better. How do you get 10 the
options?
Try holding it down and moving the mouse.
(Tries.) Ah, got it. (Selects Save.)

2. Change margins
(Not sure what to do. Points to the manual.) Can you ...

Yes, okay. How about looking at some of the menus.
(Loots at Edit and Ftle.) Page setup? (Looks at the Format menu.)

(Reads.) Change margins, you use the ruler.
(Looks at the ruler.) I suppose that those Jines indicate the margin. But bow do you ... (clicks on the right
band margin owker).

Try moving it.
(Starts dragging it.) Ah, brillianL (Moves it to 6.5.) Now the leflto 1.5. (Grabs the paragraph indent marlcer
and moves it to 1.5. Then, grabs the margin marker and moves it to 1.5 as well.)
3. Insert word
So we put it in there ... (moves the pointer to the text insertion point and starts typing.)
[Hadn't positioned the cursor in the correct place so the characters are inserted at the cwrent cursor position rather
than at the intended point.]

We're now a1 the end. Maybe

if you click.

(Reblms to the text insertion point. Positions the cursor and starts typing.) Ab, that's interesting.

4. Delete characters

me

(Positions
cursor behind the character to be deleted.) Ah, right. (Presses the BACKSPACE to delete
character.) So, 1 get rid of that t. Deletes the other character by positioning tlle cursor bebiod them and

Mckspaciog.
5. Delete words
I bet there is a word delete function . Have you got any delete sections in there (pointing at the manual)?
(Reads manual.) There's nothing in the menus is there?
Thai's a good point. (woks at the Edit menu. Reads the options.) Paste, select, undo M .
Cut, how about Cut? [Currently greyed I
Ob yes. (Tries to select it. Notbing happens.)
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. Well you block _it [t~.xt to be deleted} like you did before.
(Tnes.) Yes, draggmg at. (Manages to highlight the te xt after a few attempts) It was in Edit . . . (sele,..~ Cut).

6. Delete line

·

.......,

(Quickly and without problems highlights the line and selects Cut.)
7. Double spacing
Well, you bettec look that up.

(Reads the manuaL) ThaJ's the ruler again.
What does it say [the manual]?
ThaJ boz (poinrs to the doubk-spacing box). Just click on it.
(Does.) That does it.

8.

Slngle spacing

(Tries to click oo tbe double space box again, nothing happens.) What does it [the manual] say?

I assume you choose the one the other side.
This one (points to the single-spacing box)?
Yes.
9. Centre paragraph

Is it in Format? (Looks at the Format menu, select Insert ruler. A ruler is inserted at the current cursor
position.) Ob.
Oh. It's put the rukr in where you had the cursor.
Ob. I see. (Looks at the Format menu again. Reads the options.) Hide ruler (selects Hide ruler).
It-seems to put it where you put the cursor.
So, if we put it there [on top of the paragraph to be centred] . . . And now we've got to go back to the top and .
. . Ob no. I can get it from there [the menu bar] can't I. (Selects Insert ruler from lhe Fonnat menu. The ruler
is inserted.) Rigbt.
There must be some box on there I'm sure.
Yes. (Points to the Format menu.) Align centre?

Could be, but thai's got nothing to do with the ruler.
Oops! (Selected Insert ruler by m istake thus inserting another ruler. Selec ts Hide rulers and tbey're both gone.)
Rigbt (selects Insert ruler again, now there are three). Hide rulers.
What are you trying to do?
I'm trying to delete two of them . . . l don't know.

I think. thaJ you have to delete them. If you hide them they'll all go.
How do you do that?

I dora't know, try clickirag on them.
(Higbligbts a ruler.) Ah, very good. And bow do we delete it? (Tries to highlight the second superfluous ruler.)
Did you see what I did to get that [highlighting]?

Try tQ delete one first.
That was io Edit wasn't iL (Goes into Edit and selects Cut. The ruler disappears.) Ob, we can only do one at a
time. (fries to bighligbt the second ruler.)

Click anywhere.
(Clicks around oo the ruJer and bits the 6 lines per inch box.) A-am bad news. (Moves to the right hand side.)
I'm sure that I clicked somewhere here and it went black . . . (Tries again and the ruler highlighted. Selects Cut
from the Edit menu.) Right! Perhaps we could centre the text. There was something in tbat menu (goes into
the Formal menu and points at Align Centre). Isn't that what we want to do?

That may be a different way of doing it. But, ·we wouldn't need the ruler for that. (Looks
poirUs out the centre box.)

al

the rukr and

If we want to do that paragraph, we do that (highlights the paragraph). (Clicks the centre box.) Ah!
But, it's done iJ all [all of the text below}.
Ob dear! We are going to have to . . . For some reason it's affected everything under the cursor [he means ruler].

Everything under the ruler.
Ob, I see. Does that mean that I have to put two rulers in? (Points to the Format menu.)
Hang on, wlu!re is your cursor?
Yes, you're right. Where do 1 want the ruler. (Positions the cursor underneath the paragraph. Selects Insert
ruler.) And then we want this lot to be that one (points to left align icon and selects it) Okay. Shall we get rid
of the rulers?

What are you trying to do?
fd like to get tbem blacked out and remove them ...

We could just hide them.
True. (Selects Hide rulers from the Format menu.)

10. Underllne word, embolden word
(Click on tbe Style menu, is about to select Underline.) Ah, I presume we have to block [highlight] a word
before we can underline it. (Marks several words and underlines them.) Very good! (Marlcs several words and
emboldens tbem.)
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11. Cut and paste
(Marks the paragraph, flicks through the File, Edit., and Search menus.) Have I missed it?
~ell/ presume thai you use the cutting and pasting from the Edit menu and that you cut it first.
Oh, ngbt (Selects Cut.) And then presumably if we move the cursor to the top and paste it
(does)

12. Print

···

·

Print .. : (looks at the File menu) ... lhere it is. (Selects Print Reads the print dialogue box.) Yes, yes, yes
. . . (Clicks on OK. The docwnent is printed.)

13. Quit document
Now, ifwe've got to leave without saving quit presunUJbly? (Selects Quit.)
14. Create a document
I suppose it's going to be MacWrite ... (clicks on MacWrite icon).
How about the menus.
(Points at Ftle.) New folder.
No Open.
(Selects Open. Starts typing.)
15. Save a new document
(Points to File.) Is it that one? (Selects Save.) I suppose it want a name. (Types in file name and presses
CARRIAGE REJURN.) And now do you want me to quit?

Subject 8
1. Save file
So yoil've got to choose something from the top have you?
[Struggles to work out how to use the menus. Co-experimenter instructs her on how bow to use the mouse and
the menus. Eventually she gets the File menu up. The co-experimenter tells her to select Save.]

l. Change margins
Change the left margin to 1.5. (Clicks on the Format menu and reads it.)

It's on the ruler. You have to nwve those things and the text will line up with it.
So it's not in Format? (Clicks on the margin marker.) Don't you bave a command to move it.
If you point at it . . . try to nwve it across while you keep the button pressed down.
[Subjects struggles considerable to control the margin marker. Eventually with a lot of help from the coexperimenter she manages to pot the left margin marker at 1.5. Step-by-step instruction to set rigbt margin.)

3. Insert word
You want to insert a word in between "and" and "the" don't you, to make it a proper sentence.
(Moves the pointer to the insertion point.) Do I just type a word out?
You have to tell it where to insert it first.
I want insert it there. (Points with finger on screen to where the poimer is.)
How does it know?
Tbat's the menu. So surely if you want to do anything you have to go to the menu (points to t.be menu bar).
Just click the mouse, just click the buuon. That positions the cursor. That flashing line, that tells you tM
cursor is there.
Rigbl (fypes in a word.)
4. Delete characters
(Positions cursor behind the characters to be deleted and backspaces.)
S. Delete words
How about marking the wrong words with the .nwuse and deleting thetn.
Positions the cursor at the end of a word and backspaces.
You can actually mark the words with the mouse and delete the whole lot in one go.
I'm trying to think if you position the cursor just before the word would that do it.
How would it know how much to delete? lfyou click at the end, hold the button down, and move it.
That's lilce the other one where you highlight it (Presses BACKSPACE. Marks two more words and deletes
them by backspacing.) Actually I could have done two of them couldn'tl?
6. Delete line
(Marks the line and presses the BACKSPACE key.)
7. Double spacing
Can I use the menu?
(Reads the manual.) /fyou back up to the cop of the document.
(Points at the menu bar.) Can't you use Fonnat? (Clicks ad reads Lhe menu.)
If you go back to the top on the ruler there are bits on that.
(Looks at the ruler, points to the double space icon.) Is that for double-spacing? (Clicks on it.)
8. Single spacing
(Returns to the ruler, selects one and a half line spacing.)
I think that is one and a half
You can't see on a diagram what sort of spacing iL's supposed to be. (Looks at the menu again.)
(Points to the single-space icon.) Maybe that's it.
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(Clicts oolbe single-space icon.)

9. Ceatre p~~ragrap..
Doo't you bave to bi~igbtlhis text [paragraph) then. if you're centring this bit and nocbing else (correct).
Yes you can do '' that way, but you can also do it by using the rvlus. Bw. you wQIU a MW 11Uer raJNr
than using IN! top agailt.
So what, do you bave lOgo lO the menu? (Clicks oo Format and selects Insert ruler. A ruler ippean oae
paragtapl above wbcle it sbould be.) Is that supposed to be there.
No, you actJuJUy want il down hue don't you? So why haJ it come in IMre?
Because my mouse presumably [cursor) was there. How do I delete ... (Tries to highlight tbe ruler, buC moves
10 far lO lbe right and bits tbe scroU bar by mistake. The text is scrolled.) Wbat's happened?
(bpltJilu.)
(Returns lO cbe ruiCI'.)
How ca~~ you get rid of it?
Same as wilh tbe wOlds. (Finally manages to bigbligbt the ruler.) It actually highlights aU ot it witbouc ao'DI
bact 10 !root
It willtreal it as one, you can't delete just half of it.
(Presses tbe DELETE key and deletes the ruler.) So I have to create anoeher one. (Points to l.be FonDa& IDICDU.)
Well. what was wrong with tM last one . .. it was in tM wrong ploct was11'1 il?
So I bave to go bact. (Positions lbe cursor and selects Insert ruler.)
Now you have 10 try and centre the ten.
(Points at tbe Format meou.)

Using the ruler.
(Points at tbe boxes.) Wbat do these stand for I wonder.

You want to liOn of centre the text which means put that bit in thL middle. So it's probably thil (poi.lw 10
the celllriltg icOII.)
(Seleas lbe ceolring ie<xl and the text below the ruler is centred.) Now bow do I get rid ot dW [lbe ruler) delete
it?

If you deltte il you also undo thL centring. At the moment you've centred t~rythUtg ~low the ndlr. How
would you get the rest of the teXl back. to normal.
(Points to lbe ruler.) Put it bact to oonnal.
BUl, you WallliO keep this one paragraph centred.
How about bigbligbbng lbe rest of the text and selecting tbe nonna1 [left align) style apin.
I dmt't thUtk tluJJ wiU wort. I thillk thai you have to itJsen ONJther 111ler ~low the paragraph..
(Selects IDsat ruler from tbe Format menu. Want to click on double-spacing.)
TIIIJl's double-spacing.
(Clicks oo single-spacing. Nothing happens.)

Thol's single-spacing. You su that it is highlighting tlu ones that it is currently o". Silltlt·fiHJCilll iJ

otay. You've got to un-centre it.
(Selects lbe justified &ext icon.)

11. Uaclerline word, embolden word
(Clicb oo Style and highlights Bold.)
How does il bww whaJ you want to embolden.
Ob. do you bave to mart wbat you want to underline? (looks at the p:atagrapb.) Do I want to undcrtiDc lbil
lhcD, «the rest of tbe text?
Well probably just one word.
(Moves back 10 the Style menu and select Bold. Nothing bappcns.) It should actually do il sbouldo'a il?
You QCfllaUy llllve 10 mark. il, you have to block. what you want to UN!erlint.
(Marts lbe wbole paragraph and select Bold.)
ANIIINlerUM it as wdL
(Sdccts t.1DdediDe M weU.)

11. Cat aad paste
I biYe to bigbligbt il doo't I? (Highlights the paragraph.) And what now?

YoM 1ffDW it l1y ewtillg and pasti11g.
~? (Loots aclbe Formal and Style

menus.)
Probably Edil b«mue il meCUIS thlll you are ediling IM te.xl.
(Ciicb <.a Edit. loob atlbe menu.) How do you do tbis?
Fim Clll, thtrt po.su, ~a~J~Se it says ill the illStnu:titm thai you cut and pasu il.
(SckasCUL)

Altd MW you paste it bact ill agai11.
(Oicb oo the Edit menu.)

Bill you're supposed to paste it in at tlu beginning of tlu text.
. .
So 1 bave to go bact 10 tbe beginning then. (Positions the cursor at the begannang of Lbe a t aDd KkcU Palle.)
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ll. Print
[Can't work out ~ow 10 print so the experimenter explains how 10 print using the File menu 1
How do you tell ll to send the file to lhe printer?
·
~eoler explains bow to fiJI in the print dialogue box.)
(Clicks OK and produces a print)
13. Quit document
(Selects Quit from tbe Fale menu.)
14. Create a document
[Subject did DOt wish 10 proceed fwtber. FoWld the use of the mouse too difficult]
15. Save a aew document

Subject 9
1. San Ole
(Clicks oo tbe File meou and select Save.)
l . Change margins
That's Edit tben is it or Format ...
Shall/ have a look (reads the manual).
(Clicks oo FormaL) No.
(Reading the manual.) It says you change the format using the ruler on top of the page.
(Loots at tbe ruler.) Change lhe left margin to 1.5, ob my god.
(Puts tbe pointer 10 l.S. Clicks, and highlights lhe ruler.) Oh, bow do I get rid of that? How do I get out of

tbat then?

Click somewhere below somewhere in the ten.
(Poiocs at the margin/indent marker.) Ah, there's the marker. (fries to click at it)
(Reads the manual.) You click on it and then you drag the margin marur to . .. you lulvt 10 hold il doWil.
(Goes 10 the right margin marker and tries to move it)

Yes, thai's it, ju.st move it to 6.5 now.
(Does. Then drags tbe indent marker to 1.5.) That isn't the whole thing there. How cocne that isn't aU the way.
[Experimenter explains that the paragraph indent marker and the left margin marker have to be positioned

togelber'.)
(Needs several attemptS to grab the left margin marker and move it to 1.5.

3. Iasert word
{Pcsitioos tbe cursor at the text insertion point.) So what's that flashing line?
Thal's the cursor.
(Tries 10 aeale a gap between two words before inserting. Types in the word.) What aboutlbc tlasb.ioaliDc.
bow can I get rid of tbat?
(ExpkJUis thal it is the cursor and will go wherever he clicks.)
4. Delete characters
How do you do thal ?
Must be (poincs up to the menu bar). What about a DELE1E key on bere (points to the keyboard). (Moves tbe
pointer to a clwacter, presses DELETE. and deletes a letter at the cursor position.) Ab bell. tbat was l&ill up
lbere. (Re-entets tbe letter.) Right we'll bring that [cursor) down. (fries to move the cursor by dra&Jina it)
Put it where you wanl it to go and now click.
Ab, I see. (Positions tbe cursor behind a character and presses BACKSPACE.)
5. Delete words
(Detea a word by backspacing.)
You shouldn't have to do that by backspacing all thL way. Set, it says you can mart words with a IMJUe
IJIId deleu them.
How do I delete tbem easily.
By dragging the mouse from the beginning to the end by holding the button down.
(Marts lbc words to delete.) BACKSPACE or what? (Presses lhe BACKSPACE key and tbe words are delelcd)

6. Delete Une
(Marts tbe line and presses lhe BACKSPACE key.)

7. Double spacing
Ab. that's Formal again isn't it, but we haven't used any of these commands.
(Reod.s the maiUUJI.)
(Loob al tbe Fonnal menu.) No. Style perhaps (looks at tbe Style menu). No. Edit? No.
It has something 10 do with ruler. If you go back to thL top .. :
. .
(Rctums to tbe top.) Right bere we go, 6lines per inch; -~· ~ants at tbe spacang &COOs) these are dilJc:n:DI
types of lioes. (Points at tbe double·spacing icon.) 1bat s 1t ISO t at?
Yes.
(Clicks oo it Moves down tbe text) Ah, that's done tbe whole text now.
8. Slnale spacing
.
. . .
(Points at tbe single· spacing icon.) That's single-spacmg there asn t at? (Clicks on it)
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9. Centre paragraph
(Clicks at the Fo~ me~u.) What sort of ruler do we want? (Highlights Insert ruler.)
8 Ul w'Mre w•lltt be msened?

w .

.

e'U ~a ruler and see what happens. (Does it) Ah, that's the ruler is it?

. It s tn t'M wrong place, so you want to get rid of it.

<T[Exnes ~move the ~er by dragging it into the correct position. Looks at the Format menu.)
penmenter asks if he wants to delete it.)
No, I. want to put it back at the top again.
[ObvlOUSlY. be thinks that be's moved the ruler which was at the top i.e. be believes that it was insert the ruler
rather tban msert a ruler.]
(Looks at lhe menu again.)
I think thill [ruler] will be a different one. Why don't you look again at the top.
Ah. ~·s a different one is it? (Returns to the top, sees the other ruler.) Oh, far enough. Tbere must be
somedling easy ... File. Edil What's Fonts then?
(E:lplaills.) You can delete this one similar to a piece ofteXJ.
Wba&, hactspace it?

You have to mart il first.
(Highlights the ruler and deletes il)
You Wtlllt to pill IM ruler down there, so you hllve to position tM cursor before you insen il?
How do I do tbal then? [Tries to position the cursor by dragging it with the pointer again.]

No, you hllve 1n click it.
(Positioos ~e cursor and saoUs up to the top to the ruler. Clicks on Format and selects Insert ruler.) [He
seems to think tbat be needs to be at the top to insert a ruler.]

See thllt box there, you can use that to centre text.
(Points at the paragraph.) Is that marked properly? I thought that if I wanted to centre that (points at the
paragrapb) I'd have to highlight it. [fries to mark the paragraph, but bas problems working out bow to do il]
(Highlights the paragrapb eventually, points at the centre icon.) That one?

Yes.
(Selects iL)

Thai's all/aU teXJ below the ruler] cenrred.
How come, because I bad that [paragraph] marked?
It's doM everything that is below the ruler.
Is there any way to avoid that? 'That's not very good, you mark it and ...
(Explains how to do it and that another ruler must be insened.)
(Inserts another ruler.) So do we go to Format again. (Wants to select Align left from the Format menu.)
No, you want In u.re the box here.
(Points to Align left box.) What. this one here? (Clicks it)

10. VnderUne word, embolden word
(Clicks oo the Style menu.)
What do you think you are doing?
Ob. I have to mark it fmt don't I. (Positions the cursor at the beginning of a word.) How do I cell it where to
stop, will it uodetline the rest of the paragraph from here? [He still bas difficulties in marking texl]
(Explaills how to mart the text.)
(Marts a word. selects Underline. Marks a word and selects Bold.)

11. Cut and paste

·

Tbal's definitely editing isn't it? (Looks at the Edit menu.) There you go cut and paste. Let's select Cut (does).
Wby can't I select it? Why has it got it there when I can't select it?
How can the program know what to cut?
(Marts tbe p;uagraph.) Okay, that is what is going to be cut. (Looks at the Edit menu.) Abab, (Cut is displayed
in black) we sbal1 cut it, but where is it going to cut it to? Shall I move the cursor back up to the top tbem? It
might cut lbat all completely. Or, do I say paste and paste it up to somewhere else? [lbe experimenter explains
about tbe clipboard.] (Selects Cut, moves to the top, and positions the cursor and pastes.)
11. Print
[Notdooe.]
13. Quit document
(Looks at the File menu for Quit.) So, it's either Close or Quit ... Quit

Why?
14. Create a document
(Afttt some dithering.) Ob. MacWrite, that's the program isn't it? (Clicks on the MacWrite icon.) How do I get
out of bere [window]. Where is the menu? (Clicks File menu.) New folder or Open? (Looks at View, then
Special menus.) I haven't got a clue bow I get out of he;'"C· (Is told to open. a file.] (Does. Tries to position tbe
ctJr'Sa' on tbe empty page.) Oh, I've got to write somethmg now (starts typmg).
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15. Save a new document
(Selea.s Save from lhe File menu. and enters a name for the file.)

Return.
(Presses RE'IURN, and then selects QuiL)

Subject 10

1. San rue
2. Cllan1e mar1lns
3. lmert word
4. Delete characters
(Uses CUI'SO' keys to position the cursor behind the character and backspaces.)
5. Delete words
Could you use tbe mouse to move the cursor.
Yes. Set [the manual}, it says you can mark lhe words with the mouse and delete them.
Can I just~ each of them? (Moves the cursor the end of the piece of text 10 be deleted.)
1'hal JUSI moves the curS()r. (Reads manual.) You can mark a piece of teXl by draggillg it acrou 111111 tMII
relea.re tilL mouse button.
(Marts ooe word, then moves to the next line and tries to mark to another word, Lbercby de·selcctiDa lbe
previous malki.og.)
What do )'OU Wanlto do?
I want to delete the wbole lot in one go. (Can't work out bow to mark across the end of a line. Preuea
DEI..EfE to delete one part. tben marks the rest and deletes it by pressing DELETE.)
6. Delete line
Do we do lbat tbe same way? (Marks the line and presses DELETE.)
7. Dotable spadn1
(ReDtb 1M trlliiWDL)
Is that going to be iD Formal? (Looks in the Format menu.)
Then where elu could;, bt?
Top of tbe page ... (goes to the top of the page). (Looks at the ruler.) Is it tbis one bere ... (poiau • &be
single-spacing icoo). Ob no, that's single. (Points to the one and a balf line spacing.)
Thai's OM fllld Q halt
(Points 8l tbe double-spacing icon and selects it.)

8.

Slftlle spacing

(Returns to lbe tq> of the page. Goes to the ruler and selects tbe single·spacing icon.)

9. Ceatre paragraph
a.oots allbe Format menu.) Insen ruler, that's this one. (Highlights Insen ruler.)
But where? Thal's put it in the wrong place.
Wbere do I need it? (Points at tbe paragraph.) I need it down bere don't I? How do I delelie lbe ruler? (Loob 11
lbe Fonnat meou. PoiniS at the ruler and marks it. Presses the DEI.EfE key.)
Whtre shall we put it now?
Above bere. (Positions tbe cursor above the paragraph. Selects Insert ruler from the Formal maw.)
And IIOW to Ctnlrt the text.
Will dW cencre everything or just one?

I thUik so.
{Points below lbe paragraph.) So, dol need another ruler. (Positions the cursor and inserts a ruler below 1be
~)

You still hDve to ce11lre this one.
(Loot.s at lbe k:oo and hesitates.)
(l..oob a1 1M manual.) Those

boxes are for left, cenlrt, and righl justify.
Whicb ooe is lbe centre tbis one? (Points at the centring icon. Looks at tbe ruler.) So wbeo lbele boua an:
<8t tbal means it's selected. (Selects the left align icon. Tries to select lbe ruler.)
W1aat do you wartt to do ?
How do I get rid of tbe:m?
r,. 1101 sure you want to delete them. or whal you 'vt just done will go away to. Bill. )'OM aJIII /tiM dal if
you wartt.

WbeK do I Ftlbal frool?
Fof'lltiJL

Ob yes, of course. (Selects Hide rulers from tbe Format menu.)
11. Uaderllae word, embolden word
(Loob a1 the Style menu.)
..
.
So tbcsc .e in bere., but I bave to tell it what to underline so we oeed me cursor. (Po5itioos &be c:unor • flwl
of ooe word and selects Underline nothing happens. Marlc.s a word and selecu Uoderlioe dooe. H.iplip&J
aaocbet word and selects Bold.)
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11. Cut and paste

Is this a similar thing? (fries to highlight paragraph, but has difficulty controlling lbe mouse.)
(Reads the manual.) It says here you use Cut from the Edit menu.
(Pops up the Edit menu, and tries to select Cut.)
You should mark some text probably so that it knows what to cut.
So I bave 10 highlight .. . (tries to mark the paragraph again).
TluJt's alright, just move down now.
(Does.) Ab. and m.ar1cs ~e paragraph. [Couldn't work out until now how to mark beyond the end of a line.)
(Selects Cut from the Edit menu. Returns to the beginning of the text.)
What do you think you should do now?

Position the cursor and get back into Edit. (Does. Looks at the Edit menu hesitates tries to select Copy which
is greyed.)
•
•

Paste.
(Selects Paste.) Ob!

ll. Print

What do you think you should do to print it now? (Reads the manual.)
(Looks at the Flle menu. Is about to select Print from the File menu .. .)

It says here you should use Print from the File menu.
(Does. The dialogue box pops up. Looks at the options.)

(Explains the options.)
So I just click on OK? (Does. The printer status box appears.) Do I have to press Continue [which is greyed)
now? [lbe printer starts printing.]
13. Quit document
(Clicks at the Flle menu and looks at it. Is about to select Save .. .)

No, you should quit without saving.
(Selects Quit)

14. Create a document
What dQ I do here go to File and New?

You have to select the program we were using.
(Highlights MacWrite.)

And open.
Is that in File. (Goes 10 File menu and selects Open. Starts typing.)
15. Save a new document
(Goes 10 the Fa.le menu and selects Save.) [The dialogue box pops up.] (Tries to select Save which is greyed.)

You have to give it a name.
Oh, right (Types in a name and presses R.ETIJRN.)

Subject 12
1. Save file
(Looks through all of the menus.)

Why don't you have a look at the File menu.
(Does, looks at all the options, goes to Save and selects it.)

2. Change margins
Change the left margin to 1.5. Is this your tum to have a go?
(Reads the manual.) It's on the ruler. We have to find the right margin marker. That's the black one over

there.
This one (points 10 it).
So you want to change the left margin to 1.5. Press and hold the mouse button and drag the marku.
(Grabs the paragraph indent marker and moves it to 1.5. Moves the right margin marker to 6.5.) [Experimenter
points out that she bas only moves the paragraph indent marker and not the left margin marker.] (Moves the left
margin marker 10 1.5.)

3. Insert word

Obviously you have to insert something to get the sentence to make sense.
(Moves the pointer 10 the text insertion point.)

I assume that if you position the cursor you can type text.
{Positions the cursa.) And just put it in. (Types the missing word.)
4. Delete characters
(positions the cursor with the mouse behind the character to be deleted and deletes by pressing BACKSPACE.)
Is that the right way to do it?

I assume so.
(Moves the pointer 10 the next character and presses BACKSPACE thereby deleting the character aL tbe cursor
position.) Oh, I didn't click the cursor. (Deletes the rest of the characters in the same way.)

5. Delete words
(Positions the cursor behind the flfst word to be deleted.)
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I woiiMr if there's a quicker wa>: of doing that ? (Stam reading the manual.) OIICt ~u'w lfiiUI:.ed a pila of
ttXI you can use Cut on the f:t!•t menu. To u ltct it you WQJII to go to tM pitct of tuL 1 tJa.iM tJtat )fOil
want to gtt to tM stan of the paece ofttXJ that you wanlto rtmovt. Click allM nan aNI drag o-wr il.
(Has difficulties to bigbligbll.be text and finall y manages to do it)
Now ~u go to 1M Edit menu and use Cut.
(Does.) <ll. I see. (RepealS tbe p-ocedure for the relruUning word.)

6. Delete Jiae
(Marks lhe line and selects Cut.)
1. Double spacing
How do I get bact to see ... [the ruler] . I was just trying to get the double-spacing. (Had accidenlally clicbd oa
tbe doub~spacing box at the very beginning of the session.]

Maybe ifyou we Formal.

(Looks at Style. tbeo at the ruler and points at Lbe double-spacing box.) It's Ibis ooe. is lbal double? (Mcwa 10
tbe ooe aod a half line spacing and selecas.) Yes. that's it [Difficult to see the ditren:oce betweea oae and a ball

tiDe spaciD11Dd double-spacing.]
1. SID&Ie spadna
(Retan to tbe IUier and selects the single-spacing icon.)

9. Ceatre par..-apla
(Goes to Format aod looks at the menu.) Do we bave to mark it to do just tbal? To put il oa ceocre. (LooU •
Format. Foot. and Style.)
(Rtatb the IPiiJiliUIJ.) If you only want to change a ftw lints you ust IM align cOIMtQNU. 1/ _,.,.. 11M e1w
alig11 coiMJIUid from the menu you don't havt to highlight the whok rut. you just haw 10 diet 411
illsenion poitll iNo the paragraph.
Do I just click in abe centre of thi s? (Clicks the cW"Sor in the paragrapb.)

Yts. Well it could bt anywhere.
(Goes to F<Xmal and bigbligbts Align centre.) This one? That will centre the text I suppose.
aDRJd.)

f1be.,.,.......

ia

11. Uaderllne word, embolden word
(Clicks oa Sryle.) So. don't I have 10 . . . (positions the cursor within the paragrapb).
Yts, you havt 10 ulect again.
How about this one? [Cursor is at the beginning of a word.)

WtU ...
(M..ts &be word
selects Underline.) [The word is underlined.) RigbL (Clicb &be CW'10r iD &be IDiddle oldie
word UDdcrtiDcd.) Sball we do that in bold face .
Wtll . ..
<MRs me word and selects Bold.) Right.

a

11. c.t and paste
Rigbl. move a piece of text (positions the cursor at the beginning of the paragrapb.)
With cuttillg you have 10 mark tM paragraph.
. .
. .
(Marts tbe paragrapb. Looks at the Edit menus.) Cut and Paste u IS. (Hagbhgbts CuL)
Righl, you want to cut it.
(Selects CuL)

Now if you loot at the clipboard there it is. Hidt it again {IM clipboard. Now yo., WGIIIIO 10 10 t1tt
posilio11 wMre you want to insen it.

(Po&itioas abe cur&OI" at tbe begiMing of the teXL)
Now paste it.
(Sdecss Pas&e from tbe Edit menu.) RigbL

ll. Prlat
PriDL (Goes to tbe File menu.)
(Rtods the manual.)
Is it iD File?
Yes.
(Selec:u iL Loots at lbe dialogue box.)

.
.
[C.'t work it ouL 1be experimenter eventually explains what to do. The documelll&S priDCEd.]
13. Q•lt doc•ment
How do I get out of it?

17ltJI would be in the File menu.
Qai.t? (Sdccts Quit.)
14. Create • d0e11ment
(Goes 10 lbe File menu.) New?
Maybe ()pe11 wiU do it.
.
.
.
(Does.) (Noching bappens. Can't work it out and the expenmenter bas 10 explain bow to do aL)
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15. Save a new document
CS.tarts typing. Goes to ~ File menu and selects Save.) Do you want me to give it a name? rr........ a name and
clicks on Save.) [The file as saved.]
· '&J~

Subject 13
1. Save file
(Goes to tbe Hie meou and selects Save.)

l. Change margins
Thai will be Format won't it? So. do I go to Fonnat?
No. you_cluJnge ~~.margi'!S ~re on the ruler. (Reads 1~ manual.) Right, the left margin marker is tM
blact tTUlllgle. (Pomts to 1t.) That one.
Is it that ooe ~ ~tone? [P~grapb indent or left margin marker.] (Tries to drag iL Starts dragging iL)
Yes. that s nghl. Drag a to 1.5. and now if you release it. {The first lines of each paragraph haven't been
tbnL]

(N~~.) Is that because the ~or wasn't at the beginning? The cursor is down bere at be moment you see.
(Posit100s.tbe ~at the be?•nnmg.) No, that didn't do anything. Shall I change the right one?
1M nghl marg~n marker IS the other black triangle.
(Points al the right margin marker and clicks at it. Nothing happens.) So, 1 clicked.
Welt you have 10 hold it down and drag it.
(Does.) Don't know wby it didn't do the flrst three lines . . .
I thi1llc that you have 10 try and drag the indentation marker as well. See the black one there {paragraph
indent marlcer1 which is still on 1.
(Tries to grab and drag it tbereby selecting the ruler.) Wby bas it [the ruler) changed colour? (Actua.lly drags the
paragraph indent marker to 1.5.) So tba.t's done it now.
3. Insert word
(Moves tbe cursor to the text insertion poinL)
What you Med 10 do is 10 try and put a word in here that makes sense.
So wbat rve got to do fust of aU is put some spaces in isn't it?
Why do you want to put some spaces in?
To put the wool in. What, can I just type it and it'll go in?
Yt.s, as long as t~ cursor is there.
(Moves tbe pointer slightly.) Well it is there isn't iL
Not yet. You have to click.
(Does.) Ob yes, that's the cursoc. If I type it now will it shove the rest [text] along? (fypes be word in.) Tbete

ycuare.
4. Delete characters
(Moves the pointer down then returns it to the cursor.) Do I click it to take the cursor down? [Tries to drag tbe
cursor to move iL)
As long as you position t~ marker {pointer} somewhere else and click it, that will move 1M cursor.
(Positions the cursor behind the first character to be deleted.) Backspace is it? (Deletes by backspacing.
Cootinues for tbe rest of the characters to be deleted.)

5. Delete words
Is there a special function for taking out a whole word? Look in where Edit?

(Reads t~ manual.) The first thing you want to do is to mark what you want to delete. Clicl at tM
beginning, uep it pressed, and 1nove it to the position .at the end and let go.
[Struggles a bit, but manages to highlight the text]
Now, if you look in the Edit menu.
(Does.) It's Cut isn't it? (Selects Cut.) The words are deleted.

6. Delete line
Delete line, so I can mart this. (Does.) And then I want to get to Edit again don't I? (Selects Cut from the Edit
menu.)
7. Double spacing
Is Foouat bow you do the double-spacing.
(Reads the manual.) /think if you go back to the top.
Of the document?
Then an aU the different spaces.
,
(Returns 10 the top of the document and looks at the ruler and poin~ at the.spacing icons.) So thats double aod
that's ooe and a half. So do I just select that one? (Selects double line spaCJng.)
8. Single spacing
(Returns to tbe ruler and selects single-spacing.)

9. Centre paragraph
?
Right, centring. Do I have to mark this paragraph if it's the only one I want to centre .
Yes .
And Format tells me bow to centre?
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(Reads tM manuaL) It's says that if
l
.
command from the format menu If:~~ ~n ~ want to do It for a few lines you mark it and select the align
the Tiller, bUf they worlc a lillie .different/;;:::~~la;te~ piece of,:;xt or the wh;>lt document you can use
paragraph, JUst IMrie a piece of text within the
gh co;;;ma s. You ~on t have to selecr the whole
nwugh if you put the cursor in the middle oftheparagraph. a choose the align command I think that it's
(Marks a piece of text within lhe
.
paragrap
scroU.ing to the top of the docume=~h~ :n~d ~ow.: Format? Can I go there d.irect from here? [Without
Yts, just click on iL
usJon tween use of menus and rulers.)
(Selects Align centre from the Format menu.)
lt. Uoderllne wor~ embolden word
So it's Style?
Ye.r, I think you want to mark . ..
i~~~~d wbicb I want to underline. (Marks a word and selects Underline. Selects anodler word and
II. Cut aDd paste
Ls tbal in Format or in Edit

You want mark it [thl! paragraph].
<Marts tbe paragrapb.) And now I want to edil (Goes up to tbe Edit menu and selects Paste which pastes some
~ext o-m- tbc marked paragraph.)
(Explain..s that she should have done Cut before Paste.)
(Removes~ pasted text.) But what happene~ to tbe paragraph? Ob dear.
(Explains thalthl! paragraph has been deleted.)
(C\Iu and pastes another paragraph.)
ll. Print
Try and get it printed. which is a File menu option.
<Goes to the Flle menu and selects Prinl)
You just cliclc on OK.
(Docs.) [lbe pinier status box appears.) What do I do with that? [The printer starts printing.)
ll. Qvlt document
So for tbc quit do I go to File? (Selects Quit.)
1•. Create a document
So 1Mmt to do wbat MacWrite? (Highlights MacWrite.)
Alld then open the file.
(Clicks oo lbe Flle menu.) I want a new file.
No, Open.
(Dou. Wants to cbange margins in the new docwnent. Keeps selecting the ruler. Gives up.) ru just start here
inslead.) (Types text.)
IS. Save a new document
File . . . (selects Save). (Types a file name.) Just press that [RETURN). (Does.)

Subject 14
1. Save file
(Clicts oo Lbe File menu and selects Save.)
l. Claanae margins
W ouJd we bave to bigbligbt Edit.
(Looks at the manual.)
(Looks at the Edit menu.) Format., that sounds more like it. (Looks at the Format menu. Points co the align
cCDUOaD<l at the bottom of the Format menu.) That bit there? (Looks at the Font and Style menus.)
It says in here [the manual] that it has got something to do with the ruler. (Points to it.) This bit. What
about those little markers? (Points to the right hand margin marku.) What are they?
Do J push it [tbe right band margin marker]? (Tries to move it.)
If you try ro hold the button down while you push iL
CEYCDcuallY grabs tbe right band margin marker and sets it to 6.5. Tries to move tbe left band margin m.arter and
ldccU tbe ruler. Grabs the paragraph indent market and moves it Grabs the left band margin marker aud moves
at 10 1.5. Eveacually works out that the paragraph indent marker needs to be moved as weU.)
l. r-rt word
(MoYes lbe pointer to the text insertion point)

11ttre's 110 cursor there, just the mouse thing [pointer} 10 move the cursor there.
the pointer.) Is tbat not the cursor there.
WtU. the cursor ~sjlash doesn't it?
l1...oob at several of the menus.) How do you insert words into it.
(Reads the manual.) Put the cursor there with mouse.
"Moves
the pointer to tbe text insertion point and clicks.) Ob rigbt. Just type it in? (Types in the word.)
1
mg.~es
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4. Delete characters

[Still bas problems bow to move the cursor.]
Pr~sumably you do the sa~ thing move the pointer to ther~ and click it.
(Sttuggles, then manages lO position the cursor behind the fJtSt character to be deleted. Presses BACKSPACE.

Proceeds to delete tbe remaining characters in the same way.)
5. Delete words
~Positions &be cursor at the end of a word and proceeds to delete it by backspacing. Deletes the remaining words
m the same way.)
6. Delete line
(Moves the wrsor to the end of the line.) There's probably a way to delete the whole line.
(R~ads IM tnallUtll.) I noticed before that sometimes when you dragged the cursor you can actually lfiQrt
bils of text.
Um!

(Clicks around witb the cursor.) I don't know bow tbat works.

(Deletes the line by repeatedly

backspacing.)
7. Double spacing
(Loots at tbe Fonnat menu. tben at Style.) Could you insert lines?
Yes, you could do thal but it's very tedious. TMre must be an easier way. Whal ~lse is tMre on thal rukr
a1 IM top. Maybe we should go back and hav~ a look. at thai.
(Does.) Maybe lhat one there (points at the double-spacing icon). (Selects it)
Is that double or triple spaced.
I lhiDk that's triple. (Seleas one and a half line spacing.)
8. Single spacing
(Clicks oo lbe single-spacing icon.)

9. Centre paragraph
(Clicks oo tbe Format menu.) Highlight Insert ruler.

Yes, see whal happens.
(Does.) [A ruler is inserted at the current cursor position.]

Now rhal is inleresting. It has pur the ruler at the position ofthe cursor hasn't it?
Do I bave to get lbat [the ruler] down on top of that [paragraph) do you think?
Probably. otherwise il's going to centre that paragraph as wen.
(Tries to drag tbe ruler. Positions lbe cursor above the paragraph to be centred. Points at lbe centring icon oo
tbe ruler.) Is it this one?
Yes, it looks like it.
(Does,)
Wei~

tluJI's centred it.

But it's done tbe lot

But il's 11ot done the previous bit has it?
No, it's just tbe bit below the ruler.
So presumably we want to put the ruler down there.
So do I go back to Format? Or shall I put this one back fJtSt? (Selects justify icon. Loots at tbe Format

menu.)
Pusumably you want to put another ruler in don't you.
(Loots at Formal) What would Hide rulers be? [Still thinking about bow to get rid of lbe farst ooe.]

Well, if il would actually destroy the ruler it would probably say remove or something like tluJI.
Presumably we want to insert another ruler 1 iuppo:r~.
(Selects Insert ruler wbicb is inserted above the paragraph to be centred.) Ob god! [Is upset at having so many
rulers in tbe document.]
Well iJ's in the right place now so we can centre it.
Would it centre tbe rest of it then?

Yes, that's true. (Reads the manual.)
Put tbe wrsor below it maybe?

Yes, maybe.
(Positioos tbe cmsor below tbe paragraph to be centred and selects tbe centre icon.)
Wei~ that's done the OTII! paragraph but again it's done the lot /the remaining tat below the nder}. What do

weoo?
Put another ruler in below tbe paragraph and change it back. (Does.) I'd love to get rid of those rulers.

I suppose you could hide them
(Goes to tbe Format menu and selects Hide rulers) Great!

10. Uoderline word, embolden word
(Looks at tbe Style menu.) Ahab. So we want to underline underline. I have to put the cursor down bere.
(Puts tbe pointer at the end of the word underline.)
I don't know.
Ob,let's try it tba1 way. (selects Underline, but nothing happens.)
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No.
I need to be in the word?

Try it.
(Positions ~cursor in f:be word and selects Underline but again nothing happens.)

Lets think about th1s.
Try it to~ right .(P~~tions the cursor at the beginning of the word accidentally highlighting the fl.rstleuer.)
That s Ullerestmg ll s gone black there hasn't it?

Yes. (Selects Underline and the letter is underlined.)
Gosh.
(Struggles.)

Maybe if you try . . .
Make the wbole word black.
When you position the cursor try lwlding the cursor button down and moving the mouse.
(Does, and selects Underline) How do I get rid of the black? (Highlights another word and clicks on Bold.)
11. Cut and paste
(Clicks oo Edit and looks at the menu.) Do I want to cut and copy it
I think that we have to cut it to start off with don't we?
So I need to bigbligbt it. (fries to mark it by positioning the cursor flfSt at the beginning then at the end of the
paragraph.) Can you drag it across the whole lot? (Manages to highlight the first line, tries to highlight lhe
second line and the highlighting on the first line goes away. Struggles, but eventually manages to highlight the
paragraph.)
Now what?
(Goes to Edit and selects Cut)
Where did it say il slwuld go?
To the beginning. (Scrolls to the beginning of the text. Positions the cursor and looks at the Edit menu.)
We've got to really insert Paste? (Selects Paste from the Edit menu.)
ll. Print
(Looks at t.be Edit menu and then at File, selects Print. Looks at the printer dialogue box. Selects File and gets
a beep.)
I think that we've got to print it first.
Do we have to flll something in? (Wants to put 1.5 to 6.5 in the page range boxes.)
(Explains tlu! clwices.) So maybe it wants us to change something or just carry on.
So do we just click OK then? (Does.) ffhe printer starts printing.}

13. Quit document
(Looks at the File menu and selects Quit.)

14. Create a document
[Runs out of time.]
15. Save a new document

Subject 15
1. Save file
(Goes to t.be File menu and selects Save.)

l. Change margins
(Looks around the menus. Looks in Fonnat for the change margin couunands.)
Is thert anything in the menus?
.
No. (Goes to t.be Edit menu.) Page setup?
(Explains that it is not in the menus.) If you look at this one here (poinrs to the ruler).
Ob, you mean the ruler.. Pemaps that's where it is then. (Inspects the ruler but cannot find out what to do.)
(Poinls out tlu! margin markers.)
(Grabs the left margin marker and drags it to 1.5.)
.
.
.
So ifil's that triangle for tlu! left margin presumably it's that trUlllglefor the nght (pomr_s).
(Tries to grab t.be rigbt margin marker and highlights the ruler. Eventually manages to drag tt to 6.5.)
(Poinls out that the first line ofeach paragraph is incorrectly indented)
(Grabs t.be paragraph indent marker and moves it to 1.5 as weU.)
3. Insert word
(Moves the pointer to tbe text insertion point) You just type it in ... (clicks to insert cursor) and types in the
wool.
4. Delete characters
(Positions the cursor behind the first character to be deleted and presses BACKSPACE. Proceeds to delete the
other characters in the same way. Starts to use the arrow keys to position the cursor.)
5. Delete words
There must be an easier way to delete whole words. Are you going to tell me how?
(Explains how to mark a piece of te.a.)
.
(Marks a word and deletes by backspacing. Marks the rest and deletes by backspacmg.)
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6. Delete line
(MaRs tbe line and deletes with the BACKSPACE key.)

7. Double spacing
Double-~g. What does double-spacing mean?
(~.) You already done somejonnatting before.
Ob. ~th the ruler. (Returns to lhe top of the text and looks at the ruler.) 6lines per inch?
nO.

(Points at tbe double-spacing box.) That one?

Yes
(Selects the doubJe..spacing icon.)
8. Single spacing
<Returns to the top and selects single-spacing.)
9. Centre paragraph
Format (looks at the Format menu). Insert ruler (selects Insert ruler). [A ruler is inserted at the CW'SOl positioo.)
I see, that's wbere it is.
Where was it inserted?
Were that dling [cursor) is.
(Exp/Qins how totklete a ruler.)
(Returns to the paragraph to be centred and wants to position the cursor.) Does it matter wbere?
~best thing might be to put the cursor in the line above the paragraph.
{Posiboos the cursor and selects Insert ruler.) Centre (looks at tthe ruler). Which one is for centre?

C011't you work that out from the pictures?
That ooe (points at the centre icon).
(Explains that it has centred the enlire text below the ruler.) You only want this paragraph.
So you put it here below the paragraph and pul it back to where it was before. (Positions lhe cursor below tbe
ru.lez" and selects Insert ruler. Selects one and a half spacing then single-spacing.) That one?
(Explains thiJl they are spacing icons.)
Of course. (Selects tbe align justified icon icon.) I can do away with those now I suppose. (Highlights the first
rulec and wants to delete iL)
But wluzl would happen to the text if you deleted the ruler? (Explains that the teXI is always formalted
according to tht nearest ruler above it.)
So if I delete this ruler now it would go back to the formatting that the ruler at the top bas.
(Explains thtll Hide rulers can be used)
(Seleas Hide rulers.)
10. Underline word, embolden word
(Looks at the Style menu.) How will it know what to do? Will it do all of the text? (Selects an option from
tbe Style menu and nothing happens. Marks the paragraph and selects an option from the Style menu.
Highlights aootber paragraph and selects another option from the Style menu.)
11. Cut and paste
(Looks at lhe Format menu.) Do you black it out [mark it].

Yes.
(Marks tbe paragraph.)

Well you can cut it first and then paste it back somewhere else.
(Looks at the menus and arrives at Edit) Cut (selects Cut). (Wants to immediately select Paste.)

You're supposed to put it somewhere else.

·

AlrigbL (Saolls to the top of the text. positions the cursor, and selects Paste.) Wow!

U . Print
Ab, you can print this stuff can you? How? (Looks at the File menu an~ set~ Print.) fibe printer ~ue
box pops up.] From ... to ... [page range the flashing cursor makes btm tbmk that be bas to fill something
in even tbougb "all" is the cwrent selection].
(b:plains the options.)
(Clicks oo OK and the document is printed.)
13. Q.alt document
(Looks al the File menu.) Quit. (Selects Quit.)
14. Create a document
MacWrite perhaps (bigbligbts MacWrite and selects Open from the File menu) or New folder perllaps?
(Explains that the correct choice has been made.)
(Swts typing.)
15. Save • new document
(Selects Save from the Fonnat menu, the save file dialogue box pops up, be tries to selea Save but it is greyed.)
Ob. I have to give it a name as well. (Types in a file name and selects Save.)
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Subject 17
l. Save Ole
(Clicks oo tbc File menu and selects Save.)

l . Claange margins
Cbange the Jeft margin to 1.5 , change the right margin to 6 .5. Lbat must be in Foruw. Clicks oo Forma& lad
looks atlbe meou.
(Rtads tM mmaiUJJ.) I don't think it has llllything to do with thai menu. It's gOISOifttl/tiJtl 1.0 do wi1A 11tt
ruler undemelJIIr.. And il's the markings on the rultr. You'vt g0110 drag il. It's 1M block tnar.,k.s. 'l'Jwn's
OM all twlonea16.

(Grabs tbc paragr;apb indent marker. Positions tbe paragraph indent owker
pngrapb is set to 1.5.]

at

1.5.) (1be finlliDc o1 ew:ty

Thai's not quite right is it? I think that's the indtnuuion. The trianglt is the actiMJllffllrilr, 10 10" www 10

that as wtlL
(Drap tbc left margin martea- to 1.5.) Ab! (Goes to tbe rigbt and draas tbe rigbt ~~*liD aurta co 6.S.)
3. luert word
(M<MS die poiDlel' to tbe text insertion poinL) So do I just type? (Types tbe fnt cblnaa.) Ab. ll (me c.wlal')
iJ llill up lbere. (Moves to the text insertion and clicks tbe cursor. Lben types tbe wonS in.)
4. Delete c•aracters
(Positions tbe cursor behind the fii'St character to be deleted and types BACKSPACE. Procecda 10 ddele die
mnaining duncters in the same way.)
5. Delete words
(Positioos tbe<:ursor at tbe end of the flfSl word to be deleted.)
Thtrt ltUISI ~ an tasier way to dtlttt wholt words. TMrt's thrtt of thtm. So. Itt's ltllw 41 IDol. (R141b
tht mtUIUIJL) So you want to drag the cursor across the ltXI that you waJJI to rtfltO~.
(Tries to mart all three words [struggles].)
(bpii.Un.r how to highlighl across mort than ottt lint.)
(Struggle initially, but eventually manages to highlight the words to be deleted.)
JnOVt

lr says you ust Cur from the Edit mtnu then.
(Loots at lbe Edit menu and selects Cut.)

'· Delete line
I suppost you do ilthe samt way.
(Higbligbta lbe liDe and selects CuL)
1. Doable apaclng
Does itldl you bow co do that?
(~tld.r 1M lfttUIIUJL}

1'llll wou.ld be in Fonnal wouldn't it?
You llllvt 10 scroll righl up to tht top. I thittlr. that it's on tht ...
(PoiDcs to lbe ruler.) On there. (Points to the double-spacing icon.) That one?
Yts, thtU's il.
(Sdeccs iL)

L

SIJIIIe apadna

(Rewma to the ruler and selects the one and a half line spacing.)

t. Ceatre paraarapb
You don't walllto unJrt the tntirt tt.tl, only that paragraph.
(Loots at tbe Format menu.) Is it Align centre.
(Loola altht lrllUUIQ/.) 1 suppose thai you havt to mark il firSt. IMII yo~ ~DII 41U,11 il. (ltHttls frottt
lfttUiual) . •. if you wtJ/11 to changt tht formatting for only a ftw
wathi11 1M .dt:lcuwrtl . . ,., ~
collllntJIIds. That owrridts tht formatting on 1M rukr. You hovt to tnDk1 41 #l«tiiDII ~ JIC* did
fllfYWhtn ill tht ptUagraph.
Allywbere .. . (dicks tbe cursor in the paragraph.)
Go 10 Fonnal?
Yea. (Does. Sdeas Align cenue.)

'!-

'"'es

11. UDderUae WOI'd, embolden word
(Loob at tbe Style menu and bigbligbts Underline.)

"'::!:·at
wont

~.:.Suldthc

illbc middle of a

~ ,
Do I bave 10 select wball WIDIIO IMiidcrtilc.

~ sd~

tbe beginning of a word
UPdctfioe. NodUD& bappeDS. POe-..
and sclecU Underline. Agam. ootb•ng happens.)

* c:.nar

Posi ·
tbe
• . - .aiddlc ol-*'
bappms. Selects Bold. and nolbin& happens.
bODS
cunor •
WCid aDdiCicc:U Bold. NodUng bappcoS.. )
171at's .rtr1111p. (Rtllds tht manU/Jl.) Seiter a piece ot,word twl sella the COIIfll1tlllfllfrtJIIt

Try agailt.
(Does. NodWag

*--.

(Oicb at tbe beponing ol a WOfd and selects Bold. NocbinJ happens .)
(~that tilt word hils to bt higlalighled.)
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~

(Marull
C a wool and underlines it. Highlights another word and selects Bold ) Hooray'

.

ut and paste
·
(lli~~ts the paragraph and selects Cut from the Edit menu.) Do I go up.

··

(Moves to tbe ~ginning of the text. goes to the Edit menu, and highlights Paste.)

!~_ow does a blow where to paste it?

(Positions tbe aasor and selects Paste.)

U. Print

Must ~ in Edit I think. (Looks at the Edit menu.) No Print there. (Looks at the File menu and selects Print
The JX1Dler dialogue box appears.) Urn!
What do you reckon?
(Points on OK.) Probably here.

Yes, click on OK.
(Does. During the delay she points to Continue on the printer status box but the printer then scans printing.)
13. Quit document
How do I leave? (Looks at the File menu.) Close?

How about Quit.
(Selects Quil)
14. Create a document
Now you want to open your own document.
(QQes. to lbe File menu and highlight Open.) Is it New or just Open.
I don't blow, try.
<Does, ~ ootbing happens.) How does it know what to open.
I think that you clwose the option on the display.
(Loots around and is not sure what do do.)
(Explains that she has to open Mac Write.)
(Does.)

And then Open.
(Does. Scans typing a document.)

15. Save a new document
(Goes to the File menu and selects Save as.)
Why did you select Save as rather than Save.
(Loots at tbe dialogue box.) Does that means give it a name?

Yes.
(Types in a fde name, hesitates, then presses RETIJRN.) And leave it? (Selects Quit)

Subject 19
1. Save file
(Goes to the File menu and selects Save.)
l. Cbange margins
Then we want to change the left margin to 1.5. (Looks at the Format menu and selects Align lefl) Let's try
that.

!think we have to look it up. (Reads the manual.)
(Looks at the ruler. Points at the ruler.) I presume these are the markings up here. Have you found anything

yet?

It says these triangles are tabs.
(Drags the tab marker.)

That's the tab and not the margin.
Tbese migbt be the margins then.

11&ey're the black ones.
(Tries to click at the right margin marker and marks the ruler.)

Try and move the black triangles.
(Eventually dmgs the margin markers to 1.5 and 6.5.)

We've still got a problem at the beginning of the paragraphs. You see that tlwse lines still haven't moved.
It looks liU they are aligned with thal other marker [the paragraph indefll marker].
(Grabs the paragraph indent marker and moves it to 1.5 as well.)

J. Insert word
(Moves the pointer and clicks the cursor. Types the word in.)
4. Delete cbaracters

(Positions the cursor in front of the letter to be deleted.) That will delete it. (Presses BACKSPACE deleting
the wrong letter. Corrects the mistake. Proceeds to delete the other characters by placing the cursor bthiNI
each letter and pressing BACKSPACE.)
5. Delete words
<Positions the cursor at the end of the last word and backspaces.)
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6. Delete line
<Marts the line wilh the mouse and presses BACKSPACE.)
7. Double spacing
Isn't this double-spacing DOW.
No, I think doubk-spacing .. .
Ab. sbe wants a line in between each of these. (Looks at the Edit menu.)
(Reads the manu.aL)
(Loots at ~ other menu~. Looks at Format again.) That would probably be in Format I would of thought
Werm t there some l~~~es on the ruler at the top. ShaU we just nip back up and have a look.
Okay. (Returns to tbe top and looks at the ruler.)
What about those boxes. Do you see those boxes with those lines there?
Abah. bere. (Points at the alignment icons. Clicks at the align justify icon.)
(PoilllS at the spacing icons.) These three have got lines in them haven't they?
(Clicks at lbe double-spacing icon.)
1'hat's done something, that's triple-spaced it.
It's this ooe. (Selects the one and a half line spacing icon.)
8. Single spacing
Is it lhis ooe (points at the single-spacing icon)?

Probably.
(Selects il)
9. Centre paragraph
Ceotre the text Okay. (Looks at the Fonnat menu. Selects Insen ruler.)

We've got it in the wrong place.
I don't understand what it's done.

It seems to have put a ruler . . . Why did it put it there?
I doo't understand why you need a ruler at all. Surely it's just within the margin.
(Explains what centring means.)
Shall we go to Format again and get the ruler.
Yes, okay try thai.
(Selects Insert ruler which is again insened at the cursor.) [She has two rulers in the wrong piDce.}
Oh, we've got two of them now. Have you noticed it's putting it in at the last cursor position i.s11't il? &J

presumobly if we wanr to put one further down we have to nwve the cursor.
Yes okay. What does sbe [the experimenterJ want us to decide here?
(Explains the justification icons on the ruler.) I don't think we actually move these [the misplaced rulers}.

&J just put another one where you want it.
So bere. (Puts the cursor at the end of the paragraph to be centred.)
I thinlc you probably have to put it above.
(Puts lbe CW'S()(' two paragraphs above.)

No, it's this paragraph.
(Puts the cursor in the rigbt position and selects insert rulcc.)

Brill
(Clicks on tbe centre icon.)

That's ®ne the rest as well.
Right!

How are we going to get around that.
NQt really,

DO.

We've used a ruler haven't we to change it .from normal to centred text, so ...
Um!

Choose another one to change it back again.
Would it be sometbing like this (points at the align justify icon)?

Prenunobly ifyou click on there now it'll go back to what it was. So . .. what would happen if we stud
anaher rukr in?

Yes, I mean wbere? (Moves the pointer around.)
(When the pointer is in the correct position.) There.
(Goes to Cbe Fmnat menu and is about to select Insert ruler.)
Well we have to put the cursor lkJwn there .first don't we.
yes. (Moves tbe cursor and selects Insert ruler.) How's that? (Selects the justify icon.)
T'hat's it.
11 Underline word, embolden word
1 ~·t toow. (Pops up the Style menu.) Perhaps (selects Underline and nothing happens). Petbaps (marts a
piece of text and selects Underline). Ah!
Whal else do we have to lkJ ?
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Boldface. (Points at some of lhe text underlined.) Actually it's beuer not to have unde rline there. (Marks the
text. but marks a few additional characters at the end which are not underlined. Selects Underline expecting the
underline to disappear.) Ah, tha t hasn't done it. [Because not all of the selected text had been previously
underlined. Tbe underlined option was not ticked on the Style menu.) Wha t about bold. (Selects Bold.) [1be
text is both underlined and bold.) (Selects underline again, which is ticked lbis time. The underlining is
removed. Subject did not notice the difference of the tick o n the Style menu.

11. Cut and paste
(Looks at the Format menu.)

What we're looking for is some way of culling and pasting it. It's not in that menu is it?
(FAit perhaps.) Looks at the Edit menu. (Tries to select Cut.)

BUl, thaJ's grey.
(Tries to select Cut again and then looks at lhe File me nu.)

Preswnllbly wilh Cut being grey at the moment it means we haven't done something.
But. perhaps I was thinking of file. Maybe you can change . . . (Looks at the File menu. Edit. tben File again.)

Stems to me thaJ with everything else on this we've had to highlight something before we do it.
Ob rigbL Maybe if we try that (Highlights the paragraph.)
Now look at the menu if you can get at Paste now.
(Pops up the Edit menu.) All! C ut is now black. (Selects Cut.) Okay.

So now we want ...
The trouble is it's disappeared.
You bww like in Wordstar you cut something and it goes into a buffer.
(Scrolls to the top of the text)
lfyou want to stick il somewhere here.
(Pops up the Edit menu and is about to select Paste.)
Ah, but where.
(Positions the cursor and selects tries to select Copy [ whicb is greyed].)
Presumably it's Paste. I think Paste is the only one you can get at.
(Selects Paste and the paragraph is inserted.)

ll. Priat

(Goes to Ftle and selects Print.) All, shall we do all. {Clic ks on it but it is already selected.) Shall ~ press OK?
(Does.) (The printer status box pops up.) Shall I press Continue [whic h is greyed]? {Presses Conunue.) [The
printer starts printing.]

13. Qult document

ut's get out.

(Pops up the File menu.) Quit? (Selects Q uit.)

Bril.
14. Create a document
MacWrite options (highlights).

Well. the word processor is Mac Write.
(Highlights il)

.

Now you've got to open it. Open on the Ftle menu.

. . .
Ob. (Selects Open.) (The untitled docume nt ~pears.] Do I have to g1ve 1t a utle.7
I think thaJ we can do thal when we save lt.
(Stai1S typing in a document.)

15. Save a new document
(Goes to the File menu and selects Save.)

Subject 20
1. Save file
(Clicks on the File menu and selects Save.)

2. Change margins
(Explains about the ruler.)
Yes 1 can see that I'm not sure how you change it though .
.
'(Reads the ~ual.) Right. you go up to the black triangles. These are the margm markers. You want to

drag those along.

.?

So we put the cursor there do we? So what do I ha ve t? do press th~re to get 1t.
Poinl the arrow tMre [the left margin marker}. Cltck and drag 11.
(Tries to do it and selects the ruler by mistake. Has difficulty to control the mouse. Eventually drags the

.
h ha bt
(Explains that she's dragged the indentation marker so only til£ first lmes of each paragrap
ve lfl

paragrapb indent marker and moves it to 25.)
~vd)

.

(Grabs tbe left band margin marker and drags tt to 1.5.)

(Explains thal she must move the paragraph indent marker b~ck as well.)

Now this one. (Grabs the right hand margin marker and moves 1t to 6.5.)
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3. Insert word
Do 1 have to correct this one first then? (Positions the pointer and click.s to position the cursor.) Do I just write
or do I use the keyboard? (Types a word.)
4. Delete characters
(Positions~ cursor behind the character to be deleted and presses BACKSPACE. Proceeds to delete the other
cbaracters m lbe same way.)
5. Delete words
Do J do it a word at a time?
Yes.
How do you do l.bal?
(Reads tM manual.) You want to mark . ..
Befae and after or something? (Cliclcs the cursor at the beginning and at the end of the word.)
Click at tM beginning then drag the cursor over the te.xt that you want to delete.
(Marts one word.)
There are two words on the ne.xtline as well.
(Marks the other two words thereby undoing the marldng of tbe fJ.tst word. Marks one word and presses
BACKSPACE. Marks the two words on the next tine and presses BACKSPACE as well.)

6. Delete line
(Marts the line and deletes it using the BACKSPACE k.ey.)

7. Double spadng
Do I go to Format to do that son of thing [double-spacing].
Do you want me to have a look? That's at the top of the document.
(Pops up the Format menu.)

No, actually it's underneath the ruler. See the little pictures. If you click on them you'll get thai spacing.

[Subject keeps looking at the ruler.]

No those. (points to the spacing icons.)
What will they do?
They are dijferenl types of line spacing.
(Points at tbe single-spacing icon.)

Thol's tM one you've currently got.
So lhis one. (Points at the one and a half line spacing and selects it.)

No, I think it's the other one.
(Points at the double-spacing icon and selects it.)

8.

Single spacing
You have to change it back to single-spacing.
(Selects single-spacing from the ruler.)
9. Centre paragraph
Format ... (pops up the Fonnat menu and select Insert ruler). [A ruler is inserted at the current cursor
position.] Is that what I was meant to have done?

You want to ...
I want to centre this one (points to the paragraph).
(Reads tM manual.) If you want to change the alignment for a few lines in a document ust the align
command from the menu. Rather than using the align commands from the ruler. Click an in.strtion poifll
any where in the paragraph.
I doo't see wbat I'm meant to do at all.
Just wilhin the paragraph you want to centre position the marker.
(Clicks the cursor within the parngraph.) And drag it along to the end.

It just says click and insertion point.
(Pops up tbe Fonnat menu.) And select?

The align w command.

(Selects Align centre.)

10. Underline word, embolden word
What are we aciUally meant to be underlining it doesn't say? (Pops up tbe Style menu.)

Any word in that paragraph.
(About to select Underline.) Ah, I should have ... clicked on it [the word] fJ.tst before selecting Italics. (Selects
Italics and nothing happens. Positions the cursor in front of a word and selectS Underline again. Nothing
happens.) Um! Does it say about it there. I was trying to underline the word underline.

How oo you think you've got to mark it?
. .
The cursor. Perhaps dragging it along. (Struggles initially then manages to btgblaght tbe word .. Selects
Underline. Marks the next word and selects Dold.) [Since the word is still highlighted she can't see the difference
and selects Bold again. This de-selects the Bold.]

It's okay,

if you click the cursor again .. .

{Does.) [The word is in plain text.)
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(Explmns thal she both selected and de-selected the Bold option for that word.)
(Highlights the word and selects Bold again.)

lfyou click the cursor somewhere else.
()kay. (Does.) [The word is emboldened.] Got it.

11. Cut and paste
I'm not quite sure what it means but I'm lighting it up here. (Highlights tlle paragraph. Scrolls to tbe top of the
text Positions tbe cursor and highlights a piece of text at the top.)
What do you thinlc you are doing?
I was ttying to move it [the paragraph] to just there, but I can't actually move it. Shall I try Fonnat again?
Where do you think it mighl be?
Ah, Edit (Looks at Edit and selects Paste.) [Tile contents of the clipboard are pasted over the selected text]
(Explains whal has happened. Makes the subject look at the original paragraph.) See, il's stiU there?

12. Print
It's in the File menu.
(Goes to the Ftle menu and selects Print.) [The printer dialogue box appears.]
You just want to click on okay.
(Does.) [1be printer status box appears.] (Tries to select Continue which is greyed.)

The printer will stan any second.
[The printer starts to print.]

13. Quit document
[Runs-out of time.]

14. Create a document
IS. Save a new document
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MacWrjte Comparison Group
Comparjson-Sybject I
1. Save file
(Pops up lhe File menu, hesitates.)
What are you trying to do?
To select Save, where do you have to go? To the keyboard or to the

On tilL menu.
The S [tbe keyboonl acceletator?
Yes, pull it down.
(Selects Save from the File menu.)
l . Change margins

···

So the left margin to 1.5 • ..
Do you have any idea whm to do?
No, not really.

Do you want to try something?
Search maybe (pops up the Search menu). Format maybe (pops up the Format menu). Align left maybe
(selects Align left). (Nothing happens.]
What do you think this would do ? You've got to change the left tc 1.5 and the right to 6.5.
Well ~ ~ven't changed anything _have I? Let's go to Format 111 go there again. (Pops up the Format menu.)
Set page. (Selects Set page.) [Dtalogue box appears for the new page number.} That's not it. (Selects Cancel.)
So I haven't actually changed the left margin to 1.5 have I?

No. Do you want to try any of the others?
(Looks through the other menus.)

(Reads Ilk! manual.) There's a bit here about changing margins - you use those ruler thingies on the screen.
The lin/e markers aJ the comers.
(Points to the left hand markers.) These?
Yes.
(fries to click at the left hand margin marker, but selects the ruler instead.) Let's try some of these here. (Clicks
at the ooe and a ba1f line spacing. De-selects the ruler.)
No, you've just changed the spacing. Put it back.
There (clicks on the single-spacing). Yes.
Those margin markers -you have to drag them.
(Clicks and tries to drag, but moves the window.)

Those markers.
(Clicks on the left hand margin marker and starts dragging it.) Ah, I see. We'll get there evenruaJiy. So that's

that one.
What about the right hand one.
That was 6.5. (Points at it, clicks. and drags it to 6.5.) [Hasn't moved the paragraph indent marlcer to the caTeCt
position.]

3. Insert word
(Moves t.be pointer oo the text insertion point and clicks to position the cursor.) Do I print that now using tbe
keytxwd?

Yes, just type it in.
(Types the word in.)

4. Delete characters
(Moves the pointer behind the first character to be de leted and presses BACKSPACE.) [Deletes the last character
of the word she has inserted and is confused.] Why have I got two cursors? (Re types the letter just deleted.) Is
it because I left it there? How do I move it, c lic king maybe? (Tries to drag the cursor.) I want it to come with
me.

So where do you want the cursor to go?
(Points on the screen.) There.

So if you go down there.
(Moves the pointer and jiggles it.) So that doesn't come with me. So that's the moving one [pointer], but that
[cursor] is still staying there. How do I get it then?
See what you can do with the one that moves around the screen. You got it there somehow, so you must
have done something to get it there.
(Plays around with the mouse and marks a line of text.) Why does that tum it black?

You could try moving it there and clicking it in.
So if I move and click onto that (moves the pointer behind the first letter to be deleted and clicks to position the
cursor.) (Presses the BACKSPACE key to de lete the character.) Now move it to the other one. (Moves the
pointer and presses BACKSPACE.)
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You've done it again.
(Cerrects the mistake then proceeds to delete the other charncters.)

5. Delete words

There must be a quicker way to do this than to do the whole .. .

Yes, what do you think?
(Deletes ooe word by backspacing.)

Is there a way ofmarking them?
With the mouse.
Any idea how to do it?
No. but it must be possible.
(Reads the manual and reads out to the subject how to mark a piece of te.xt.)
Ah, bere we go (marks a word and presses DELETE).
6. Delete line
So (marks tbe line and presses DELETE).
7. Double spacing
Any ideas?
If we blacked out one of the lines and moved it with the arrow cursors.
I think you have to do the whole document.
(Marb tbe paragraph.)
So what are you going to do now?

So that's no use lhen is it?
What options could it be on? (Reads the manual.)
Format? (Pops up the F<Xmat menu.) Not really.

Any of those other menus?
(Looks at Edit and Style.) Why is it not under Format? That's where I would have put it.

TeU that to the people who design these things. (Points at the manual.) It's actually on the ruler.
So we have to bring that back don't we?
You have to go back to the top of the page I suppose.
(Scrolls back to tbe top of tbe page.) Right. That one here must be double-spacing (points it and selects it.)

That's double-spaced it.
Has it?
Well, you've got twice as much space between the lines as you had before.
8. Single spacing
So we need to get back for that. (Goes to the top of the text and clicks on the single-spacing icon.)

9. Centre paragraph
[Is still at the top of the text.] Insert ruler (selects). [A ruler is selected at the current cursor position.] Oh!

What happened?
It bas inserted a ruler .. . there.

What have you done?
It told me to insert a new ruler and I have.

But why there?
I don't know wby it was there. So if I went back: up to the rop again. Now I've got a ruler in tbere wbere I don't
waoL [Tbe subject thinks that she has to be at the top of the text to use the menus.) (Clicks on the Format
menu.) So bow do you know where your ruler is going to appear? (Selects Insert ruler.) It's just chance?
[Aoocber ruJer is inserted immediately below the previously inserted ruler.)

It's more than chance.
Ab, so it's wbere I leave that cursor. So the next one will appear there (points to the cursor posit.ioo oo the
screen). (Clidcs the cursor somewhere else.) Now it would appear above that line. To centre text . ..

You'vt got two rulers now.
(Points to the ~ntre icon on the second ruler.) That one? Or do I have to black that paragraph before? (Marks
the paragraph to be centred and selects the centre icon.) [The text below is centred as is the paragraph above into
wbicb tbe two rulers have been inserted.]

Wlral are you doing now?
fm going back to the top to get rid of the rulers. (Goes to Format and highlights Hide rulers.) I wonder if I
have to set the page? Or use Ruler, that would be more useful wouldn't it? (Selects Use ruler.) [This returns
bee to the piece of text where the rulers are.] (Clicks on the rulers.) I'm trying to black one of the rulers.

Why?
Or could we just go back: and hide the rulers?
No, I don't think that would get rid of them.
Blacking out is cheating.
Why is blacking out cheating?
Because it's not really there is it?

So whal are we going to do?
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I don't lhink we are really going to achieve very much here.

Well we've got two rulers.
Yes. I don't seem to be able to pick up this cursor.

What are you trying to do.
The ~d ruler appeared where I left the cursor. So if I took it (the cursor] into there (points at the ruler) I can
make It disappear.
I don't know.
The rulers can be selected from Format, you just can't get rid of them. (Scrolls to the top of the text and pops up
the Format menu.) [Seems to think that she has to be at the top of the text to use the menus.)

So whal are you trying now?
Get rid of the ruler. Hide rulers? (Selects Hide rulers.) Yes, that's got rid of the one at the top. (RetWllS to the
paragraph.) So we just need one don't we? (Scrolls back to the top.) [fo use the menu.)
Wait a minute. Where are you going to put it?
Well it's going to appear where the cursor is at the moment. (Selects Insert ruler from the Format menu.)
[There are now three rulers above the paragraph to be inserted.] We've got three now. [A line of text which was
highlighted bas been deleted when the ruler was inserted.]

How can we get rid of the other two, any ideas?
No, not really.

What could you do?
Wbat haven't I tried? Well now I know where U1e next one will appear when I tell it to give me another ruler.

You'd 11UJde it black before.
But you can't black a ruler.
You did lhal at the top when you tried to align the tabs.
(Clicks on tbe ruler and nothing happens.) See, the cursor is left there [below the ruler]. It doesn't want to
come. (fries to drag the cursor into one ruler thereby highlighting it.) How did I do that? (Marks all three
rulers and a piece of text.) Well, lots going to go in a minute. (Clicks tbe cursor and the marking disappears.)
Now bow did I do that? (Tries to click on the rulers again trying to highlight them, finally managing to
bigbligbt one of them.)

Now what are you going to do?
Delete (Jesses BACKSPACE).

Now you can get rid ofanother one.
Was that just around there? (Clicks a couple of times and manages to highlight another ruler. Presses
BACKSPACE.) Are we meant to be using this one [the one remaining ruler]?
Yes, centre the text but only in this paragraph.
RigbL (Marks the paragraph below the ruler.) Now.
What are you going to do now?
Go back at tbe top.

No.
No. Centre the text (Selects the centring icon.)
[1be text below the ruler is centred but me first paragraph below me ruler doesn't look centred because of the
combined effect of the paragrdph indent marker not being set correctly and the lines of text within the paragraph
happen to contain the maximum amount of characters. The subject is now totally confused and proceeds to try
all alignment and spacing options.)

What are you trying to do?
Centre it but . . . (Points to the centring icon and selects it.) I thought that one would but . ..

Yes, but it didn't centre the paragraph that you wanted it ro do.
(Selects tbe Right align icon.)
Go back to single-spacing.
(Does.)
So why hasn't it centred. (It is quite clear now that the alignment and justification options apply to• all the text
below tbe ruler.] (Points at the single-spacing icon.) That's just for the up and down spacing it's not sideways
spacing is it?
You've centred the bit below the bit to be centred. {The co-experimenter is confused. Actually, everything

btlow tht ruler has been centred.]

(Clicks the left align icon.) That's how it was originally. (Clicks on the centring icon again.) That's centred
that (points 0 the paragraphs below the first paragraph). So I must have to move my black [marking] up. It's
not changing this paragraph at all.
What do you think.?
.
.
.
(Removes the marking. Marks another line in a paragraph below.) If I JUSt do that tha11s gomg to centre that,
or is it? (Clicks on the left align icon. Tries the spacing icons.) [Seems to believe that any choice made on the
rule only affects the marked text]
It's affecting the whole lot, but you just want to centre the one paragraph._
We didn't achieve anything with that paragraph at all except up and down spacmg.
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~'J clicking on the centre one [icon/ again (points to the centre icon).

TluJl's centre~ it. But, it'~ centre1 everything below it as well. Any ideas?
It must be, sometbmg to ~o wtth what s below that the cursor, which is below the f1rst paragra hj .
What s your suggestzon now?
P
Well I've g~ to get it up there haven't I. (Marks the paragraph above the ruler.) It will centre everything below .
Isn't that gomg to belp?
No, I'm just trying to work oul what you're thinking.
Well. when we blacked out this paragraph [the paragraph below the ruler] it centred everything below. So if we
want to do that paragraph [the one below the ruler] we have to do [mark] the paragraph above it

Won't thai still cenlre everything below [the ruler].

Yes.
What do you think? We've got the ruler there now and we've centred everything below it.
Move lbe ruler down?
Hang on, another o~?
Move it [tbe ruler] up.
(Starts reading the manuaL)
(Clicks tbe cursoc at the beginning of the second and then the first line of the paragraph to be centred.) That's
just moving it to tbe beginning of each line. (Points at the Format menu.}

Try another ruler?
[Tbe co-e~perimenter doesn't realise that the subject doesn't realise that the paragraph below the rule¥ is actually

centred. 1be co-experimenter is trying to get the subject to put another ruler below the paragraph to be centred.
to format the rest of the document correctly. However, the subject is still trying to centre the paragraph,
thinking that every paragraph below the ruler except this paragraph is centred.]
Pulling it where? Below this paragraph? (Positions the cursor and scrolls back to the top of the text)

So you're going to the cop of the page now?
Didn't need to do that did I because I've got those little words {the menu bar] there. [The subject finally realises
that she does not have to be at the top of the text to use the menus.] (Relums to the paragraph and selects Hide

rulers.) Hand on.
Thai hid il.
It [tbe ruler] is still there though. That's the uick the ruler is still there.
Don't you wanl another one.
When I put it back in we'll have two again won't we. [Tile subject understands that wben a ruler is inserted. all
bidden rulers are displayed as well.] (Selects Insert ruler. The ruler is inserted below the paragraph to be centred.)
The first OM [rulerI has centred everything below. Whal do you do with the next one?
(Points to the fmt ruler.) This one has centred everything below. Right. So this one (points to tbe second
ruler) bas that ooe centred everything below it?

It's 011 ce111red
So ...

Any ideas?
(Selects right justify on the first ruler.)
Hang 011.
That's now centred (points to the paragraph to be centred which is now right justified.)

No, you've just switched it to right [justification/.

Ob!
No, it affects the text below it.
(Selects centre again on the first ruler.)

Thai's ce111red il.

.

~-L
Everything below that paragraph you want to put back to what ll was before.

.

To the left, that's that one (selects the left justify icon). Job done? So now we want to get nd of some of these
rulers doo't we?

It's up to you.
(Points to the Format menu and pops it up.)
How did you do it before?
.
Blacked them Oets go of the Format menu.) Highlights the f1rst ruler and presses BACKSPACE to delete JL
Highlights the seconds ruler and deletes it also by pressing BACKSPACE.)
10. Underline word, embolden word
(Highlights a word and goes to the Style menu.)

Underline.

(Selects Underline. Highlights another word.) This one on bold face . (Goes to the Style menu and selects

Bold.) Happy?
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11. Cut and paste
Any ideas?
It's got to be blacked. (Marks the paragraph.)

Whal are you going to do with this?
Edit (goes to the Edit menu and selects Cut). So this will do that.
Righi, now you have to put it at the top of the documenl.
Edit (pops up the Edit menu) we want to paste it somewhere (selects Paste). Has that put it back where it was?
Yes.
So I have to move this cursor first have I? To the top. (Pops up the Edit menu and selects Undo Paste.) Wba!'s
bappeoed tbere.
It's gone again. You undid the Paste.
(Tben pops up the Edit menu again and selects Redo Paste.) So that's put it back in. (Pops up the Edit menu
and looks at tbe choices.) And. you don't want to do anything else.
You are supposed o put the paragraph at the top of the document. What do you suggest.
We did that before ... Well it knows what paragraph we're talking about (Pops up the Edit menu again.)
Try to move it to the beginning of the text.
So do I have to go back to tbe beginning of the document (Scrolls to lhe beginning of the document)
Where do you shove it.
(Positions tbe cursor.) There.
Alright then.
(Selects Paste.)
Yes.
(Returns to the bottom of the document.) We've still got that piece of text there so shall we just delete it?
(Highlights the paragraph and presses BACKSPACE.)
ll. Print
So I want to print the document. File (pops up the File menu). Print (selects Print). {The printer dialogue box
appears.] (Looks at the options.) Draft?

Yes.
All? (Tries to select it.)
It's on All.
Copies 1 (tries to select automatic but it's already on automatic). What now?
You've got OK or Cancel.
Ah (selects OK).
[The printing in progress box pops up.]

(Tries to select Continue.)
13. Quit document
(Pops up the Format menu.)
What are you trying to do?
Undo tbe changes that I've made.
Well, if you just leave the document without saving. That will get rid of it.
Back to tbe beginning.
No, you have to quit or leave it. Go back up to the menus again.
(Scrolls up to the top of tbe document.) I don't really need to go up to the top do I? (Looks at the File menu.)
(Reads out the choices which are blackened.)
Quit (selects Quit). [1be quit dialogue appears.] Save changes- no.
14. Create a document
[Not completed because of lack of time.]
15. Save a new document

Comparison-Subject 2
1. Save file
(Clicks oo the File menu and selects Save.)
l. Cbange margins
Change the left margin to 1.5 and change the right margin to 6.~.
.
Right (Points at the the left band margin marker and the paragraph mdent marker and chcks ~ them. Starts tD
move the paragraph indent marker.) So if I ... left margin to 1.5 (positi?ns the paragraph mdent marker ~
1.5). Right margin to 6 .5. (Grabs the right hand margin marker and drags 1tto 6.5. ReturnS to the left margm
and drags tbe left margin marker.) Do I try and change the left margin here?
That's not quite there. If you try to nwve it.
(Grabs tbe left band margin maker again and drags it to 1.5 .)
That's it.
So I've changed both the margins, the left one to 1.5 and the right one to 6.5. I guess we bave to move to the
next page.
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3. Insert word
(Moves tbe poinrer to the text insertion point and clicks it, then types in the word.)

4. Delete characters

.

(IUitioos the cursor behind the fllst character to be deleted.)

Which character are you going to delete?
This ooe (presses the BACKSPACE key). (Proceeds to delete tbe other characters in the same way.)
5. Delete words
(Goes to the first word to be deleted and marks it with the mouse and presses the a key.)
Oh, how did you do that?
I don't know, I just pressed SPACE.
You puslwl space to delete a word. I didn't know you could do that?
Push the SPACE to delete it? I thought it might.
Did you thinlc il would do that or have you used it before?
I_remember that one from before, yes. If you blocked things out on something I used I before then yoo could get
rid of the whole lot at once. (Marks the remaining two words and deletes them by pressing SPACE.)
6. Delete line
(Marks tbe line and pushes SPACE to delete it) [Instead of just deleting the text she's added a SPACE as well.]
7. Double spacing

Spacing ... (pops up the File menu, then the Edit menu.)
What are you looking for?
How ro cbange it from single space to double space. (Pops up Search and then Format.)

So you are just looking through the menus.
rm just looking through the menus to see where it might have a ... to change it from single space to double
space (cootinues to look through lhe other menus.) (Now proceeds to look back through the menus from right to
left. Looks at the Style menu.) So that's what it [text] is going to look like. What's that? (Looks at Font then
Formal)

Any ideas?
No, we need to look up .. . would it have anything on the size of the space?

(Reads the manual.) This thing at the top of the page. The ruler thing. Line-spacing boxes. This thing
(points in the manual).
Ob, the ruler. (Clicks on Format and selects Insert ruler.)

On top of the page.
(Looks at tbe ruler which she's just inserted and points to the double-spacing icon.) So that must be doublespacing. (Selects the double-spacing icon.)

You ha~n't changed the whole document.
I haven't changed the whole document? (Pops up the Format menu.)

There was a ruler al the top of the page, at the top of the document.
(SeroUs up to tbe top.) Ah, Like there. So !.hat's one (points to the single-spacing icon, and then elides oo lhe
double-spacing icon). So that's all being double-spaced.

8. Single spacing
If I go back to the top and go back to single (does, and selects single-spacing). (Scrolls down lhe text.) [1be text
below the second ruler is still double-spaced.]

That's still double that bit.
(Inserts another ruler above the second ruler.) That's interesting. Why have I got two rulers now? Did I just put
in aootbec rulec when I already had another ruler in? (Selects the single-spacing icon on both of the rulers.)

Yes.
Okay. (Selects Hide rulers from the Format menu.)
9. Centre paragraph
(Reads tbe insttuctions) ... centre the text but only in this paragraph . . . So l have to insert a new ruler.
(Inserts another rulec without paying attention to where the cursor is.) [The two bidden rulers are now also
displayed.] How many rulers are on here?

You've got three here. We can get rid of two of them.
(Selects Hide rulers again.) When I bid the rulers before lhat took away all of lhem didn't it? So why ...
But you've got rid of the one you want.
(Scrolls through the whole document to see if there are any rulers left) No. (Selects Insert ruler again.) If I get
another one rm going to get all three again. [There are now four rulers.] So each time 1 get an extra one.
Any idea?
Tbe.re must be a way of just coming up with the original ruler. (Selects Hide rulers again. Selects Insert ruler.)
Am I going to get five now?

Yes. You keep insening new ones. How are you going ro get rid of them?
Can I?
There are five ofthem now.
Yes, I think thece are. (Highlights Hide rulers.)
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Thai's only hiding them obviously.
right. (Looks at.the Format menu_.) So instead maybe of adding another ruler I want to Use ruler maybe
mstead. (Looks at File menu, then Edtt and selects Undo Insert ruler. Pops up tlle Edit menu again and selects
Redo Insett ruler, then selects Undo Insert ruler. Pops up Search and Fonnat)
What are you trying to do now?
(Looks at File ~d then Edit.) So I've only got rid of one of them. [Which is correct.] So I've got 1, 2, 3, 4.
(Looks at the Edit menu.) But that [the Redo Insert ruler] is only going to allow me to redo. So I can't get rid
of aooCher ooe that way. So I'm stuck forever with the four. I think I'll go ahead and centre it and try and forget
about the otbets. I'm going to insert a new ruler.
How do you get rid oftext?
Um,_ (s~ c~cking on a ruler) you block them out and delete them. (Clicks on severaJ parts of a ruler and fails
~ hi~blight 1t.) Can I drag the thing over it? (Tries to click on different parts of a ruler, finally manages to
highlight all four rulers and presses BACKSPACE to delete.) Back to centring the text
But only thlll paragraph.
So if I only want one paragraph centred, block that paragraph out (highlights it). Whatever I select now will
only bappen to that paragraph.
(Reads from tM instructions.) You have to insert a new ruler. new rulers can be selected from Format.
{Selects Insert ruler which deletes and is inserted at the paragraph.)
Now whlll happened to the paragraph.
I didn't delete did I?
Can you Undo do you think?
(Pops up Edit, looks at File and Search.) So that did delete it didn't it? (Looks at Format. Search, and tben Edit
Looks at Hie.)
What are you doing at the moment.
I'm looking if I can see anything that might get something back.
It's on tM next one.
(Pops up the Edit menu.) Paste maybe.
No, Undo Insert ruler.
(Selects Undo Insert ruler.) rrhe ruler is gone and the paragraph comes back.] Oh, there it is. (Cancels llle
highlighting.)
So you've got to insert a ruler.
(Selects Insert ruler and gets a ruler above the paragraph to be centred.) There's the ruler and I want to centre it?
Yes.
So . .. (points at justify - which is the current selection) that looks like it might have something to do witll
centring (selects it). [Nothing happens.]
(Looks at the manual) You've got align left, centre, right, and justify. (Points at the icons in the m.anual.)
So centre is the second one?
Yes.
(Selects it.) But only this paragraph. So it's going down all of the document after my cursor. Put tbe cursor to
the end of tbal paragraph?
And then what?
And then back to ruler and change it back to what it was before which was this one (clicks on the justify icon).
Thai's put them all back.
If I try to block out those (marks the paragraph) and then put it on centre do you think (Selects the centre icon.)
Thai's centred everything also. Another ruler maybe?
Yes. (Positions the cursor and selects Insert ruler. Selects the justify icon on the new ruler.) Do we have to
leave these two rulers in here?
Do you want to get rid ofthem? Whnt did you do before when you had five of them?
Wbicb one was it {pops up File, Edil, and Search menus) .. I don:t want t_o Hide the rulers becau~ 1'~1 just keep
having them back. I dragged across the line then I deleted tl. (Tnes to cltck on lhe ruler to htghhgbt tt. bot cant
fmd the spot.)
Whlll are you trying to do?
.
I'm trying to delete it. By getting to the end of the ruler and getting to lhe end of llle olher one and deleung

9h

them.)

Why aJ tM end ofthe ruler.

..

.

I thought that I bad to put tbe cursor behind what I had to delete. (Postuons the cursor at llle end of the hoe of
text below the ruler and tries to drag upwards from lhere to mark il)

Try to click on the ruler itself, you keep clicking on the box [icon} there.
Ob, I see. There. (fries again and manages to mark the second ruler and presses B~CKSPAC? to delete. Tbeo
highlights the flfst ruler and deletes it in the same way.) [They don't seem to nouce t.bat lllts bas undone the
formaUing.]
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10. Underline word, embolden word
(Pops up the ~tyle menu.) Un~erl~ne a wo~d (select Underline). [Nolbing happens.] (Pops up Ule Style menu
oouces that Underhne 1s now ucked.) That has selected it, so now if I write anything it will be

=::!.

Would it?
(Pops up tbe Style menu again.) See, that's ticked.
But how do you underline a word thai's already there.
If I went and did that (marks a word). Go to Style and select Underline (does). (The word is Wlderlined.]
Now to bold.
(Pops up Style again and select Bold.)
11. Cut and paste
So I can black all of this out (marks Ule paragraph). And I'm dealing with just that. Now I have to move this
paragraph to tbe beginning of the text. That's Edit. (Pops up Edit.) Cut, Copy, Paste. (Highlights Cut and
besiwes. Then selects Cut) Now if I put this to the beginning (scrolls to the top of the text) and Paste (selects
Paste). [lbe paragraph is pasted back to where she cut it from.]
What hoppmtd?
(Reads tbe instructions again. Looks at the Edit menus again.) Undo paste, well what if I ...
(Explai.lts thai she cut aru1 pasted it in the same positions.)
Okay, we'll tty that again. (Highlights the paragraph again. Selects Cut.) And I didn't put the cursor at the
beginning did I? (Goes to the beginning of the text and positions the cursor then selects Paste.)

ll. Print
Find out where printing will be. (Pops up the File menu.)
Yes.

(Selects Print) [The print dialogue box appears.] (Looks at Ule options.) How many pages bave I got? From

page?
(Explains thai All is the current selection.)
Okay, so that's .. . (clicks on OK). [Printer status box appears.] Printing in progress.
(Explains about the printer status box.)
13. Quit document

Save, where will Save be? (Pops up the File menu. Highlights Save.)
Witlwut saving.
Ob. (reads tbe instructions again) without saving the changes you've made. So if I just leave it then.

Quit this witlwut saving the changes.
(Goes to File menu and selects Quit.)

14. Create a document
So now I've got to open a new file?
How do you open a new file?
(Points to Empty Folder, opens it it, then closes it. Pops up the File menu. Highlights Empty Folder and
selects Open from the File menu.)

What about Mac Write.
(Selects MacWrite options.)

Thtrt's MacWrite there.

(Double elides on MacWrite and opens it.) So I'm now at the beginning of my untitled document. (Starts
typing.)

15. Save a new document
(Goes to the FJ.le menu and selects Save.) Save current document as ... (types in a file name then clicks oo
Save.) (Selects Quit.)

Comparison-Subject 3
1. San file
/think you go up to the top [File menu/ and select Save.
(Pops up the File menu.)

ANi sekct Save.
(Does.)

l. Change margins
Any idea?
(Points at tbe left band margin marker.)
What art you trying to do rww?
Don't know. (Points at the tab icons.) Is it one of them?

So whal suggestions would you have, or ideas?
I don't know.
(Starts reading the manual.)

If you try and move any oftiJe things there.

.

.

(Clicks 00 me ruler and selects it. Grabs the paragraph 1ndent marker and moves 1t along the ruler.)
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I think tlulJ's 35 now.
Ob, righl (Points on it trying to move it back.)
Try clicking on it.
(Eventually manages to pick it up and move it to J.5.)
Move the righlto 6.5.
(Does.)

. There are stiU thes.e bits here. It's only indented the first line ofeach paragraph.
(Pomts t tbe puagrapb mdent marker.) That? (Grabs the left margin maricer and moves it to 1.5.)

3. Insert word
(Moves tbe pointer to the text insertion point and clicks the cursor.)
Insen?
Do I type it? (Types in a word.)
4. Delete cbaracters
(Moves the pointer behind the first character to be deleted and presses BACKSPACE, thereby deleting the last
character of tbe word just inserted. Types the letter back in again and tries to move the cursor by dragging it
with tbe pointer.)
What are you trying to do?
Go down there. (Tries to drag the cursor with the pointer and highlights a large piece of text.)
What are you trying to do?
I don't know. I want to go there. Am 1 done with that one.
Yes.
(Moves the pointer behind the first character to be deleted.)
What are you trying to do now.
Delete il
What?
1be extra leuers.
It's gone all black, I just wondered wlult you were doing.
(Clicks somewhere and manages to get rid of the marking . Moves the pointer behind the flfSt character to be
deleted.)
(Points to the cursor on the screen.)
(Uses tbe arrow keys to position the cursor and presses BACKSPACE to delete a character. Proceeds to delete
the other characters in the same way.)
Do you .find it easier to do that from the keyboard than with the mouse?
5. Delete words
(Hesitares.)
What are you trying to do ?
Delete wmls.
Any idea?
(Positions the cursor at the end of the text to be deleted.)
Are you going to do something with tlze mouse now
(Highlights two words and deletes them by pressing BACKSPACE. Marks the other words and deletes tbem in
the same way.)
6. Delete line
(Marks the line and presses BACKSPACE to delete it.)
7. Double spacing
Double spacing.
What do you mean by double-spacing?
(Explains.) There should be sot~Uthing 10 do it automatically.
(Marks a line.)
You should do it for the whole docut~Unt.
(Proceeds 10 m.aJt the line.)
What are you trying to do now?
Trying to move the line down.
Why
To make a gap in between.
.
?
Do you want to do that for every line? Don't you think there would be an easter way. See if you can fl.lld
that. (Stans reading the manual.) See if you can find anything in the menus.
(Looks at Edit. Format. and then the other menus. Looks at Format again.)
Any ideas?
No. (Proceeds to look at Search and Style.)
It says here that you have to use the ruler.
(Pops up tbe Format menu again.)
I think there's one at the top.
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(SeroUs to the top of the document. Points at the 1.5 spacing and selects it. Is quite happy with the result)

8. Single spacing

(Returns to the top of the docwnent and selects single-spacing.)
9. Centre paragraph
(Goes to~ Format menu and selects Insen ruler.) [The cursor was in the right position.]

Any idea wllalto do to centre it?

(Loots at tbe ruler. Points to the margin markers.) Move these bits along?

Well, at the moment it is justified.
(Points at tbe tab markers.) These?

I don't think. they'll do it.
(Looks at the Format menu again.)

It says here there are line-spacing boxes and align boxes as well.
(Points to the alignment icons.) One of them?

I think so.
(Selects lbe right justify icon.)
I think tllal's righl alignment. You want it centred.
(Clicks on the centre icon.)
You've done the whole lot. Any idea how to do just one paragraph.
What. on the ones above as well?
(Points to the paragraph above the ruler.) They're still the same. What do you think you should do?
Go ... (points to the paragraph below) put this back to the left or the right.
Yes.
(Goes to the Format menu.)
What are you thinking of doing.
(Highlights Align left)

It was justified before.
(Selects justified.) [Nothing happens.]

It's still centred
(Positions lbe cursor in the paragraph below the one to be centred and clicks on the align left icoo.)
That's kft alignment.
Was it right [aligned] before?

No, it was centred.
So do I want to centre that bit

Yes, you want to centre that paragraph [points to it). But, you don't want to centre these paragraphs beneath
it. And, you don't want to centre anything above it. (Explains that when she centred everything befort all
paragraphs below the ruler were centred.)
I might move this down.

What?
The ruler. (Points at the centring icon.) If I centre that bit and move the other bit back.
How are you going to do that?
(Selects centring.) It's centred now?

Yes.
Right.

So. how can you move the bit back?
(SaoUs down, points at the Format menu and selects Insen ruler.) [The ruler is inserted in the middle of the
paragraph below the one to be centred at the current cursor position .].

Have you got any idea why that happened.
Did it too low
What shall we do now?
(Goes to tbe File menu and selects Insen ruler.)

We've got 2. Any idea why we've got two there?
(Pops up tbe Format menu and highlights Hide rulers. Lets the menu go.)
Is there any reason why it has come in between the word options?
That's because the cursor is there.

Can you get rid ofthe rulers then

<Lo<*s at Format and selects Hide rulers.)
So where do you want the rulers?
(fries to move tbe cursor by dragging it.)

How are you trying to move the cursor?
(Uses tbe arrow keys to position the cursor. Selects Insen ruler.) [The new ruler is inserted in the correct
position and tbe other two rulers reappear.}

Can you get rid of those.
(Pops up the Format menu and highlights Hide rulers.)
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That will hide all of them.

(S~ectsdtb.:eleft align ~con on th~ new ruler. Goes to f-onnat and selects Hide rulers.) l'Jlle text between the new
ru r(Pan .

om1s

tht~o pre)v•ous ones •s set to left align. The text below the other hidden rulers is still centred 1
zs out.

·

(Selects Show rulers.)

Can you just delete those two rulers.
(fries to click on tbem.)

How did you get rid ofletters and text?

(Manag~s ~highlight one ruler and presses BACKSPACE. Struggles. then highlights the second ruler and
deletes It usmg BA~KSP~CE.) Can you change lllat from justify to left align? (Selects left align from the
Format menu.) Has 1t done tt?
No. How did you do il before?
(Selects centre icoo.)

That's centred, you wanted justify.
(Selects tbe justify icon.)
Do you want to get rid of the rulers 110w?
(Deletes the bottom ruler.) [The text bas gone back to being centred.)
What about the other one.
(Deletes the other ruler.)

10. Unclerllne word, embolden word
(Goes.to Style and selects Underline.) What happened?

Can you underline a word?
Wbalwool?

Any.
(Marlcs a word and selects Underline.)

Can you put one on bold.
(Positions the cursor within a word and selects Bold. Nollling happens. Does llle same again.)

What do you want to do?
I want tba1 to go .. . Can I do any word?
Yes.
That bit went black.

How?
By pressing it (Positions llle cursor in anol.her word and selects Bold. Nothing happens. Manages to mark a
w~d by double-clicking on it Selects Bold and the word is emboldened.)

11. Cut and paste
(Marks the paragraph.)

Cutting and pasting, how do you do that?
(Pops up Format. Font. then Edit. Selects Cut)

And 110w you put it at the top of the document.
(Scrolls to tbe top of the document and selects Paste. The paragraph is pasted where she deleted it from.)

You put it back. Why is that?
Because tbe cursor was still there. (Selects Undo Paste. Return to llle top of the document and clicks to
position the cursor. Selects Paste.)

ll. Print
(Looks at File and selects Print) [Primer dialogue box appears.] (Looks at lhe options, clicks on All - even
though it's selected. Clicks on From, but nothing happens. Clicks on OK.) [fhe printer progress box appears.]
(fries to click on Continue.)
13. Quit document

Now. leave the document without saving changes.
(Goes to File.) Quit?

Yes.
(Selects Quit)

14. Create a document
You have to open up a new file to write a letter.
(Highlights MacWrite, then double-clicks on it to open it. Starts typing a documenL)

15. Save a new document

Comparison-Subject 4
1. Save file
(Has some problems sorting out how the menu works.) (Eventually selects Save.)
l. Change margins
Change the left margin to 1.5. Okay. (Points to llle ruler and then pops up llle Fonnat menu. Highlights
Align left.)

So whal are you doing flOW?
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It says change the left margin to 1.5 and the right margin to 6.5.

So you're looking through this.
Yes, just cbeck tbe Format. I presume it'll be in Format anyway. AJign left - I presume that
That will align all the text left.
···
Alright (Selects Set page and clicks on OK very quickly wilhout realising.)
Any more ideas.
(Loots at tbe Font menu, then Style, Search, Edit, and File.) What about Page setup? (Selects Page setup.)
flbe Page serup dialogue box appears.]
No, Cancel il.
(Does.)

Have you got any ideas?
~ about this? (Poin~ to the left hand mar~in marker and paragraph indent marker. Grabs the paragraph
mdent marker and moves tt to 1.5.) [lbe flfst hne of every paragraph is set to 1.5.] Um! (Moves to tbe right
band margin marker.)
It's only moved the top bils.
Wouldn't it belp there w~ a menu there because on .a word processor that I've used it was very very easy
because all you did was brmg up a menu for the margm and you just tell it bow much you want, how many
lines in very very quickly.
Move il to 6.5. {Righl hand margin marker.]
(Grabs tbe paragraph indent marker and moves iL)
So what are you doing now?
(Drags it to 50.) Keep coming? [Wanted to drag it to 6.5.1
I think you've moved it 100 far.
(Drags it back a little.)
That's 40 I think. That's moving the first line bit here.
That's wbat it's doing, it's just reformatting those two lines.
I think il should be 1.5 that [the left hand margin marker.}
(Moves it a liUle further lefL.)
You wanl the left to 1.5 and the right to 6.5.
That must be there. (Moves it to 16.) [Finally understands that the first lines are aligned witb Lbe paragrapb
indent marker.]
(Points to the righl hand margin marker.) What about those margin markers?
1bal one? (Points to the margin marker.) What about !bat one? (Points to the tab marker and drags it Points
to tbe margin marker.)
Try that one.
(Moves the right band margin marker to 6.7.) On my computer which I used last year which was an Olivetti it
bas a counter which shows you exactJy how many columns you've moved it.
Here you've got scales on a ruler.
(Looks at the Edit menu.) No. (Looks at Fonrull, Search, Style, and File.)

i!

3. Insert word

rand tbe missing word?
Yes, and write it in.

(Swts typing, and the characters are inserted at the cursor position.)
What happened there?
How do I get rid of it?

BACKSPACE.
(Presses BACKSPACE.)

Why has that {the text] gone up there do you think.
Good questioo. You must have to use a command LO say insert.
WeU it went up there first when you started typing. but you want it to go there (points to the text insertion
poilll on the screen). Any idea?
Is there an insert command.
1 don't tnow. 1 don't think so. (Starts reading the manual.) It says here you position the cursor wiJh the
mouse.
(Tries to move the cursor by dragging it thereby highlighting a piece of text) Ah. I see. (Still keeps dragging it
a few lines at a time.)

You want to put it down here.
That's a bit strange [the effect of the highlighting]. Can l make a suggestion about the cursor as well?

You want to try just putting it [the cursor] in.
(StiU tries to move the cursor by dragging it.)

.

Can you try and position it between and and the rest of the sente~ce .. What are you trymg to do.

(SLiU tries to drag the cursor to the text insertion point thereby highhghung some text.)
Why is il going black? What do you think?
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~ybe it was sort of blocking each line as I went over it. (Clicks the pointer without realising ) The cursor ba:
JUStmoved.
·
It says posilion the cursor with the nwuse.
~·s what I'm ttying to do. Why it's going black I don't know. (Moves the pointer

poml)

to

the text insertior

Try clicking it now.
(Does.)

Put the word in now.
(fypes in the missing word.)

4. Delete characters
Can we use just BACKSPACE Qr do you have to use the mouse. Lets see. (Presses BACKSPACE which
deletes lbe last character of the word she's just inserted. Re-inserts the character.) Ab, the cursor bas got to be
tbere.
How did you get il (the cursorI there in the first place.
It just followed. (Is still ttying to move the cursor by dragging it.)
Try positioning the cursor with the mouse.
When lbe cursor in not on text and do that (marks a blank line) ... (Starts using the arrow keys to position lhe
cursor.) That's cheating. (Positions the cursor and deletes by backspacing. Proceeds to delete the other
cbaracters in the same way.)
5. Delete words
Is there any way you can think of of just doing the word itself instead of just deleting each letter ofa word.
(Reads from the instructions.) You can mark the words with the nwuse and delete them. Can you[wi out
hew? You've got three words to delete.
If I delete words on that line first will it interfere with the other lines?
Any ideas?
(Positions the cursor and starts deleting by backspacing.) There ought to be something else. (Moves the pointer
over the words to be deleted without highlighting them.)
Any ideas?
(Looks atlbe Edit menu.) I'm going to see if there's anything in the menus. (Looks through the other menus.)
It says you can mark the words with the mouse.
The question is if you are using the mouse what key afterwards do you press.
Don't l:now. (Stans reading the manual.)
Because I was thinking if you position the mouse there (points to the pointer at the end of the word) it would
take away everything between it. [Seems to think that text can be marked by having tbe cursor at one end and
the pointer at the other.] (Means Lo press DELE1E but presses backslasb by mistake and doesn't realise.) I was
hoping it would take away the whole word.
How can you distinguish between that and a word?
Good question. You've got to tell it.
Any idea hew to tell it?
If you position the cursor before (points to the beginning of a word) and then click on that and tell it to delete.
For selecting te.xl it's got to be black.
What it was doing before with cursor (marks a piece of text) like that? (Presses BACKSPACE. Marks another
wocd and deletes it in the same way.)
6. Delete line
Ah, so basically (marks the line and presses BACKSPACE to delete it).
7. Double spacing
Any ideas on how we can double space it ?
(Pops up the Format menu.)
What are you looking for?
Well this is Format ... Or Style (looks in the Style menu). No. (Looks at Edit) That's strange.
Any ideas? (Reads the manual.)
No.
If you go back to the top of the document. It's something to do with the ruler thing.
(Scrolls back to the top of the document.) I wonder what these are? (Points to the spadng an? ~gnment icons.)
We11 soon find out. (Looks at the spacing icon more closely and then selects the double-spaong tcon.)
Thai's doM it.
8. Single spacing
.
And then you want it back to single. (Clicks on the double-spacing icon again.) How do you cancel tt?
How do you do that?
Or do you cbange it back to single space? (Clicks on the single-spacing icon.)
9. Centre paragraph
.
(Pops up the Fonnat menu and selects Insert ruler. The ruler is inserted one paragraph above where tt should be.)
Why has the ruler gone there and not where we are trying to put the ruler?
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d
(Pops up the Fonnat menu.) How do you cancel this? (Points at the ruler Clicks aro d th
to highlight it Presses BACKSPACE and deletes it)
·
un
e ru 1er an manages

So how can we gel the ruler?
(Points to the cursor.) It's lhe cursor lhere that's told it We've got to move it haven't we

How do we do that?

·

(Tries to move the cursor using the mouse by dragging it. Abandons this approach. Moves the cursor by using
the arrow keys.) Selects the ruler. (Goes to the Format menu and selects Insert ruler.)

How do we cenJre the text? Any ideas.

When we centre it what does it mean?

(Explains what centring is.)
{Points at lbe right align icon.)
Thas's mort lining it up to the righl.
(Points to lbe centring icon.) That one? (Selects it)

Yes, thal's cenlrtd. (Explains that only this paragraph is to be centred.)
Sball I pot the cursor there? (Points to the end of the paragraph.)
Well it hasn't done the text above has it?
No. (Points to tbe cursor.) Well, that's told it where to start [centring]. So if I put the cursor at the end. It was

on that before. (Clicks on left align icon.)
So whal are you trying to do now?
(Positions tbe cursor at the end of the paragraph to be centred.) Try it. (Selects the centring icon.)

Thas's still cenlred all ofit. You could use another ruler.
(Changes it back to left align.)

You want to centre that paragraph. Any ideas? It's done everything below the ruler.
Insert another ruler there (inserts another ruler).
And now whal are you going to do?
(Selects centring on the first ruler.) Then if I . . . How do I remove it? Before I made tbe ruler go black.
(Clicks around the ruler trying to mark it Marks it and deletes iL Deletes lhe second ruler in the same way.)

So we're back to the start again.
So there ought to be a way of keeping them.

So whal are you going to do?
(Pops up tbe Format menu.) Insert a ruler. Let's try again. (Inserts one ruler at lhe top of the paragraph

to be

centred.) And another one. (Inserts one below.)

We have to change that to centring now.
But why is it on left now?

Because there's one I ruler} at the top.
Do we change that?
No. Can we sort of hide them?
What. Hide rulers?
Yes, but we want to centre it first.
(Selea.s centring on the first of the two rulers.)

Yes, well done.
(Selects Hide rulers.)

10. Underline word, embolden word
(Pops up the Style menu.) Underline.
How do you do it?
Well you have to move the cursor. (Positions the cursor at the beginning of the word to be underlined.) Will
that underline all of it? Let's try it
What are you trying to do.
I reckon if we put the cursor there it will probably underline the whole lot from then on. Let's give it a go.
(Does and nothing happens.)

No.
(Looks at the Style menu again, selects another style and nolhing happens. Tries to move the cursor using the
arrow keys while highlighting Underline at the same time.) There's obviously somelhing you bave 10 do before.

Any idea how to tell it?
(Moves the cursor around the word.)

Any idea how to signal what you want to underline. How did you delete things?
(Marks the w<Xd.)

Are you trying to underline using the keyboard.
(Pops up the Style menu.) Yes. on the menu it says you can use that (points to tbe keyboard accelerator).
(Releases the menu and uses the keyboard sequence to underline the word. Moves tbe cursor with the keyboard 10
the end of the word to be emboldened. Tries to drag tbe pointer, thereby moving tbe cursor again.) Ob! (Moves
the cursor to the end of the word using the arrow keys again.) So! (Marks the word.) Bold. (Pops up lhe Styie
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menu to fmd out what the keyboard acceleraror corrunand is. Presses the keyboard accelerator to embolden the
wool.)
11. Cut and paste
Tbal's in Edit (Pops up the Edit menu.) Cut, Copy and Paste. Do I have to Cut and Paste?
Any ideas on lww ro Cut il?
~ should imagine you ~ve to black this before? (Tries 10 highlight the whole paragraph but can't quite manage
1~. Moves lbe. cursor w~~ ~e arrow keys to the end of the paragraph. Tries to highlight the paragraph several
~es: Each time repostuonmg the curso~ at the end of the paragraph with the arrow keys. Finally manages to
highlight the paragraph. Pops up the Edit menu to see what the keyboard accelerator command is and cuts it
using the command.)
Now you've got ro nwve it to the top of the document. Any ideas on how to do thal?
(Scrolls to the top of the document Positions the pointer.) Where is my cursor now? [Still doesn't undetsland
that the mouse has to be clicked to position t11e cursor.]
If you do il with the mouse.
(Saolls back down again.)
What are you trying to do now?
Trying to fmd my cursor. (Scrolls down the text.)
'l'Mre il is.
(Moves lbe cursor using the arrow keys.)
So whoJ are you doing now?
{Pops-up the Edit menu.) So Paste is that and V [the keyboard accelerator]. Uses the keyboard accelerator
command to Paste the text in.
U. Print
(Pops up the File menu and presses the keyboard accelerator conunand to select Print) [Tbe printer dialogue box
appears.] (Tries to select All arld Automatic even though they are selected. Selects Best quality and clicks OK.)
13. Quit document
(Pops up the File menu.) Quit (Presses the keyboard conunand to select Quit.)
Why do you keep on using the keyboard instead of the menus?
I didn't realise. Can you use the mouse? I'm totally used to using the keyboard. I've never had a mouse on any
computer I've used
14. Create a document
[Ran out of time.]
15. Save a new document

Comparison-Subject 5
1. Save file
(Clicks on the File menu.) Click on File (does). Oh, I see. (Selects Save.)

l. Change margins
(Points to the left band margin marker.) Will that one there .. . (Grabs the paragraph indent marker and drags it
to 25.)
That's about 25.
Ob, I see. (Tries to drag it back, accidentally highlighting the ruler.)
If you click on it with the pointer . ..
(Grabs the paragraph indent marker and positions it at 1.5.) I've used one of these [mouse] things before filling
in a golf COW'5e on a computer game. I wasn't very dexterous.
You've indented the first lines to J.5.
I can change the right to 6.5. (Grabs the right hand margin marker and drags it to 6.5.)
Yes.
Is that all you want me 10 do.
You've only indented the first lines of every paragraph.
Yes, I see what you mean. Have I been moving the wrong bit then?
What do you think?
(Inspects the icons on the ruler.)
What are you doing now?
.
1 don't know (clicks on the single-space icon). I don't ~w, fiddling. As you say ~ve only brou~t the~ ~f
paragraphs in. It says you have to change the left margm to 1.5 so that means movmg all of them 10 does.n t1t .
Yes. If you look at how you change the righl one.
.
What's wrong with it? (Grabs the left hand margin marker and drags 1t to 1.5.)
Yes, that's it.
3. Insert word
So you have to put a word in I suppose.
(Clicks on Search, and EdiL)
Now try and position the cursor with the mouse.
~~isthecur~now?
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I haven't a clue.
Well I've got to get the word "find" from somewhere. What cw I ... Ah! Of course mere's a keyboard sitting
there (laughs).

Yes.
Wbere's my cursor? (Clicks at the top of the window and selects Close by mistake.) I don't want that
Just Omcel.
(Does.)

Whal de you think will happen.
WeD somehow I've got to get myself a cursor on the screen. (Moves to the text insertion point and clicks.)
This is very easy. (Types in the missing word.)

4. Delete characters
Now you have to delete a few letters.
How do I move the cursor? (Does it again by highlighting and positions the cursor behind the first character to
be deleted. Deletes by pressing BACKSPACE. Proceeds to delete the other characters in the same way.)
5. Delete words

Now you have to delete a few words.
You can mark words with a mouse and delete them ... Ob yes. I've seen this done before, where you put them
in a block and blast them. So you've had enough of me deleting words have you?

No, you've got to delete "words words words".
Ob, I know. (Highlights two words and deleted them by pressing BACKSPACE. Tries to mark the rest of lhe
words but bas some problems with highlighting, because show doesn't realise that she can just click at where the
highlighting is to start.) I can't control this stupid thing. Keeping the button down when you're moving it ...
(Manages to mark another word and deletes it by pressing BACKSPACE.)

6. Delete line
(Marks the line and presses BACKSPACE to delete it.)
7. Double spacing
I could just go along and rid of lhe extra spacing in.

T'here must be something easier.
Edit (Pops up the Edit menu.) Cut? (Tries to select Cut even though it's greyed.) That didn't do anything.
Any other ways you can think of to change it?
H all I'm doing is taking out these extra bits of space ...
(Explains whal double-spacing is.)
(Highlights a blank line.)

What de you want to do?
Well, there's a blank line there. (Clicks, the highlighting goes.) No, that didn't work.

Have you got any other ideas. It's usually something very easy and you can do it for the whole document.
(Reads the manual.) It says h.ere at the top of every document in Mac Write there is a ruler with the prestfll
format which you can keep or change.
(Pops up tbe Format menu.}
AI the top of every document there is a ruler.
There's a ruler. Oh yes. (Clicks on the top of the window. Scrolls to the top and looks at the ruler.}

Can you see anything?
(Points tp the double-spacing icon.) That?

That's up to you.

.

(Points to tbe ruler.) Because that bit was just working on the margins. (Points to tbe double-spacing
tries to drag it) But you can't take it anywhere.

ICOO

and

Just try clicking on it.
(Does.) Ob it's done it for me already.

8. Single spacing

.

.

{Returns to tbe top of the document and selects 1.5 line-spacing. Then selects 6 hnes per mch.)
9. Centre paragraph
(Positions tbe cursor on top of the paragraph to be centred and selects Insert ruler.) Alrigbt. that wasn't clever
How do I get rid of it? Oh, 1 have put it in the right place haven't I.
Yes, now you've got to cefllre that paragraph.
.
.
Centte tbe paragraph . .. It looks pretty centre to me. What does that mean? Does tt have to be central tn the

Illge?
(Explains whal centring means.)
(Points at lbe centting icon.) Ob yes. (Clicks and tries to drag the centring icon.)

What are you trying do?

Well, that looked like the centre icon. Well if I just do it lhe way I did it back there. (Clicks on the centring
icon.)

That's cefllred everything.
Does that matter?
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You're only supposed to do tiUlt paragraph.
~tb~r ruler and we could change it all back. (Pops up the Fonnat menu, but unfortunately the ruler is
munediately below the first ruler. Pops up the Format menu again.) Can I move it?
Delete il or get rid of it.
(Highlights the ruler. undoes the highlighting, pops up the Fonnat menu.)

Anyilkas.
Want to get rid of that (points to one of the rulers).

We alS<J wanl another ruler as welL
Ah, well we can get a new ruler in there. (Selects Insert ruler. The ruler is inserted below the paragraph to be
centred.) lbis extra one here, does that matter particularly?

I suppose just having one would be better than two. How do we get rid of it?
Edit (pops up the Format menu).

What are you trying to do there?
Get rid oC lbe second one.
So lww do you go about that?
(Ftddles around and manages to select all of the rulers.)
How do you the words?
Well, you've got to mark itrst of all. You're deleting the words by deleting them from in front of the cursor.
(Points to the ruler.) Though this is not actually part of the text thougb is it?
How do you tell it the thing we want to delete is words?
Got to mark them with a black box. (Tries to highlight the ruler.) I had it black just there didn'tl. [fries to
fmd the points to click on a ruler to highlight it.) (Moves the pointer across the ruler.)

Try clicking it.
(Clicks. marking the ruler and presses BACKSPACE to delete it.) I'm sure I tried that but it didn't work.
And now you've got to pur the rest back justified haven't you.
(Clicks on the 1.5 sp~cing icon on the second ruler.)

No, that was the spacing thing. What did you do to centre it?
Well. to centre it I used that didn't I? (Points to the centring icon, then clicks on the justify icon.)

That's il.
10. Underline word, embolden word
{Pops up the Style menu and selects Underline. Nothing happens.)
Are you going 10 underline a particular word?
(Highlights a word and then undoes the highlighting.)

What are you trying to do?
Well I was thinking, to delete it you put it in a box and then pressing it But that didn't work.
So you put it in a box and then what were you supposed to do?
(Tries to drag the cursor again. Pops up the Style menu.) I can't remember did I use BACKSPACE?

That was for deleting. (Reads the instructions to her.)
(Pops up the Style menu again.) Yes, Yes, so I've got them down. I've got it down to Underline (highlights
and tbeo selects Underline). [Nothing happens.]
What were you trying to underline
Well. a word (Still trying to drag the cursor.)

Any idea.
(Manages to Wlderline a word.)

Yes.
(Selects Underline from the Style menu. Highlights another word and selects Bold.)

Bingo!
11. Cut and paste
(Marks a paragraph.)
How do you Cut it and Paste it ?
Tbat was on the (pops up the Edit menu). (Selects Cut.)
Now you've got to put it back at the beginning of the document. How do you do that?
Ob dear, what have I done?

It's disappeared.
I can get it back can't I?
I would presume so. Did you think it had gone?
(Scrolls to the top of the text, positions the cursor and selects Paste.)

Brilliant.
U. Print
.
?
(Pops up the File menu and selects Print.) [fhe printer dialogue bolt appears.] Quality Best. what do I do.

What do you think?
Pages, From 1 (types in I).

(Explains that it would be easier jus: lO have All selected.)

Transcripts-216

[Wants to enter 1.5 to 6.5 as the page range.] Enter? (Presses RETURN.)
13. Quit document
(Pops up the File menu.)
Any ideas?
I can't Quit until I put it back. (Selects Quit)
14. Create a document
Get a new docmnenl
Click twice on Mac Write.
(Does.)
[Runs out of time.]
15. Save a new document

Comparison-Subject 6
1. Save file
So those are the commands are they? (Points at tlle menu bar.)
Yes, so if you try clicking on File. (Points to File on the menu bar.)
(Points to tbe File menu.) And now select Save?
Try clicking on it.
(Pops up the menu and selects Save.)
2. Change margins
Tbal's Format isn't it? (Selects Align left) Is that 1.5? (Points to the position on the ruler and clicks.) Is that
right'!
What are you trying to do?
Try Format again, Align right (does). And 6.5. (Clicks on 6.5 on the ruler.)
No, it hasn't moved. There must be some other way of doing it.
Fomw.. that's what I did last time (points to Format on the menu bar). Format again (pops up the Format
menu). It says Align left. Justify? Oh, no, that's not right. Display? Set page, must be. (Looks at Set page.)
Ob no, that's wrong. (Clicks on the Style menu and leaves it) It must be Format. it can't be anything else.
(Pops up the Format menu again.)
(Reads the manual.) Setting Fonnat, that's the sort of thing you would do with this thing here, the ruler.
There are some markers on it. (Points in the manual.) There are some markers on il. Indentation marker,
tab marker, U!ft margin nwrker and right margin marker.)
How do I move the marker?
I think you just drag it. Click on it, press the mouse button, hold it down and drag it along.
Ah, I see I've got to get it to 6.5 inches (on the right hand side]. Ah, there it is (clicks on 6 lines per incb).
No. They are those lillie triangular things.
(Struggles to move the markers. Eventually manages to grab tbe paragraph indent marker and move it to 1.5.)
Now (points to the right hand margin marker) that must be the other one. (Grabs the right hand margin marker
and moves it to 6.5.)
I don't think you've quite got it there because what you've done there only indented the first lines of ~ery
paragraph.
(Points to the paragraph indent marker.) Isn't that the margin marker?
(Explains the difference between the paragraph indent marur and the left mtJrgin mtJrk£r.)
(Grabs the paragraph indent marker and drags it back to 1.0.) Is it that one? (Points to tbe tab Ulafker.)
No.
Thatooe?
Yes.
I lried to move it but it wouldn't move. (Tries to move it again and manages t.o position it at 1.5.)
ANJ the other one {paragraph indent mtJrker).
Tbe otber one's is at 6.5. [Subject thinks that he means the right band margin marker. The paragraphs are

exleOOed.]
3. Insert word
(Pops up Sean:b, then Font.)
What are you trying to do now?
I'm trying to find out the details of how I can put in extra words. Edit (pops up the Edit menu). Copy, Paste . .
. Paste, I'll try Paste (does). [The ruler is still highlighted and a message appears saying that the fJJ"St ruler
cannot be deleted.] Did I see insert? Edit, is it Edit? (Pops up Font.) What is Foot? (Pops up Edit.)
(Explains that the instructions say to click the cursor with the mouse.)
(Moves the pointer t.o the text insertion point) Can I just type it in? (Types the fl.rst character.) [Gets the
message explaining that the flfSt ruler cannot be deleted.) I want to put insert.
.
You've turned the ruler black and it wasn't black when we first started. It was whzte when we first started.
(Looks on Search.) Do I press RETIJRN to get rid of it?
Why did you do that?
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Because I couldn't think o_f any other way of getting rid of it [highlighting]. Tries to type again. [Gets the same
en:or m~ge.] Is there msert on here (looks at the keyboard)? No. (Moves the pointer to tbe text insertion
poml) Tnes to type again. [The same error message appears.) (Clicks on the left align icon.) (Very confused.
eventually moves the pointer to the text insertion point.)

Try clicking now.
(Does.) Probably won't be able to put anything in there. Just wondering what that flashing dash is?

1M cursor.

How do I move that now?

Tries to drag it.
How can I move that cursor? (Highlights a line of text.) I don't know how to insert tbat word.

Click MW.
(Presses BACKSPACE and the highlighted text is deleted.) I can't move that cursor.

(Tries to get the subject to de-select the 6 lines per inch option saying that it will make it easier for her to
position the cursor.)
(Higbligbts a line by accident.) Why is it that it makes that line go black? I don't know bow the cursor is
moved down. I haven't worked that out yet. It won't come with me wben I ask:.

So how are you trying to move.
I ttied to move that forked think [pointer) on top if it to see if it would move. It doesn't tell me bow to move
tbecursor.

(Reads the manual.)
(Presses RETIJRN a couple of times.)
What are you doing now?
I was trying to move the cursor but it wouldn't move.
It doesn't seem to say much in here [the manual}.
(frying to drag tbe cursor and eventually manages to get it to the text insertion point.)

Yes, there.
(Types tbe word in.)
4. Delete characters
(Still tries to move tbe cursor by dragging it.) Why doesn't it follow? Can you find out about the cursor?

I think you just click. where you want the cursor.
(Manages to position tbe cursor and presses BACKSPACE to delete the character.)

Try to get rid ofthe 6/ines per inch it'll make it easier.
(Does. Proceeds to delete the characters by backspacing but still tries to move tbe cursor by dragging it.
Highlights a line and a half and deletes it by pressing BACKSPACE.)

You've deleted a whole sentence.
How did I do that? How do I get that back? If I've got that thing on memory ... (Selects Save from tbe File
menu and presses RETURN.) [This makes the loss of tbe text permanent.]

5. Delete words
(Marks a word and presses BACKSPACE to delete iL Struggles trying to highlight the other words.)

How are you trying to delete the words.
I don't know wbat I'm doing. I don't know why when I'm trying to delete a word it's made the whole sentence go
black. 111 get rid of it all if I'm not careful. Does it say how to delete things?

(Reads the manual.) Select the words you want to delete.
It doesn't say how I actually do that.

(Reads the instructions out from the manual.)
(Moves the pointer around and accident.a.lly highlights a couple of lines.) See. it does that (Eventually manages
to highlight one word.)

Let go, now delete it.
Wbal., do I press the mouse again?
No.
(Does anyway and the highlighting goes.) How did I d~lett: be~ore? .

You must have done something else apart from h1ghilghtmg w1th the mouse.
(Highlights the word again and presses BACKSPACE.)
6. Delete line
(Highlights tbe line and deletes by pressing BACKSPACE.)

7. Double spacing
(Clicks on Fonnat.) That's the way I want the page. I would have tbougbt it be FormaL Can you look up
spacing.

It says here there are line-spacing boxes on the ruler at the top of the page.
It was as the top was it? (Returns to tile top.)

There. There should be some line-spacing boxes on there.
Which boxes does it say it is?
Those three in the middle.
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(Po~ts ~ single-spacing.) That's 1. (Points to lhe 1.5 line-spacing icon.) That's 2. (Points to the double line
spacmg tcon.) That's 3. (Selects lhe 1.5 line-spacing icon.) That's double-spacing.

8. Single spacing
(Returns to the top of the text and selects tJ1e single-spacing icon.)
9. Centre paragraph
(Returns to the top of the text. Clicks on Format.) Insert ruler (selects Insert ruler.) [The ruler is inserted at the
current cursor position.] (fries to drag tJle cursor and accidentally highlights some text and the ruler. Clicks on
Format and selects Insert ruler.) [The new ruler replaces the highlighted text and the fJist ruler. The subject
doesn't realise.]
Why did tM ruler go in there? (Points to the position on the screen where the ruler was inserted.)
(Pops up tbe Format menu.) Use ruler (selects Use ruler and nothing happens). That must be centre. (Selects
tbe rentring icoo from the inserted ruler.)

But, (points to the paragraph to be centred) it says here you're only supposed to cenrre the text in that
paragraph.
(Clicks on justify, then single-spacing.) That's single-spacing, that's the right one. (Clicks on the left align
iron.)
What are you doing now?
I'm blacking the whole paragraph. (Struggles, but eventually manages to highlight the paragraph.) Now (clicks
on the centring icon on the ruler). [All of the text below the ruler is now cenlred.) (De-selects and selects the
paragraph.) I did that and then centre and I thought it would centre that paragraph.

But what happens when you do do that [click on the centring icon] when you haven't blacked it?
Well, I wanted to tell that thing that I only wanted to cenlre that paragraph.
Everything else is centred here. (Points to the teXl below the ruler.)
(Clicks on left align. clicks on centre again, clicks on left align again.) Can you look up centring?
(Reads the manual.) Do you have any ideas?
I'm trying to set it aside from the otJ1er paragraphs, but I need to know how to change just that one paragraph.
bow to centre it.

Tlwse boxes, it seems to centre everything below the ruler.
Doesn't it say what to do if I just want to centre just one paragraph.

Well. everything see1ns to be done below the ruler. (Points to the ruler.) Why did it puJ the ruler in there?
(Selects Insert ruler from Format thereby deleting tbe paragraph which is currently highlighted.)
Why did you put tM ruler there. You've put it in the middle . ..
Ob. I see. But. I didn't even tell it where I wanted to put my ruler.
ClJII you get rid of the ruler it's not in the right place? [Doesn't realise that it has overwritten the paragraph
I() be Cenlred.]
(Selects Hide rulers. Scrolls down the text.) I don't recognise that. I think tlle paragraph bas gone?

Yes, we've lost the paragraph haven't we.
Yes I have. I don't know bow I did that How do I reclaim it?
Try.to cenlre to that paragraph, but not the rest (Points to another paragraph. Struggles, and eventually

manages to highlight the paragraph.)
What are you doing?
Ob, I have the feeling if I want to cenlre just that paragraph I have to set iL apart from the others.
When you were doing things with the ruler it was changing everything below the ruler.
I was trying to get the ruler down, but it happened to go in lhe middle and I don't know wby. (Pops up the
Format menu.) If I select Insert ruler how do I know where tbe ruler is going to go because I haven't told it?
What do you think?
(Selects Use ruler and nolhing happens. Presses BACKSPACE and deletes lhe paragraph.)

Now you've deleted the paragraph.
10. Underline word, embolden word
Underline a word and put a word in boldface.
(Pops up Font and FormaL)

Thai's in Style it says. (Points to the instructions.)
(Selects Bold and nothing happened.)
Just do a word in bold or unaerline it. What are you doing now?
(Marks a wool.)
Have a look at the Style menu now.
(Selects Bold.) Well done. That means I ought to find a word fJist and lheo press the boldface, rather than
selecting tbe boldface. So if I want to look at boldface I want to press tbat after. (Manages to Underline a word
as well.)

11. Cut and paste

,

(Struggles but eventually manages to highlight the paragraph.) If I manage to black out lhat paragraph tbeo ~ U
look bow I can move it. It must be Format (Pops up the Format menu.) No. (Looks at Search. then at Edit)
Paste (highlights Paste).
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Cuning lJ1Id Pasting.

~:u..:J.
.,...'
"6'...,.. ~·~tpearswiU.)it de lete it because I want to put it som ewhere else?.

(S e1ects Paste and the highlightt

It's go~ somewhere.
But, I didn't tell it ~.here to go. I'll loo.k a.t lhe top of the page. (Scrolls to tlle top of the lext.) It's not there
doo t know where at s gone because I d1dn t tell it where to go. I wanted it pasted but I didn't tell it where S~
should have actually told the thing where I wanted to move it to.
·
'

ll. Print
[Not completed because of lack of time.]

13. Quit document
14. Create a document
15. Save a new document

Comparison-Subject 7
1. Save file
(Clicks and the Flle menu flashes up. Nothing happens.)
Click again lJ1Id lwld it down.
(Does.)
And sekct Save.
(Does.)

l. Change margins
(Positioos tbe pointer on tbe ruler.)
What art you going to do?
I was looking at the margin rulings at the top. (Clicks on tlle ruler but no tlling happens.) Maybe 1 have to take
the cursor ...
Whal art you trying to do now?
I'm trying to move the margin out. It's a bit difficult. Ob, I might lry Fonnat. (Points to the Format menu.)

(Poinls to tht rukr.) You can move them [margin} with the mouu.
(Pops up tbe Format menu.) I'll see what Style is like. (Pops up the S tyle menu.) So, it's got to be ...
(Pops up the Format menu again.) Um, Align left. (Selects Align left and nothing happens.) No, that doesn't
belp.
(Reads the manual.) To drag the margin marker, you just position the pointer on the marker, press and hold
the mouse button and drag the marker, and then release the mouse button.
Is there anything ·...
Tht dart black ones, the black triangles. They are the margin markers.
(Clicks on the paragraph indent marker and drags it to 1.5.)
Thal's inlkmed it. (Looks in the manual again.) That one is the indentation marker the other one is the kft
margin marker.
(Points to tbe tab boxes on the left hand s ide.)
No, that o~ there. (Points to the left hand margin marker.)
(Drags the left band margin marker to 1.5.) Right.
And the righJ o~ to 6.5.
(Grabs tbe right band margin marker and moves it to 6.5.)
3. Insert word
You just try and insert a word.
(Puts tbe pointer at the text insertion point.) Okay, inserting. (Clicks on Spelling. then all t.be menus from
right to lefl)
Any ilkas how to insert a word?
(Moves the pointer to the text insertion point and clicks. StartS typing.) Will l.bat ...
Yes.
(fypes the whole word in.) I j ust put the cursor in the place and typed.
4. Delete characters
(Goes to Spelling.) Maybe I could just sort of de lele o n the actual . . . What would you use here
BACKSPACE?
Yes.
(1be cursor is positioned in the word in which a characler should be deleted. Presses BACKSPACE deleting t.be
wrong cbaracters.) I'll type them back in again?
Yes. You slwuld position the cursor . ..
(Positions the cursor correctly and deletes the character with a BACKSPACE. Proceeds to delete tbe other
characters in the same way.) [Occasionally deletes the wrong letter because she doesn't move tbe pointer off t.be
word and therefore can't quite see where the cursor is.]
S. Delete words
It says you can mark whole words with the tJWuse and delete them. Can you find out how?
(Goes to SpeUing.) Use the dictionary?
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Whal? See

if you can mark the words with the mouse

(M:rts a word with the mouse and presses BACKSPACE Proc
presses BACKSPACE.)
.
eeds to mark the other words one by one and

6. Delete line
So I do tbe same. ~ks llle whole line and presses BACKSPACE to delete iL)
1. Double spacmg
Well, 111 tty Format fll'SL_ See if they've got anything to offer. (Pops up tbe Format menu .) No (Po

Fool. Style, and ~n Spelhng.

Loo~ at Se~ch and Edit.) Have you got anything in that mere?

·

u
ps P

(Shantansdreadlng t~ manual.) Lme-spacmg, you've got line-spacing boxes on the ruler at the top where you
c ge the tabbmg.

Ob, the ruler.
It was at the top of the page, the document.
(Returns to the~ of the document) So the line-spacing boxes are which ones?
The three middle ones.
(Points to the single-spacing icon.) Well, that's obviously single. (Selects the double-spacing icon.) Righ•
that's iL
..

8. Single spacing
Single, that's back to . . . (Selects 1.5 line-spacing.) Is it that one?

That's 1.5.
(Clicks on single-spacing.) Right, okay.

9. Centre paragraph
(Pops up the Format menu.) Hang on, I need to use the ruler. Only in that paragraph.

Any idea.
PeJbaps I can scroll it up.

You have to insen a new ruler. What do you think?
Um, have you got anything in there?

You can align left. right, centre, and justify from the ruler.
I'll go back to the top . . .

But, you want just that paragraph there. You want to insert a ruler from Format. So we'll have to inurt a
ruler.
It's a bit inconvenient because if I go back up to tbe top 111 lose that paragraph.

So how are you going to do it?
I'll see what Format bas. (Pops up menu.) Insert ruler. (Selects Insert ruler.) [A ruler is insened at the CUITe.Dt
cursor position.)
You've insened the ruler . ..
In the wrong place. So delete ruler. (Pops up the Format menu again.) But how do you delete the ruler? I don't
know bow to get rid of it now. Perhaps I can delete the whole thing. (Clicks on the ruler. Pops up Search and
selects Change.) Change perhaps. [The Change dialogue box appears.]
No.
(Gets rid of the dialogue box. Highlights the ruler.) Will tbat delete it?
Try.
(Presses BACKSPACE and the ruler is deleted.) Shall I scroll this up perhaps.
Where do you want to put the ruler? What are you going to do?
Well the Format brings me the ruler again. (Pops up the Format menu.) I want lhe ruler to stay with that
paragraph.

So, how are you going to do that?

I was thinking of scroUing it up till (positions the paragraph to be centred at the top of the window). [Seems to
lhink that the ruler is inserted at the top of the window.] I wonder if lhat does it. (Selects Insert ruler.) [The
ruler is inserted at the same place as the previous ruler.]

That's put it where it was before.
I wonder wby it keeps going there? (Clicks on it and marks it again and deletes it by pressing BACKSPACE.)
Ah, this is getting to me. Oh, I see. It's where the cursor is. Right. so I have to move that Ob, we'll move
it (Tries to drag the cursor.) How do I move tbe cursor?
How did you move the cursor before when you were inserting and deleting words?
Yes, but 1 can't quite remember bow tbat moved. (Tries to drag it) I can't remember bow I moved it oow.
Perhaps I can go like that. (Uses the arrow keys to position tbe cursor.) So now I'm okay because the ruler will
go there. (Clicks on Format and selects Insert ruler.) Okay, now we've got to centre the text. (Looks at the ooexperimeoa.)
(Starts reading the manual.) It says there are some ?axes for alig~nt _and centring o~ the rule~.
.
Boxes, well these? (Points to the alignment icons. Pomts to tbe centnng tcon.) Well, thi.S loolcs like centnng.
(Selects tbe centring icon.) Right, okay.

Is it only in that paragraph?

.

Yes. (Scrolls down the text a little way .) Oh, it's not. Il's centred everytl"ung.
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So what else can we do?
We can move tbe ruler down and reammge the rest or ...
Put another in.
Put another ruler in. (Positions the cursor using the arrow keys. hesitates and selects Insert ruler.) Um, and that
will be that one. (Selects left align on the second ruler.) Alright
Well have a look. and go down.
(Saolls down.)
I think thai's just aligned to the left and before it was justified.
(Looks at lhe top rulex.) Oh, I see. (Selects justify on the second ruler.)
Can you malce the rulers disappear so you can't see them?
Yes. (Marks and deletes them.) [Doesn't seem to notice that the formatting bas gone.]

10. UDCierlloe word, embolden word
(Pops up the Style menu.) Lets try Underline. (Selects Underline and nothing happens.) Well, that's wrong
because it wasn't in the right place. (Positions the cursor at the beginning of a word using the arrow keys and
uses the mouse to mark it Undoes the marking.}
What are you trying to do?
rm trying to mark this word. (Positions the cursor at the beginning again and selects Underline. Nothing
happens.)
What happened there?
rm putting the cursor on the word I want, but nothing happened. (Select!> Bold and nothing happens.) This is
not very good. Format won't help me.
What have you tried before?
Well before I chose one of these menus. (Pops up tlle Style menu.) But the cursor doesn't go where I want it to
go.
It says here, editing and styling te.xr- you first make a selection and then act on it by choosing a command
from the menu. So I think you have to mark il and show it what you want.
(Positions the cursor at the beginning of a word.) So we'll show it like that. (Starts highlighting the word,
selects Underline. The word is underlined.) Right. (Marks another word and emboldens it)

11. Cut and paste
Do I have to ... (highlights the paragraph). Oh, I see. Let's try (pops up the Format menu).
Any others?
Style? Is Format not ... (pops Format up). What about this Insert page break? (Pops up Searcb, Change, I
cou1d Change it. Looks at Spelling.)
Which ones haven't you woked at.
(Looks at File.) There was one where I saw Paste. (Pops up the Edit menu.) Ab, let's Paste it (Does.) [The
paragraph disappears.] Has it gone? Oh no.
Why did you paste it?
I don't know. Is it sort of gone now. (Scrolls up to the top of the document) I thought I could Paste it and then
move the cursor to where I wanted to put it in.
What are you trying to do now with it?
I don't know wbere it's gone.
So have you wst it?
I think so. Yes, I've lost it. Is there any way I can get it back:. (Looks at File, Edit, selects Paste again.)
Maybe if I press Save or something. (Pops up tlle_Edit menu.) Can't Undo.
I think. you'v~ lost it.
(Selects Save.) Has it just saved what I've lost?
It's saved the whole document.

12. Print
Where did you go to Save?

.
.
.
Try again. (Pops up the File menu and selects Pnnt.) [The pnnter dialogue box appears.) Do you sort of
choose ... (Clicks on All and Best even though they are already selected.) Does that work?
Yes, bus it's already on all.
(Clicks on Automatic, even though it's selected. Clicks on OK.) [The printer status dialogue box appears.)
(Clicks oo Continue.)

13. Quit document
Leaving tbe document without saving the changes .
.Any ideas, suggestions?
But 1 bave saved. Do you want it back to the original? (Clicks on File.) Is there any way to get back to the
original version?
_ .
No, not from here. Just now leave without savmg ll.
Ob, I see. Do I scroll this up. I really don't ...
Try loolcing at File.
(Pops up the File menu.) I suppose I Close.
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Or?
Or Quit (Selects Quit.) Whcre's it gone?

14. Create a document

[Runs out of time.]
15. Save a new document

Comparison-Subject 8
1. Save file
Try cliclcing on File and selecr Save.
(Reads the instructions again.) I don't know how to do it

Click on File and select Save.
Click oo Hie?

Click on the word File there ar the lop.
Oh these apply to these. (Points to the names of the menus on the menu bar. Moves the pointer up.) Does it
mauer wbere it goes?
On the word Fik.
(Clicks, and menu flashes.) Why isn't it [the menu] staying there?
You hllve to lwld il down.
(Does.)

Now select Save.
Highlight iL (Selects Save as.) [fbe Save dialogue box appears.}

Click on Save.
{Does.) (MacWrite enquires "Replace existing ftle?" .]

No.
l. Change margins
(keads the insttuctions.) Now where are (points at the ruler) the margins here?

Any Ukas on lww to do that?
Can you do that using the tabulating as on a typewriter?
How would you do thai?
Well, oo a typewriter you set your tab to 1.5. Then you'd move over to the other side and set it to 6.5. You set
it using your tabbing key. I can't think of any way of doing it on this. (Presses the TAB key oo the keyboard
and nothing happens. Points at the ruler and highlights it. Points to the left margin.) Do we just type in 1.5?

No.
(fries to type 1.5 in and gets an error message "Can't remove or replace the first ruler· .) 1bat's obvious, so I've
got to move the screen across. Six lines per inch. (Points to the 6lines per inch option on the ruler.)
What are you trying to do?
I'm allowed 6 lines for every one inch is that right? I want to change my left margin to 1.5 so what I want to do
is tab along to 1.5. But, I can't do it (Selects 6 lines per inch.)

(Starts reading the manual.)
(De-selects 6 lines per inch.) There is something wrong because I new bow to do it on a typewriter.

It says here you've got indenJation markers and tab markers (pointing 10 the man.ual) which you can actually

move by dragging them with the mouse.
So, I've put it oo that and I can't move it.

Keep pushing it.
(Manages to drag the paragraph indentation marker and positions it on 1.5.) Now 6.5.

And the righl hand one to 6.5.
That's set now isn't it?

ThaJ's put the indentation in.
That's put the indentation in.

But it hasn't pul the margin to /.5.
But it hasn't put the margin to 1.5.
The little triangle is the left hand margin marker.
(Points to it.) I bad it on there.

No.

(Grabs the left band margin marker and drags it to 1.5.) What was it [paragraph indent marker] bef<n?

And the righl one to 6.5.
(fries to drag the right hand margin marker to t11e left.)

You've set the left one now to 1.5.
(Keeps trying. drags it off the screen, and eventually drags it back to 6.5.)
3. Insert word

Now and try and insert the missing word. You can position the cursor using the mouse.

(Moves me pointer to the text insertion point anti clicks.)
Putt~

word insert in there.

(fypes the wad "insert" into the correct place.)
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4. Delete characters
(fries to highlight one letter with mouse.) Is there a delete on this (the keyboard]? I've marked it but how do
you delete it?

How about BACKSPACE.
(Deletes ooe character in this way, proceeds to delete the other letters in the same way.)

S. Delete words

(Deletes tbe words by highlighting them and pressing BACKSPACE.)

6. Delete line
(fries to_ mark the line.) I'm leaving that [the cursor) behind. (On the previous line.} I need to lake that with
me.. ~nes to move the cursor by dragging iL Finally manages to mark tbe line. Positions the cursor at tbe
begmnmg of the line using the arrow keys and then highlights the line using the mouse.) Can 1 just use
BACKSPACE? (Does, and the line is deleted.)
7. Double spacing
(fries to mark tbe paragraph.)
Why are you trying to do that?
I'm thinking I'm doing it wrong when you say that. I was going to highlight the line, just the one, and move it
down.

You've got to double-space the whole documeflt.
The whole document I've got to double-space the whole documenL I don't know how to set iL So I should be
able to set il I need to bring back a menu and select double-space if there is such a function . How do we bring
bad a menu? Well, in theory, it's not just this line I'm doing the whole document. In theory I could just go to
tbe eod of tbis line and return it and that would double-space it for that section. What about a function key?
Wbat do these do these function keys do (points to the function keys on the .keyboard). There sbould be a
function ... I don't know.
(Starts reading tht manuaL) It's got in here look there are some line-spacing boxes (points to the manual).
How do I bring up my menu [Presumably means the ruler)? Do I have to go all the way back or can I just bring
in my menu here?
That was on the ruler. Tlull wasn't a menu. (Explains again.)
But I need to get back to this [the ruler].
Yes.
So if I go back all the way up to the top of the page I would have lost where I am. Or can I mark the whole
document anyway?
(Manages to get back to the top of the document. Points at the spacing icons.) 1 need double-spacing. I've got
to choose one of these. (Points at tlle line-spacing icons. Points to the double-spacing icon.) Is l.ba1 double?
(Selects il)

Yes.
8. Single spacing
(Points to the double-spacing icon.) If I click on that and go all the way down the document (Clicks on tbe
icon and drags the mouse down.) Let's just go down the document that should automatically do it? Do I have to
go all the way through? Let's go back up. (Points to the single-spacing icon.) That's tbe single line spacing.
(Clicks on it.)

9. Centre paragraph
From Format. how do I get Format at the top of the page? (Points to the manual .)
Thai's the ruler.

I sbouJd be able to bring up a menu. (Points to the close window square.)

No. You want Format at the top.

(Pops up tbe Format menu.) I have to - I'm not aligning am I. I'm inserting the ruler (does). (The ruler is
insened in tbe paragraph below the one to be centred.]
Whtre has il inserted the ruler?
Wbat am I doing? I take it I can just move this (left margin marker] andre-select a new ruler. Is that possible?
Just like I set is to start witll.

What do you do to centre text then?
To centre text you can just centre it.

(Points to the alignment icons.)
Ob yes, it's bere. That. one (selects the centring icon).

Now thal's centred below. But you want to centre just this one. (Points to the para_graph above the ~~.)
So I have to move this lot back up. (Highlights the paragraph to be centred and clicks on tbe centnng tcoo
again.) And that sbould do it.
No.

I would have thought it would. If I've highlighted it it means I've cbosen the text that I want to do it. So that
means 1 have to get this [the ruler} up hers [points above tbe paragraph to be centred]. The rul~, I have ~call
up the Format again. I have to get rid of it [the ruler} first. (Highlights the ruler.) Can I move 1t up? (fnes to
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drag it. but it oo;sn't work.) There's got to be some way to move it. (Points to the tab markers.) Wbat are
these arrows bere..
(Explains.)
How do I get rid of it [tbe ruler] then? (Marks the ruler again and presses BACKSPACE to delete it) So,
(marks the ~b ~ be. centred) Format, I want the ruler back. (Selects Insen ruler which is pasted over the
~grapb V.:hicb was htgbhghted.) [Doesn't notice that she's deleted the paragraph to be centred.] Am I centring
this one (pomts to the centring icon).

WeU the paragraph you want is not there.
The paragraph is not there.
The one you highlighled Where is it?
(Points to the ruler.) Isn't it under that? That [the ruler] covered the last paragraph that was under it (points to
the paragraph below).

You didn't cover (mark] the last paragraph. The ruler was insened in the middle of thai one. It (the ruler]
put itself in the middle of it.
In tbe middle of it So I take it the paragraph is above that [the ruler].
Any ideas?
I've got to get rid of Ibis [the ruler] again. and bring back my paragraph.
So whaJ are you going to do now?
I want to get rid of it [the ruler].
How did you get rid of the previous ruler?
Highlight il (Highlights it and presses BACKSPACE to delete it.) (Moves the cursor upwards.) Now I've got
to fmd my puagrapb.

It's gone.
I highlighled it and I pulled down the Format. I didn't actually Edit it did I?

It's gone.

It's pobably gone tO another part of the text. I need to find it (Pops up the Search menu.)

I think il's gone.
How did I make it go then? I highlighted it and put a ruler in its place. I would have thought that you would
bave to use a delete function to delete text. Nonnally it asks you "Are you sure you want to delete this? Yes or

no".
10. Underline word, embolden word
I'll tell you wbat to do rather than do it. [She's become very cautious since losing the paragraph.] I would
highlight it. bring Style, and if tbat's got Underline do it.

Do it.
(Highlights a word and highlights Underline on tbe Style menu.) Will it underline the whole thing or just the

ooewmt?
WhaJ do you think?
We'll see. (Selects Underline and the word is underlined.)

Can you do a word in boldface as well?
(Pops up tbe Style menu and selects Bold.) Oh no. I didn't highlight my word. (Highlights a word and selects
Bold.)
11. Cut and paste
(Highlights tbe paragraph.) Don't know what it's going to offer. (Pops up the Style menu.) No. Will it be
under Format? (Pops up Fonnat. Highlights Set page. Looks at the File menu. Pops up tbe Edit menu.)
Cut. Copy and Paste there. (Selects Paste.) But I haven't told it where to go I tbin.k. That means I've got rid of
another bit

What's happened then? What were you trying to do?
I was taking a piece of text and in fact lifting it off tbe paper what ever you call it and putting it up to tbe top.
Transfer the text from one section to another. But instead I've ...

So you've highlighted it and selected Paste.
WeU you bave to tell it what text you're choosing, but then you normally tell it where it's got to go. I pasted it

nowhere.
Culling and pasting.

.

.

.

I sbould bave Cut it ftrst. (Looks at the Edit menu agam.) So I should have fust cut 1t then pasted 1t
Thai would be one way of doing it.
.
.
That would be the long way round. But in theory I should be able to cuttt and paste tl

Can you get il back at all?

Search (pops up tbe Search menu), Find (selects Find). Find wbat? (Realises it's about finding words.}
Go 01110 the next one. Print the docwnent.
12. Print

(Looks at Edit. tben the File menu.) Print (selects Print). [The printer dialogue bo~ appears.] (Loolcs at tbe
options.) Do we cancel or do we want to print?
Click. on OK.
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Ob. I want Automatic paper feed (selects il).

[Even though it is already selected.]
13. Quit document
(Pops up lbe File menu, Edit, and Fonnat.)
You just want to leave the document.
Can b~~:.t under File? (Pops up the File menu. Highlights Close.) Save, do we need 10 Save it?
<Seic:cts Cl~.) (MacWrite asks "Save changes before closing?".] No. (Selects No.) So hopefully all tbe b1· 1
15
got nd of will come back.
14. Create a document
(Goes to File and selects Open.) [Get's the File Jist up.) What have 1 got here?
(Explains.)
(Goes to File and selects New. Types a document)
15. Save a new document
(Pops up tbe Ft.le menu.)

Shall we Save it?
(Selects Save as.)
(Enltrs a jilt name.)
(Clicks on OK.)

Comparison-Subject 9
1. Save file
I'm going to click on File. (Flashes the File menu.)
It says click on File and select Save.
How do you save it?
Try clicking it and holding the button down. Can you now select Save?
(Does.)
2. Change margins
Has it something to do with this line across the top? (Points at the ruler.)

Have ago ...
(Reads) ... six lines is one inch. Don't know, don't understand that.
If you look at the fiUlrgin at the moment it's not set. You can set it to 1.5.
I'm not following it

(Reads the manual.) It says drag the margin markers to where you want them There are on the lint with
numbers on.
Yes. (Points at tbe left margin and paragraph indent marlcers.)

There, those things there. That's one of them.
(Points to the 6lines per inch.) Does lhis mean 6 of them [markings on the ruler] equal one inch?

No, it's got nothing to do with that. (Reads the manual.) It say's that is the standard lyfN!writer spacing
option. It's the spacing of the lines to the inch. You should set the tabs there.
(Points to the left markers again.)

Yes, drag the to 1.5.
(Points to 1.5 on the scale and clicks.) [Nothing happens.]

Try clicking on it, holding it down, and dragging it.
Alright. (Drags tbe paragraph indent marker to 1.5.) Right.

Can you do the other one as well? Thai's just indented the first lines. It hasn't actually done the margins.
(Moves to tbe right hand margin marlcer and drags it to 6.5.)

Can you go back to the beginning and do the first one there. (Grabs the left hand margin marker and drags iJ
to 1.5. Clicks again and marks the ruler by accident.)
3. Insert word
(Moves the pointer to the text insertion point and clicks.)

Type it in now.
(Does.) Do I need to press RETURN? (Does.)

4. Delete characters
(Positions the cursor behind the first character to be deleted and then marks it. Presses BACKSPACE to deJece
it Proceeds to delete the other characters in the same way.) [Ibis sa little tedious because it is difficult to marie
just one leuer.)
5. Delete words
(Marks a word and deletes it using BACKSPACE. Highlights tbe otber words and deletes them using the
BACKSPACE key.)
6. Delete line
(Marks the line and deletes it by using BACKSPACE.)
7. Double spacing
Have I got to format it or somelhing? (Click on !be Fonnat menu and looks at all the options.)

What are you looking for?
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Spaces. None of them seem to apply really.

Any other ideas?

<P?PS up the Style menu, Font, Search,

then Edit.) How about Undo typing? (Selects Undo typing.) [This
brings the last line which she delete back.)
You Med to delete thaJ line there.
(Presses BACKSPACE to delete it.) I'm stuck.
(Reads the manual.) It says here changing line spacing there's some boxes on the ruler thillg a1 the top of

the document. Change the space boxes.

Yes, they're gone. [The ruler is not visible at this poinL]

Can we get them back.
Scroll it (Returns to the top of the document.)
There are single space. one and a half, and double-space boxes.
Sorry.
In the middle. 17wse three boxes.
Yes. I want double-space (points at the 1.5 spacing, then at the double-spacing icon.) Tbat?

Yes.

(Selects the double-spacing icon.)

8. Single spacing
(Points at the 1.5 spacing icon.) Is that single-space? No (selects the single-spacing icon).
9. Centre paragraph
(Goes- to tbe Format menu.) Centre . . . (Selects Align centre, and nothing happens.) Has that done anything
diffe.rcm?
Can you see any difference?
No. Was that for all of them or just for that one. How do you get it to do just the one paragraph?
(Remis the instructions OUl aloud.) I suppose we have to insen another ruler.
(Highlights Insert ruler.) We should try for that one. (Selects Insert ruler.)
Slwuld be abk to make it centred . ..
(Points to the centring icon.) Is it that? (Selects the centring icon.) Ah, I've done it to tbe wrong paragraph
have I.
You've doM it to everything below the ruler. So what do you think you should do?
Get rid of that one.
Get riJ ofwhiJJ?
I don't want to centre this one [paragraph] just that one (poinL<; to the paragraph to be centred). This ruler needs
to be below there (points).
Yes. So how do you think it should be done?
Pressing Format again. (Selects Insert ruler. A second ruler is inserted below the first one.)
What's happened TWW?
(Points to the alignment icons on the second ruler.) Put it back like it was. What was it like. (Points to
justify and then left align.)

It was justified. It was justified right and left I think.
That one? (Selects align justified.)
What are you going to do now?
(Pops up the Format menu, selects Insert ruler.) I don't know how to get rid of Ibis one [the paragraph above the
one to be centred and have just that one [the paragraph to be centred].

You've done it three times TWW and the rulers have all gone into the same place, one after the other.
Right. I don't know.
(Reads tM manual.) Do you want to get rid of those three rulers. or ...

Yes.
How can you d1J that?
I don't know. I think I need some help.
(Reads the manual.) I can't find anything here. Can you try and see if you can do anythillg to actually get
rid of it.
(Points to the rulers and clicks, but nothing happens. Goes to Edit. Goes to Edit again.) Is tbere anything
helpful under Edit?

You must be able to delete a ruler somehow.
(Pops up the Format menu, but doesn't find anything.)

How do you delete letters and words?
You move tbe cursor on it and highlight (Points at lhe ruler and clicks.) BUl that's not doing anything.
Can you make it go black or something.
(fries to highlight it again. Selects 6 lines per inch by mis take.)

Can you change that back.
(Does.)
Try clickillg higher up in the ruler.
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(Does, and marks one of the rulers. Presses BACKSPACE. Marks the second and third rulers and deletes lbem

as well)

. How can we get the ruler to go in above the paragraph there. (PoinLs above the paragraph to be centred)

(fnes to move tbe cursor by dragging it)

What are you trying to do now?
How do you get tbe cursor to go down there?

Just lf'IOVe il to where you want it and click it.
(Positions the cursa and selects Insert ruler.)
What tkJ we do 110w?
(Looks at tbe spacing icons.)

You want to centre the text.
(Selects the align centte icon.) That's that
You've centred tlu! one down here as well. Can you make that go back to the other way?
(Marks tbe ruler.)

Well. can't you put another ruler in.

What. leave that one and put another one in there [below the paragraph to be centred]?
Yes.
Is that okay to leave it black [the ruler is highlighted] or? (Moves the pointer below the paragraph and clicks to
position tbe cursor. Selects Insert ruler.)

Don't you want it to be justified.
(Selects tbe align justify icon.)
Can you make them [the rulers] disappear so that we don't see them?
(Marks lbe rulers and presses BACKSPACE thereby deleting them.)
Oh, you're just deleting them?
Is that what you said?

No. We've gone back to where we were before.
So I have to do it again. (Puts lhe rulers back in and centres the paragraph.) [When positioning the cursor sbe
always clicks at the current position first before clicking at the target position - as if picking up the CUJ"S()(".)
(Ask.sfor the rulers to be hidden.)
(Goes to Edit and selects Undo ruler change, then Redo ruler change. Pops up the Format menu.) Ab! (Selects
Hide rulets.)

10. Underline word, embolden word
Try and IUiderline one ofthe words Any ideas how to do that.
(Pops up tbe Style menu. Marks a word and selects Underline.)
Can you put a word in Bold also?
(Marks anocber word and selects Bold.)
11. Cut and paste
Edit (pops up tbe Edit menu). (Points at Cut, which is cmrenUy greyed.) Urn!
You've got to try and move the whole paragraph up.
(Looks at Edit and tries to select Cut, which is greyed.)
Whal are you trying to do?
Some.bow cut this bit [paragraph] out and move it to the top.

How do you tell it what to cut?
These three lines here.

How can you tell it which lines you want?
(Starts m.arlring.) Do you do lhat?

Yes.
(Maiks the ~graph and selects Cut.)

Now put it at the top of the document.

.

.

.

(Scrolls to lbe top of the documem and positions the cursor. Tries to select Copy, wbtcb IS greyed. twlCe.)
What are you trying to get from there?
(fries to select Cut, which is greyed.)
Try pasting it.
(Does. and the text is inserted in the correct place.)

ll. Print

Now you can prinJ the document.
(Hesitates, tbeD selects Print) [The printer dialogue box appears.]

What now?

I don't understand this sort of [the dialogue box], what it's trying to say to me. Do I have to ftll things in before
I print it?

(Explains the options.)
(Clicks on OK.)

Tran scri pts-22 8

.4

13. Quit document
(Pops up tbe File menu and hig hlights Quit.) Press !bat one?

It's up to you
(Selects Quil)
14. Create a document
Jfyoujust click rwice n MacWrite.
(Does. Types a document)
[Runs out of time.)
15. Save a new document

Comparison-Subject 10
1. Save file
So it's point at it is it? (Points at the File menu Clicks and no thing happens.)
Hold it down.
(Does, and highlights Save as.)
No you walll Save.
(Selects Save.)
l. Change margins
What do you think. we should do?
WeU go over there I suppose. (Moves the pointer to the left band side of the document) What's it oo at t.be
momeoL (Reads from the ruler.) 6 lines per inch. I'm stuck. What are these things (poiniS to the icons oo the
ruler)."
Whal do you think?
I don't know. Let's have a look. (Clicks on the s ingle-spacing icon, and nothing happens. Clicks on the 1.5
line-spacing.) Ob, what have I done there?
What do yDu think you've done ?
Ob, it [tbe text) has gone down hasn't it? And tl1e lines have gone from that one (poiniS at the single-spacing
icon).
Can you put it back?
I don't know. (Clicks on single-spacing.)
(Starts reading tbe manual.)

It says here you've got markers on the ruler thing. That ruler. there's some markers on iJ and you can mow:
them by dragging on it. The black triangles.
(Points at tbe right band margin marker.)
That'll be the right one. So you move that to 6.5.
(Starts dragging it and eventually moves it to 6.5.)
Ifyou can do the left one to 1.5.
(PoiDIS at tbe tab marker.) So the white one is the left one.

No.

(Goes to tbe left.) This one is a bit complicated. (Grabs the indentation marker and drags it to 1.5.)
Thai's the indenting marker. Can you drag the other one.
Ob, righl So, 111 move that one back again?

No.
(Grabs t.be left band margin marker and drags it to 1.5.)
3. Insert word
Now you·v~ got to insert a missing word there or something or put iJ in the sentettee.
So we need a gap?
Can you pUI a word between the "and" and the "the".
(Moves tbe pointer between the two words.) Format ...
What are you thinking of doing?
Maybe it's in the things up here. (Points to the me nu bar.) But I don't lmo w whicb o ne to do. We doo't want
Edit We don't want Font. (Returns to tlte text insertio n point and clicks to positio n the cursor.)

Yes.
So there's tbe cursor.
Can you just put the word in?
That might be a good idea, but wbere's tl1e word.
You can pUI any word you want to in. Any ideas?
I doo't k:oow where I ge t it from .
What are you thinking ? What are you trying to do?
How to get tbe word to go there.
.

.

.

.

So whal are you looking f or? Are you look1ng f or anythtng tn parttcular.

Some command with . . . Let me look at tl1ese [the menus) and see what else ... (Looks at the menus. Pops
up the Formal menu.) Insert ruler, Insert page break .

You can just type in a word or a sentence.
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Well I need a gap fiCSt. (Looks at the Format menu.) Maybe it'll just appear. Can I just try this?

Yes.

(Starts inserting spaces by pressing the space bar.)

So you're just pushing the space bar?
Yes.

So what's happened.
(Posi~ns the rursor at the beginning ~f the space she's cr~ated. Types the fiCSt character.) Ooh! (Types the
word m.) Now there, we need to get lt back together agam. [Presumably means closing the gap.) (Presses
BACKSPACE and deletes the last character she's typed. Re-inserts it.) Can I leave it like that?

Yes, if you want to.

4. Delete characters
(Positioos the cursor.)

Which "v" art you going to delete?
I don't know. Do I need to have a space here? (Presses the space bar. Finally manages to deleted the character
after sevetal re-positionings and backspacings.) Somehow I'm not doing this right. Is there a delete buuoo oo
this? {Even though she's just been using it.] (Uses the arrow keys to position the cursor and deletes the other
characters using BACKSPACE.)
S. Delete words

You've got four words here and you want to delete three ofthem. It says here you can mark them with the

mouse. Can you think how to do that? Any idea?
(Pops.up the Format menu.)

So what are you doing now? What are you looking for?
See if there's anything that just says like you know . . . (Looks at Search.) Change. (Reads the instructions.)
You can mark tbe words with the mouse. (Drags the pointer over a word and nothing happens.) You can rnat'k
them with tbe mouse ...
(Explllin.s that she has to mark the words to identify the te.xt to be deleted.)
Oh, I don't know. (Pops up the Edit menu.) Select all. (Pops up the Style menu.) No, I can't lhink wbal to do.
~the insttuction again.) You can mark words with the mouse and delete lhem.

(Starts reading the manual.) Selectte.xt, press and hold the mouse button and drag it across the word
How do you get text?

Well, tM text on the screen.
Ob, right (Maiks a word with the mouse.) And now what?

Delete the word What about BACKSPACE?
(Presses BACKSPACE and the word is deleted.) Got it. (Highlights the other words and deletes them using
BACKSPACE.)

6. Delete line
(Marks the line and deletes it using BACKSPACE.)

7. Double spacing

Ay idea bout how to do double-spacing?
Insert another line.
For tM whole document.
(Pops up the Format menu.) Insert ruler, Insert page, Insert Page break. Insert ruler. We don't want a ruler, or do
we? (Reads other options.) Set page (selects Set page). New page number, no we don't want that (presses
Cancel). 1bat was a waste of time.

(SilJTU reading the manual.)
(Pops up Format again.)
Any ideas?
(Selects Insert ruler. Points to the spacing boxes.) Those ones there? (Points to the double-spacing icon.) Is
that douiJie..spacing?

Yes.
(Selects"iL) Yes. yes.

It hasn't done the bit at the top of the document.
WeU we don't want that anyway.

It say you slwuld do double-spacing for the whole document.
We go to tbe beginning flfst I suppose.

Yes.

So we want to go up. (Does.) Right. (Points to the 1.5 spacing icon.) Is it that one.
Thai's 1.5 spacing.
So that's one's rigbt?

No. It's the other one.
Ob right (Clicks on double-spacing.) So now we've got the stupid ruler in there.

Can you get rid of it.

.

.

.

Yes. (Pops up the Format menu.) Hide rulers. I don l want to htde both I only wam to btde one.
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Surely

if. you p~t it i~ there must be a way of getting rid of it completely.

Well, ho~ did I get tt? I mserted a ruler ... maybe if I. (Selects Insert ruler again.)

You ve got two now.

I had that Cancel thing. Edit. &lit, &lit. (Pops up lhe Edit menu.) Undo Insert ruler, yes. (Selects it. Pops up
the Edit menu again.) Redo Insert ruler. Now what?
Can you get rid ofthe other one as weLl?
I suppose I could delete it but that would take ages.

How would you delete it then?
1be wbole thing?
Yes.
I don't know. (Clicks on it and manages to highlight it Clicks somewhere else and the highlighting is gone.
Highlights it again.)
So how do you delete?
(Presses BACKSPACE and deletes it.)

8. Single spacing
What do we do? (Scrolls back to lhe top of lhe text and points to the 1.5 line-spacing icon.) So this is single?
(Points 10 tbe single-spacing icon.) Oh, this one. (Selects single-spacing.)
9. Centre paragraph
(Points 10 the Format.)

What are you going to do.
Centre the text Is it not already in the centre?

No, it's justified right and left. (Explains wh~t centred te:a is.)
(Pops up the Format menu and selects Insert ruler.)
There must be something for centring it.
There, there, that one. (Points to the centring icon.) But only in lhis paragraph. If I do that surely all of that
(points to the text below lhe ruler) will be centred as well.

Yu.
Don't know. Maybe if I put a ruler there (points above lhe paragraph to be centred) and a ruler there (points
below the paragraph).
Yes, why not. What are you going 10 do about that one {the ruler previously inserted).
Get rid of it (Selects Undo insert ruler from lhe Edit menu.) Where is the stupid cursor? (Positions the cursor.)
I want the cursor 10 be there.

Yes.
(Goes 10 Format and selects Insert ruler.)

And now centre it.
So if I do it now then everything below it will be [centred].
(Positions tbe cursor below the paragraph and gos to Format and wants to select Insert ruler.)

Are you not going to centre it then?
Do you want me 10 do it now? But !hat will do everything.
But you can stop that.
(Selects centring.) But !hen all that's centred as well.

Now you can put ...
Ob, right. (Pops up the Edit menu.) Undo rule change. We can forget that for now. (Goes to Format.) No,
wait. (Positions the cursor below lhe paragraph and then selects Insert ruler.) Insert the ruler there, and then we
want 10 (selects the align justify). And then I want to get rid of all these rulers don't I.

Yes .
I did that befoce dido 't I.

You deleted them before.
(Pops up the Edit menu.) Under ruler change, no. So I have to delete them? I don't know.
What do you think?
I don't know. (Looks at the menus. Pops up the Format menu.) Can we bide them? Or do we want to get rid
oftbem?
Hilk them. What do you mean by get rid of them?
Well we don't want them. If we hide them will it hide the first one as well, or does that not matter?

Not really, but it's up to you.
Ah, well delete them. (Proceeds to delete the second one. Realises that it's undone tbe formatting . Inserts the
ruler again and changes the formatting.)

So whal is the other option then?
Hide it I suppose. (Pops up the Format menu and selects Hide rulers.)
10. Underline word, embolden word
..
(Pops up the Style menu.) So can I just underline now? Where's the cursor? (Positlons tbe cursor at the
beginning of a word and selects underline. Nothing happens.)
What are you trying to do?

Transcripts-231

~Pops up the Style menu again.) Underline. But you have to tell it wbicb word you want don't you? I would've
JUst put the ~r there, bu~ (Pops up the Style menu and selects Underline. Nothing happens.)

Well you ve got to relltl somehow what you want to underline.
Yes. (Pops up Style again.) It says 9 point here.

(Explains what point sizes are.)
Ah. So we've got to. (Positions the cursor within a word and selects Underline and nothing happens.)

Could we mark. the word itselfdo you chink.
(Marks a word and selects Underline and the word is underlined.)
Om you put another word in boldface?
How do I get rid of the black again.

Just click somewhere else.
(Malts aoolber word and selects Bold.)

11. Cut aDd paste
Presumably (marks a paragraph) you do that first. (Pops up File, then Edit.) So Cut it first and then . ..
(selects Cut).
What are you going to do now?
Pasting it (Points at Edit.) I better go to the beginning flrst. (Starts scrolling up.) It [the paragraph] bas gooe
now.
Yes, so what are you trying to do now.
(Positions the cursor at the top.) Put it here. (Selects Paste.)
U . Print
(Pops up the File menu and highlights Print.) How do I get it to print it all?
What de you want to do now?
(Scrolls to the top of the text) Then it will do it all.
What are you going to do now?
Well I have to black it all . . . (Proceeds to highlight the whole document.) But you couldn't really do thls with
a big thing [document). {Selects Print) [The printer dialogue box appears.] What do I do here then? Do I just
do OK?

Yes
Quality, All, Automatic?

Yes.
(Clicks on OK.)
13. Quit document

How de you think. you can leave the document?
(Pops up tbe File menu.) Save as.
_
_
Do you want tc save it. It says we should JUSt leave II?
Quit?

It's up to you.
Can I not save it as it was before?
No.
So. I just quit and that's it? (Selects Quit.)
14. Create a document
[Runs out of time.]
15. Save a new document

Comparison-Subject 11
1. Save file
I don't know what to do.

Try pointing al the command at the top and clicking.
(Fumbles for a wbile, finally clicks on File and selects Save.)
l. Change margins
(Doesn't UDder~ what 10 do.)
_
_ :>
(Explains what a margin is.) What do you thznk you need to do to change the margm . Change the left
margin?
I've got no idea.

,

.

:>

Do you see anything on the screen that s gomg co help you.

(Points to the ruler.) Maybe I've gotlo move that [ the scale].
Whal do you think. it is?
Some kiod of measurement. Would it be Style? (Pops up the Style menu .)
Whal exactly are you looking for now?
.
.
1 just wondered if Style had anything 10 do with the way 1t was lrud out. So if you wanted

ID

move it across . . .

But there seems to be nothing in there.

And if you try something else.

(Pops up the Format menu.)
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Is there anything in th£re?
I don't know if these would be any good (points to the bouom part of the Format menu).

What do you think th£y miglu do?
(Highlights Align right)
. ~h do ~ou want to do? Do you want to move th£ left margin?
(Highltghts Altgn lefl Nothing happens.)

What's that done?
Nothing really. So that's no good.
(Pops up the Edit menu.)

Try something different see if anything else happens.
(Selects Align right.} [The paragraph in which the cursor is is set to align right] It's done something to the
paragrapb.
Why did it do that paragraph?
Because the cursor was there. So if we put the cursor on each line - would that work:? (Positions the cursor in
anoeber paragraph and selects Align right)

What has that done?
(Points to the line.)

It's just moved the first line. That's where th£ flashing cursor was?
Yes.
It doesn't seem to be doing th£ right thing. Where do you think the left margin is at the moment?
Where is it?

Yes.
(Points to the left hand side.) All of this is the left margin (points to it).
(Explains to her again what margins are.)
(Selects Align centre from the menu.)
The paragraph below you selected Align right. What is that currently aligned to? How jar right has it
gonl!?
6. I don't know what the measurement is.

Is there any way the program might be telling you how jar righl it's gone?
(Points to the scale on the ruler.)

All the lines start on a different position on the left. But on the right hand side, where do they all finish?
That's 6.

And on the left in the other paragraphs where does that start?
That's 1.

I think you're meant to put it berween 1 and 2.
Ob, I see.
Do you think that this at the top [the ruler] tells you anything else apart from Jww far across the page you

tn?
(Points to the spacing and alignment icons.) These might be patterns in which the page might be set out

Anything else?
I don't know. I'm confused. I'm not sure what I'm supposed to be doing.
Shall I look up left margin for you? (Starts reading the manual.) Okay, it says on the ruler thert 's a

~ft

margin marker and a right margin marker, little triangles like this (points in the manual). And it says to
change them you just drag th£ marker to where you want it.
With the cursor? (Points to the left margin and paragraph markers. Tries to drag them. Marks the ruler by
accident)

Try moving it [the mouse] when you press it as well.
(Grabs the paragraph indent marker and drags it to 1.4.)
It says the left margin marker is th£ triangle.
(Moves the left margin marker to 1.5. Points to the paragraph with the modified formatting .) I have to put that
back DOW don't I?
Ahah.
(Sets the three top paragraphs back to align left)
The first line of each paragraph is slightly different. /wonder if we can get that back. The margin's now

1.5 isn't it?
Yes. (Selects Align left from the Fonnat menu.)
That didn't do it.
No. (Clicks on the second line in the paragraph and selects Align left.) [Nothing happens.)
If the text is at th£ right hand margin, marked by the triangle and there is something further left than thal . .
lbere's that one (tbe indent marker] .

I wontkr what that does. Yo11 moved that didn't you?
Yes. Shall I move it back?
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Move it somewhere else.
Do I move it back to 1? (Does.)
We have to change the righl haTUi margin as well to 6.5.
(Does.) [Moves oo, but the paragraphs are extended.]
3. Insert word
(Moves the pointer to the text insertion point and clicks the cursor.)

You Willll to type a word in.
Okay. I doo't have to move these [the other words] across?
Try it anyway.
(fypes tbe word.)
4. Delete characters
(Positions tbe cursor with the mouse. Clicks before and after the letter to be deleted.) Can you actually put the
cursor oo the letter?

Which letter did you want to get on to, the one you wanted to delete?
Yes.

WeU you can't get on the letter. You go ne.xt to a letter somehow.

(Positions tbe cursor again.) Then {pops up Spelling, Format, and Edit). I'm stuck.

Ifyou were using another machine what would you do?

You'd put lbe cursor on the letter and press delete. [Obviously she is used to systems which use a block cursor.]

Is there any button which says DELETE on it?
Not tbat I can see, no. Shall I try pressing a few?

Yes.
{Looks at tbe keyboard.)
Whal do you think BACKSPACE would do?
Go back I suppose. [Interprets BACKSPACE as back one space.]
Do you WiUiltO try it?
{Presses BACKSPACE and the character is deleted.)
So thal did delete one ofthe v's?
Yes. (Proceeds to position the mouse and delete another character by pressing BACKSPACE.)
(Explains thal BACKSPACE deletes to the left of the cursor.)
(Proceeds to delete the rest of the characters in the same way.)
S. Delete words
(Positions lbe cursor at the end of the word and presses BACKSPACE. Hesitates.)

Do you want to delete the whole word?
Yes.

Maybe you can delete all the letters.
(Proceeds to delete by BACKSPACING over the whole word. Deletes some of the other words in the same
way.)

Did you find out how to mark words?
No.

How do you think words might look when they are marked?
With a black border.

Was that the black border you had before ?

Yes.

Do you remember how to do that? Try and do it again.
I think I did it accidentally before.
Perhaps you can move the mouse at the same time aTUi pressing the button.
(Does and bigbligbts a word)
How do you delete it?
(Presses tbe BACKSPACE key.)
That seems t have done it.

6. Delete Hoe
(Marks tbe line and deletes it by pressing the BACKSPACE key.)
7. Double spacing
So double-spacing means that the space between the lines is twice as big as it is now.

Did you su how to do that earlier?
No. (Pops up Edit, and Fonnat.)
Did the ruler have anything?
Can't remember.

Do you want to have a look and try?
(Scrolls to lbe top of the document and looks at !he ruler. Points at the paragraph indent market.) Would it have
anything to do with those ones.

That was the margin wasn't it?

Transcripts-234

/

(Points at the left margin marker.)

Yes that was the margin. That was rig/11 What do the boxes on the ruler mean?
·

(Points at them.) Wbat these?
The 7 boxes yes.

I would bav~ th~ught it would have to do with the layout of the lines. (Looks at tile boxes again Points at the
·

dou~~g tcon.) Maybe that would give it the extm spaces and make it bigger.
(Selects it)

There's quite a lot of space there isn'tthere?
(Selects 1.5 line-spacing.)
How much space do you think there is between the lines now 'l
I suppose it's double what it was before. {Difficult to tell.]
·
8. Single spacing
Can you get it back to what it was before.
(Clicks oo tbe single-spacing icon.)
9. Centre paragraph
Perhaps we could centre tbe text. but only in this paragraph. But that's different. That's got nothing to do with
a new ruler. [Seems to remember the align commands from the Fonnat menu.] (Pops up the Format meou and
selects Insen ruler.) [The ruler is inserted in the wrong place.]
Where did the ruler go. Where did it put it?
Here (points to it).
Why did it insen it there?
Because of the cursor. (Points to it.)
Because ofwhere the cursor is. That's right.
But we want it here. (Points just above the paragraph to be centred.)
Thai's righl.
(Positions the cursor and selects Insert ruler.)
Oklly. And now you want to centre the text.
(Hesitares.)
(Expiojns what centring is.) So how do you mLJke the lines move towards the centre.
Move this (starts dragging the left margin marker). Would the centre be exactly half way between the two?
(Positions tbe left band margin marker midway along the scale.)
The tut isn't in the centre any more is it?
(Puts tbe left margin back ilO 20.)
Well you did something similar before when you tried to put the margin all to the left or all to tM rig hi
didn't you?
(Pops up the Fonnat menu and selects Align right)
So what did that do? That's all right aligned. How do you think you could put the text in the ceTilrt?
(Pops up tbe Fonnat menu again and selects Align centre.)
Right.
Do I have to press it again? [The paragraphs don't look properly centred because of the difference between the
indentation and the alignment.)
Okay. See if that makes any difference.
(Selects Align centre again.) No that doesn't make. any difference. So that's it.
Yes, so that's centred.
10. Underline word, embolden word
(Pops up the Style menu. Positions the cursor at the beginning of the word and selects Underline. Notlling
happens.)

Thal didn't do it. What do you think it did?
What did it do? Nothing as far as I can see.
Anything you could do?
Put it in the black outline. (Marks the word and selects Underline. Marks another word and selectS Bold) What
does boldface mean?

(Explains.)
(Pops up tbe Style menu again, selects boldface again thereby de-selecting it.)
What has that done there? Try again and see exactly what you did?
(Selects Bold again.)
What do you think il's done? Can you see any difference between the old word boldface and the new word

bokfaa?
(Removes the highlighting.) Yes. It looks darker.

Th4l is bold.
11. Cut and paste
Should I put it all in black outline.
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Yes, put it in black.
(Marks the paragraph. Points to Edit.)

What do you want to do exactly?
Move it to the beginning.
_By ~uning and pasting. What do you think that means?
Taking 11 out and moving it up I suppose.

Oktly, how do you take it our?
(Selects Cut)

So now move it to the beginning.

(Selects Paste.)

Where did it move il to?
Just put it back where it was.
Do you think there is any way of . ..
If you move tbe document back up maybe.

So do you want to cur it our again?
(Marks tbe paragraph again and selects Cut. Scrolls 10 tbe top of l.be document. Positions tbe cursor and selects
Paste.)

Where did it pur it exactly? How did you tell it to pur it there?
By putting the cursor there.
U. Print
How do you think you can tell it to print?
I'm oot sme at all.
How do you think you might be able co tell ir? I mean it's a command isn't it?
Yes.
So where would you find the command?
I doo't know.

Would it be on the ruler?
I wouldn't have thought so.
So if you don't think it's on the ruler . ..
(Pops up Edit.) Are we going to tell it to Copy?
Why do you thinlc it's Copy? Where else could it be?
(Pops up FtJe menu.) Print I better put the cursor back to the beginning. (Does. Selects Print.)
[Runs out of time.]

13. Quit document
14. Create a document
15. Save a new document

Comparjson-Subject 12
1. Save flJe
(Points 10 the File menu and clicks on it twice. Pops up the File menu again and selects Save as.) [The save as
flle dialogue box appears.]
(Tells subject to click on Save.)
{Does.)

l. Change margins
Do you blow what the left margin and right margin are?
Well, that's sort of the tabulator isn't it?
(Explllins what the margins are.) Can you find out lww to change them ?
Well, we want a list of commands don't we? Try Format (pops up the Format menu, selects Align left).
[Nothing happens because the cursor is not in a paragrnph.}

What does that do ?
Welllbe cursor moved . ..
Try again.
(Selects Align left again.) [The paragraph with the cursor in is left aligned.]
Did you su it do anything ?
(Selects Align left.) No I didn't see anylhing. (Selects Align left.) What else is there (pops up tbe Format
menu). Wbeo it says . .. let's get rid of that [the Format menu] then. [Lets the menu go and selects Hide rulet's
by mistake.] Oops.
What did you do.
It doesn't matter. It says left margin to 1.5.
(Explains again what the margin is.)
What is font? Pops up the Font me nu.
What did you actually do last time?
(Pops up the Format menu again. HighlighlS Set page.) I put Set page.

You didn't actually press that did you?
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No. What does Set page do?
Can you select the Show rulers? Back a1 the top {of the Fornull menu} you selecud that by accitk111.
lbat would be a good idea then. (Selects Show rulers.)
. That's okay, you'v~ got the ruler back now. Now you want to move the left margin to 1.5.
(Pomts on the ruler wath the pointer.) Which is that one. (Clicks, thereby highlighting tbe ruler by accident
Clicks again and nothing happens.)
Where do you think the left margin is at the moment. Does the ruler tell you where the left margin is a1 the
moffUnt.
It's at one point something. Looks like it's between there and there. (Points to tbe left and right margin markers
and the space in between. Points to the right margin marker.)
So you want to change that to 6.5.
(Grabs tbe right band margin marker and drags it to 6.5 .)
Yes, that's 6.5.
(Grabs tbe paragraph indent marker and drags it to 1.5.)
What has that done?
That's just tbe indentation of the paragraph. So I'll have to drag this other thing. (Drags the left hand margin
marker to 1.5.)

3. Insert word
TMre's a missing word. Do you want to rype it in where it should be?
(Moves the pointer and clicks in the correct position. Drags the cursor thereby highlighting the space.) Urn!
Do I bave to make a space there?
Thai's a space already. There is a space between the two words.
So sball I try to type it in? (Starts typing the word.)
4. Delete characters
(Positions the cursor behind the character to be deleted. Pops up Edit, File, then all tbe other menus.)
Have you seen anything that might help you to delete the teXJ?
(Looks at the Spelling menu.) Spell word'! Can you look at the dictionary perhaps? (Selects User dictionary.)
[The dictionary dialogue box appears.]
What do you think that does?
It gives you a few options here what to do.
What do you think that does?

Remove leuers?
From what?
(Looks at the dialogue box again.) Ah, I see. I don't want this. How do I get rid of the whole thing? (Doesn't
know bow to get out.)
(Tells subject to press Cancel.)
(Pops up the Spelling menu again.)
.
.
. .
.
I don't actually think you should do It by usmg the d1Cl10nanes 7
Okay. (fries to highlight one Jetter.)
Okay, you want to delete one leuer. How do you think you can do that?
Type over it
But here you want to get rid of it altogether.
. . .
.
(fries to move the cursor by dragging it and therefore keeps on htghhghtmg pteces of text. Marks tbe whole
wool)
You just want to get rid of the /euer don't you?
(Positions the cursor behind the letter eventually.)
You've got the cursor in there now.
(MaaXs the letter.) Press delete?
Ahah.
Is tbt7e a DELETE button?

Ed~ the Edit menu, lets it go again.)

(Pops

Yes, there is a

d~lete.

There should be. (Looks at tbe keyboard.)

1bat one? (Presses the left arrow key, which remove the markmg.)
What did that do?
Just moved tbe cursor. (Marks the letter again.)
What other keys could you press?
SPACE? BACKSPACE?
Try BACKSPACE.
dra · · Stru gles to positioo
(Presses BACKSPACE twice. Tries to move the cursor to the next word by
ggmg tl.
g
the cursor.)
What are you going to do ?
I want to move the cursor down t11ere.
.. .
You've done it before. Didn't you just press the mouse burron to posawn II 7.
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Them~ button? (Still tries to drag the cursor from its current location. Eventually decides to position tbe
cursor usmg the arrow keys and uses the mouse to highlight the word to be deleted. Deletes by pressing
BACKSPACE.)
(Tells the subject to position the cursor by clicking the mouse and then just using BACKSPACE to delete.)
(Does, aod J¥()Ceeds to delete the remaining characters in the same way.)

S. Delete words
(Marks a word ad deletes by using BACKSPACE. Deletes the other words in the same way.)

6. Delete line
(Marks the line and deletes by pressing BACKSPACE.)
7. Double spadng
[Subject believes lhat double-spacing refers to tbe spacing between words.]
(Explains whol double-spacing is.)
(Pops up Flle, Format, and Style.)
So what are you looking for? Are you looking for the word double-space somewhere?
(Pops up the File menu again.) Page setup? (Selects Page setup.) [Page setup dialogue box appears.] (Selects
Cancel Goes lbrough the menus again.) No.
(Explaills again whal double-spacing means.)
What else rould you try if you can't see it on the menus? (Goes through the menus again. Selects Set page, and
cancels il)
Whal did the ruler do?
(Selects Iosen ruler. Points at the spacing boxes.) What are these llhings here? (Points to the double-spacing
box.) Ah, that. (Selects it.)

Is that doubiL-spacing?
Well, that looks like two lines between each line. [Difficult to tell.]

How could you get slightly less?
Here. (Selects 1.5 line-spacing.) So the other one would have been triple-spaced?
Okay.
8. Single spacing
Try and change it back to single-spacing.
(Selects Iosen ruler and selects single spacing on it.)
Couldn't you hnve used the old ruler for that?
Sooy?

Is the old ruler still on the page?
(Scrolls up.) Yes, we've got two rulers.
Maybe you could delete one ofthem.
(Can't work out bow to delete a ruler.)

.

How do you delete several characters at once or a word. There mighl be a way to deiL~e a ruler like thai.
(fries to mart the ruler by clicking on it and can't find the right spot) I'm not sure there IS.
You tnlJik a ru/Lr go black a while ago. Try to click on it somewhere.
(Clicks on 6lines per inch by accident)

(TeUs the subject to de-select the 6 lines per inch option.)
(Pops up the Edit menu.) No. (Pops up Format)
How did you make the ruler go black?

Go black?
Um.
With the cursor. No idea.

Can you just press the mouse button on the ruler somewhere?
(Does and immediately highlights Ule ruler.)

And you want to . . .
fi
I can delete it. (fries to click mark the second ruler as well. Presses the BACKSPACE key deleting the 1fSt
inserted ruler.)
Now thal double-spaced again. Can you select single-spacing?
(Does.)

9. Centre paragraph
Centre the text in the middle of the page?
Ahah.
But it is isn't it?

(Explains the difference between centring and align justifY.)

.

. .

(Mumbles) ... move the ruler then. (Tries to grab the left markers and marks the ruler by acctdent) I ~dn t
want to do that (Moves the paragraph indent marker to the left. Moves both the left m.arlcers to 1.) That s DO(

aured.
That's still not centred. No.
(Points to the right band margin marker.) That one to the end?
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Try.
(Drags the right band margin marker to 7 .)
Thai's still not centred is it?
Wba~ it's straight on both sides?
That's righl.
(Brings the right band margin marker back to 6.)
Explains cenlring again.
(Points to alignment icons on the ruler.) Oh, I see. (Selects lhe left align icon.)
What did thal do?
(Poincs to the line-spacing icons.) Those ones make them aJI tbe same length and (pointing to the alignment
icons) these ones don't
How doesn't that one make it the same length, the one you just pressed? What difference would thai rna.1ce
to the screen?
Um. (Clicks on single-spacing.) It's on lhat one. (Clicks on right align.)
What's the difference?
Well it's aligned it so that it's straight down lhis right side. (Selects left align.) So it's straight down that side
[left], but it's not centred. (Points to the centring icon.) How about tbal one? (Selects it.) That's not centred.
That's centred between the two margins.
It is? So that's cenlred then. [The subject didn't really what centring was supposed to look like.]
[Subject moves on to next task.]
19. Underline word, embolden word
(Pops up tbe Style menu - all choices are greyed since the ruler is still highlighted. Tries to select Underline and
nothing happens. Tries again and nothing happens.)
Doesn't let you do that does it?
(Pops up the Style menu again.) Do you use the letter "U"? [The keyboard accelerator.] (Tries to select
Underline again.)
It's not letting you do anything at all.
{Pops up the Style menu again. Points to the point size options at the bottom of the menu.) Is this thickness
of the line? (Tries to select a point size.)
Which word do you want it to make underlined? Say you wanl to I1Ul)re it underline the word Ulllkrline.
(Marb tbe word underline, thereby de-selecting lhe ruler. Pops up the Style menu and selects Underline.)
That's worked hlLsn 't it? Can you get the word boldface printed in boldface?
(MaRs the wool boldface and selects Dold.)

11. Cut and paste
(Pops up Style, then Edit.) Yes.
So it's Cut and Paste.
(Pops up the Edit menu again.) Oh yes. Okay. (Marks the paragraph and selects Cut)
Now you wanl to move it to the beginning of the texl.
(Starts scrolling up and scrolls to the top of the text and selects Paste.)
Where has iJ [the paragraph] gone? That's exactly where it was. . . Why did it put it there? Why did it
paste iJ there?
Let me just have a look at this. (Pops up the Edit menu.)
How do you tell it where to paste it?
How should you tell it? (Looks at the Edit menu.) Select all? No. Oh, press it ... (Marks the paragraph
again .and selects Cut.)
How do you tell it to paste it at the top?
(Scrolls to the top of the document and positions the cursor.) Put the cursor there. (Does and selects Paste.)
12. Print
(Selects Print.) [The printer dialogue box appears.]
(Explains the options.)
(Selects a different qualily .) That's it lhen.
How do you get it to print?
(fries to pop up the File menu.) OK. (Selects OK.) [The primer status box appears.) (Tries to cliclc on
Continue.) [lbe document is printed.)
13. Quit document
(Pops up the File menu.) Quit
No, thal's quit the whole program.
Page setup. (Selects Page setup.) [Page selup dialogue ~x appears.)
You just want to leave the docwnent and try somethrng else.
(Clicks on Cancel.) Save as?
It says not to save at all.
Oose? (Selects Close.)
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14. Create a document
Now you want to start a new document and write a Letter. How do you -to that?
(Pops up lbe Ftle menu.) ~ew: (Selects New.) What do I do, just type? (Tries to position tbe cursor lower on
the empty pa~e by draggmg 1t. [Cannot understand why he can't position tbe cursor anywhere on a blank
documml Tnes to use the arrow keys and gives up.] Starts typing a docwnent.)
15. Save a new document
[Runs out of tim.e.]

Comparison-Subject 13
1. Save file
(Clicks oo File and selects Save.)
2. Change margins
W1Jal do you think the Left margin is now?
One.
Why is it one?
(Points to the left markers.) Because it's in line with !hat one there. I presume tbat's tbe margin.
How do you change it?
Under Format would it be? (Pops up the Fonnat menu.) Can I Aliign left?

Try and set, .see what they do.
(Selects Align left.)
What did that do?
I don't know.

Go and see what Align right does.
Do I have to go back up to Format.
0/cay.
(Selects Align right.)
What did thai do?
It's moved that over (points to the aligned paragraph). Moved the cursor bit over.
How far across did it move it?
Tbose are inches are they . . . six inches. (Points to the left side of the scale.) This one wants to be 1.5 then.
So do you go to Format, select Align left and point to bow many inches. (Selects Align left and points to 1.5
oo tbe ruler and clicks, accidentally highlighting the ruler.)

What are you doing? Why do you think the right halid side ten was a1 6 inches?
It's in line with that there [the margin marker] straight down. So do we want to move this lot over to 1.5 and
that lot over to 6.5?
Yes. How do you think the program is telling you where the margins are at the moment.
By puUing the scale up on the top, and you just read it off.

It is telling you explicitly where the margins are at present? Or do you just think it's thue so that you
know where to put it in in the future?
What do you mean?
Well is iJ telling you at the nwment IVhere the margins are?
Yes, as far as I'm reading it off. (Looks at the ruler.) What about one of these things (alignment boxes). Are
these to do with lines, and moving it about.
What do you think tlwse 4 do?
Tbey seem to align it all up on the left, on t11e right and ... This is the one I want because they'll give us an
even margin. (Selects the align justify.)
That hasn't done anything has it?
No.
What are tlwse little blobs there, those shapes on the ruler?
Um, tbal is wbere it is at the moment yes? The right margin. (Points to the right margin marker.)

How do you think you can change it?
(fries a few times then manages to move it to 6.5.)

Is thai whal you wanted?
That's 6.5 isn't it?

Okay. &> can you do the left one as well.
(Grabs tbe paragraph indent marker and drags it to 1.5.) Missed a bit haven't we?
What eXJJCtly .h as it done?
It's dooe it into paragraphs hasn't it when a new line's started. I want llle wbole lot in. (Grabs tbe
margin ma:rker and drags it to 1.5 as well.)
3. Insert word

left hand

Do you want to type the word in there?
. .
Can you do that? I have to move everything along then if I want to putn m?
Where do you want to move it to ?
.
I'll have to move this, "the missing word", ru1d all the rest won't I. [To the nght.]
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And you want the word "find" before tflar.
Well, I want to type it in.
So lww do you do that?
B~ to Format? (Pops up 1.he Fonnat menu.) No, I don't think it's thai. one. Edit (pops up !be Edit menu), yes
that s the~- . Cu~ C~py, would that be a Cut? (Selects Cut) (Gets a warning !bat !be ruler can't be deleted.)
[lbe ruJez- 1S still highlighted.]
Why is it talking about the first ruler? Why did it think you wanted to cut out the first ruler?
What's the fust rulez-?
(Points to it.)
Ob tha1 will be the size of the page won't it?
Why did it think you wanted to do something with that?
~Y
I pushed Cut rul<: or something. Cut down !be size of !be page or something? Got to get rid
of It now. (Clicks on OK to get nd of the dialogue box. Returns to !be sentence where !be word has to be
~.) I want to move these across, all the sentence.)
Why don't you try to type the letters "find" in first?
What, just in there? (Points to the text insertion point)
To the left of that don't you?
I just type it in above it. (Starts typing. Again gets the message that the ftrsl ruler cannot be deleted because
the rulez- is still marked. Clicks on OK to remove the message box.)
Where did you want the texJ co appear? How do you make it appear there apart from just typing them?
How are you telling the computer you want the letters there? What about the cursor?
So do I have to go and click? (fries to position the cursor by dragging it from its current position.) So how do
I move the cursor about? Can you just move the cursor somewhere or do you have to make it all black?
Is there some way you can put the cursor sort of up on the mouse and then position it where you want it?
The cursor id there at the moment. What would happen if you just put in the word "[md"?
Well I could move them on this as a word. (Types "find" at the current position.)
So the letters went in where the cursor is, but you actually wanted them to appear between those two words.
Where would you put the cursor if you wanred it to appear between "and" and "the".
(Tries to move the cursor by dragging it. Manages to position it at lhe text insertion point) Shall I just type it

becau_se

. ?
m.

Why don't you try it?
(Types the word "find" in.)

4. Delete characters
So I want to move the cursor again in front of lhese extra letters. (Looks at the keyboard.) There should be a
delete button on here somewhere.
Which one do you think it might be?
I don't know. On the olher hand is it one of those with an arrow? Shall we move it? Might as well get it there.
(Positions the cursor by dragging it.)
So how would you delete that?
. .
.
BACKSPACE? (Deletes the character hy pressing BACKSPACE. Deletes the remammg characters m the same
way.)

S. Delete words
We've got w<X"ds now.
How are we going to delete those?
(Positions the cursor at the end of a word and proceeds to delete by backspacing. Proceeds to delete the other
words in tbe same way.)
It says here yott can mark words with the mouse and delete them. How might you mark words with the
mouse?
(Marks a word and deletes it.)

6. Delete line

So I've got 10 get rid of the whole line ~ow. (Still struggles to position lhe cursor. Eventually manages to
mark the line with the mouse and deletes 1t.)

7. Double spacing
.
Double-spaced as in the type being double-spaced and the hoes.
Yes, thal's right.

·
· ) N tha bas 't done
A style would that be? (Pops up lhe Style menu. Tries to select a larger pomt stze.
o,
t
n

aoytbing.

What else could you do?
.
.,
Format again. (Pops l!lp the Format menu.) Can ~ou .do that wtth a ruler, 1t s at !be top. (Selects Insert ruler.)
Or ooe of these perhaps. (Selects lhe 1.5 line-spacmg tcon.)
Is that double-spaced?
Did I just do that?
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8. Single spacing
Do you wanJ to change that back?
(Selects single-spacing.)

9. Centre paragraph
Insert a new ruler. (Pops up the Fonnat menu and highlight Insen ruler.)

Where's ir going to insert the new ruler?

Don't know. I'm not quite sure about these rulers. (Reads the instructions again.) Insert a new ruler.

But where do you want to insert it?

Between lbese (points above the paragraph to be centred).
How would you tell it to do that? Where did it put the last ruler?
B~ ~ CUJ"SOI'". (First tries to position the cursor by dragging it. then highlights the paragraph

10

be centred.

Higbhgbts Insert ruler.)
Whal are you trying to do exactly?
(Selects Insert ruler, which is inserted over the marked paragraph deleting iL)

~tat has disappeared
Or is it uodel" tbe ruler? It's disappeared somewhere.
Maybe you did the wrong thing.
Yes.
You can undo the cJu:mge somehow.
(Pops up tbe Format menu.) Hide rulers? (Selects Hide rulers.) No, that [the text] is still lose
See ifthue are any other commands.
Searcb f<X" iL (Pops up the Search menu.) I could find page 1. Are there no pages numbered?
You are on page 1. Where was the text you wanted to fllld, was that on page 1.
No, that was on tbe second screen. Does each screenful count as a page?
Might be a page on the printer. So, how do you think you could undo the change? I think there's a
command for it somewhere.
Ftle (pops up the File menu). (Pops up the Edit menu, then lets it go.)
It says something about undo there ...
Can't Undo.
Ok/Jy, maybe we've lost it altogether. Try and centre that paragraph.
(Inserts a ruler immediately below the another one which is now displayed also. Pops up Format menu.) Align
centre?
See whal thal does.
(Selects Align centre from tl1e Fonnal menu.)
Don't think so. What's happened to the cursor?
Tbe cursor's gone to the centre ...
Try moving the cursor to the text ofthe paragraph you want to change.
(Marks tbe paragraph to be centred l:>ut then marks one of the rulers at the same Lime, removes the marking.) I
don't want to black it out. got rid of it all last time I did that. (Marks the paragraph again and selects Align
centte from tbe Fonnat menu.)
TluU's righJ. that's in the centre.
How do I get rid of these rulers now?
Don't worry about that.
10. Underline word, embolden word
Sballl uodetline "underline"?
(Higbligbls tbe word.) Style. (Pops up the Style menu and selects Underline, then selects Bold.)
11. Cut and paste
(Marb tbe paragraph.)
What are you trying to do?
I've seeu that moving and pasting under Edit. (Pops up the Edit menu.) Cut (Selects CuL)
And it wanted you to paste it at the top of the document didn:t it?
.
(SeroUs to lbe top of the document and positions the c ursor.) EdiL (Pops up the Ed1t menu and selects Paste.)
12. Print
Is that tbere? (Pops up Edit, then File.) Print. (Se lects Print.) fThe printer dialogue box appears.) Wb.al have
I got Automatic feed? From what to what?
What does that mean?
Well from the computer onto a bit of paper.
I'm not sure it means that. (Expla ins what it means.)
(Clicks on some selections even though they are selected.) And now tell it_~K? (Clicked on OK.) [The printer
status box appears.] Continue, yes. (Clicks on Continue even though 1t IS greyed.) [The document starts
printing.]
13. Quit document
How do you leave the document.
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(Clicks on Hie and highlights Save as.) As what?
You'r~ not supposed to save it.
Quit. yes?

Closl!~ would leave the program, but you still want to do something else.
Try thaJ.
(Selects Close.)

14. Create a document
You Wanl a new document, a new file aClual/y.)
(Pops up tbe Hie menu and selects New.) I wanted a new document I got one. (Looks through the menus.)
What are you looking for?
L~king for if you want to write a letter it might have something in it. [A standard letter format.] (Starts
typmg.)

15. Save a new document
~re is the save? (Pops up the File menu and selects Save.) [The save file dialogue appears.] (Looks a1 the
list of current names. Clicked on the Save box which is greyed.) Save.
You need to give it a name.
(Eoten a name and selects Save.)

Comparison-Subject 14
1. Save file
(Pops up the Flle menu.) I'm trying to get onto Save. Do you use these? (Points to the arrow keys.)
No. You can just pull it down.
(Selects Save.)

2. Change margins
(Points to the ruler and tries to click on 2.5 on the scale and marks the ruler by accident.) Wby isn't it doing
anything?

What are you trying to do?
I tried to click there. That's 1.5 isn't it?
Where aboUls do you think the margins are at the moment?
(Points to the left markers.) Ob, is that the margin?
How about the right margin?
(Points to the right band margin marker.) There. (Returns to the left markers and tries to move them.)
You tlwught the right margin was at6 and the left was at I? What makes you say that, because it looks it?
(Points to the left and right markers.) It's just these two.
Do you think these control the margin? How might you change them?
(Points to the 2.5 again.) Is it here?
If you move the left one to 1.5.
Ob, I see. (Points to 1.5.) There. (Clicks.)
Try clwnging the right one first.
(Tries to move the tab marker, but has problems getting it to move.)
Try pointing a little bit lower.
You mean with the mouse? (Clicks t11e pointer in the text, thereby un-marking the ruler.) So that's it is it?
(Points to the cab marker.)
Not quite, I think the right margin is at 6 inches. (Has problems controlling and manoeuvering the moose.)
(Explilins lww to move the mouse.)
(Eventually picks up the tab marker and moves it to 6.5.) Is that the right (correct) one?
Thal's done something, but you haven't clza11ged the margin. You still got the left hand side at 1 and the
right hand side at 6. So you want to change 6 to 6.5.
(Grabs tbe right band margin marker and drags it to 6.5.)
Ahah.
I've got to move this two. (Grabs the left paragraph indent marker and drags it.) Is that the indent marker?
(Doubtfully.] (Drags it to 1.4.)
What difference did it make?
Don't know. Did I move that?
(Explains whal paragraph indentation is.)
So. (Grabs the left margin marker and drags it 1.0 1.5. Adjusts the paragraph indent marker to 1.5 as weU.)
3. Insert word
I think it wants you ro type in the missing word.
(Positions the pointer and the text insertion point and types in the first leuer. Pops up the Format menu.)
Whal are you lnokingfor?
Is it justify ... no, that's changing it all. Insert ruler?
What happens when you just type the word insert or whalever? What happens then 7
It [the pointer] wasn't moving. (Lets go of the menu and selects Insert ruler by mistake.)

Transcripts-243

Whal would happen if you just typed in the word?
(Types the word in, which is entered al tJ1e current cursor position.)

Where does the word go?
Oh, it's there. (Points to it on the screen.)
B~t you want il down there. How do you make it appear down there ?
Move u. no? (Tries to drag the word.)

How would you move the cursor between the words?
(Clicks 10 position the cursor in the correct place.)

Now you've got the cursor there. How do you make the leuers appear?
Edit? (Pops up the Edit menu, then pops up the Format menu.) Do you go to that? (Highlights and selects
Align right.)
Oh no. Thal didn't do it.
It just set tbe ...

lt1110l11e.d the paragraph didn't it?
(Pops up the Fonnat menu again.)
But you want 10 make the letters appear !here?
How did you make the word "insert" appear up there?
Just typing it. I don't know, I didn't see. I didn't see how it got !here, I just typed it in.

Ifthe cursor's there what would happen?

(Positions tbe cursor at the beginning of lhe word "insert".)
Try typing now. Where would the word appear if you typed il now?
(Still tries to move the word by dragging it. Highlights a line of text, starts typing and overwrites it)
What happened there?
It insened it .. .

There was a lot more te.xJ there before. where did ir go? What happened to it?
It went up. It's just gone up lhe screen hasn't it?
Can you try and find tlze old sentence that was there?
(Scrolls up and down looking for me missing text.)
Why did the text disappear?
Can't tell you.
WeU it was sort of reversed [highlighted} wasn't it?
I can't see when that's happening you see. [She's looking at lhe keyboard or mouse wben she's operating either
of tbem rather tban looking at me screen.] (Moves me pointer around tbe screen.) So you've got to press it first
and then type it. (Tries to position the cursor and type me word. but gets cursor position and pointer position
confused. Finally types it.)
Why did the word "insert" appear there?
Because I was typing it in it was happening in lhe space.
Why did it appear in that space?
Because the cursor was there.
0/cay, right.
4. Delete characters
(Presses tbe BACKSPACE and deletes me character at the cursor position rather than the one intended.)

Which letter did you de/ere then ?
The "t", It's in that line [where tJ1e cursor is] there. But, I can't seem to steady the ...
The cursor ...

. . . dead on.

Which ones do you wanr ro delete?
I to delete the two i's.
0/cay.
(Tries to position the cursor by dragging it, thereby highlighting it. Manages to position the cursor the dlaractet
to be deleted, then marks me characrer wiLh me mouse and presses BACKSPACE. Deletes the next character in
the same way. Deletes the other ch.aracters in tlle same way.) [Is always very careful to position Lbe pointer over
the letter 10 be deleted as well.]
S. Delete words
(Marks the flfSt word to be deleted with l11e mouse and presses BACKSPACE.) If I'd gone along and covered it
all in black would it delete it all in one?
Try it.
(Marks the remaining words and deletes !hem by pressing BACKSPACE.)
6. Delete line
(Marlc.s the line and deletes it by pressing BACKSPACE.)
7. Double spacing
.
.
How do you change that . . . (Types in a 2.) Or is !hat the first page perhaps. Edt~ try Edtt. (Pops up Edit,
and Format. Looks at the spacing icon on the ruler previously inserted.) Ah! Is that tt?
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Okay.
(Clicks oo the double-spacing icon.) Thai's double-spacing.

Thai's more, that's 3 isn't.
Ob, is that 3? I'll change it (Clicks on the 1.5 line-spacing.) [The spacing is not done for the whole
document)

8. Single spacing
Where tlid the ruler go to?
It's up isn't it? (Scrolls up until she can see the ruler then selects single-spacing.)
9. Centre paragraph
(Pops up the Format menu and selects Insert ruler.) [The ruler is inserted at the cursor position wbicb is below
the paragraph to be centred .]

It's inserud the ruler there. You wanted it below the paragraph to be cenJred Why did iJ appear where it is?
Um. wby did it appear there? Perhaps because that (points 10 the cursor) was tbere.

You want it in front ofthe paragraph.
So you want it in front of tbe paragraph. (Positions the cursor and selects Insert ruler.) Yes, that's rigbt So
centre, it's something to do witb. Is it this one (points to the justify icon)? No.

What's thai do?

I'm DOt quite sure. (Clicks on it, but notbing happens.)
Try pressing it and see.
(Clicks oo it, but notbing happens.) I can't think which one centres tbe paragraph. Ob, is it this one (points 10
the centring icon)?

Try it.
(Does, and the text is centred.)

10. Underline word, embolden word
(Pops up the Style menu and highlights Underline.) Does it say wbicb word.
Un&rlinL the word "underline".
Rigbt, we'll go back 10 the . . . (Marks the word and selects Underline.)

So, you've done that. Okay. Can you put another word in boldface.
Right (Selects Bold.) [The word "underline" is botb underlined and emboldened.)

11. Cut and paste
(Pops up the Edit menu.)

What do you actually want 10 do.
I 've to get this paragraph, and I got to sort of get the beginning and the end have I? Or make it dark?
(Highlights the paragraph, highlights Cut.) So you go Cut?
Thal's right.
(Selects Cut.)

You've moved it from where it was.
Yes.

So now you've got to paste it to the top of the document.
So it's Copy. (Pops up tbe Edit menu and tries to select Copy.)

Thal didn't really do anything.
(Pops up the Edit menu.) Undo Cut is it?

Thai's put it back.
Is it Paste? (Selects Paste.) No. (Pops up tbe Edit menu.)
Undo Paste.
Try again. (Selects Undo Paste.)

You've got the paragraph selected
(Pops up the Edit menu.) Redo Paste.

WhaJ happened when you cut the paragraph? .
(Selects Redo Paste.) It took it completely, tt took tt away .

It as/ad you to cur it and then paste it didn't it?

~So, once you've cut it you want to paste it, you want to paste it somewhere else. Try andredoL
tr~c paste.
(Does.)

Have you cut it yet?
No.

Try and CUI it again.
(Does.)

Now you want to paste it at the top of the document.
Yes, so do I take that (pointing to the cursor)?

(Scr!t~·IO tbe 10p of tbe document, and positions the cursor.)

Try. (Selects Paste.) [The paragraph is pasted]

Ab, that's it.
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12. Print

I've. got to pnnt.
·
(P
·
·
ops up Edtt then File. Selects Print.) [fhe printer dialogue box appears] (Looks at tbe
0
P'1oosQ ~d selects OK.) [The printing in progress box appears.] Is that okay? [fbe document~ printed]
13 .

uat document

(Pops up the File menu.)
You don't want to save do you
Can I u~ that ... (points to Quit) ... Quit?
Qua would quit the entire program.

Save as?
You don't want to save it.

Save as?
Try and select it and see wlult it does.
Save current document as "!rial".
It's as~g you to save something and you don't actually want to do tluu ?
(Pops up Edit. then File.) Print?
You've just printed it haven't you?
Close? (Selects Close.)
14. Create a document
(Goes to File and selects Open.) [Open file dialogue box appears.] Open?
You don't want to do that at all. You want to open you're own new dJCument.
(Selects Cancel. Selects Open again.) Untitled? (Wants to click on Open.)
. (Explains that she should have a completely new file.)
(Clicks oo Cancel. Pops up the File menu and selects New.) So I just type it in do [? (Does.)
15. Save a new document
So I take it to File?
You want to sa!•e it.
(Selects Save.) [The save file dialogue box appears.]
Whal name do you want to give it?
(Types in a name and presses RE11JRN.)

Comparison-Subject 15
1. Save file
(Clicks on the File menu and selects Save.)
Z. Change margins
Ob; I see. Change the left margin to 1.5, chaJlge the right margin to 6.5.
Change the right margin first it's easier. Whereabouts is the right margin at the TtWmenJ?
(Points to the right band margin marker with her finger.) There.
That's righl.
Go to Formal (Pops up the Fonnat menu.)
Do you see anything rlzatm;ght change rile margin there?
(Pops up Edit. File, Format, and selects Set page. Selects Cancel in l.be dialogue box .)
What did thai do?
I don't know. I lost the whole thing !.here. Nothing happened did it?
I didn't see anything happen on the screen.
I've no idea bow to change the margin.
You tlwughl the right margin was at 6? Why do you think the right margin is at 6?
I don't think that's the margin actually. I was just looking for something that . . . On anything else I've seen
before the line that goes across the top usually denotes where the tabs are and where the margins are. So I
assumed that's what that was. (Points to the scale on the ruler.) But, perhaps for this one you have to look for
it scmewbere else.
Why did you say before the margin was at 6?
Because of the liUle black thing there. (Points to the right margin marker.)
0/cay, if the black triangle is at 6 now can you change it to 6.5?
Can you pick it up with the mouse and take it?
Try it and see.
(Grabs the right margin marker and drags it to 6.5. Grabs the paragraph indent marker and drags it to 1.7 .)
What's that? What did that dof That's not the left margin is iJ?
(Points to the left margin marker.) 1l1at's the left margin. (Tries to move the left margin marker and highlights
the ruler by accident) What have I done there?
You just missed it. Try and move it again.
I've changed the operation. have I sem it to off or something? [The ruler is still higblighted.] (Tries again and
drags the left margin marker to 1.5.)
3. Insert word
(Positions the cursor and types in U1e wortl "insert".)
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4. Delete characters
(Positions lbe cursor using the arrow keys. hesitates.)

What are you doing now?
I was going to use the keyboard, but having read the instructions you can do it with the mouse. I was going to
remove the "v". But. I have to tell it that it's got to be removed.
How au you going to do that?
(Pops up tbe Edit menu.)
No, that isn't very helpful is it?
(Pops up Ftle, Font. Style, and Spelling, then lets it go.)

Could tM keyboard help you at all?
(Presses BACKSPACE to delete the character. Positions the cursor with the arrow lceys and presses
BACKSPACE to delete the other characters.)
5. Delete words
(Deletes the words by positioning the cursor and backspacing.)
How do you mark a word with the mouse?
Just go ro tbe end of it and click it
Is that marlcin.g a word?
Just go to the end of it and click it, that should mark it.
How do you know something is marker?
Because fd moved the cursor. (Points to the cursor on the screen.)

6. Delete line
(Positions lbe cursor at the end of tJ1e line.) There's got to be a quicker way than BACKSPACE. I have 10 marie
tbe sentence and then just delete it. (Starts pressing BACKSPACE.)
How would the sentence look ifyou marked it? Cursor at the end?
No, it would be highlighted.

(Asksjoranother sentence to be 1narked.)
(Positioos the cw-sor several times. Looks at the Format menu.)
.An~ you looking for

a way 10 highlight a sentence?

Yes. (Pops up the Style m enu and highlights Bold.) No, that's just going to tum it to bold isn't it? (Selects
Bold.)

What happens when you press the nwuse button?
It moves tbe cursor.

And press tM mouse buuon at the same time?
(HighligblS the line and presses BACKSPACE to delete it.)
7. Double spacing
(Pops up Style, Format, Edit, and File. Starts scrolling up.)
What are you going to do?
I'm not sure. Something's happened, and I missed it.. [Possibly confused because the ruler is not at the top of
the window.]
WMre else could the spacing be changed apart from one ofthe menus thai isn 'tthere?
I don't know, I really don't.
"What happened to the rule that was on the screen? Where did that go? The one you changed the margin
with.
It's still at the top of the page I think. (Scrolls up.)
Do you think the ruler helps at all?
6 lines to one inch. (Selects it, then de-selects.)
ThaJ's done something but it's not double-spaced.
(Points at the spacing icons.) I was wondering whether that's close spacing. (PoinlS to tbe single-spacing icoo.)
And that's double. (Points to the double-spacing icon. SeleclS the double-spacing icon.)
Is that nwre than double-spaced do you think?
(Selects 1.5 line-spacing.)
Yes, that's now dnuble-spaces now.

8. Single spacing
(Returns to tbe top of the text and selects the single-spacing icon.)
9. Centre paragraph
(Pops up Format and selects Align centre.) [The paragraph in which lhe cursor was bas been centred, whi.ch is
not tbe coo-ect paragraph.]

What does that do?
WeU. yes, I didn't move the cursor.

Okay, so try moving the cursor this time.
(Marks tbe paragraph.)

Okay.
(Selects Align centre.)
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That's cenlred isn't ir?
Yes.

10. Underline word, embolden word
(Pops up Style and highlights Underline.) How can I cancel from there now because I've realised that I haven't
put the c~ where I want to underline.

By moving the mouse away from the menu.
(Marlc.s the wool and select Underline.)

The next one is boldface.
(Marts a word and selects Bold.)
Okay. tluu's good.
11. Cut and paste
(Marks the parngrapb.)
How do you cut and paste a paragraph.
(Selects Cut)
You've got to move it to the top ofthe text. the top of the document.
(Goes to tbe top of Cbe document and positions the cursor. Points to Edit and hesitates.)
What are you trying to do?
I can't fmd it again now. Wbat did I do with it?
You cut il didn't you? So did it stay in the text?
(Scrolls down.) I don't know, I'll go back and have a look.
(Points.) It was there /think. So it's gone now. Can you paste it anywhere ? You've cut it once, can you
~ il somewhere?
It seemed I could go where I want and paste it there. But, I'm not exacUy sure where it [the text] is now. Where
did I put it then I cut it.
I don't know, where did you think it went? Did it delete itself completely?
(Loolcs at the space where the text was cut from.) I've taken it from there. Presumably it's just sitting, waiting
for me to put it where I want it to go. All I did was 1 scrolled to the beginning to put it where I wanted to put it
and I put my cursor there (does).
Can you paste il yet? Is it where you want?
(Selects paste.) [The text is pasted at the top of the document]
12. Print
(Pops up the File menu and highlights Print. Hesitates.
What would thai do?
I'm just wondering whether would prinL the whole page.
Try and see.
(Does.) [1be printer dialogue box appears.]
What do you think it will do. The printer is set up.
It's set to Automatic I'll just press OK.
Yes.
(Hesitates.) Or do I have to enter the page range here.
Leave it as it is.
Ab, it's on All at the moment. (Selects OK.) [The printer starts printing.]

13. Quit document
(Highlights Quit.)

Quit will quit the entire progrant
(Highlights Close.) Close the document?

Try and see.
(Does.)
14. Create a document
(Selects Open and looks at the list of files.)
Those are all the previous peoples Leuers. You want to create your own. You want to creak a new
document don't you.
(Points at Open.)
No, you don't want to do that.
I want ...
You don't want any of those.
(Points to untitled.) I wam that one.
No, you don't want that.
(Can't work out what to do.)
. 'J
There's nothing there that you want to do is there? So how do you get out of 11 .
Cancel? (Selects Cancel.)
Well, you want something new.
)
[All menus except File, Edit and Spelling are greyed.] (Looks at Search, Format. Style, and Apple menu.
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It's not there. Hl1\le you tried everything?
Yes.

Have you tried everything on File?
(Pops up tbe File menu and selects New. Starts typing a document)
15. Save a new document
(Pops up tbe File ~enu and selects Save.) [fhe save file dialogue box appears.]
You have to g,ve it a name.
(Enters a file name.) [A replace existing file warning appears.]
(Explains.)
(Changes the name and selects Save.)

Comparison-Subject 16
1. Save file
(Points to File.) Select Save? (Pops up the menu.) How do I get there?
Try moving tlu mouse.
(Does and selects Save.)
l. Change margins
I want Edit or something don't I?
Try.
(Pops up tbe Edit menu.) Cut. Copy, Paste, No. Fonnat? (Pops up the Fonnat menu.) Must be somewhere in
tbete. It's DOt Font. I know it's not Font. (Pops up the Search menu.) Wbere could that be? It's not in File is
it? (Pops up tbe File menu.)
No.
Wbere abouts do you think the right margin is at the moment. (Points to the right hand margin.) There.
How does MacWrite tell you where the margin is?
(Points to tbe rigbt margin marker.) That one there, that black thing . . . Ob. right!
How do you change it ?
(Grabs it and starts moving it)
Move it to 6.5.
(Does. Grabs tbe paragraph indent marker and moves it to 1.5.) Is tbat . . . Have I done it
No, there's still text on the left isn't there? What happened when you moved that one? What hap~Md to
the screen when you did it?
It moved OVeJ' didn't it?
Try moving il with the mouse, the lillie arrow head. The little shape that you moved to 1.5 whaJ did rhaJ

cb?
(Clicks on tbe ruler and highlights it by accident) It didn't really move. (Grabs the left margin marter and
moves it to 2.)
You wanled 1.5.
(Drags it to 1.5.)
Okay.
3. Insert word
Try aod fand the missing word?
Thal's righJ, and type it in.
(Moves the pointer to the text insertion point.) If I go about there. (Clicks and types the word in.)
4. Delete characters
(Positioos tbe cursor.) Delete. (Looks at the keyboard. Hits tbe BACKSPACE key. Proceeds to delete tbe
otber cbaracters in the same way. Deletes the wrong cbaracter twice because she doesn't position the cursor
acanr.ely.)
Why dUJ you tklete that one?
Because I didn't put the mouse in the right place. (Accidentally deletes a character while positioning the cursor.)
Why does it go black?
Whalmighl it mean if it goes black? What do you think it means? What hap~ns to rilL cursor whL11 g~s
biDet? Is the cursor still on the screen?
I hadn't noticed. I assume it goes from what you say.
S. Delete words
Cao you delete a wbole word at once? (Starts backspacing.)
How do you think you'd do it?
I don't know. (Deletes l.he ftrst word by backspacing.) Tum it black maybe.
How do you delete the two words at once?
I don't know.
How do you tell the program to delete nvo words at once?
. .
I don't know. (Tries to mark by positioning the cursor firs t at the bcgmnmg and t.hen at lhe end of the texl)
Well, tbat didn't work.
How do you tell the nwchine what to delete?
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I want to show it with a different background.

How will it tell you it's going to delete two words?
The two words wiU flash.
Can you make them flash at all?
I don't know ~ow yo~ do that. I'll have t? do it really boringly now, or will you tell me bow to do it?
See whal 11 says m here. (Starts readmg the manual.)
(Keeps trying_to mark tbe words by moving the cursor over them. Eventually deletes the words by backspacing.)

6. Delete hne
It says here you can select some text by dragging the mouse button across the letters you want 10 delete.
Ob. I

see. (Highlights the line.) And you do this. (Presses BACKSPACE.)

7. Double spacing
(Points to the space between two paragraphs.) Does it mean that?
(Explains what double-spacing is.) How do you think you can do that?
I'll search for- spacing up here [in the menus]. (Pops up Edit. Search, and Format.) Don't know. (Pops up Style.
and Spelling.) Wbat's a ruler?

Thai's the thing at the top ofthe page that you clumge the margins in.
So I could have changed the margins with those really [commands on the menu]. I don't lmow how to do this.

Su ifyou can .find the ruler, see if that will help you at all.

(Pops up the Format menu.) Hide ruler, Insert ruler. (Selecrs Insert ruler.) [The line of text which was
bigbligbted is deleted.]
Do you think that will help you to double space the text, that thing there? Try something and see.
I wonder what that is? (Selecrs 6 lines per inch.)

What did thal do?
Put a aoss in it [the boxJ.

What did it do to the text? It squashed it up didn't it?
Ob yes. (De-selecrs it.) Oh [ see. It's this lot here. It's this one. (Selects 1.5 line-spacing.) lbat's doublespaced

8. Single spacing
(Selects single-spacing.)
9. Centre paragraph
Ceotte the text. what does that mean.
(Explains.)
(Pops up the Format menu and select'\ Insert ruler.) But I've got that one haven't I? I've got two now.

Try something anyway. What do you think mighl change the ... the way the text looks.
(Grabs the paragraph indent marker and moves it to the right, positions it at 2.0.) If I grab this one, tbe right
band margin marlcer and make it even narrower. (Puts it to 6.0.) That's not centred is it?
No. (Explains again what centring is.)
You mean like this one? (Selecrs t.h e centring icon.)

Yes, thal's centred now.
(Puts the marlcers back.)

10. Underline word, embolden word
(Pops up the Style menu.) Is it Bold, boldface? (Selecrs Bold.) What happened?
Where did it do it. Did you tell it to underline the word?
No, it didn't. So if I pick a word. (Marks a word and selects Bold.)

Can you underline a word as well?
(Pops up the Style menu.) Oh. I haven't done Lhe wharsit (Marks the same word again and selects Underline.)

11. Cut and paste
(Marks the paragraph.) What to that bit there? (Points below the paragraph.)
You want to move the whole paragraph by cutting and pasting it to the top of the docununt, the top of the

first page.
So, if it's on black, if I make it go forward (starrs scrolling up) and press the mouse it should just recall it
sbouldn't it? (Positions the cursor at the beginning of the document)
What are you actually going to do there?
Last time I told it "do this bit" but this time I haven't actually told it to do anything. Right. I'm going back.
(Returns to the paragraph.) Where's it gone? [The highlighting was removed when she clicked the cursor at tbe
top of tbe document.] I want the whole lot to be deleted and kept somewhere like that

Well, it says Cut and Paste.
So it wanrs me to ... (starts marking paragraph} ... no.
What?
Well that's what I did last time. I covered it all in black.

But you didn't tell it to do anything did you?
I don't know wbat to tell it to do.

Would the ruler help you or one of the menus help you?
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(Pops up Format ) Display. What's a Header and a Footer?
(Explains)
So, if I say Display header.
(Explains again what headers a rut footers ore.) Thai's separate from the documem.
I want a delete buuon. I want to cover that [lhe paragraph] in black and store.
Cover iJ in black anyway and do something with it.
(Marks the paragraph.)
What t:/Ms it say to do. cw and paste?
I don't know.
Su ifyou can select something that will let you do it on the menus.
Ab, on the menus. (Pops up the Edit menu.) Cut, yes. (Selects Cut)
Ok/Jy.
(SeroUs to tbe top of the document. Positions the cursor.) 1 want to tell it where to do it as well.
How do you do that.
Let's see what Paste does. (Select Paste.)

ll. Print
(Pops up tbe File menu and selects Print.) [TI1e printer dialogue box appears.] (Clicks on copies.) One copy.
That's ok/Jy as it is.
Okay, let's go. (Clicks on OK.) [Tile printer status box appears.] (Clicks on Continue.) [The printer starts
printing.]

13. Quit document
Edit? (Pops up Edit, then File.) C lose?
Try.
(Selects Close, and selects No on the question box.)

14. Create a document
(Pops up tbe File menu.) New. (Selects New.) Is lhat it? Dear Angela, so I can type. (Starts typing.)

15. Save a new document
(Pops up the File menu and selects Save.) [The save fi le dialogue box appears.] Save as . . . (points at Save
which is greyed) .. . unlitled.
lf youjust give it a name.
(fypes in a ftle name and clicks on Save.)

Comparison-Subject 17
1. Save file
(Points to File and clicks briefly.)
Try keeping the button down.
(Does and selects Save.)

l . Change margins
Format is that then is it?
What do you think? Any ideas?
No. (Pops up the Format menu.) No. (Lets go. clicks on Style.)
So what are you doing no w?
I'm just seeing what they [U1e menusl say. (Clicks on the tab markers and nothing happens.) Does it teU you in
the manual then?
(Starts reading the manual.) Here, you've goc a left and a right margin marker. If you position IM poillltr
on the marker, press the mouse button, drag it where you walll to llJUi release.
(fries to click on the left margin marker and accidentally marks the ruler.)
What art you trying to do?
,
.
.
Put it onto the left one. (Tries to move it unsuccessfully.) That s not taken 1t anyway bas tt?
lfyou try to hold the nwuse button down.
(fries again., and eventually grabs the paragraph indent marker and ~gs it t.o 1.7.)
I think that is tM iruient 11UJrker. You've just indented the first ltnes.
(Points to lhe left margin marker.) So I want this one as well then. (Grabs it and moves it to 1.7 as well.)
You 've got to move the right one to 6.5.
(Points 10 the tab marker.) Tilat one?
No, the one on the 6.
(Grabs it and drags itt.o 6.5 .)
3. Insert word
(Hesiwes.)
You're supposed to insert the missing word. You can position the cursor with the mouse.
(Positions the cursor.) So you just insert it?
Ye s.
(Types in the word.)

Transcripts-251

4. Delete characters
(Positions the cursor behind lhe character to be deleted.)
Do you know how to delete it?
With a key on here (points to the keyboard) perbaps. (Clicks tile cursor again and then presses the
BACKSPACE key deleting lhe wrong character.) What have I done?
(Explains thaJ the wrong character has been deleted.)
(l'ypes the character in.) Is it where that line is flashing where I actually put it? (Presses BACKSPACE and
deletes the same character as before. Types lhe character back in again.)
I think thaJjlashing line is the cursor.
How do you move tbe cursor then? (Can't work out to position the cursor. Marks lhe character eveniUally and
presses BACKSPACE to delete it. Tries to position the cursor by dragging it. Marts several character and
presses BACKSPACE and accidentally deletes them.)
1 think you've deleted the whole lot.
(fries to move the cursor again by dragging. Marks a large cbunk of texL) This is very annoying. I'm trying
to move the cursor, but I can't work out how to do it. (Proceeds to position tbe cursor by dragging and then
clicking. Deletes the remaining characters by moving the cursor in this way and pressing BACKSPACE.)

5. Delete words
(Marts a word and deletes it by pressing BACKSPACE. Marks the remaining two words and deletes l.bem by
pressing BACKSPACE.)

6. Delete line
(Malts the line and deletes it by pressing BACKSPACE.}
7. Double spacing
(Pops up Style.) No. (Pops up Format.)
Any ideas?
No, weD I would have thought it was ...
What?
(Points to tbe menu bar.) In one of these. (Looks at Font and EdiL) Manual ~lease.

(Reads the manual.) At the top bit on tile ruler there are some boxes for smgle-space, one and a half spaa

and double space.
So bow do I get there?
The ruler is at the top of the docwnent.
. .
(SeroUs 10 the top of lhe document Points to the double-spacmg tcon.) That one. (Selects iL)

8. Single spacing
So I'm going back for single-spacing first?
Yes.
(Scrolls back to tbe top of the document and selects 1.5 line-spacing.)
That one and a half.
(Selects single-spacing.)

9. Centre paragraph

(Is still at the top of the document.) Fonnat. (Pops up lhe Format menu.)

What are you doing now.
.
.
.
Tbe next bit said centre the paragraph. (SeroUs down to read the tnstrucu~ns agam. Scrolls back to the top of
the document) I didn't need that did I because tile Format is there all the ume. (Pops up l.be Focmat menu and
points to Align centre.)
What are you doing now?
I'm going to try and align that paragraph. (Select align centre.) [The cursor was positioned between two

Jm38f3llbs and is centred.]
Any idea what happened?
No.

(Reads the instructions to her.)
· inserted
""'~~
lee then (Pops up the Format menu and selects Insert ruler.) [The ruler ts
ooe .-'"6'...above the~ to be ~ntred.] (SeroUs up.) Where's my ruler gone? (Goes to Format and selects Insert ruler.)
[1be rulec is inserted immediately below the first one.]
You've got two rulers now.
.
.
I need to do my ... (points to the left hand margin marker.) ... thts agam.
(Poinls out thallhe paragraph below shoul£1 be cemred)
So I want to delete my ruler then .. Is that possib~e?
et them out An idea how you could tkute tMm?
If you can put them in there tt mu~!~ po~s~~~~oB~CKSPACE an/ manages to delete it Points to the left
(Clicks on the ruler and manages to mtu"' tl. r
. ho
h?
margin marker on the remaining ruler.)
S hal
·ng 10 do now? How are you going 10 centre the text m t r fX!ragrap .
ow AJ~re you ~~from Fonnm? (Pops up the Format menu again.) I keep trymg thts one. (Selects Align
Do I want tgn cen
) S . th. . n the cenl!e now?
centre.) [Nothing happened.) (Points to t11e cursor.
o IS IS 1
·

So I need
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The cursor, yes.
(Points to the scale on the ruler.) What about4.1.

What are you thinking ofdoing?
Set it Align centre. I thought that would do it for me.

(~eads the. manual.) ~here are alignment boxes on the ruler for justify left, righl, cefllre, or justify both
. sides. (Pomts to Jhe al,gnmefll bo.xes.) These are the alignment bo.xesfor selling format.
{Pomts to lbem.) These 4 here?
yes.
(Points to tbe justify box which is currently selected.) This one here?
No celllTe.
(Points to tbe centring icon.) This one?

Yes.
(Selects il) [All of the text below the ruler is centred.}
But you were only meant to do it in that paragraph.
So my ruler is too high up then?

So what do you think you should do?
Move on to the next one.

No, no,
(Selects justify.) And now I move t11e ruler down. (Tries to drag it down with the pointer. Clicks oo the ruler.)

What are you trying to do?

rm trying to delete this ruler.

How did you do it last time?
It went black. (Clicks again and marks tJ1e ruler and deletes it.)

What are you going to do now?
(Pops up the Format menu and selects Insert ruler.)
What$ happened now?
It put it too high up. I think I'm too stupid . . . (Marks the ruler and deletes it.) I forgot to move the cursor.
How do you do that? (Tries to drag the cursor again.)
How did you do il before?
l just thought that if it was at the top of the screen it would put it at the top. (Tries to drag the cursor.) Why
won't the cursor come with me then? (Tries a few more times.) I don't know.

You movM the cursor before.
I lwow. I can't remember. I can't remember how I moved it. (Finally moves the pointer above the paragrapb
and clicks to position the cursor.) Ah, it's there. (Selects Insert ruler. Selects Align centre from the Focma1
menu.)

How are you going to centre it?
(Clicks oo the centring icon.)

That's centred everything below the ruler. You only wanted to cenJre that paragraph.
Do I take the cursor below [the paragraph] and change that

How are you going to do that?
(Positions the cursor.) Selects Insert ruler.
Okay.
(Selects Align centre from the Fonnat menu .) That didn't do it?

What?
(Clicks on the justify ilcon.)
Why align centre? (Suggests that the rulers should be removed from the screen.)
I don't know bow. (Pops up the Edit menu and select Undo ruler change.) [The text is now set baclc lO centred.]

What happened now?
I don't know.
I think you've cenJred everything again below the second ruler.
(Selects Redo ruler change from the Edit menu.) That's not it then.
Oh, havt another look. You haven't looked hard enough.
(Looks at Searcb, then Format) Urn! (Selects Hide rulers.)
10. Underline word, embolden word
(Pops up the Style menu and selects Underline.)

Can you underline the word "underline"?
(fries to mark the word by clicking ftrst at the beginning and then at the end.) No.

How are you going to do it?
I want to move the cursor. (Selects Underline again and nothing happens.)

So wluJJ are you trying to do now? Well how are you going ro show it which word you wanJ to u.n.tkrli!IL?
(Marks the wold. un-marks it, marks it again.) Now that's the word I want

The options are in the Style menu.
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(Pops up lhe Style menu and selects Underline. Points to the word just underlined.) That's got that black bit 00

does tba1 mauer?

(Suggests thai another word should be changed to bold.)
(Marks anOlber word and selects Dold.)

11. Cut and paste
(Marks the paragraph, pops up the Edit menus and hesitates.)
So what are you doing now?
Cut it? (Selects cut.)
So how are you going to pur it up there 10 the beginning of the text?
Where has it actually gone now?
What do you think has happened?
It's been taken away.
What's happened so far?
Well, it's cut it out It's cut out the paragraph and I want to take it with me to tbe beginning. (Pops up Edit)
Ob dear, Sbow board perhaps. (Highlights Show board tben selects Paste.) (The text is re-inserted back from
wbere it was cut] It's come back to where it was before.
So what you think you should do now?
I've got to move the cursor to the beginning where I want it to be.
So can you get rid of that paragraph now and put it 10 the beginning of the te.XJ.
(Pops up the Edit menu.) So I can't cut it now. (Selects Undo paste.)
Can you pur it at the beginning oflhe text?
(SeroUs to the top of the text, positions the cursor and selects Paste.)

12. Print
Is that in ... (pops up Edit then File. Selects Pint.) [The printer dialogue box appears.] (Selects draft quality,
tries to select All which is already selected.)
Can you get it to g(l and prinr.
(Clicks on Automatic.) Can I have a look in r.he book then?
(Explains the options.)
(Clicks on OK.) [The printer status box appears. The document is printed.]
13. Quit document
(Pops up the File menu, reads the options, highlights Close and hesitates.) Save as? (Highlights Save as.)
You don't want to save?
(Selects Close.)
[Runs out of time.]
14. Create a document
lS. Save a new document

Comparison-Subject 18
1. Save file
So those are the menus at Lhe top? (Points to Lhe File menu.) Do I bave to press !bat? (Pops up the Ftle menu
and hesitates.)
Select Save.
(Does.)
2. Change margins

Any ideas how to change the margins?

No.
Have a go at something. . . . What are you thinking about.
Are you using the mouse. or somel.hing else?

Well, how are you thinking of changing the margin?
(Pusbes the arrow keys.)
So you tried to push those arrow keys.
Um. (Presses the SPACE bar a couple of times. Pushes the first line of one paragraph to 1.5 using the SPACE
bat.)
What are you doing now?
I don't know.
You were just putting some spaces in. You just added spaces into the first senJence. . . . Any Uka? (Suuu
reading the manual.) There's margin markers, these little black triangles on the ~t.er, and iJ says if yo~
click. press and hold the mouse button on it and you can drag the marker to the posllwn where you wan~ II
and delete il.
(Grabs lhe paragraph indent marker and drags iL to 1.3.) What have I done now?
It's indented it a bit.
(Points to tbe left hand margin marker.)
Move that to 1.5.
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(Grabs the paragraph indent marker and drags it to 1.7.) Oh, I see.
. Can you move the margin markers to 1.5 on the left and 6.5 on the right.
(Pomts to tbe body of one paragraph.) Why hasn'tlhis moved then?
You:ve just moved the indentmion marker, you haven't nwved the other one.
Ab. (Pomts to the left margin marker.) That one.
Yes.
(~bs the ~ft hand margin marker and moves it to 1.6. After some fiddling manages to move it on 1.5. Moves
the indentation marker to 1.5 as welL)
And the riglu one.
(Grnbs the rigbt hand margin marker and moves it to 6.5.)

3. Insert word
You're supposed to put a word into that sentence. Any ideas?
(Puts lbe pointer at the text insertion point. Positions lhe cursor and types in the word.)
4. Delete characters
(fries to drag the cursor to the next paragraph and highlights lhe words just inserted.)
What are you trying to do?
I'm trying to pick that [the cursor] up and take it to the next paragraph. (FinaJiy positions the cursor in front of
tbe charactes 10 be deleted.)
Which cluuacter are you trying to delete? Which "v" are you trying to delete?
Tbe first ooe. So I have to go afler the v· don't I?
How are you going to delete?
(Hesiwes.) There should be a delete buuon somewhere on here. (Looks at the keyboard.) Is it this one?
Which one?
Clear?
I ikJn't brow.
(Pushes Clear and nothing happens.) No. Which button do you press to delete?
Try BACKSPACE.
Ah, of course. (Pushes the BACKSPACE key and deletes the character in front of the one to be deleted. Types
tbe character back in again and tries to move the cursor by dragging marking the rest of the word.) So, what
have I done now. (Finally manages to position the cursor and deletes the character by backspacing. Deletes the
remaining characters by positioning the mouse witJl the cursor and backspacing.)

5. Delete words
It says you can mark words willz the nwuse and delele them rather than deleting them letter !Jy lenu. Can
you find ous how?
(Marks one word and deletes it by pressing BACKSPACE. Marks the remaining two words and presses
BACKSPACE.)
6. Delete line
(Marks the line and presses BACKSPACE 10 delete it.)

7. Double spacing
How are you thinking of doing it?
Do you use these arrows here?
What the arrow keys? What were you going to do with those?

Um, lbe cursor.
So what are you going to do?

.
(Ftddles around for a while.) I've no idea
(Starts reading the manual.) At the top of the document on the ruler there are spacing boxes for single,
and a half, and double-spacing.
So I have to go all the way back up there again.
Yes.
(Scrolls to the top of the document.) So. (Clicks on the double-spacing icon.)

one

Right.
8. Single spacing
So I have to go all the way up to do that. (Scrolls to the top of the document. Points at the single-spacing
icoo, hesitates. and selects it.)

9. Centre paragraph
(Pops up the Format menu and selects Align centre.) [The paragraph in which lbe cursor was is centred. It's tbe
paragraph above the one to be centred.] Oh, what have I done?
You've centred the paragraph above the one you wanted to centre.
Ooh! Was the cursor in lhe wrong place?
It says you should insert a new ruler as well. Can you change back what you just did?
(Pops up tbe Format menu.) Which one was it?
I think it was justify before.
I use Align left this time?
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No, justify.
(Selects Align justify.)
Okay, cen1re the paragraph below that one.
What does it mean "a new ruler"?
wen there is a ruler at the top of the document.
So you go back again.
Well it says you can insert new rulers from Fonnat.
So you go to Format? Yes? (Pops up the Format menu.)
What are you going to do now?
Wby can I ... (selects Insert ruler by mistake) ... Whoops! What bave I done now? [The ruler is inserted ooe
paragraph too high.]
You've inserted a new ruler.
Was I supposed to?
Wel~ you wanled to centre that paragraph (points). So, lww are you thinking ofdoing that?
Ob, I see.
Any ideas?
No.
None whatsoever? What are you doing?
I don't know. I've no idea.
(Reads the manual.) There are alignment boxes on the ruler.
(Points to the alignment boxes on the ruler.) These lhings here?
Yes. There's left, centre, right alignment, and justified.
Do I select justifJCd?
What do you think?
I don't know. (Oiclcs on justified and nolhing happens.)
(Poims to the paragraph.) You want to centre the text.
(Clicks on the centring icon on the ruler.)
You've centred it, but you've centred the one down below as well. Any ideas on how to do just that o~?
No.
Well, what's happened where you centred it? What's happened now?
I've centred them all not just that one.
Have you centred the ones above the ruler?
No.
No you haven't. So any ideas lww you could just centre a single paragraph.
Move down.
Could you insert another ruler?
Mm! (Scrolls up and down the text.)
What do you think you are doing now?
Well I have to ... Well I've centred t11at one. (Points to the paragraph immediately below the ruler.)
Well yes.
But I wasn't supposed to.
Well yes. You've centred everything below the ruler.
So I bave to move the rule down.
You could put a new ruler in.
Um. I'm not sure how to control where it goes, but I know how to get it
How do you think you con get it where you want it to go?
Move the text up.
You can try.
(SeroUs up, then scrolls down.)
Where do you want it?
Above the paragraph here. (Points to !he paragraph to be centred.)
So what do you want to do now?
I don't know. I don't know what I have to do. I haven't a clue. I bave to change those back. (Points 10 the
spacing boxes on l.be ruler.)
Yes, you've centred all the ones below, so you can change the others back if you put another ruler ifl
Can I use that? (Selects the left align icon.)
You've left aligned everything including that one there which you want to cenire.
So I want to move the ruler down over Lhat paragraph (the one to be centred].
So how are you going to do that? You could get rid of the ruler you've got now and put another o~ ill. So
how do you do tlwt?
(Points to the tab markers.) Is it one of !hose two?
How do you think you could get rid of the ruler?
Go back to Format. (Pops up the Fonnat menu and selects Hide rulers.) Have I got rid of it?
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Whal diJ you think?
Yes, it's not there any more.
So whal do you want ro do now~ So what's happening now?
Well rve got to centre this paragraph somehow.
So whal are you going to do now.
(Pops up tbe Format menu.) Insert anot.her ruler.
Whe~?

Um, don't know. ~ell, i.f l insert the ruler below the paragraph then . ..
~you ~e gomg to msert a ruler. Where are you going to insert that ruler?
Well1f I put 1t above the paragraph it will centre everything below it won't it?
Yes.
So if I centre it . . .
You could diJ that.
I could do it but I'd probably centre the one ...
You'd centre them all below it.
Yes.
But if you put another ruler in below it.
Ah, right I could put a ruler above and below it.
So how are you going to insert?
Back to Format. (Pops up the Format menu.)
Where are you going to insert it?
I don't know. (Selects Insert ruler.) [ll1e ruler is inserted below the previous ruler and both are now displayed.]
Whats happened
I don't know.
Well you've got two rulers now one after the one that you had before.
Oh, so I didn't gel rid of it. So I have to get rid of both of them now. I don't know bow.
How are you thinking ofdoing that?
(Pops up tbe Format menu.)
How are you going to get rid of them then?
Don't know. It's not the one that says Hide rulers because I've tried that before.
So whal are you going to do now?
I don't know.
Any ideas on how you could delete the rulers?
Try Edit? (Pops up the Edit menu and selects Undo insert ruler. Pops up the Edit menu again and selects Redo
insert ruler.) [Subject thinks that it means repeat corrunand.] Um. (Selects Undo insert ruler again.)
You got rid ofone. How can you get rid of the other one?
I don't know. (Pops up the Edit menu.) I can't use that [Redo insert ruler] again.
No.
(Pops up Format) I don't know.
Any ideas.
I don't drink so.
You've done those other things. What could you try to do now?
I don't know, I've tried everything.
Wtll, not everything.
Well, everything I can think of.
How you tried marking the ruler and deleting it? (Starts reading the manual.)
(Tries 10 click on the ruler several times and finally manages to mark it. Deletes it by pressing BACKSPACE.)
You want to get another ruler in don't you? So what are you going to do now?
(Scrolls down so that the paragraph to be cemred is at the top of the window. Pops up Famat and selects Insert
ruler.) flbe ruler is inserted in t11e same position as before.] What have I done? -Why bas it gone there?
I don't know. (Marks it and deletes it)
What are you going to do now?
(Positions the cursor.) I've put the cursor there. (Selects Insert ruler.)
What are you going to do now?
Put in another ruler. (Positions the cursor and selects a second ruler.)
A.lrighl. A.nd now what are you going to do.
(Pops up tbe Format menu and selects Align cen!Ie.)
Hm! No. You have to use the alignment boxes, you've used them.
(Hesitates.)
1M jour boxes on the end.
(Selects the centring icon.)
You've di.>ne it.
Do I bave to get rid of the rulers?
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You Wanl to get rid of what?
1bese. (Clicks to mark the first ruler and deletes it)
Now you have put it back {the paragraph forma/ling}.
(Select Insen ruler and selects the centring icon.)
So how could you make them disappear?
Edit (Selects Undo rule r change.) [fbe paragraph is now set back to justify.)
ThaJ SlJid "Undo ruler change".
(Pops up the Edit menu again and the n selects the Centring icon again.)
Can you make the rulers disappear anywhere?
(Pops up the Format me nu again a nd selects Hide rulers.)
10. Underline word, embolden word
(Points to Style.)
So how dt:J you think you can underline a word.
(Clicks the cursor at the beginning of the word.) Move the cursor. (Pops up the Style menu and selects
Underline.) No?
What are you trying to do ?
Well. I tried to underline the word "underline".

How?

Um, move the cursor ... to underline and the n select Underline.
Try and dQ il.
(Pops up the Style me nu again.)
How can you indicate which word you want to underline apart from pulling the cursor at the beginning?
(Puts the cursor at the end.) A h. (Tries to mark the word, s lips, and highlights a couple of lines of text) How
do I get rid of that?
What were you tying to do?
I was trying to get the word black.
Just try clicking again.
(Does, mads lbe word and selects Underline. Marks another word and selects Bold.)
11. Cut and paste
(Pops up the Edit menu.) I highlight it then .. . (Marks the paragraph, pops up Edit, and selects Cut)
Now can you putthar at the beginning of tlze document?
(Selects Paste.) [The paragraph is inserted back from where it was cut.) Urn.
How can you do it ?
(Marks tbe paragraph again.)
What were you trying to do?
Well. I cut it but the n whe n I used Paste in the Edit.
Yes, you want to put it back at the top of the document. So how could you put it at ch~ cop of the

document?
I don't know. (Maries tl1e paragraph again. Pops up Edit. Format.)
What are you looking for now? What are you trying to find?
Somelhing wbicb me ntions the beginning.
So~Mthing to put it to the beginning of the document.
Yes.
What dQ you think you could do now?
(Pops up EdiL)
Cut it out.
You have to cut it out first. (Selects CuL Scrolls up lO the top of tlle document.)
Right, now where are you going to put it?
Tbere. (Positions the cursor and selects Paste.)

ll. Print
(Looks at the Format menu.)

What are you looking fo r ?
Something thal tell you how to print
What dQ you think it might be?
I'm just guessing.
Where have you looked.
I've looked under Fonnat. (Pops up Edit.)
Anything else.
.
.
.
1
(Looks at Search, the n l'ile and select Print.) [The pnnter dtaJogue box appears.) Ob gos h . (Looks at the
options for a while, points to OK .) Click on that.
It's up to you.
.
·
· Led 1
(Does.) (The printer stalus hox appears.] (Tries to click on Conunue.) [The document ts pnn ·
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13. Quit document

(Pops up the Flle menu and hesilates.)
Is tlu!re anything that tells you Jww 10 leave a documenr
Qui t. (Selects Quit.)
·
14. Create a document
[Runs out of time.]
15. Save a new document

Comparison-Subject 19
1. Save file
(Clicks on the Hie menu several times, the menu flashes.)
Can you select Save?
(Pops up the menu.) Do you have to hold it down?

Yes.

(Highlights Save.) And just let go when it's there?

Yes.

(Selects Save.)

2. Change margins
What does it mean "Change the left margin to 1.5''?
_It means you have to move the text in to 1.5 and the right margin to 6.5.
(Pomts to 1.5 on the ruler with the pointer.) So to there?

Yes.
(Clicks and thereby accidcntaJiy highlighting the ruler.) Urn.
What are you trying to do?
I don't know bow to do this so ...
Any ideas.
No. (Points at 6.5 and clicks, nothing happens.) No? No. (PoiniS 10 6 lines per inch.)
Why has the ruler gone black?
Idoo'tlrnow. You're asking me?
(Starts reading the man uaJ.)
(Experimenter tells the subject to click the cursor in the te.x1.)
(Does. thereby de-selecting the ruler.)
Now you can change the margin to 1.5. It says you've got margin markers, those little black tria.ngles.
Ob. the liUle ttiangles.
And if you just click on them.
Ob. I see.
Drag them to where you want to.
(Tries to click on the left margin marker and accidentally marks the ruler. Clicks the cursor iniO lhe text 10 deselect tbe ruler. Grabs the parngrnph indent marker and drags it to 1.5.)
That's the indentation nwrker. The triangle is the margin marker.
What do you mean?
(Points ro the indentation marker and to the text.) That's only indented the first line to J.5. The left
triangle is the actual margin marker. Can you move that to 1.5?
(Points to the left margin marker.) Move that to 1.5? (Grabs the left margin marker and drags it to 1.5.)
Can you grab the right hand one and move it to 6.5.?
(Does.)

3. Insert word
I think you're supposed to insert a word there between "and" and "the". Any il.ieas on how you do it.'
Just get tbe cursor down. (Tries to drag the cursor from the current position.)
How are you going to do it?
(Keeps trying.) I'm trying to move it. Are you allowed to move tbe keys? (Uses tbe keys 10 positioo lbe cursor
and types tbe word in.)
4. Delete £haracters
(Positions the cursor with the arrow keys and deletes by pressing BACKSPACE.)
S. Delete words
Can you delete the words other than deleting them letter by letter. It says can you mark the words with thL
mouse and delete them?
Ob right (Positions the cursor at the beginning of the word 10 be deleted using the arrow keys. ·Picks. up lbe
cursor with the pointer to mark the word. Deletes the word by pressing BACKSPACE. Moves lbe 01rsor 10 lbe
beginning of the remaining two words and deletes them in the same way.)
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6. Delete line
<M:oves the. cursor to .the. bc~inning of th~ line using the arrow keys. Clicks the mouse while moving the
pomter, accl(Jental~y htghhghtmg a bltx:k o t text.) Oh no. Help. (Presses the BACKSPACE key and deletes the
block.) Oh ~o: l ~e lost a whole s~ntence. (Positions the cursor at the beginning of me sentence using me
arrow keys. Pi~ up tl1c cursor wtth the mouse. marks lhe lines, and deletes it by pressing BACKSPACE.)

7. Double spacmg
Any itkas how to double-space the document?
An extra line between each sentence?

&tween eac~ line, yes. But that's for the whole document. There must be a way of dcing it ralher than
manually golllg through and pulling the extra lines in. Any ideas?
Style? (Pops up the Style menu.) Format? (Pops up Format, Font, Edit, Style, Search, Format, Search, Edit,
and FoonaL) Page break is it? I don't know.

Is there anything there? (Stans reading the manual.)
It doesn't really help telling you to open headers and open footers and things like that.
It says there is a ruler at the top of the document that's spacing boxes on it, single space, one and a halt and

double space.
Does that mean I have to go back up to lhe beginning?
Yes.
Double space? (Points to the double-spacing icon.)

Yes.
(Selects tbe double-spacing icon.) Right

8. Single spadng

Ob. you want it back again. Oh no. (Scrolls back to the top and selects single-spacing.)
9. Centre paragraph
(Pops up tbe Fonnat menu and selects Use ruler.) [Nothing happens.] (Marks !be paragraph.)

So how are you thinking of doing it?
To start with what's a ruler?
That's the thing aJ tile top. The one where you used the spacing boxes.
Right. (Clicks on Format and selects Insert ruler.) [The marked paragraph is overwritten by the ruler.]
What happened?
I've lost all tbe print. (Clicks on the ruler and marks it Selects Hide rulers from lhe Format menu.) It's gone
all togelher. Brilliant.
What happened?
Tbe text was replaced wilh the ruler. The ruler has been bidden or whatever. (Pops up the Format menu.) Let's
get that back. (Selects Show rulers. Pops up Format again and selects Use ruler.)

What are you trying to do?

I'm trying to get !be script back.
Why did the ruler replace the script, any ideas?

No.

(Reads the manunl.) Can you undo wluJt you've done.
I ought to go back here. (Looks at tbe Format menu.}
How about deleting that ruler and centring another paragraph.
Okay. (Selects Hide rulers.)

How about centring chat paragraph there?
(Starts marking it.)
So whal are you crying 10 do now?
Pick out tbe paragraph so tl1at I can centre. (Marks the paragraph.)

Now what are you going to do?
(Pops up lhe Format menu.) That one. Align cemre. (Selects Align centre.) Yes.
10. Underline word, embolden word
(Positions the cursor at tbe beginning of the word to be underlined and pops up the Style menu. Selects
Underline, but notbing happens. Highlights the word.) Again. (Selects Underline. Positions the cursor at the
beginning of a word, pops up the Style menu, lets go. marks the word, and selects Bold.)
11. Cut and paste
(Pops up Format. tben Edit. Marks the paragraph, scrolls to the top of the te~t. and positions the cursor.)
Right. (Pops up the Edit menu and selects Paste.) (The wrong paragraph has been mserted.]
. .

(Tells the subject to return to the paragraph at the bottom of the text and shows tluu the paragraph t.S still
there.)
1 didn't cut it out did I? (Marks a paragraph, scrolls to lhe top of the text. positions tbe cursor, pops up the Edit
menu, and tries to select Cut.) But Cut isn't coming up is it?
Have you got any ideas why? D~ you want to ~o bac~ and look?
(Pops up tbe Edit menu again and potnts at Cut.) Its not m the same type as the others. [It's greyed.]

If it's greyed that means it won't let you do it.
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Ob great.

There is a reason why. What are you trying to do now?
I'm trying 10 find out why?
Whal didn't know that you want to cw something ? How do you show it that it needs to cut a cenain p it ct?
I've dooe it in black.
l s it still in blllck?
(Scro lls back.) No, it's nor. Is the cursor likely to stay at !be beginning if I mark it now? (Marks tbe
paragraph, and pops up the Edit menu.) Yes, Cut (Selects Cut Points to the Edit menu.)
And now.
(l..ets tbe menu go, scrolls to the top, positions the c ursor. and selects Paste.)
12. Print
(Pops up tbe File menu, selects Save first by accident. and !ben selects Print) [The printer dialogue box
appears.] Ob no, what questions. (S tudies the choices. Points to !be From box where the cursor is flashing.) 1
doo't know bow many pages it's going to be.
(Explains thm it will print out all pages.)
Okay. (Clicks within the dialogue box and nothing happens. Looks again and clicks on OK.) fibe printer
status box appears. The document is printed out]
13. Quit document
(Pops up tbe File menu and selects Quit.)
14. Create a document
[Runs out of time.]
15. Save a new document
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